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Introduction

This manual explains how to use Data Logging Software
GA10 (hereafter referred to as GA10). To ensure correct
use, please read this manual thoroughly before beginning
operation.

For details on the functions related to SMARTDAC+ series
options, see also the manual for the options.
Downloading Manuals

You can download the latest user’s manuals from the fol-
lowing URL:

How to Use This Manual
Structure of the Manual
This manual contains the following chapters.

Chap. Title Description
Provides an overview of Data Logging
1 Before Using the Product Software GA10. It also explains the

main specifications of the software
and the PC system requirements.
Provides a flowchart and the

2 Preparing to Collect and Record Data procedure to prepare the software for
data collection and recording.
Explains two configuration modes

for data collection and recording with
GA10: Simple Settings and Detail

Configuring and Starting Data
Collection and Recording

www.smartdacplus.com/manual/en/ Settings.
* Electronic Manuals (this manual, and related 4 Using the Math Function (/MT option) (E/Q"T'aé’;f“‘;‘j GA10's math function
manuals) 5 Using the Report/Print Function Explains the GA10’s report/print
Manual Title Manual No. (/RP option) function (/RP option).
Model GA10/GA10CL/GA10UP IM 04L65B01-01EN 6 Monitoring Data Collecti Explains how to use the Monitor Page
Data Logging Software User’s Manual (this manual) onitoring Data &oflection to monitor data collection.
SMARTDAC+STANDARD IM 04L61B01-01EN 7 Using the Custom Display Function ~ Explains the GA10’s custom display
Universal Viewer User’s Manual (/CG option) function (/CG option).
. . Explains how to edit recording data
e Paper Manuals (manuals supplied with the 8 Managing Recording Data files from a list and how to display
product) recording data files on a viewer.
= Explains how to register, delete, and
Manual Title : Manual No. 9 Managing Users edit information of users that will
GA10 Data Logging Software IM 04L65B01-0222 ging perform data collection and recording
Downloading the Latest Software and Manuals with GA10.
. . . Explains the OPC-UA server function
Updatlng the Software 10 OPC-UA Server Function (/UA option) (UA option).

Download the latest version of the software from the fol-
lowing URL:

www.smartdacplus.com/software/en/
Notes

» The contents of this manual are subject to change without
prior notice as a result of continuing improvements to the
software’s performance and functions.

 Every effort has been made in the preparation of this
manual to ensure the accuracy of its contents. However,
should you have any questions or find any errors,
please contact your nearest YOKOGAWA dealer.

» Copying or reproducing all or any part of the contents
of this manual without YOKOGAWA's permission is
strictly prohibited.

Trademarks

* vigilantplant and SMARTDAC+ are registered
trademarks of Yokogawa Electric Corporation.

* Microsoft and Windows are registered trademarks
or trademarks of Microsoft Corporation in the United
States and/or other countries.

* Modbus is a registered trademark of AEG Schneider.

» Adobe and Acrobat are registered trademarks or
trademarks of Adobe Systems Incorporated.

* Pentium is a trademark of Intel Corporation in the
United States and/or other countries.

» Kerberos is a trademark of Massachusetts Institute of
Technology (MIT).

» Company and product names that appear in this
manual are registered trademarks or trademarks of
their respective holders.

» The company and product names used in this manual
are not accompanied by the registered trademark or
trademark symbols (® and ™).

12th Edition: June, 2018 (YK)
All Right Reserved, Copyright © 2014, Yokogawa Electric Corporation

1" Modbus Server Function Explains the Modbus server function

Provides messages that GA10 may
display and how to deal with them as
well as answers to frequently asked
questions.

Provides examples on how to create
templates and definitions of keywords.

12 Troubleshooting

- Appendix

Scope of This Manual

This manual does not explain the operations of your PC’s
operating system. For this information, read the Windows
user’s guide or related materials.

Conventions Used in This Manual

Notes
Important Identifies important information required to
understand operations or functions.
Note Calls attention to information that is important for

the proper operation of GA10.
Reference Item

> Reference to related operation or explanation is
indicated after this mark.
Example: P section 4.1
Conventions Used in the Procedural Explanations

Bold characters |ndicates character strings that appear on the
screen. Example: Voltage

Images

The images used in this manual may differ from those that
actually appear in the software. Such differences do not
affect the procedural explanation.
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Version and Functions Described in This Manual

Ed. Product

Addition and Change

1 Ver. 1.01.xx

2 Ver. 1.02.xx

Modified to support GX/GP R2. Expansion to Modbus Device
Definition Files (UTA advanced series), other improvements,
changes to display and system requirements.

3 Ver. 2.01.xx

Modified to support GM10. Modified to include mail function
enhancements, language switching, and the following options.
Report/Print function (/RP), OPC-UA server function (/UA), and
Math function (/MT)

4 Ver. 2.02.xx

Modified for functional improvements (retention of settings
when connected devices are added, warning display when
communication is disconnected, etc.)

5 Ver. 2.02.02

Modified for functional improvements (fixed report printing
problems on some printers and the like), improvements to
descriptions.

6 Ver. 2.03.xx

Modified to support GX/GP/GM R3.

Added descriptions for project setting display and print functions.
Added descriptions for starting multiple client screens and DDE
server’s Visual Basic 6.0 support. Modification to the operating
environment.

7 Ver. 2.04.xx

Addition of new functions (common alarm ACK setting, sharing

of the temporary suspension of warning beeps, etc.) and
improvements to the report/print function (/RP option). Modified to
support GX/GP/GM R3.02.01 (AO module).

8  Ver3.01.xx

Added descriptions for the custom display function (/CG option).
Modified to support connections with the WT3000/WT3000E.
Expansion to the number of channels of the math function (/MT
option). Added descriptions for manual save and other functions.
Improved screens. Improvements to descriptions.

9 Ver. 3.02.xx

Modified to support GX/GP/GM R4.

Added descriptions for functional improvements such as Alarm
foreground window and Operation dialog boxes (/CG). Improved
screens. Improvements to descriptions.

10 Ver. 3.03.xx

New functions were added such as different alarm sounds,
individual alarm ACK, clearing of alarm log, storing of viewer
display condition files in the GA10 server folder, linked viewer
display of data via a GA10 client, and test mail transmission.

11 Ver. 3.04.xx

Added descriptions for the improvement (font size, grid, zone,
legend position, etc.) to the waveform printing of the report/print
function, the improvement to the deletion of entries from the
Register Device list, and the improvement to the manual save
operation.

12 Ver. 3.05.xx

Revisions

Addition of the Modbus server function, improvements to the
difference between the GA10 server time and data time, statistics
on the trend monitor, GA10 server port change function, support
for the formula ABS, alarm information export selection function
for EXCEL format recording files, support for 16-character
channel names in Modbus device definition files, performance
improvements in displaying large operation logs on Universal
Viewer, show/hide function for the parameters shown in the
statistics dialog box on Universal Viewer.

1st Edition February, 2014

2nd Edition  June, 2014

3th Edition  January, 2015

4th Edition __ April, 2015

5th Edition  June, 2015

6th Edition December, 2015

7th Edition _ April, 2016

8th Edition  November, 2016

9th Edition  June, 2017

10th Edition December, 2017

11th Edition March, 2018

12th Edition June, 2018
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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:

THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION (“YOKOGAWA"). BY INSTALLING OR OTHERWISE USING THE
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE
THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE.

1. Scope
This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, “Software Product”). Unless otherwise provided by
Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa.
Software Product: SMARTDAC+ Data Logging Software (Model GA10)

2. Grant of License

2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a single or,
the following specified number of, computer(s) and solely for your internal operation use, in consideration of full payment by you to Yokogawa of the license fee separately
agreed upon.

Granted number of License: the number of purchases
2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:
a) to reproduce the Software Product, exce pt for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;
b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any other
person or entity;
c) to use the Software Product on any unauthorized computer via the network;
d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other human
readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;

to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or

f) to remove any copyright notice, trademark notice, logo or other proprietary notices or identification shown in the Software Product.

2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa.
Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder.

2.4 You agree to maintain the aforementioned property and trade secret of Yokogawa or licensors and key codes in strict confidence, not to disclose it to any party other than your
employees, officers, directors or similar staff who have a legitimate need to know to use the Software Product and agreed in writing to abide by the obligations hereunder.

2.5 Upon expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your
computer or media shall be deleted irretrievably. If you dispose of media in which the Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6 The Software Product may contain software which Yokogawa is granted a right to sublicense or distribute by third party suppliers, including affiliates of Yokogawa (“Third
Party Software”). If suppliers of the Third Party Software (“Supplier”) provide special terms and conditions for the Third Party Software which differ from this Agreement, the
special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier.

2.7 The Software Product may contain open source software (“OSS”), for which the special terms and conditions separately provided by Yokogawa shall take precedence over
this Agreement.

o

3. Restrictions on Application

3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft operation
or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail facility, nuclear
related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2 If the Software Product is used for the abovementioned purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use and
you shall indemnify and hold Yokogawa, Supplier, their affiliates, subcontractors, officers, directors, employees and agents harmless from any liability or damage whatsoever,
including any court costs and attorney’s fees, arising out of or related to the said use.

4. Limited Warranty

4.1 The Software Product shall be provided to you on an “as is” basis at the time of delivery and except for physical damage to the recording medium containing the Software
Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom. If any physical defect is found on the recording
medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective medium shall be returned to
the service office designated by Yokogawa at your expense within the said twelve (12) months. THIS LIMITED WARRANTY PROVIDED IN THIS CLAUSE IS IN LIEU OF ALL
OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES RELATING TO THE SOFTWARE PRODUCT,
WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR
PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY, RELIABILITY AND RECENCY. IN NO EVENT SHALL YOKOGAWA
WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE SOFTWARE PRODUCT AND OTHER SOFTWARE NOR SHALL BE LIABLE
THEREFOR. The warranty provisions of the applicable law are expressly excluded to the extent permitted.

4.2 At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number (“Upgrade”) and make it available to you at your expense or
free of charge as Yokogawa deems fit. In no event shall Yokogawa be obliged to upgrade the Software Product or make the Upgrade available to you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa'’s current list price. Scope and terms and conditions of the maintenance
service shall be subject to those separately provided by Yokogawa. Unless otherwise provided in Yokogawa catalogues or General Specifications, maintenance services
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than 5
years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more than 5
years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide any service
for the Software Product which has been modified or changed by any person other than Yokogawa.

5. Infringement

5.1 If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party’s patent (which is issued at the time of delivery of
the Software Product), trade mark, copyright or other intellectual property rights (“Claim”), you shall promptly notify Yokogawa thereof in writing.

5.2 If the infringement is attributable to Yokogawa, Yokogawa will defend you from the Claim at Yokogawa'’s expense and indemnify you from the damages finally granted by the
court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa of the Claim
in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you give every and all
necessary information and assistance to Yokogawa upon Yokogawa’s request.
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Software Licensing Agreement

5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the Software
Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it become non-
infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value of the Software
Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the
infringement is arising from a) modification of the Software Product made by a person other than Yokogawa, b) combination of the Software Product with hardware or software
not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa’s suggestion, or e) any other causes not attributable to
Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party’s intellectual property
rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special terms and
conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability

6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY
PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES,
OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT, OR
ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN WARRANTY
(EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS. IN NO EVENT
YOKOGAWA AND SUPPLIER’'S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE 5) SHALL EXCEED
THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE PRODUCT. If the Software
Product delivered by Yokogawa is altered, modified or combined with other software or is otherwise made different from Yokogawa catalogues, General Specifications,
basic specifications, functional specifications or manuals without Yokogawa'’s prior written consent, Yokogawa shall be exempted from its obligations and liabilities under this
Agreement or law.

6.2 Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the cause
of action accrues.

7. Export Control
You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa.
If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America,
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense.

8. Audit; Withholding

8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product
as may be reasonably necessary in Yokogawa’s opinion to verify that the requirements of this Agreement are being met.

8.2 Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery
and, in Yokogawa'’s reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to
continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment
If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this
Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession
irretrievably. This Agreement shall inure to the benefit of and shall be binding on the assignees and successors of the parties.

10. Termination
Yokogawa shall have the right to terminate this Agreement with immediate effect upon notice to you, if you breach any of the terms and conditions hereof. Upon termination of
this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product,
certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any
termination of this Agreement.

11. Governing Law; Disputes
This Agreement shall be governed by and construed in accordance with the laws of Japan.
Any dispute, controversies, or differences which may arise between the parties hereto, out of, in relation to or in connection with this Agreement (“Dispute”) shall be resolved
amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either
party to the other, the Dispute shall be addressed in the following manner:
(i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.
(ii) If you are not a Japanese individual or entity, the Dispute shall be finally settled by arbitration in Tokyo, Japan in accordance with the Commercial Arbitration Rules of
the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of arbitration
shall be final and binding upon both parties, however, each party may make an application to any court having jurisdiction for judgment to be entered on the award and/or for
enforcement of the award.

12. Miscellaneous

12.1 This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the extent
such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.

12.2 If any part of this Agreement is found void or unenforceable, it shall not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according
to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that achieves to the
greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3 Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in relation
to that default or any subsequent one.

End of document
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Using Open Source Software

Expat

Heimdal

The report generation section and print section in the Report/Print function of the following
products use Expat source code. In accordance with the Expat license; copyright,
distribution terms, and license are provided below.

SMARTDAC+ Data Logging Software GA10, or GA10CL
Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

The password-management function of the following product uses Heimdal source code for
AES authentication key generation.

In accordance with the Heimdal license agreement, the copyright notice, redistribution
conditions, and license are listed below.

SMARTDAC+ STANDARD Universal Viewer

Copyright (c) 2006 Kungliga Tekniska Hogskolan (Royal Institute of Technology, Stockholm,
Sweden). All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of the Institute nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE INSTITUTE OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Using Open Source Software

OpenSSL

The OPC-UA server function of the following product uses OpenSSL source code for
communication. This product includes software developed by the OpenSSL Project for
use in the OpenSSL Toolkit (http://www.openssl.org/) This product includes cryptographic
software written by Eric Young (eay@cryptsoft.com) In accordance with the OpenSSL
license agreement, the copyright notice, redistribution conditions, and license are listed
below.

SMARTDAC+ Data Logging Software GA10

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL
License and the original SSLeay license apply to the toolkit. See below for the actual license
texts. Actually both licenses are BSD-style Open Source licenses. In case of any license
issues related to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. All advertising materials mentioning features or use of this software must display the
following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL”
appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT TAS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT ORITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

vi
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Chapter 1 Before Using the Product

1.1 Overview

Data Logging Software GA10 is used to collect data from measuring instruments and
controllers via communication and monitor and record the collected data. Recorded data can
be displayed and printed from the Viewer software.

To use GA10, you need a PC that can connect to target devices. The connection

between the PC and target devices is established through Ethernet communication, serial
communication, or USB communication (GM only.)

You can use the Simple Settings mode to easily start data collection.

Server and Client

GA10 is a client-server software application. Users perform various server operations from a
client. The server collects, records, and manages data received from connected devices on
the basis of the instructions received from the client.

When you install GA10 to a single PC, the client function and server function are installed
together. You can also install GA10CL, which is a version that contains only the client
function, in other PCs. Multiple clients can simultaneously access a single server.

——————— GA10 ———————— Data

Instruction to collection —
GA10CL the server =
Operation /=
User Client
Response to Server
the client Data
N _/ collection 009

Connectivity with Many Devices

GA10 is a software application that consolidates various devices connected over a network
and performs data collection. GA10 can connect to YOKOGAWA recorders and data
loggers. It can also collect data that has been acquired by YOKOGAWA's data acquisition
software (MXLOGGER, DAQLOGGER, and DAQ32PIlus) Further, it can connect and collect
data from YOKOGAWA's data acquisition software (MXLOGGER, DAQLOGGER, and
DAQ32Plus) and Yokogawa Test & Measurement’s power meters (WT3000/WT3000E).
Moreover, it supports the Modbus protocol, enabling data collection from YOKOGAWA's
control instruments (temperature controllers, signal conditioners, and power monitors).
GA10 can also collect data from other manufacturers’ devices that support Modbus
communication.

Data Logging Software GA10

Server Client Client
c Data collection
onverter RS-232 o
Operation o p—
Data collection
RS-422/485 Data cgllection Ethernet
| RS-232 I MXLOGGER
DAQLOGGER
DAQ32Plus
nstruments supportin Instruments GateWT for GA10
RS-422/485 supporting Ethernet
ommunicatio communication

Instruments
supporting RS-232 Source devices for Instruments
communication MXLOGGER data supporting Modbus
collection communication
Source devices for
DAQLOGGER data
collection

Source devices for
DAQ32Plus data
collection

*+ MXLOGGER, DAQLOGGER, DAQ32Plus are YOKOGAWA's data collection applications.
GateWT for GA10 is YOKOGAWA's driver software.
*  Modbus ASCII protocol is not supported.
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Chapter 1 Before Using the Product

Data Collection Project

GA10 collects data in units of projects. Projects are created by users to suite their purposes.
For example, a project named “Process A” can be created to collect measured data from a
process called “A.” In this way, a project can be created for each set of collected data.

For each project, the data to be collected, data to be recorded, the monitor page layout, and
the like are specified.

Multiple projects can be created in a single server.

Monitoring

Collected data can be monitored on the Monitor Page.

On the Monitor Page, you can arrange four types of displays (trend, digital, meter, and
alarm) or five types of displays that include the custom display on models with the /CG
option in an easy-to-view layout.

In addition, related data can be displayed in groups to monitor measurements efficiently. In
the trend display, you can refer to past data.

User Management

GA10 users can be registered and managed. There are two user levels: administrator and
user. Administrators are responsible for registering and deleting all users. Users enter their
IDs and passwords to access a server.

Of the users registered in a server, only those that have been granted privileges can access
projects. The operation scope of each user can be managed by assigning one of four levels:
owner, manager, operator, and monitor. If a user is accessing a project, other users cannot
access that project.

Administrator: Register and delete users

[ () [
HOA D
Client Client Client

Yy 3 ¢

Server access perlIeges

Project operation privileges

Sem(pm,ectD Cpm,ectXpm,ect>

Monitoring Data collection and recording

1-2
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Features to improve reliability
GA10 features the following functions to ensure reliable data collection.
Data supplementing function (Backfill function)

If a data dropout occurs in the data file that is being recorded due to a communication
interference, this function automatically acquires data from the internal memory of the
device and restores the data loss in the file.

Data dropout

]

L]

Several conditions must be met for the backfill function to operate properly.
For details, see Q4 on page 12-7.

Auto reconnection when communication is disconnected

If the communication is disconnected and data collection is interrupted, communication
retry is performed every approximately 30 seconds. When communication recovers,
the server resumes data collection and recording. This allows data loss to be kept to a
minimum.

Protection of data files up to the moment of power failure

GA10 writes to the data file every approximately 10 seconds. This reduces the chances of
the data file being lost in the event the PC shuts down unexpectedly.

Convenient Features

You can use the Simple Settings feature to easily start data collection.

You can set the data timestamp to PC time or Device time.

The DDE (Dynamic Data Exchange) server feature allows collected data to be loaded
into Excel and other applications.

Multiple screens (operation and monitor) can be started on a single PC.

Project settings can be displayed and printed.

GA10 has a trial mode that can be used for 60 days without a license.

Functional Addition Option
The following options can be added to the GA10.

Report/Print function (/RP option)
Math function (/MT option)

OPC-UA server function (/UA option)
Custom display function (/CG option)

IM 04L65B01-01EN
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Chapter 1 Before Using the Product

Connectable Devices and Software

The following table lists the devices and software
applications that GA10 can connect to.
Registering devices for connection: p» page 3-3, 3-10
Connectable devices and interfaces: P> page 3-16

Compatible Devices and Software

:Text Appearing on the GA10
:Screen When Connected

DAQSTATION :CX1xxx :CX1000
:CX2xxx :CX2000
:DX1xxx :DX1000
‘DX2xxx ‘DX2000
FX1000 FFX1xxx :FX1000
DAQMASTER IMV1xxx :MV1000
IMV2xxx ‘MV2000
IMX100 ‘MX100
‘MW100 ‘MW100
IR “R10000 ‘uR10000
‘UR20000 ‘uR20000
DARWIN :DA100 :DA100
DR130 ‘DR130
‘DR230 ‘DR230
:DR240 :DR240
SMARTDAC+ :GX10 :GX10 or,
iGX20 :GX20 GXGPGM_
: : PIDSIot0 2
‘GP10 ‘GP10 to
GP20 iGP20 GXGPGM_
‘GM10 1 ‘GM10 PIDSIot9 2
UTAdvanced (UT32A :UP35A or UP35A_R3 2
UT35A ‘UP55A or UP55A_R3 2
(UT52A :UT52A or UT52A_R3 2
{UT55A :UT55A or UT55A_R3 2
(UT75A :UT75A or UT75A_R3 2
{UP35A :UP35A or UP35A_R3 2
:UP55A :UP55A or UP55A_R3 2
‘UM33A ‘UM33A
WT3000 3 :WT3000 :WT3000
:WT3000E :WT3000E
DAQWORX :DAQLOGGER :DAQLOGGER
:DAQ32Plus :DAQ32Plus
:MXLOGGER :MXLOGGER
GateWT for GA10 4 :GateWT for GA10

Devices supporting the Modbus protocol 5 Ehardware

1 Supported in GA10 R2.01.01. The advanced security function (/AS) option

is supported in GA10 R2.03.01.

2 The displayed characters of the product name that is used when
connecting to a GA10 with the custom display function (/CG option). (It

corresponds to the output channel.)

On the GX/GP/GM, you use the PID control module by selecting the slot
in which it is installed on the custom display at the time the module is

installed.

3 The WT3000 and WT3000E are precision power analyzers by Yokogawa

Test & Measurement Corporation.

4 GateWT for GA10 is YOKOGAWA's driver software. It is software for
connecting to the WT series power meters (excluding the WT3000/
WT3000E) of Yokogawa Test & Measurement Corporation. Only Ethernet
connection is supported between the GA10 and GateWT.

5 Devices, including YOKOGAWA control instruments, defined using Modbus
device definition files. However, Modbus ASCII protocol is not supported.

Main GA10 Specifications

Maximum number of simultaneous

device connections

100

Maximum number of simultaneous No limit (operation guaranteed up

client connections 1

to 32 clients)

Maximum number of simultaneous

- . 30
operation projects
Maglmurln number of device 1000
registrations
Maxlmum number of project 10000
registrations
Maximum number of user 100

registrations

Maximum number of clients that
can run simultaneously on the
same PC

Multiple clients possible (See
“Starting Multiple Screens”
described later.)

Monitor interval
(when set to PC time)

100 ms, 200 ms, 500 ms, 1's, 2's,
5s,10s,20s, 30s, 1 min, 2 min,
5 min, 10 min

Monitor interval
(when set to device time)

The acquisition interval of each
device 2

Record interval
(when set to PC time)

100 ms, 200 ms, 500 ms, 1s, 2
s,5s,10s,205s,30s, 1 min, 2
min, 5 min, 10 min (limited to an
integer multiple of the monitor
interval.)

Record interval
(when set to device time)

Same as the monitor interval of
GA10

Maximum number of recording
channels (tags) per project

2000

Models with the math function:
4000 (including the maximum
math tags of 2000)

Number of display groups 50

Number of channels (tags) per 50

display group

Language 3 English, Japanese, Chinese,

French, German, Russian, Korean

1 Make sure that the version of the added client is the same as the server

version.

2 GX10/GX20/GP10/GP20/GM10 (R4.0 or later): 1 ms (shortest)
MX/MW, MXLOGGER: 10 ms (shortest).
WT3000/WT3000E: Same as the recorder’s data update rate (except 50

ms). Shortest 100 ms.

3 Make sure to use the same language setting for this software, Windows
0S8, and the recorders that data is to be collected from.

On Models with the Math Function (/MT option)

Computation interval

Same as the monitor interval of
measurement tags

Number of math tags

200 to 2000 !

1 The number is synchronized to the number of measurement tags (number
of measurement channels) as shown in the following table.

Measurement tags Math tags
100 200

200 200

500 500

1000 1000
2000 2000

If the number of measurement tags increases due to an upgrade, the
number of math tags also increases accordingly.

Nofte

» Depending on the model and the model firmware
version, older versions of GA10 may not be
compatible. Update GA10 to the latest version.

» Data acquisition may not be possible depending on
the communication status, monitor interval, or number
of data acquisition channels.

» Data update interval of the monitor screen depends
on the data acquisition interval as follows:

Data acquisition interval

Data update interval of the monitor screen

Less than 100 ms

100 ms

100ms-10s

As specified

20 s or more

Half the specified interval (i.e., 10 seconds
if 20 seconds is specified)
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Chapter 1 Before Using the Product

1.2 MODEL and SUFFIX Codes

* Basic Software
Data Logging Software

Model Suffix Code Optional Code Name
GA10 Data Logging Software
license
Channels -01 100ch
-02 200ch
-05 500ch
-10 1000ch
-20 2000ch
Options /RP Report/Print function
MT Math function
JUA OPC-UA server function
ICG Custom display function 1

1 To create custom display monitors, you need DAQStudio (DXA170), a

software sold separately. The /CG option includes a license for DAQStudio.

* Additional Channels or Functions
Data Logging Software Upgrade license

‘Model Suffix Code Name
GA10UP Upgrade license for GA10
Upgrade Channel upgrade

-01 100ch—200ch, 200ch—500ch,

500ch—1000ch, 1000ch—2000ch

Channel upgrade
-02 100ch—500ch, 200ch—1000ch,
500ch—2000ch

Channel upgrade

-03 100ch—1000ch, 200ch—2000ch

04 Channel upgrade
100ch—2000ch

RP Report/Print function

-MT Math function

-UA OPC-UA server function

-CG Custom display function 1

1 To create custom display monitors, you need DAQStudio (DXA170), a

software sold separately. The -CG option includes a license for DAQStudio.

¢ Additional Monitoring PCs (Clients)
Data Logging Software Client license

Model Suffix Code Name
GA10CL Client license for GA10
Number of -01 1 license
licenses -05 5 licenses
-10 10 licenses
-50 50 licenses

* How the software is provided

Name Description

License sheet Contains the license keys. Check that the
correct number of licenses are present.

GA10 Data Logging Software
Downloading the Latest Software and
Manuals

1 sheet (A4 size)

1.3 PC System Requirements

¢ Hardware 1

Item Description

CPU Pentium 4, 3.2 GHz or faster

Internal memory 2 GB or more

Hard disk 100 MB or more of free space, NTFS recommended
Mouse Mouse compatible with the OS

Display 1024 x 768 dots or higher, 65536 colors or more

Communication ports 2 RS-232 or Ethernet port compatible with the OS
To perform RS-232 communication or RS-422/485
communication with a connected device, the server
PC needs a RS-232 serial port.
A USB port is required for USB communication.

1 If you plan to use GA10 continuously for a long period of time, we
recommend that you run it on a desktop PC rather than a notebook.

2 Operation is not guaranteed if you use the converter cables, such as USB-
to-serial, for the communication.

¢ Operating System 1

0s Edition 32 bit 64 bit SP Browser
Windows 7 Home Premium Yes Yes SP1 IE11
Professional Yes Yes SP1 IE11
Windows 8.1 — Yes Yes Update IE11
Pro Yes Yes Update IE11
Windows 10 Home Yes Yes No SP__IE11
Pro Yes Yes No SP__IE11
Windows Server 2008 R2 _Standard No Yes SP1 IE11
Windows Server 2012 Standard No Yes No SP__IE10
Windows Server 2012 R2 Standard No Yes Update IE11
Windows Server 2016 Standard No Yes No SP_IE11
1 Exclude operating systems that Microsoft has finished supporting from the
above list.

¢ Other Operating Environment

Item Description

Microsoft Office Excel 1 2007, 2010, 2013, 2016

Windows Internet Explorer |IE9, IE10, IE11 (Corresponding OSs are shown
above.)

Windows Media Player Version 10 or later

Adobe Reader Adobe Reader X or later (latest version

recommended)
RS-232 - RS-422/485 To perform RS-422/485 communication with a
converter connected device, use a converter. (YOKOGAWA

ML2 recommended)

1 Use Microsoft Office Excel 2010 or later to view Excel reports generated
with the Report/Print function (/RP option).
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Chapter 1 Before Using the Product

1.4 Menu and Icons

This section describes the GA10 menus and icons and page references on how to use them.

Menu before logging in

File View Help

.|
H/_/
Tool Bar (see the table below)
Menu Description \See pages...
File(F)
_& |Login Login server 24
Exit Exit application -
View
Style » Switch the display style 2-5
/| |Tool Bar Show or hide the tool bar -
Help(H)
User's &Manual F1 Display user operation manual -
Input Server License... Display server license dialogue 2-14
2 |About... Display program information, version number and copyright 214
Server information... Display server version information dialogue 2-18
To Update Website Display website of Data Logging Software -

Menu after logging in

Append mark to the current group

Acknowledge of
Append mark to all groups

Stop the waring beep

device communication interference

Mark edit box Alarm ACK
File Edit View Project Operation User Help l J
HY o amih DD X &8 @ e BBl 2 -l
AN ~ J v J - J
Tool Bar Mark Bar Warning Action Bar
(see the table below)
Menu \Description \See pages...
File
Logout... Logout from server 2-5
New Project... Create a Project 2-8, 1-6,
3-6
Import Project... Import Project information to create Project from file. 3-7
Export Project... Export Project information to file 3-7
Import tags... Import tags from tag information tag message file 3-26
Export tags... Export tags from tag information tag message file 3-26
Server Port No.... Display or change the server port number. 213
Modbus Server Setting... Display or change the port number or timeout value of the Modbus |2-13
server.
Start DDE Start DDE service 3-50
Stop DDE [DDEServer Connection: Stop DDE service. While the DDE server is running, the host 3-50
Host name/IP address] (P) name or |IP address of the server connected to the DDE server is
displayed.
Exit Exit application -
Edit
[y |Copy Ctrl+C |Copy the selection and put it on the Clipboard 3-9
oy |Paste Ctrl+V |Paste the copied content 3-9
w% |Delete Delete |Delete the selected content 3-4,9-4
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Menu \Description \See pages...
View
gg |Project List Page Switch to Project list page 2-8,3-5,
6-1
4 |User Management Page Switch to user management page 2-7,9-2
o |Log... Display log dialogue 6-16
= |Refresh Update the current page 8-2
v |Alarm Show or hide alarm 6-7
Alarm List... Show alarm list dialogue 6-11
/| |[Move The Window To The Top Show this window in front when an alarm occurs. 6-13
When Alarm Occurred
es |Group Link Linkage shows when switching between different groups 6-2
Cursor value... Open the Cursor Window 6-6
Cursor Value Transparency > Switch cursor value transparency 6-6
Erase Cursor Erase Cursor 6-6
Statistics... Display a statistics dialog box. 6-6
Tag Display Form. » Switch tag display format (Tag Index, Tag No., Tag Comment) 3-22
User Display Form. > Switch user display format 3-49
Style > Switch the display style 2-5,6-3
Date Format > Switch the date format 6-3
Month Display Form. > Switch the month display format 6-3
Decimal Point » Switch the decimal point 6-3
/| |Tool Bar Show or hide the tool bar -
/| |Mark Bar Show or hide the mark bar -
v |Warning Action Bar Show or hide the warning action bar -
Language (M) > Switch the language (English, Japanese, German, French, Chinese, |2-18
Korean, Russian)
Manual Save Button Switching the show or hide Manual Save button 6-1
Manual Save Confirm (Q) Show or hide the manual save confirmation dialog box. -
Frame Size Display Shows or hides the screen size of the custom display monitor. 7-3
Full Screen (J) Display the selected monitor in full screen 6-2
Project
Open with specified permission Open the project according to the specified permission 9-5
Modify Basic Information Modify project's basic information 3-9
Modify Owner Modify project's owner 9-4
Append Mark > Append mark to the current group or all groups 6-7
Reset Computing Reset computing on the server (when math tags are enabled on|4-8 , 6-14
GA10 with the /MT option)
Start Device's Computing Start computing in the devices used in the Project 6-14
Stop Device's Computing Stop computing in the devices used in the Project 6-14
Reset Device's Computing Reset computing in the devices used in the Project 6-14
Reset & Start Device's Computing Reset and start computing in the devices used in the Project 6-14
Alarm ACK Alarm ACK 6-11
Clear Alarm Log Clears the alarm log. 6-9
Update Tag Information > Updates the selected tag information manually. 3-27
"Tag No., Tag Comment" or "Except Tag No., Tag Comment"
= Assign Tag Automatically... Assign tags automatically 3-31
) ﬁorting Tags in Order of the Device Sort tags in order by device number 3-26
o.
Unlock Project Forcibly Change the project's lock state forcibly 9-5
Setting Printout Config...(G) Configure the setting display (select the settings to be shown) 3-57
Config Display(l) Displays settings 3-59
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Chapter 1 Before Using the Product

Menu \Description \See pages...

Operation

Gy |Start Monitoring Simultaneously All opened Projects start monitoring simultaneously 3-5

@ |Stop Monitoring Simultaneously All opened Projects stop monitoring simultaneously 3-5

W Start Recording Simultaneously All opened Projects start recording simultaneously 35

@ |Stop Recording Simultaneously All opened Projects stop recording simultaneously 3-5
Re-execute Modbus Server Restart the Modbus server. 3-52, 111

Warning Beep

Share the Warning Beep across clients

Stop the Warning Beep

Turn on or off the warning beep that sounds when a warning occurs|6-11

Specifies sharing or non-sharing mode of the temporary
suspension of warning beeps.

Stop the warning beep

Acknowledge of Device Perform an acknowledge of device communication interference. 6-12
Communication Interface

User
Change Information Change user's information 2-6,9-2
Register New User Register new user in server 2-7,9-3
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2.1 Preparation from Installation up to Data Collection and Recording

The following flowchart shows an outline of the procedure from GA10 installation up to data

collection and recording.

Installation Sec. 2.2 Adding functions:
<% P Sec. 2.8
CC) Log in. Sec. 2.3
=
z By
© Register the administrator password. | Sec. 2.4
o
o v
| . P=- === -—-=--5
o I Register users. |, Sec.2.5
Create a project for data collection and recording. | Sec. 2.6
No . A A
Create a new project? Use enstmg_; projects.
* Export and import
Save and load projects (settings).
YES * Copy and paste
Copy and paste existing projects (settings).
Confi i d Sec. 3.3.1
Quickly start logging Select the ontiguire Setings an
setting mode. start logging.
C Simple Settings gec. 3_2> Detail Settings gec. 3_;9
Switching not possible | |
V X « V
Register devices to connect. Sec. 3.2.2 Register devices to connect. | Sec. 3.3.2
Set the col!ection and Switching possible Set tags. Sec. 3.3.3
record interval. Sec. 3.2.3
c v V
(o) Set the data save destination. | Sec. 3.2.3 Set display groups. Sec. 3.3.4
e
o gL
S vV
[®)) Set the data collection method.| Sec. 3.3.5
=
c 4 y
(@] V
@) Register monitoring. | Sec. 3.3.5
it
vV
Set data recording method.| Sec. 3.3.6
g
A
Set mail settings. Sec. 3.3.7
Set project access privileges. | Sec. 3.3.8
A4 {v}

Gtart collection and recording) Sec. 3.2.4 CStart collection and recording)

Monitor data. View recorded results. Manage users.

Chapter 6 Chapter 8 Chapter 9
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2.2 Installation

The GA10 installer package includes a server, client, and viewer programs. Executing the
procedure below installs all programs in a single PC.

The server runs as a Windows service and starts running as soon as it is installed.
(Hereafter, a PC with the server function installed will be referred to as a “server PC.”)

Nofte

» Before installing the software, check that your PC is not infected by a virus.
» Install the programs as a Windows administrator.
* Uninstall GA10 before reinstalling.

The procedure here is explained for Windows 7.

1 Double-click the downloaded file to extract the files.

2 In the extracted folder, right-click Install_x86.exe (Install_x64.exe for a 64 bit edition),
and click Run as administrator.

3 If you accept the license agreement, click Next.
The Customer Information dialog box appears.

Customer Information
P

InstallSield < Back bext > Cancel

4 Enter the user name, company name, and license number and then click Next.
If you do not enter the license number here. a 60-day trial version will be installed.

5 Continue to follow the instructions on the screen to install the software.

6 When the installation is complete, click Finish.
Check that SMARTDAC+ Data Logging Software has been added to the Start
menu under All Programs.
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Trial periods

If the GA10 is installed without the license number, the trial period starts running.

» Continuous operation is possible for 60 days. When the trial period expires, the software
will no longer run.

* During the trial period, the maximum number of recording channels (tags) is 4000 (2000
tags + 2000 math tags), and all options can be used.

» Projects created with the trail version can only be passed on to products with 2000 device
channels (suffix code “-20”) and with all options.

* In the software, click About on the Help menu, and check the remaining number of days
in the dialog box that appears.

Installing different versions
» In case you already purchased a license for the old version but would like to try the new
version for 60 days:
You can try the new version. However, install the new version in a PC different from
the one you are running the old version on.

* In case you have tried the old version before and would now like to try the new version:
You can try the new version. However, install the new version in a PC different from
the one that you tried R1 on.

* In case you already purchased a license for the old version and would like to upgrade to
the new version:
You can upgrade for free. Uninstall the old version, enter your license, and install
the new version. You can use it with the same specifications as the purchased (old)
version.

Project Compatibility

* Projects created in an earlier server version can be used in later server versions. Projects
are not displayed for the opposite case.

+ If an option is added to the GA10, projects created in the previous configuration can
be used with the GA10 in the current configuration. Projects are not displayed for the
opposite case.

For details on adding option functions and clients, see the following sections.
Adding Functions (GA10UP-RP, -MT, -UA, -CG)
or
Adding a Client (GA10CL)

For details on the trial period and entering license information after the period ends,
see the following sections.
Entering a License Number during the Trial Period
or
Entering a License Number after the Trial Period

IM 04L65B01-01EN
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2.3 Logging In
Logging in is an operation carried out to connect a GA10 client to a server.
Users start the client, log in, and perform various operations. When logging in for the first
time, you do not enter a password.

1 On the Start menu, click All Programs, SMARTDAC+ Data Logging Software, and
Data Logging Software.

Fle View Hep
2

A Login dialog box appears.

2 Leave the username admin and the password blank.
User name: admin
Password: (blank)
If you want to change the port number, specify a number between 1 and 65534.

f 3
Login x
Host Namef? Address:

Port No.: 50310
User Name:
Password 1
( 0K ] [ Ccancel )
b .

For changing the port number: p» Sec. 2.7.4

3 Click OK.
The dialog box closes, the initial Project List Page appears.

100 mbnh 0088 oo e e e

(ToProject Page

If the software is started for the first time after installation, a log dialog box appears.
IM 04L65B01-01EN
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4

Nofte

Adjust the log dialog box display.

Log
Fitter: [ 21 [H Project
OCTM8 10:06:19 SYS:admin has logged on.[SYD03]

OCTM8 10:06:19 SYS: admin has logged on.[SY003]

» Change the displayed position: Drag the dialog box to move it.

» Change the size: Point to a corner of the dialog box so that the pointer changes to
an arrow. Then, drag to change the size.

» Hide: Click the x button at the top of the dialog box.

» Show again: On the View menu, click Log.

What is the log dialog box?: 4

To create a project, on the File menu, click Create New Project.

To log out, on the File menu, click Logout.
A confirmation message appears. Click OK to log out.

Registering the administrator password: P Sec. 2.4
Registering users: P sec. 2.5

You can change the background color from the two available colors by using Style in the View

menu. The following figure shows the “dark” style window. (The windows shown in all other figures

of this manual is “light” style.)

Setting general display options: p Sec. 6.1.3

Starting Multiple Screens
You can display multiple operation screens (clients) on the same PC. To start multiple

screens, repeat the login procedure from step 1 to 3.

When multiple screens are shown, the screens use the same display conditions stored

in the PC. Be careful when you change the display settings.

Limitations may be placed on the number of screens that can be started depending on

the PC performance, collection and recording environment, and the like.

» For details on display conditions, see Sec. 6.9.6

IM 04L65B01-01EN
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2.4 Registering the Administrator Password

After installation, first set the administrator (admin) password. The administrator can register
and delete other users and initialize their passwords.

1 After logging in, click Change Information on the User menu.

HIo@ mbkk X 2o @ |5 & [

The Change User’s Information dialog box appears.

2 Enter the new password for the administrator, and click OK.
Enter the password using 4 to 30 alphanumeric characters.

4 '
Change User's Information x
User Name: admin
User Full Name: | admin |
rossurs —

New Password,

ket
R

[ OK ] [ Cancel ]

Confirm New Password,

\ v

The Change User’s Information dialog box closes. The new administrator password has been set.

Important

After registering their passwords, users will need to enter the passwords to log in to the server.
If the administrator cannot log in, administrator privileges cannot be used. Make a note of the
administrator password, and do not lose it.

IM 04L65B01-01EN



Chapter 2 Preparation

2.5 Registering Users

After registering the administrator, register users as necessary. The administrator registers
users.

1 Start the client, and enter the administrator password that you set earlier to log in.

2 On the View menu, click User Management Page.

Or, click the % icon.
The User Management Page appears.

3 On the User menu, click Register New User.

Fle Gt View Project Opeton Usr
1o wbeh 00X Qe[ oo

Coprecipase )

The Change User’s Information dialog box appears.

4 Type the user name and user full name.
Enter up to 20 alphanumeric characters (ASCII except for the control characters) for

the user name.

Registe User x
User Mame: | Usert |
User Full Name: |BBBB_fu Iname |

[ 0K ] [ Cancel ]

5  ciick ok.

The user is registered, and an icon is added in the window.

: U=zert

User FullNa_ BBBB_fulln_
-

I

6 To add more users, repeat the procedure above.
Registered users will be able to log in, set their passwords, and perform their as-

signed tasks.

Nofte

User names are case-sensitive. When logging in, enter the user name exactly as it was registered.

Differences between the administrator and users and changing and deleting users: P sec. 9.1

2-7
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2.6 Creating a Project

After logging in to the server, create a project to manage data collection and recording.
You can create a project in one of the following ways.

» Create a new project: You can create a new data collection project.

« Export and import: You can export and import a project.

» Copy and paste: You can duplicate an existing project.

1 Switch from the User Management Page to the Project List page.

On the View menu, click Project List Page. Or, click the B icon.

Switch to Project List page

The Project List Page appears.
The first page that appears when you log in is the Project List Page.

(ToProject Page

2 On the File menu, click New Project.
The Create New Project dialog box appears.

Create New project x

Projects Name: |

Comment:

Settings Mode: (8 Simple Settings () Detail Settings

| OK I l Cancel I

2-8
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3. Type the project name and comment.
You can enter up to 20 characters for Project's Name and 60 characters for

Comment.
Following characters are unavailable for Project's name: \ /:,;*?"<>|

4 Set Settings Mode to Simple Settings or Detail Settings.
To start data collection and recording with a few steps, select Simple Settings.

To set operation details, select Detail Settings.

5 ciick ok.

A new project is created in the Project List Page.

e @ e & [ o |

(JoProectpage )

A project that you create is shown in the Project List Page along with the information about

the project.
Access privilege
and the user name Projeclt name

. }— Access

; 1
[ I
A i T -
_ Project_1 ] privilege
I
=
Owner: admin 2
4 adming :Locking
User who are locking
(accessing)

The following types of access privileges are available.

¥ » o -
Owner Manager Operator  Monitor

Project access privileges: P Sec.3.3.8

6 To continue with the configuration, double-click to open the project.
For the setting procedure, see the following pages.

Easy Configuration (Simple Settings): P sec. 3.2
Detailed Configuration (Detail Settings): P sec. 3.3

IM 04L65B01-01EN
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2.7 Controlling the Server
This section explains how to manually control (start, stop, and change) the GA10 server
program “DLGServer. "Perform these operations as necessary.

2.7.1 Checking Whether the Server Is Running

1 On the Start menu, click Control Panel and Administrative Tools, and double-click
Services.
The Services window appears.

< Services el =]
Fie Action View Hep

e @ o=Hml > v mnw

) Services (Local) || <. Senvices (Local)

Select an item to viewits description. | Name Description  Status  Startup Type  LogOnAs
 ActveX nstaller (. Provides Us Manual LocalSyste..|
¢4, Adapive Brightness Monitorsa Manal LocalSenice |
G Adobe Acrobat U AdobeAcro.. Stated  Automatic  Local Syste..
£}, Adobe Flash laye. Manal Local Syste..
£, Application Experi.. Processesa.. Started  Manual Local Syste..
¢} Appliction dentity Determines Manal Local Senvice
& Application nfor. Faclitatest.. Stated  Manual Local Syste..
£}, Appliction Layer .. Provides s Manal Local Senvice
£ Application Mana... Processes in. Manual Local Syste...
& Background ntell.. Transfers il Stated  Automatic (D... Local Syste..
G Base Fitering Eng. The BaseFil. Stated  Automatic  Local Sevice
% BitLocker Drve ... BDESVC hos Manal Local Syste..
{4 Block Level Backu... The WBENG. Manual Local Syste...
% Blustooth Suppor... The Bluetoo, Manal Local Senvice
CiBrnchCache  This senice Manal Networks.
£}, Certficate Propag... Copies user Manal Local Syste..
(4 CNG Key Isolation  The CNG ke. Manual Local Syste...
C.COM» EventSyst.. SupportsSy... Stated  Automatic  Local Sevice
,COM= System Ap... Manages th. Manal Locsl Syste..
 Computer Browser  Maintins ... Stated  Manual LocalSyste..
gl o

Extended /(Standard

2 Scroll down to find DLGServer in the Name column. Check the Status column.
The DLGServer status should be indicating Started, and Startup Type should be set to Automatic.

. Services (Local)

Select an item to view its description. | Name Description  Status  StartupType  LogOnAs  *
(4DCOM ServerPro... TheDCOM... Stated  Automatic  Local Syste..
(iDesktopWindow .. ProvidesDe.. Started  Automatic  Local Syste..
. DHCP Client Registers an...  Started Automatic Local Service [
* Diagnostic Policy .. TheDiagne.. Stated  Automatic Local Service £
%} Disgnostic Senice... The Diagno... Started  Manual Local Service
% Dignostic System... The Diagno.. Manual Local Syste.
) Disk Defragmenter ~ Provides Dis.. Manual Local Syste.
i Distributed Link Tr... Maintains li.. Stated  Automatic  Local Syste.
g ed Transa... Coordinates... anual NetworkS...

SMARTDAC... CStarted @ Automatic Network S...
£ DNS Client The DNS Cli...  Starte Tomatic Network ...
£, Encrypting File Sy... Provides th. Manual Local Syste.
£, Extensible Authen... The Exens. Manual Local Syste.
i Fax Enables you... Manual Network S...
£ FLEXnet Licensing... This service. Manual Local Syste.
£l Function Discover.. The FOPHO.. Manual Local Service
(. Function Discover.. Publishesth.. Started | Automatic Local Service
(i.Google Seftware..  Google 7. Manual Local Syste..
(/. Google Update t... Google ..  Started | Automatic (D... Lecal Syste.
£ Google Update ... Google V... Manual Local Syste...
T i ] v

DLGServer Status: Started
Startup Type: Automatic

If the DLGServer status indicates Started, the GA10 server is running.

3 After confirmation, close the window.

Nofte

If Startup Type is set to Automatic, the server will start and stop when Windows start and stop.
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2.7.2 Starting (Restarting) or Stopping the Server
To manually start or stop the GA10 server, follow the procedure below.

Important

Before stopping the server, stop data collection and recording, and log out.

1 On the Start menu, click Control Panel and Administrative Tools, and double-click
Services.
The Services window appears.

% Senvices [ElE] =]

File Action View Help

e |[@ o=zBE v > a0

% Services (Local) || Services (Local)

Select an item to view its description. | Name Description ~ Status  StartupType  LogOnAs  *
4 ActiveX Installer (. Provides Us. Manual Local Syste. &
(% Adaptive Brightness Monitors a Manual Local Service | |
(4 Adobe Acrobat U. Adobe Acro. Started Automatic Local Syste.
(4 Adobe Flash Playe. Manual Local Syste.
(}, Application Experi... Processesa.. Stated  Manual Local Syste.
{}, Application Identity Determines Manual Local Service
(%, Application Infor..  Facilitatest.. Started  Manual Local Syste.
£, Application Layer ... Provides su. Manual Local Service
“, Application Mana... Processes in. Manual Local Syste.
‘4. Background Intelli... Transfers fil Started Autematic (D. Local Syste.
‘4 Base Filtering Engi... The Base Fil... Started Autematic Local Service
% BitLocker Drive En... BDESVC hos. Manual Local Syste.
% Block Level Backu... The WBENG. Manual Local Syste.
% Bluetooth Support... The Bluetoo... Manual Local Service
(4 BranchCache This service ... Manual Network S...
(% Certificate Propag... Copies user .. Manual Local Syste...
(5 CNG Key Isolatien  The CNG ke... Manual Local Syste...
(5, COM+ EventSyst.. SupportsSy.. Stated  Automatic Local Service
(5, COM~ System Ap... Manages tha. Manual Local Syste.
(%, Computer Browser Maintainsa... Stated  Manual Local Syste... .
<0 I ] v
Extended / Standard /

2 In the Services window, choose DLGServer.

3 To stop the server, on the Action menu, click Stop.
The status turns blank.

< Services (=] 8 i
File [ Action ] View Help
ae Start
G5 Fices (Locan
Pause
Resume er Neme Description  Status  StatupType  LogOnAs  *
Restart *Diagrostic Policy .. TheDiagno... Stated  Automatic Local Senvice
aats (; Diagnostic Service... TheDiagno... Started Manual Local Service
All Tasks > Bservice ;
i - Diagnostic System... The Diagn... Manual Local Syste...
Refresh J, Disk Defragmenter  Provides Dis.. Manual Local Syste... =
‘4 Distributed Link Tr... Maintains li... Started Automatic Local Syste... | |
s n: % Distrbuted Transa... Coordinates. Manual NetworkS..
Help Rt LRk RS D G5crver  SMARTDAC.. Started __Automafic___Network 5. |
DN Clent TheDNSCli.. Stated  Automatic  NetworkS..
i Encrypting File Sy Provides th.. Manual Local Syste..
(. Bxtensible Authen... The Extensi, Manual Local Syste..
CFax Ensbles you. Manual Network S..
£i FLEXnet Licensing... This service . Manual Local Syste..
%4 Function Discover... The FDPHO. Manual Local Service
% Function Discover... Publishes th... Started Automatic Local Service
i Google Software .. Google 7. Manual Local Syste...
% Google Update ... Google V... Automatic (D... Local Syste..
G Google Update ... Google . Manual Local Syste...
i Group Policy Client Theseniice .. Started  Automaic Local Syste..
(i Health Key and Ce... Provides X5. Manual Local Syste..
;i HomeGroup Liste.. Makes local. Manual Local Syste...
ay i i
Extended  Standard

The status turns blank.

4 To start the server, on the Action menu, click Start.
Click Restart on the Action menu to stop the server once and restart.
The status shows Started.
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1 Carry out steps 1 to 3 in the previous section to stop the server.

In the Services window, double-click DLGServer.
The DLGServer Properties appear.

DLGServer Properties (Lecal Computer) | 22 |

General |L05 on I Recovery I Dependencles|

Service name: DLGServer
Display name: DLGServer
Description: FMARTDAm Cata Logeing Software Server -

Path to exacutabla:
C:¥Program File s¥vokogawa Electric Corporation¥SMARTDACH Data Logeing

Startup type [Automatic -

Help me confieure service startup oplions.

Service status: Started

Start [ Stop ] [ Pause ] Rezume

“ou can specify the start parameters that apply when you start the service
from here .

Start parameters:

o

3 Click the Startup type arrow, and click Manual.

DLGServer Properties (Local Computer) ﬁ

General |Log On | Recovery I Dependencies|

Service name: DLGS erver
Display name: DLGServer
e soription: FMARTDAD+ Cata Logging Software Server -

Path to executable:
C:¥Proeram File s¥vokogaws Electric Corporation ¥SMARTDACH Data Loeging

Startup type: [Automatic S— -]
Automatic (Celayed Start)

Help me caonfigure = Ay tomatic -.%
Service status: UD|sabIed

Start [ Stop ] [ Pause ] Rezume

“rou can specify the start parameters that apphy when you start the service
from here.

Start parametars:

o

4 Click OK to close the dialog box.

2.7.3 Changing the Server Startup Type from Automatic to Manual.

212
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2.7.4 Changing the Server Port Number
By default, the GA10 server port number is set to 50310. If necessary, change the port

number by following the procedure below.

The port number can be changed only when a GA10 administrator logs in. Because two
ports will be used, you cannot use other servers.

1 On the File menu, click Server Port Number.
A Server Port Number dialog box appears. (setting range: 1 to 65534)

Server Port No. x

Port No. [50310 |~50311
( Ok ] ( Cancel ]

2 Click OK.
Then, restart the GA10 server. (See the section 2.7.2)

2.7.5 Viewing or Setting the Port Number and Timeout Value of the Modbus Server

The port number and timeout value can be displayed or changed only when a GA10
administrator logs in.

1 On the File menu, click Modbus Server.
A Modbus Server Setting dialog box appears. (port number setting range; Port number: 1 to

65535, timeout value setting range: 1 to 120 minutes)

Modbus Server Setting x
Port No..
Timeout: Minute

( Ok ] ( Cancel ]

2 Click OK.
Then, restart the Modbus server. (See the section 2.7.6)

2.7.6 Restarting the Modbus Server
The Modbus server can be restarted only when a GA10 administrator logs in.

1 On the Operation menu, click Re-excute Modbus Server.

IM 04L65B01-01EN
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2.8 Entering a License Number

When entering a license number, use Windows administrator privileges. If you are using
Windows 7, follow steps 1 and 2 below to start the software, and then enter the license
number. Before entering the license, we recommend you to back up your projects.

Checking the Remaining Trial Period

In the software, click About on the Help menu, and check the remaining number of days in
the dialog box that appears.

Entering a License Number during the Trial Period

1

2
3
4

Right-click Data Logging Software in the Start menu.

On the shortcut menu, click Run as administrator.

Data Logging Software starts.

Log in to the server.

On the Help menu, click Input Server License.

A dialog box appears.

-
Input Server License
Please input software’s license numbers.
ftem License

Type the license number, and click Register.

A message is displayed.

Message

@ Server is activated. Please restart server (M1012)

Click OK.
The license number appears in the dialog box.

rInplll Server License
Please input software’s license numbers.
OO Cregise)
tem License
License - — ——
\
7 Click Close.
Restart the server.
Nofte

After registering the license, you must restart the server.

Restarting the server: p» Sec. 2.7.2.
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Important
If you enter the server license after the trial period has expired, projects that were registered up

to that point can no longer be used.
Export the project (output and save) before entering the license. Register the license, restart

the server, and then import the project (reload) for use. For the procedure, see “Exporting and
Importing” on page 3-7.

Entering a License Number after the Trial Period
If the trial period expires, you will no longer be able to log in. When you start the software,
you will be prompted to enter the license number. If you have purchased a license, type the

number.

Adding Functions (GA10UP-RP, -MT, -UA, -CG)
To add an option, in the Input Server License dialog box, register the upgrade license
number.

Model Name
GA10UP _RP Report/Print function
-MT Math function
-UA OPC-UA server function
-CG Custom display function

~\

Right-click Data Logging Software in the Start menu.

On the shortcut menu, click Run as administrator.
Data Logging Software starts.

3 Log in.
Export the project (output and save) before entering the license.

After registering the license, import the project (reload) for use.

4 On the Help menu, click Input Server License.
A dialog box appears.

# ™y
Input Server License X
Please input software’s license numbers

Item License Content
License License/100
Close
\. 7

5 Type the license number, and click Register.
A message is displayed.

Message

Option is added to server. Please restart server to
enable oplion.(M1013)

( OK

IM 04L65B01-01EN
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6 Click OK.

The description of options is displayed on the second and subsequent lines under license items.

License
License(Upgrade)

-
Input Server License

Please input software’s license numbers.

O[O0 G

Item

Content

400-0000-99856-1 License/100
401-0040-99856-M5 Math

Close

7/  Click Close.

Then restart the server.

Restarting the server: P Sec.2.7.2

Adding Channels (GA10UP-01, -02, -03, -04)

To add channels (tags), in the Input Server License dialog box, register the upgrade license
number. The procedure is similar to adding an option.

The following table shows the maximum number of tags in a project after channels are

added.

Model N Maximum Number of Tags in a Project

Before After

GA10UP -01 1 level upgrade 100 200

200 500

500 1000

1000 2000

02 2level upgrade 100 500

200 1000

500 2000

.03 3level upgrade 100 1000

200 2000

-04 4 level upgrade 100 2000

Nofte

On a GA10 with the math function (/MT option), adding measurement tags by upgrading also

increases the math tags according to the number of tags there are after the addition.: P “Number
of math tags” on page 1-4

2-16
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Adding a Client (GA10CL)

To add a client, use the installer InstallClient_x86.exe, which installs only clients.

(InstallClient_x64.exe for the 64 bit edition)

You can download the installer from the following URL.
www.smartdacplus.com/software/en/

You will need to enter the client (GA10CL) license number when you install the client.

Model Name
GA10CL Client license (for GA10)
Number of license .01 1 license
-05 5 licenses
-10 10 licenses
-50 50 licenses

Install additional GA10CLs in different PCs from the one in which the GA10 basic software
(server and client) is installed. The installation procedure is the same as the GA10 basic

software.

When you start the client after installation, enter the following information.

* Host name/IP Address
The host name or IP address of the PC in which the GA10 (server) is installed.

» Port Number
GA10 (server) port number (default value: 50310)

+ User Name
User name already set on GA10 (default value: admin)

» Password
The password of the above user (default value: blank)

Nofte

Make sure that the version of the added client is the same as the server version.

IM 04L65B01-01EN
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2.9 Checking the Number of Channels (Tags) and Options That Can Be Used

You can check the maximum number of channels (tags) and the options that can be used in
the server information dialog box.

On the Help menu, click Server Information to display the information of the server that
you are logged in to.

Maximum number of channels (tags) and options
|

Server Version x
- SMARTDAC+ Data Logging Software Server x86 R2.01.01 B01(
® @ o

Copyright (C) 2014-2015 Yokogawa Electric Corporation
Software Japan
Serveris licensed to
YHQ

Doc

Item Display Description

Maximum number of /number of tags Display example: /500

channels (tags)

Math function availability /MT Displayed when the Math function (option or added with an upgrade) is
available.

Report/Print function /IRP Displayed when the Report/Print function (option or added with an

availability upgrade) is available.

OPC-UA server function  /UA Displayed when the OPC-UA server function (option or added with an

availability upgrade) is available.

Custom display function /CG Displayed when the Custom display function (option or added with an

upgrade) is available.

2.10 Changing the Language

On the View menu, click Language to switch the user interface language. You can select

from English, Japanese, Chinese, French, German, Russian, and Korean.

* The language setting is managed at the PC level.

» The default language is the OS language. If the OS language is an unsupported
language, the language is set to English.

2-18
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2.11 Uninstallation
To uninstall GA10, follow the procedure below.

Click Uninstall.

Select SMARTDAC+ Data Logging Software.

On the Start menu, click Control Panel and Programs and Features.
A list of programs installed in your PC appears.

Control Panel Home

) Tun Windows festures on or
off

Instal  program from the
network

£5 » Contrl Panel » Al ControlPanel tems » Progrms and Features - [ 4 [ search Programs and Features B
Uninstall or change a program
| Change, o Repair
Name - Publisher Installed On  Size. W
3723
Lhaplus 30712
EMicrosoft o Microsoft Corporation 2030619 8MB
£ Wicrosot Forefrot Ciet Securiy MicrozoftCorperation 30712 s77MB
EMicrosof Forefront Clent Security SN MicrosoftCorporation o372 22m8
& Microsoft Offce Communicator 2007 Microsoft Corparation 20130619 158MB
& Microsoft Office Communicator 2007, MUI Microsoft Corporation 2013/06/19 4a2m8
53 Microsoft Offce 190 MicrosoftCorporation 2030619 57MB
53 MictosoftOffce Language Pack 2010 - English MicrosoftCorporation 20306720
EIMicrosoft Offce Live Mesting 2007 Microsoft Corparation 20130619 s21m8
2 Microsoft Offce rofessionl Plus 2010 MicrosoftCorporation 20130619
EMicrozoft Operations Manager MicrosoftCorporation o372 138MB
L] Mictosof Viso Viewer 2010 Microsoft Corporation 2030619 1048
£ Microsoft Visusl - 2005 Recistrbutable Microsoft Corporation 030719 0K8
! v Microsot Corporat 030719 sa8 K8
[ Microsot Visusl G-+ 2010 186 Reditributable - 10040219 MicrosoftCorporation 2030619 1me
20130619
2030619
2030619 £
2030619
Yokogauw lectric Corporation 031210
Yokogaws Electric Corporation 20130805
0030723
0307723
20310725 717m8
o320 w3me | |
« i | v
[ 1] Yokosawa Electric Corporation Productverson: Support ik hitp://wwwyokogawa.cojp/ns/ss/ns-c..
Help lnk hitpy//uweyokogaw...

SMARTDAC+ Data Logging Software - InstallShield Wizard

A confirmation message appears. To proceed, click Yes.

Do you want to completely remove the selected application and all of its features?

Uninstallation begins.

Uninstall Complete

< Back Finish

Cancel

Uninstallation is complete when the progress bar disappears.

On Windows 8, click Settings, Control Panel, and Programs and Features.

Important
Do not change or delete files in the following folder: local disk > ProgramData > Yokogawa >
SMARTDAC+ Data Logging Software > Config.
These files contain user information, project setting information, project status information,
and device information.

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

3.1 What Are Simple Settings and Detail Settings?

In GA10, you need to configure various project settings before beginning data collection
and recording. There are two modes to configure these settings: Simple Settings and Detail
Settings. You can select which setting mode to use when you create a project.

In Simple Settings mode, you only have to specify the device to connect to, data collection
and recording interval, and data file save destination in a single window to begin data
collection and recording.

In Detail Settings mode, you can configure settings in detail to customize data collection,
monitoring, and recording.
Detail Settings mode consists of the following seven Setting Pages that you switch between
to configure the settings.

» Device Setting Page

» Tag Setting Page

» Display Group Setting Page

» Collection & Monitor Page

* Record Setting Page

» Email Setting Page

» Access & Others Setting Page

If you select Simple Settings, you can change to Detail Settings while you are configuring a
new project, but you cannot change from Detail Settings to Simple Settings.

Device connection

4

Project configuration

Detail Settings Page

C Device )( Recording >
" Report/Print ™

( 129 > (/RT option) .+

ST Mathtag :

.. (IMT option) C Email >

CDisplay grOup> CACCess&OtherSD

- O\ " Server Setting
@qwsmon&Monlto) .. (IUAoption)

Ch bl
Simple Settings T

Simple Settings Page

<

Data collection and recording

Report/Print, math tag, and OPC-UA server Setting Pages appear on GA10 that have the
corresponding options.

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

3.2 Easy Configuration (Simple Settings)
This section explains how to configure the settings in Simple
Settings mode before starting data collection.

In Simple Settings mode, you can set the device to
connect to, data collection and recording interval, and
data save destination in a single window. You can start
data collection and recording with fewer steps than in
Detail Settings mode.

Create a project

Register
applicable devices

Select the collection
and record interval

Specify
the data save destination

Start data collection
and recording

Note

If you select Simple Settings, you can change to Detail
Settings while you are configuring a new project, but you
cannot change from Detail Settings to Simple Settings.

Detailed Configuration (Detail Settings): > Sec. 3.3

3.2.1 Creating a Project in Simple Settings Mode

1

Start GA10, and log in by typing the user name and
password. (When logging in for the first time, set

the user name to “admin” and leave the
blank.)

On the File menu, click New Project.

password

The Create New Project dialog box appears.

Type the project name and comment. Leave

Settings Mode at Simple Settings.

.
Create New project

Project's Name: |

Comment:

Settings Mode: @ Simple Settings () Detail Settings
®

L OK J | Cancel l

Leave this at
Simple Settings.

Click OK.
A new project is created.

(43 Data Logging Software — [admin]

File Edit View Project Operation
H1o?@ mEe® DD X

project a ¥

Owner: admin

3-2
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Chapter 3 Configuring and Starting Data Collection and Recording

3.2.2 Registering Devices to Connect
Add devices to the project you created.

Below is an example of connecting a DX1000 to the PC

6 Drag & drop the icon of the device that you want to
register to the Device List on the left side of the page.

through the Ethernet interface and registering the DX1000 T e
in GA10_ Hlo? wbk X 8B @® e g M=l e

1 Connect the device and the PC through a network

using LAN cables.

PC
i ——— Ethernet

HUB I

[ —
* The figure shows a one-to-one connection.

Connect Device:

N7 sweoal |

BR

MonitorRecardntera
Folder

s ] CRstere)

In the center of the page, a window appears showing
the details of the device that you are about to register.

2 Configure the Ethernet settings on the device. Set 7 i the displayed information is correct, click OK. To

the device’s IP address and subnet mask.
On the DX1000
Press MENU, hold down FUNC for 3 s (to switch
to basic setting mode), and select the Menu tab >
Communication (Ethernet).

Nofte

reselect a different device, click Cancel.

If the security settings on the device being registered
are enabled, you need to enter the user information*
for accessing the device. Otherwise, you can leave

For details on where the Ethernet port is located and

hierarchy of setting menus, see the user’s manual of the

relevant device.

the the user information blank and click OK.
* Not the user privileges for GA10

Register device )(1
3 Check that the PC and the device have been T  om ®
connected. Comm. Kind:
You can check the connection using Windows De- Host NameflP Address
vice Manager or from the command prompt. E— —
4 Double-click the project that you created. sﬂssim ]
The Simple Settings page opens. '
‘:M m— m— ﬂp"‘“’“’”W‘“”"“‘””"“"’“"S’ ( OK ) (_offine Regist ] [ cancel )
Hecoe W BiE e Eled—— | =] . J
e el L T T User information
S — The DX is added to the Device List.
e Nofte
— — + Ifalogin is required for communicating with the
device, you need to specify the user information.
[ Check the user name, user ID, and password for the
device, and enter them.
»  When connecting to a DXAdvanced (DX1000,
s DX1000N, DX1000T, DX2000, or DX2000T) with the
/AS1 advanced security option through the Ethernet
5 Click Search in the Online Devices List on the right ilntcter:faci, log in as Ia” admi(r;is_trgt?r to aC_“iIe;S th; Dtx-
side of the page. l(r;g ir|1$ situation, only one administrator will be able to
m &3 Detail Settings| y
Register Device )|

[T 08 {2l |comm king: B Ethemst (] serial ]

005 005 oz 008

i) o10 ot o1z <

Devices connected to the network are detected and

displayed.
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Chapter 3 Configuring and Starting Data Collection and Recording

@ Data Loggng Softvare-—Tadmin] - Froject 5]
Fle Edt View Projest Operation User Hep

B0 mhinh X 8 £le @ - O [ e [

Regiserbevee ] Upoateseing J_vett Devce
o [ T oo

o5 o o1 [

L

B8

Device Name:  Devce

=] DeviceType:  DX1000 Nat ch.

» To delete a registered device, click the device icon to
select it, and click Delete on the Edit menu or click the
Delete button. You can also select the device icon and
press the DELETE key.

Nofte

There are two ways to register devices to a project. One
way is to connect the target devices to the network first
and then register, and the other way is to register without
connecting the devices (offline registration).

For details on the registration procedure, see the
following pages.

Offline registration: 4 page 3-15

Register device dialog box details: > page 3-17

3.2.3 Setting the Monitor and Record Interval
and Save Destination

After registering the device, set the Monitor and record

interval and the measurement data save destination.

1 Second #: )
Datal

Foder [cw

Click to select the interval.

Click to select the save destination.

1 Choose the interval from the Monitor/Record
Interval list at the bottom of the page.

Name Default Value Options
Monitor/Record 1 Second 100 Millisecond, 200 Millisecond,
Interval 500 Millisecond, 1 Second, 2

Second, 5 Second, 10 Second,
20 Second, 30 Second, 1 Minute,
2 Minute, 5 Minute, 10 Minute

2 Click Refer to, and select the directory for saving
recording files.

Nofte

» The Refer to button for specifying the save destination
folder is available only when the server and client are
installed in the same PC.

*  We recommend you use the default setting for the
data save destination folder. (See “Folder” on page
3-39.)

3.2.4 Starting Data Monitoring and Recording
You can start data collection and recording using a
configured project.

» To close the project without collecting data, click the x
icon on the right edge of the page.

» To return to the list page with the project open, click
B8 at the left end of the toolbar.

Controlling an Opened Project Individually

Click the icons that are displayed on the tab on the right
side of the screen to collect or start and stop recording.

=] Standby
N @& Monitoring

Qﬁ .9 Recording

:,U' Start Monitoring [» Stop Monitoring [l
‘,-°,- Starts data monitoring.

- Click again to stop.

]

- Under monitoring

Ma ]

™8 »—— Start Recording > Stop Recording [l
Q Starts data monitoring and recording

- to the data file at the same time.

\E Click again to stop only the recording.
@ Under recordin

% ’

=]
— Manual save (hidden by default)

X You can show or hide the button by selecting

Manual Save Button from the View menu.
When clicked, the recording data is split
at that position.

This button is valid only during recording.

Click the ”‘ icon to start data collection.
Click again to stop.

Likewise, click the i icon on the right to start
recording.

A QO N =

Click again to stop only the recording.

To also stop data monitoring, click I .

To return to the Setting Page, click ""..
Recorded data files are listed when you click @

Data files Page. P sec. 8.1
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Controlling Multiple Projects Simultaneously

If you want to start or stop recording or start or stop
monitoring on multiple projects simultaneously, follow the
procedure below.

1 Click the BB icon at the left end of the toolbar.
The Project List Page appears.

2 On the Operation menu, click Start Monitoring
Simultaneously. Or, click the i@ icon.
To start recording, on the Operation menu, click
Start Recording Simultaneously. Or, click the g
icon.
A confirmation message appears.

3 Click OK.
Data collection (or recording) will start.

| | |
project_a f N

7

|
oL
_ pojecta |

= =

Owner. admin

Owner: admin

:Locking ! admin :Locking

Data collecting Recording

4 To stop, on the Operation menu, click Stop
Monitoring Simultaneously. Or, click the @ icon.
To stop recording, on the Operation menu, click Stop
Recording Simultaneously. Or, click the gy icon.

Nofte

Projects that you can simultaneously control are those
that you have Operator or higher privileges for.
Project Access Privileges: P Sec.3.3.8

3.2.5 Closing a Project
To close a project, click the % icon on the right edge of
the page.

* Note that clicking the close button in the upper right
of the window closes the software.

Dsta Logging Software~ (admin] = [ProjectS]
Fle Edt View Project Operaton User Help
Blo? wnkh BE e (oo [ e fEwee

£ Deta et

Close the project.|

When you close a project, the Project List Page
appears.

When data collection and recording are stopped and the project is
closed

4 =
Projectd ¥

Owner.  admin

. .

When the project is closed with data collection and recording in progress

4 S 'R
Projectt ¥
Owner.  admin

e >

* An open project is locked (other users cannot edit it).
Click B8 Project List Page to view projects that are
locked.

Details on the page when data collection and recording
is in progress: Chapter 6

Nofte

You cannot perform the following operations while data

is being collected.

» Register devices from the Online Devices List to the
Devices List

* Register a new device on the Devices List

» Change device registration positions on the Devices
List

» Delete registered devices from the Devices List

» Change the settings of registered devices on the
Devices List

» Specify the record interval

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

3.3 Detailed Configuration (Detail
Settings)

In Detail Settings mode, you can customize data

collection, monitoring, and recording. This section

explains how to configure the settings in Detail Settings
mode before starting data collection.

Create a project

Register applicable devices

,/ Set math tags N
\ (/MT option) ) /

~ - -

Configure the display

Configure the recording

-7 Configure \
I reporting and printing J
\ .

N (/RP option) _7

Configure mail settings

Set access permission

Start data collection
and recording

3.3.1 Creating a Project in Detail Settings Mode

First, create a project, which is a set of data collection and
recording. For each project, connected devices and data
collection and recording conditions can be saved.

Creating a New Project
Create a new project in Detail Settings mode.

Start GA10, and log in.
The Project List Page appears.

On the File menu, click Create New Project.

LN

Type the project name and comment. Set Settings
Mode to Detail Settings.

~
Create New project x

Project's Name: ‘

Comment:

Settings Mode: () Simple Settings @ Detail Settings

L OK ] l Cancel

L -

4 ciick oK.
A new project is created in the Project List Page.

@ Data Logang Sotvare-admin) Tex
File Edi View Project Operation User Hep
H4o0 Wk DOX RS2 o o —

5 Double-click a new project.
The initial setting window appears.

Configuration navigation area

@ Dot Logging Softwore— i)~ {Frogect O] —
Fie Edt View [Proect Operation User el
Haocd wihm o o m=—

] [ Seting J Deiete 0 J[_update
6 001 002 003 2 |comm.King [ Ethemet W Serial W uss
% T
£ vispuay

o e

<2 Record
[ evan

el ,‘ o7 o5 o8

Comm.kind [ Ememet (] Seral  [Juss

Setting page area

3-6
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Chapter 3 Configuring and Starting Data Collection and Recording

You can switch between different setting pages by clicking
the items in the left navigator.

~—
|ﬁlxpandlreduce button

s Tog Cf
o - A check mark appears

< Record when you configure
5 the settings.
E-Mail

IE Access80thers

Reduced Expanded

To continue configuring the project, proceed to Sec. 3.2.2.

Exporting and Importing
You can export the information of a created project
to a file (.pjf extension).
This file is referred to as the project information
file. The procedure to export and import a project is
explained below.

Nofte

* Projects created in an earlier server version can
be used in later server versions. Projects are not
displayed for the opposite case.

» If an option is added to the GA10, projects created in
the previous configuration can be used with the GA10
in the current configuration. Projects are not displayed
for the opposite case.

Related topic: 4

Export procedure

1 From the list of projects, select the project that you
want to export.

File Edit View Project Operation User Help

H40¢ bbb HDX( Bl e ¢ = & [ e

Project_1 # proect 2
Owner: admn . Owner  samin

Click to select.

2 On the File menu, click Export Project.
The Save As dialog box appears.

Select the save destination, assign a name, and
save it.

The project information file (.pjf extension) is saved
to the specified location.

B

S ke g1

Nofte

« If you do not have access permission to the project,
you cannot export it.

« If the project contains Modbus device connections,
the register and channel information of the Modbus
devices are not exported. You must save the definition
files separately.

Modbus device definition file: > Sec. 3.4

e OPC-UA projects when the OPC-UA server function

(/UA option) is in use cannot be imported or exported.

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

Import procedure

1 On the File menu, click Import Project.
An Open dialog box appears.

2 Select the file that you want to import (.pjf
extension), and click Open.

(3 Open = |
Leokin: | 04Froject fles - @ ¥ E° @~
T Mame - Date modified Type Size
e (project_1pit 2013/11/2914:18 PEFile )
Recent Places
Desktop
m:u]
Libraries
L
Computer W | v
File name: Project pif - ﬁ
Files oftype: [Preisct Information File ¢ gif) ¥ [ cencel ]

The imported project is added to the list of projects.

File Edit View Project Operation User Help

B B DOX Sle P -= O [ e

Project_1 L Project 2 L Project 2 001 ¥

Owner.  admin Owner:  admin Owner:  admin

Nofte

When you import a project, you become the project
owner.

Owner: p> Sec. 3.3.8

To modify the owner: P> Sec. 9.4.3

Importing a project created on a GA10 with a
different system configuration (GA10 version
R2.02.xx or later)

If you try to import a project created on a GA10 with
option functions (additional channels, math, etc.), a
message (W2008) may appear.

This is because the project being imported contains
functions that the importing GA10 does not have. You
can continue importing by clicking OK in the message
dialog box. The following table shows the result of
importing.

Result of importing
Functions not available on the import destination
GA10 server
GA_1 0 Math Report g:’:t;m
Settings Channels function function fun(r:)tox
(Tags) (Option, (Option, 3
MT) IRP) (fepte o
ICG)
Device - - - -
Tag Tags outside - -
the server’s tag
range are set
to None.
Math Tag |- Not displayed. |-- -
Display Tags outside Math tags are |-- -
Display the server’s tag | set to None.
range are set
Group to None.
Display - - - Register
Aquisition button is not
&Monitor displayed.
Record If the start tag |If both the start |-- -

or end tag is tag and end
When Start outside the tag are math
Condition or  |server’s tag tags, Start

Stop Condition|range, the Condition is set

is Alarm. range is setto [to Immediate
the server’s and Stop
maximum Tag |Condition is set
Index. to Continuous.

If the start tag  [If the start
exceeds the tagisa
server’s tag measurement
range, Start tag and the
Condition is set |end tag is a
to Immediate math tag, the
and Stop range is set to
Condition is set |the server’s
to Continuous. |maximum Tag

Index.
Report/ Tags outside  |Math tags are [Not displayed. |--
Print the server’s tag |set to None.

range are set

When Task is |to None.
Report Output.

3-8
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Functions not available on the import destination
GA10 server Copying and Pasting
SG;\_10 Math Report gll-':;:;';‘ You can easily copy and paste projects.
etlings | Channels | function function
(Tags) (Option, / | (Option,/ | [functon 7 From the list of projects, select the project that you
MT RP (Option, /
) ) cG) want to copy.
E-Mail If the start If both the start |-- -
tag exceeds |tag and end 2 On the Edit menu, click Copy, or press Ctrl+c on
TRIG:, the server’s tag are math
Range maximum Tag |tags, mail is the keyboard.
Index, mail is  |set to OFF, The proJect |S Cop|ed
set to OFF. and the start
and end tags 3 . ) . )
If the start tag  |in the selected To paste the copied project, on the Edit menu, click
orendtagis |range are set Paste, or press Ctrl+v on the keyboard.
outside the to the server’s X . . .
server'stag  |maximum Tag The project is pasted in the list.
range, the Index.
range is set to
the server’s In Detail Note
lma"im”m Tag |Settings mode, » The copied project is retained until you log out.
ndex. math tags are . . . ..
not displayed. *  When you import or paste a project, if the original
In Detail file is on the list, a serial number starting with 001 is
Settings mode, P :
¢ . added to the original project name.
ags exceeding
the server’s tag
range are not
displayed. . .
play Renaming a project
Attached [fthe start —|If both the start |-- - To rename a project, follow the procedure below.
Files:, tag exceeds tag and end tag
Range the server’s are math tags, 1 i i i
maximum the inclusion From the list of projects, select the project that you
Tag Index, of Alarm
the inclusion Information and want to rename.
of Alarm Instantaneous
Information and| Value is set to 2 On the Project menu, click Modify Basic
Instantaneous |OFF. Information
Value is set to .
OFF. In Detail A Change project’s Basic Information dialog box
Settings mode,
If the start tag |math tags are appears.
or end tag is not displayed.
outside the 3 Type the new project name or comment.
server’s tag
range, the
range is set to # . i i I
the server's Change project’s Basic Information x
:nzximum Tag Project's Name: | Project_A
naex.
Comment: Nowv.1% th Name changed
In Detail
Settings mode,
tags exceeding
the server’s tag
range are not
displayed.
oK Cancel
Access & |- - - - L ( ) ( e ) p,
Others
4 When you are finished, click OK.
The project name will change.
New name
Owner: admin
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Chapter 3 Configuring and Starting Data Collection and Recording

3.3.2 Registering Devices to Connect

After you create a project, register the devices to collect and record data from. The Device
Setting Page that you use to register devices is composed of the following four areas.

Devices List Registered Devices List
Data collection devices Devices registered in the server
@ rhita Logging Softuare - [admin] - [Project D] e x
File Edit View Project Operation User Help
Hio? wbeb X BBel oo e e B coor ]
~ = i (Register Device J[ Update Setting ) Delete Device J| [Regis jices Lis Delete Devicel[_Update |
g0z DKioo 05 unzoooy Gosromi (2 lcomm king M Etemet W Serial ® uss
T e —_— ) - [}
B | Deves Devce Devee e | | 2
€ sy P | | oomess | wotRis | wbrrs [ s
S B e B 2 R B
2 pecon . i
5
[ Emai 1 @'
e 05 om0 o1 o2
5]
Search @
013 014 015 016 Comm. Kind: [H] Ethernet [ serial Ousa |
woms | wewa | womew | wrms
o ey sicioo
gig o0 e P
B G SR
o P .
Device Name:  Devee wesscn: o _..o¢—— Setting button
[E Device Type:  DX2000 Math Ch. 2|
r. ‘Comm. Address: 10.0.136.44 Extra Ch. ! Show Detail —‘
Device information display area Show/Hide Detail button
Displays information of the selected device

Online Devices List
Online devices over Ethernet or serial communication

* Devices List
List of target devices for data collection and recording.
* Registered Devices List
List of devices registered in the GA10 server.
* Online Devices List
List of online devices over Ethernet or serial communication.
¢ Device information display area
Information about the selected device.
e Setting button
Click to start the device setting page (Web application).

4 “Starting the Web Application (GX/GP and GM)” on page 3-20
e Show/Hide Detail button

Click to display detailed information about the selected device in a worksheet format.
Click again to hide detail.
Description of the displayed detailed information: P See next page.

Device icons (shown in the following figure) display the devices’ information. These icons
can be used to register and delete devices.

Device number (displayed only on the Devices List)

Frame turns blue
Model name

004 DX2000
ic:eo— Device name

Device icon
10.1.32.85 10.1.32.35— Communication address

Displays the host name or IP address
Selected Not selected
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Chapter 3 Configuring and Starting Data Collection and Recording

Displaying Detailed Information

When a device icon is selected from Devices List or Registered Devices List, click Show
Detail to display the channel information of the device in a tabular format. Click again to hide

detail.
@ Data Logging Software —[admin]  [Project_D] e x
File Edit View Project Operation User Help
Esed bbb DOX B B2 -|=o B
AP oeace QOO0 002 DKION GUSLGRZO0 (@3 oW % |commKking M Ememet Wseio M USB =
2 E ﬁ iy ¥ ¥ 1
= : Device Device Device Device .
3 vispay 06Tt mormes | 00TEde | i0disrse =] E it
005 605, 007, 008, 100 T4 10013668 100136 49 10013734 M
L Recora .
e R
£ Ean Comm.Kind: @ Ethemet O serial O uss Q
e o8 o0 o iz [551] [E] [ o
worssr | worrar | wowez | 0sbres =
(omows (o mdw (WX [ owi
=
o1z i 015 016 7= =l %
DeniceName: _ Deoice weascn- 4
r-*' Device Type: GM10 Math Ch.
Comm. Address: 10.0.137.34 ExraCh 1
il s il i Dec. point o [ [
I LONG 2 0.00 100.00
(] LONG 4 -2.0000 2.0000 v
(] LONG 4 -2.0000 2.0000 v
(] LONG 4 -2.0000 2.0000 v
(] LONG 4 -2.0000 2.0000 v
(] LONG 4 -2.0000 2.0000 v
(] LONG 4 -2.0000 2.0000 v
@ o008 LONG 4 -2.0000 20000 v
@ o009 LONG 4 -2.0000 20000 v
[m o010 LONG 4 -2.0000 20000 v
| o [
No. Item Name Default Value Setting Description
1 Check box on/off On (Blue) Available When the check box is selected, it
means that the channel is in use.
When set to “not use,” tags cannot
be assigned on the GA10’s Tag
Setting page.
Tags that are already assigned
appear as “None
2 Used Cnannel No. Channel numbers of the device Not available
3 Tag No. Tag numbers of the device Not available
4  Tag Comment Tag comments of the device Not available
5 Type Tag data types Not available
6 Dec. Point Number of decimal places for tags Not available
7 MIN Minimum scale value set on the Not available
device
8 MAX Maximum scale value set on the Not available
device
Unit Scale unit set on the device Not available
10  Alarm Type Alarm type Not available
1to 4 Value Input value Not available
11 Tool button a0 - -- Selecting and clicking a line
(collectively switches the channel of the
change selected line between use and not
between use use (check box selected and not
and not use) selected).

Nofte

» Setting becomes possible only when a device from the Device List is selected.
* Buttons remain disabled when a device is selected from the Online Devices List.
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Chapter 3 Configuring and Starting Data Collection and Recording

Detailed Information of the WT3000/WT3000E
If the connected device is a WT3000/WT3000E, the measurement functions of the WT
become the data (tag) that the GA10 collects. Measurement functions (hereafter referred

to as “data”) vary depending on the model, the number of elements, and options of the
WT3000/WT3000E (Table 1).

Item Name Default Value

Used Channel No. Assigned from 0001 up to 0251. (depending on the WT3000/WT3000E element and option
configurations)

Tag No. Displayed in the following format: data group number: data name

Tag Comment In addition, “Total” and “dc,” which indicate the harmonic orders of harmonic data, are

displayed as “TOT” and “DC,” respectively. For example, data “U” of data group “Element 1”
is displayed as “1:U.” “1:U(Total)” is displayed as U(TOT) and “U(dc)” as “U(DC).”
For details, see the mapping in Tables 2 and 3 on the next page.

Type FLOAT

Dec. Point 3

MIN -20.000

MAX 20.000

Unit For the unit of each type of data, see the mapping in Table 4 on the next page.
Alarm Type Blank

1to4 Value 0.000

Table1 Configuration table of WT3000/3000E elements, options, and data groups

Number of |Option Data group name
elements

Element1

/G6 (Advanced Calculation)
- . o
/MTR (Motor Evaluation Function) Motor
-- . Element1

Element2

/DT (Delta Calculation Function) 1
IMTR

-- Element2 iElement3

/G6 El iEl

/DT

/MTR

= Element2 Element3  :Element4
/G6 ElemHrm2  iElemHrm3  iElemHrm4
/DT

/MTR

1 The Delta Calculation Function (/DT option) is a standard function on the WT3000E.
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Chapter 3 Configuring and Starting Data Collection and Recording

Table2 WT3000/WT3000E data group and data, which become tags collected by GA10

Group Data name |Group Data name |Group Data name |Group Data name
_.|ElemHrm1 to 4 :U(dc) SigmaAto B U Other ET/
u(1) |
U(Total) P
I(dc) S
Q I(1) Q
Lambda I(Total) Lambda
P(dc) PHI
P(1)
P(Total)
S(dc)
S(1)
S(Total)
Q(dc)
Q1)
Q(Total) wp
Lambda(dc) WP+
Lambda(1) WP-
Lambda(Total) q
PHI(1) qt+
PHI(Total) Qq- -1
PHIU(3) ws F1
PHII(3) wQ F18
Uthd F19
Ithd F20
Pthd
Delta DELTA1
DELTA2
DELTA3
DELTA4
Motor Speed
Torque
SyncSp
Slip
Pm

Table3 WT3000/WT3000E data group number mapping table

Group :Data group number
Element1 to Element4 1to4

ElemHrm1 to ElemHrm4 1to 4

SigmaA SIGM

SigmaB SIGMB

Other Omitted

Delta Omitted

Motor Omitted

1 These are omitted in the initial display of tags and tag comments.

Table4 WT3000/WT3000E unit mapping table

Data name Unit Data name Unit
U V q Ah

| A q+ Ah
P W q- Ah
S VA WS Vah
Q var wQ varh
PHI deg PHIU deg
fu Hz PHII deg
fl Hz Uthd %
U+pk \Y Ithd %
U-pk \ Pthd %
I+pk A ETA1 %
I-pk A ETA2 %
Time sec ETA3 %
WP Wh ETA4 %
WP+ Wh Slip %
WP- Wh Others Blank

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

Searching for Network Devices

Search for devices connected to the network to display
them in the Online Devices List. Simply click the button to

Registering Files to the Devices List

1 Select a device from the Online Devices List.

search and display the devices as icons in the list.

Note

Comm. Kind [H) Ethernet [ Serial

<

Set the search filter to Ethernet or Serial.

—
comm.kina: ([ etnernet

[ senal [ use
Search filter
Click Search.
<] —_—
Comm. Kind:  [H] Ethemet [ serial Tuse

The connected devices are detected and displayed
in the Online Devices List.

onmepevicesust [ see ]

Comm. Kind: [H Ethernet [ serial

DX2000 DX2000 DX2000

~

10.1.32.85 10.1.32.120 10.1.32.130 10.1.32.115

MV1000 DX1000 URZ0000 uR10000

2 B n

10.1.32.107 10132116 10.1.32.133

10.1.32.128

) Bl R S

10.1.32.114 10.1.32421 10.1.32.131 10.1.32.132

The icons of the following devices will not appear by
searching. To add them to the project, use the Register
Device button as explained in the next section.

Devices that cannot be detected on the Ethernet network

GX10, GX20, GP10, GP20 (up to R1.03.02)

DA100, DR130, DR230, DR240

DAQLOGGER, DAQ32Plus, MXLOGGER

WT3000, WT3000E (devices up to R6.20)

Devices defined using Modbus device definition files 1

Devices that cannot be detected through the serial interface

MX100, MW100

DAQLOGGER, DAQ32Plus, MXLOGGER

Devices whose baud rate is not 9600 bps, parity is not even, or
stop bit is not 1.

Devices whose interface is RS-422 or RS-485

1 Modbus device definition file: - Sec. 3.4

2 Click Register in the center of the page. Or, drag

the device to the Devices List.

1. Select the device.

001 002 003 004, 12| |comm king: @ etnemet W serial W uss.
005, 005, 007, 006,
- . . - 2. Click here (register button)
5 9 TE; Comm Kind: [ Ethemet (] Serial Ouss
= = v (o (o
B G
e | | okt | oswn | e
2. or drag e e e ||
2]
P P o o R R
(e (e (uwon (o
&l = [

3

The details of the device that you are about to regis-
ter (Register Device dialog box) appear.

r ™\
Register device >
-
Device Type: DX1000 ]
Comm. Kind: Ethernet ]
HostNamelP pgdress: [ om ]

[ oK ] [ Offline Regist ] [ Cancel ]

\ J

To register the device, click OK. To reselect a
different device, click Cancel.
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Chapter 3 Configuring and Starting Data Collection and Recording

To add a device using the Register Device button, follow

the procedure below.

1 Click Register Device at the top of the Devices
List. Or, double-click an empty icon in the Devices

—
1 Devices Lisf Q Register Device ) Update Seting ) Delete Device

List.
o001 GMiD 00z cX20 (0
Device Device
10.0.137.34 10.9.137.64

=

Double-click

~

MRegislerde'vioe X H U
Device Type: DX1000 )]

g Comm. Kind: Ethernet [ L

[ 1
L OF ) | Offline Regist ) | Cancel

y 4
017 T TS i

The initial page of the Register device dialog box

appears.

2 Enter the information about the device to be

registered.

For details on the input items, see the next page.

Because the available interface varies depending
on the device that you are connecting, the
communication parameters in the dialog box will
change according to the device.

-
Register device

y

X
Device Type: DX1000 ]
Comm. Kind: Ethernat (=]
( OK ) |_offline Regist ) Cancel
A o
3 Click OK.

The device is added to the Devices List and Regis-

tered Devices List.

Nofte

To delete a registered entry, click the device icon to select
it, and press the DELETE key or click the Delete button.

Registering Offline
Devices that are not connected to the network can be
registered before they are connected.

1 Click Register Device. Or, double-click an empty
icon in the Devices List.
A Register device dialog box appears.

r ™)
Register device

X
Dece Name:
Device Type: DX1000 [
Comm. Kind: Ethernet EJ
| egist J | Cancel
. 4

2 In the Register device dialog box, enter the
device name, and select the device type and
communication kind.

3 If Comm. Kind is set to Serial, also select the
communication type.

- %
Register device x
Device Type: DX1000 ]
Comm. Kind: Serial =]
COM Port No.
Comm. Type RS-232C =

.
Haud Rt RS-422IR5-435
Parity: None o
Stop Bit: 1 )
[ OK ] [ Offline Regist J [ Cancel ]
. o

4 Click Offline Registration.
The device is registered.

Nofte

Devices that are registered offline are registered with
channel set to 0 and no options.

When you click Update Setting, GA10 connects to the
registered devices and updates the setting information
of those devices. In addition, those devices are added
to the Registered Devices List.

If a registered device is not detected on the network,
none of the setting information of that device is
updated. However, even in this case, the registered
information will be retained.

IM 04L65B01-01EN

Buipiooay pue uoiasjj0) eyeq bBuiiels pue Bunbiyuon



Chapter 3 Configuring and Starting Data Collection and Recording

Adding Devices

To add devices to the Devices List, repeat the “Registering
Files to the Devices List” procedure.

Nofte

If you move to another setting page, return to the
Register Device Page, and add devices, a confirmation
message (M1015) will appear when you try to move to
another page.

Clicking OK will add the tag of the added device after the
existing tags on the Tag Setting Page. Clicking Cancel
will not add the tag.

Connectable Devices and Interfaces

The following table shows the devices that can connect to
the GA10 and the interfaces that can be used.

When you are registering the device type on the Register
device dialog box, clicking ¥ will show the following
devices in the list.

The names shown in green cells are used when
connecting to GA10s with the custom display function (/
CG option).

Interface 1
Supported Models N Ethernet
ame

or Software Serial | USB | (connection port

number)
WT3000 7 WT3000 Rs232C | No | Yes 10001
WT3000E 7 WT3000E only No Yes 10001
GateWT for GA10 GateWT for GA10|  No No Yes 502958
DAQLOGGER DAQLOGGER No No Yes | 502808
DAQ32Plus DAQ32Plus No No Yes 502788
MXLOGGER MXLOGGER No No Yes | 502848

Interface 1
Supported Models Name Ethernet
or Software Serial | USB | (connection port
number)
GM10 GM10 RS-
422/485 | Yes | Yes | 344343
only
GX102 GX10 Yes No Yes 344343
GX202 GX20 Yes No Yes 344343
GP102 GP10 Yes No Yes 344343
GP20?2 GP20 Yes No Yes | 344343
GX/GP/GM GXGPGM_ RS- No Yes 502
(PID control module) [PIDSIot0 to | 422/485
GXGPGM_ | ©°
PIDSIot9
DX1xxx DX1000 Yes No Yes 34260
DX2xxx DX2000 Yes No Yes 34260
CX1xxx CX1000 Yes No Yes 34260
CX2xxx CX2000 Yes No Yes 34260
FX1xxx FX1000 Yes No Yes 34260
MV 1xxx MV1000 Yes No Yes 34260
MV2xxx MV2000 Yes No Yes 34260
MX100 Same as left No No Yes 34316
MW100 No No Yes 34316
uR10000 Same as left Yes No Yes 34260
PR20000 Yes No Yes 34260
DA100 Yes No Yes 34150
DR130 Same as left Yes No Yes 34150
DR230 Yes No Yes 34150
DR240 Yes No Yes 34150
UT32A4 UT32A No See 502
UT32A R3 5 note 4
UT35A UT35A No
UT35A R35 Yes | 502
UT52A 4 UT52A No See 502
UT52A R35 note 4
UTSSA lﬁggﬁ Ras| RS- No | ves | 502
UT75A UT75A 4202%85 No
UT75A R35 Yes | 502
UP35A UP35A No
UP35A R35 Yes | 502
UP55A UP55A No
UPS55A R35 Yes | %02
4 See
UM33A UM33A No ot 502
Modbus protocol ©
compatible devices RS-
(including YOKOGAWA hardware 4202rﬁ1y85 No Yes 502
control instruments)

1
2

Nofte

Yes: Supported No: Not supported

The GX/GP version R1.03.03 and later supports auto searching on an
Ethernet network.

The communication port can be specified on the GX/GP, but GA10 only
supports the default value, 34434.

Open network function is not built in. Ethernet connection requires VJET
(Yokogawa Ethernet/RS485 adapter).

Model names with “_R3” correspond to SP and other output channels.
When connecting to a GA10 with the custom display function (/CG option),
use the ones with “_R3.”

Modbus protocol is not supported.

The WT3000 and WT3000E are precision power analyzers by Yokogawa
Test & Measurement Corporation. Auto searching on Ethernet is available
on R6.21 and later.

A port number must be specified as a parameter when the interface is
specified. (The port numbers in the table are default values.)

.

GX/GP/GM_PIDSIot0 to GX/GP/GM_PIDSIot9 are
used to control from GA10s with the custom display
function (/CG option) the output and the like of a GX/
GP/GM with PID control modules (GX90UT) installed.
Related topic: ’page 7-4

In the UTAdvanced series, model names with “_R3”
correspond to SP and other output channels. When
connecting to a GA10 with the custom display function
(/CG option), use the ones with “_R3.”

3-16
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Chapter 3 Configuring and Starting Data Collection and Recording

Register Device Dialog Box Details

The Register Device dialog box is used to register the
devices that you want to connect to. The following figure
shows the initial screen after you click the Register Device

button.

O]

-’
Register device
Device Name
Device Type
Comm. Kind:

Host Name/IP Address

Ixi

Device

!
|

Dx1000

Ethernet

J

—®@
—®
—®

®
|

User Name:
UserID:

Password:

admin

i

( cancel )

o

®

Item
e Name

How to Specify

Default
Value

Description

1 Model
name

Enter text.

(Input range: up to
20 alphanumeric
characters)

Device

Enter the name of
the device to be
registered.

2 Device
Type

Select from the list.

DX1000

Select the name of a
supported model or
software from a list.

3 Comm.
Kind

Select from the list.
(Selectable range:
Ethernet, Serial,
USB. But, depends
on the model.)

Ethernet

Select the interface
from the list.

If Device Type is
MX100/MW100,
DAQLOGGER,
DAQ32Plus,
MXLOGGER, or
GateWT, this is fixed
to Ethernet.

USB is selectable
only when Device
Type is GM10.

4 Host
name/
P
address

Enter text.

(Input range: up to
255 alphanumeric
characters)

Blank

This appears only
when Comm. Kind
is set to Ethernet.
Enter the host name
or IP address of the
device.

5 User
Name

Enter text.

(Input range: up to
63 alphanumeric
characters)

Admin

Customer information
items appear in the
following conditions.
When Comm. Kind

is set to Ethernet,
and Device Type is
not DAQLOGGER,
DAQ32Plus,
MXLOGGER,
GateWT, or a
Modbus device
When Comm. Kind

is set to Serial, and
Device Type is GX10,
GX20, GP10, GP20,
or GM10

Representative examples for different interfaces and
connected devices are provided below.

When connecting to DAQLOGGER, DAQ32Plus,
MXLOGGER, GateWT

e Comm. Kind is fixed to Ethernet.

» Enter the IP address of the PC in which the software
specified with Device Type is installed.

* To connect to DAQLOGGER or DAQ32Plus, leave the
System No. at zero (default value).

» To connect to MXLOGGER, select the System No. that
is being used in MXLOGGER.

* When connecting to GateWT for GA10, to display
models after models numbered 02 under GateWT’s
“WT Setting”, set System No. to None in the GA10’s
Register Device dialog box.
Or, click the Register Device button, and specify the
system number in the Register Device dialog box.
For models numbered 02 under GateWT'’s “WT
Setting”, set the System No. to 01. For example, for
GateWT numbers 1, 2, 3, and so on, set the GA10’s
system numbers to 0, 1, 2, and so on.

» To start GateWT for GA10, right-click and choose Run
as administrator.

Nofte

When using GateWT for GA10, see the WX1 GateWT

User’s Manual (IM No: IM WX1-03EN). Change the terms
to read as follows:
"GateWT" to "GateWT for GA10."
"DAQLOGGER" to "Data Logging Software GA10"

-
Register device

"y

User ID

Same as above

Blank

Password

Same as above

Blank

You need to enter
this if the security
settings on the device
being registered are
enabled. Otherwise,
leave the user name
(admin), user ID, and
password blank, and
click OK.

X
Device Type DAQLOGGER =]
Comm. Kind: t )
HostNamefP Address: | |
PartNo —®
System No [ )
e [ Cancel )
., »
@
Item Name |How to Specify |Default Value|Description
6 |Port No. Enter text. See This appears when
(Input range: Connectable [Comm. Kind is set to
1025 to 65535) |Devices and |Ethernet and Device
Interfaces. |Type is DAQLOGGER,
DAQ32Plus,
MXLOGGER, GateWT.
7 |System No. |Select from the |0 Same as above
list.
(Selectable
range: None, 0
to 60)

IM 04L65B01-01EN
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Chapter 3 Configuring and Starting Data Collection and Recording

When connecting to a WT3000/WT3000E

WT3000/WT3000E can be connected without using
GateWT for GA10. Select from the list of target

devices.

When using RS-232C communication, in the

WT3000/3000E settings, set MISC > Remote Control >

Device > RS232 control as follows:
Format (data format): 8-NO-1
Rx-Tx (handshaking): NO-NO

Terminator: Lf

*  When using Ethernet communication, in the
WT3000/3000E settings, set MISC > RemoteControl
> Network > UserAccount > Timeout to 30 seconds or
longer. If the timeout is set to the default value (Infinite:
no time limit), retrials when communication errors occur
will not be performed.

Detailed information: P> WT3000 Precision Power
Analyzer Communication Interface (IM 760301-17)

When Comm. Kind is set to Serial

r ™y
Register device x
Device Type [oxio &
L @10
Gomm Type: ezze  (G1—®
foos @@
Pariy Moe QT ®
Stop Bit [ @1 ®
f OK J [ Offline Regist ] [_Cance\ ]
L »
Item Name |How to Specify 3::::“ Description
8 [COM Port |Select from the list. |1 This appears when
No. (Selectable range: Comm. Kind is set to
1to 20) Serial or USB.
9 |Comm. Select from the list. |RS-232C|This appears when
Type (Selectable range: Comm. Kind is set to
RS-232C, RS-422/ Serial.
RS-485)
10 [Baud Rate |[Select from the list. |[9600bps |Same as above
(Selectable range:
9600bps,
19200bps,
38400bps)
11 |Parity Select from the list. [None Same as above
(Selectable range:
None, EVEN, ODD)
12 |Stop Bit Select from the list. |1 Same as above
(Selectable range:
1or2)
13 |Address Select from the list. |1 This appears when
(Selectable range: Comm. Kind is set to
110 99) Serial and Comm. Type
is set to RS-422/RS-485.

When Comm. Kind is set to Serial and Device Type is
a Modbus device

r '
Register device x
Device Type UT55A &
COM Port No.: 1 =
Comm. Type: RS-232C ]
party
Stop Bit L &+ ®
Modbus Address:
Monitor Interval 1 Second o—4— @
Timeout: Milisecond ¢ (16)
Option L] HeatingCoaling
[] casorcassec @)
[ 0K J [ Offline Regist J [_ Cancel ]
L o
. Default L
No. |(Item Name |How to Specify Value Description
14 |[Modbus Enter text. (Input 1 This appears when
Address range: 1 to 247) Device Type is a Modbus
device.
15 |Monitor Select from the list. |1 sec Same as above
Interval (Selectable range:
100 msec, 200
msec, 500 msec, 1
sec, 2 sec, 5 sec,
10 sec, 20 sec, 30
sec, 1 min, 2 min, 5
min, 10 min)
16 |Timeout Enter text. 5000 Same as above
(Input range: 100 msec
msec to 10000
msec)
17 |Option Check box Not Displays the optional text
selected [strings defined in the
Modbus device definition
file in the order that they
were defined.
Nofte

.

To register any of the following instruments by
specifying “Comm. Kind: Serial” and “User,” set the
A/D scan interval and FIFO writing interval of the
device to the same value.

DX1000, DX1000N, DX1000T, DX2000, DX2000T,
MV1000, MV2000, CX1000, CX2000, FX1000

When connecting to a DXAdvanced (DX1000,
DX1000N, DX1000T, DX2000, or DX2000T) with the
/AS1 advanced security option through the Ethernet
interface, log in as an administrator to access the DX.
In this situation, only one administrator will be able to
log in.

When connecting an UTAdvanced device (UT32A,
UT35A, UT52A, UT55A, UT75A, UP35A, UP55A) to
a GA10 with the custom display function (/CG option),
select a model name with “_R3” from the list. (This
corresponds to the SP or other output channel.)

3-18
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Changing the Registration Information
Select a device icon on the Devices List, and double-
click it. A Change Device's Basic Information dialog box
appears. Edit the items you want to change.
The items that you can change in this dialog box are
the same as those in the Register Device dialog box
when you register devices.

|—Select the device and double-click

Register Device [ Update Setting J|_Delete Device | ﬁ
002 GX2 03 004 24 lcomi
.i‘:e
10.0.137.64
~
Change Device's Basic Information xXF
DewceTvame 7
Device Type: GM10 ~
oo Comm. Kind: Ethernet & ]
HostNamefP Address
User Name: ‘%
1
=
B‘HL AL AL m—J

Deleting a Registration
To delete a registered device, click the device icon to
select it, and click Delete on the Edit menu or click the
Delete button.
You can also select the device icon and press the
DELETE key.
If you click DELETE when no device icons are
selected, all unused devices will be deleted.

Select the device to delete and click

CxB@pes] =0 o=
i (Register Device )| Update Setiing J{_Delste Device |

m:u TDM
Updating the Settings
If you change the device settings after registering it to

the Devices List, click Update Setting. The most recent
information will be retrieved from the device and applied.

Select the device, and

Register Device date Settin

001 DX2000 002 MV1000 003 uR20000 004
Device Device Device:
T =
o
10.1.32.85 10.1.32.128 10132116

click the Update Setting button.

Important
If Tag No. and Tag Comment are already registered on
the GA10 (version R2.01.xx or earlier), do not execute
Update Setting. Doing so may erase the registered
information.

Registering Devices to the Registered Devices List

The Registered Devices List shows a list of devices
registered to the server. In the initial page, nothing will
appear. When you add a new device to the Devices List, it
is also automatically added to the Registered Devices List.
You can also drag a device from the Online Devices List
to register it.

Display filter

i ices Li: Delete Devicell _Update I
Comm. Kind: @ [H Ethernet 5] Serial [® uss ’—‘

DX2000 MV1000
Device. Device

f._:_ﬁ Update

1013285 10.1.32.128 H

Click Update to retrieve the most recent list of devices
from the server.

You can set the Comm. Kind filter to display only the
devices using the specified interface. If you select Serial,
the devices connected to the serial port of the server PC
will be displayed.

IM 04L65B01-01EN
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Starting the Web Application (GX/GP and GM)

Click Setting in the device information display
area to start the Web application for configuring devices.

1 In the Project List Page, double-click the appropriate
project.

2 Change the project setting window to the Device
Setting Page.

3 Select the icon of the device that you want to
change the settings of.
The information of the selected device appears in
the bottom device information area.

4 Click Setting in the device information area.
The corresponding setting Web page will appear in
Windows Internet Explorer.

For instructions on how to use the Web application, see
the GX/GP User’s Manual (IM 04L51B01-01EN) or the
GM User’s Manual (IM 04L55B01-01EN).

URL: www.smartdacplus.com/manual/en/

Limitations on the Device Setting Page

» The following operations cannot be executed on
the Device Setting Page while data collection is in
progress.

Register devices from the Registered Devices List to
the Devices List

Register devices from the Online Devices List to the
Devices List

Register a new device on the Devices List

Change device registration positions on the Devices
List

Delete registered devices from the Devices List
Change the settings of devices on the Devices List

« The Web application can be started only when the
connected device is GX/GP and the interface is
Ethernet.

» If multiple devices use the same COM port, observe
the following rules.

Do not mix Modbus devices with other devices.

Use the same communication type.

Use the same settings for baud rate, parity, and stop
bit.

3-20
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Basic Operation

3.3.3 Setting Tags

GA10 collects and records data from multiple connected devices. Tags are assigned to
channels of connected devices for identification.

After registering devices in a project, when you open the Tag Setting Page for the first time,
the channels of registered devices are assigned automatically to the tags as default values.
You can edit them to customize the data collection.

1 2 3

@ Data Logging Software[admin] ~[PROJECT_02] ——
File Edt Viw Projct Operafon User Help
Bl bbb DO x 8O e BBE ¢ - & (i Rk Rk [ Goos
Tag C_cea C Deee J( __incer
G Devee ¥ ontor rocors Togho, | Teodommenm | e | Dec.pom | - A=
- —
> 001 001 Device. TagCommeni@01 ToNG @ 4 © 1 T5000  Standard 2
By oo (& s i s e oo n T | S
001Device (000 TagCommento003 Lone @4 @ H 15000 AamSour | | &
[ mathTag v 001:Device @) TagComment0004 LONG & 4 @ H 15000 AlarmSour®@ | | 1}
001Devce @ Tagooos TagCommento005 lone @4 @ H 15000 None @
] A 001Devce @ Tagooos TagCommento006 Lone @4 @ H 15000 none @ | M
= 001Deuce & TagCommento007 NG @4 @H 15000 None @ | | g
001Device I TagComment0008 LONG  ® 4 @ H 15000 None =
2 Recort v B ootoence @ TagCommeni000s e @i @k 180 o @ | | (7]
B ootDevice @I TagCommento010 Lo @4 @ H 15000 None ®@
O ootDevice @I ‘TagCommento011 BOOL  ®0 @ 0 None @
[&) mepopint v U 5 e Taguo12 TagCommentoo12 B0OL @0 @ 0 el
Coo1a| O o010evice  &(—0103—) Tagoota TagComment013 BOOL @0 @ 0 None @ | | @
[ Eman ¥ [Coots] O 001Deviee (0104 ) Tago0ta TagCommento014 BOOL  ®@0 @ 0 None @ | | =
(Coots| O ootDevice (0105 Tagoo1s ‘TagComment0015 BOOL @0 @ 0 None &l
Coots| O ootDevice ®@ Tago01s TagComment016 BOOL @0 @ 0 None @
(i necessaomers v (010 O ootDeviee TagCommento017 BOOL  ®0 =) 0 None @ | X
(oote| O oorDevce @ TagCommento018 BOOL  ®0 @ 0 None @
boto| ] o001Device TagCommento019 BOOL @0 @ 0 None @
Coozo| O ootevice @ TagCommentn20 BOOL @0 @ 0 None @
Coozi| O o010evice @ TagCommento021 BOOL @0 @ 0 None @
Coozz| 0 ootDevce @ Tagoo2z TagCommentot22 BOOL @0 @ 0 None
Coozs| O ootevice ®@ Tagoo2s TagCommenton23 BOOL @0 @ 0 None ®
Chooze| O ootsice TagCommentooz4 so0L @0 @ o one @
(oozs| 0 ootDevice ‘TagCommento02s BOOL ®0 @ 0 None
o026 | [  00tDevice TagCommentu26 BOOL @0 @ 0 None ®
Cooz7| 0 ootevice TagCommenton27 BOOL @0 =) o None ®
Cooze| O o010evice TagCommento028 BOOL @0 @ 0 Noe @
(ooze| (] ootDevice TagCommento029 BOOL @0 @ 0 None
Cooo| O ootevice TagCommento030 BOOL @0 @ o None @
Cooz1| O 001Device TagCommento031 BOOL @0 @ 0 None @
(oozz| 0 ootDevice TagCommento032 BOOL @0 @ 0 None
0033| ] None TagCommento033 A @Ay @ None @
Cooza| O None TagCommentou34 A @AY @ None @
Coozs| O] None ‘TagCommento03s A @AY @ None @
ooze| (] None E Tago03s Y ) None @
o [ o] -  — I - A —— I T I
T =  E—— 2l T W B I  ——"
< | )
[ tarm Sound Cu J(_ownoas J(__ e
File Name File Name 1 Fle Nome T to. Fle Noms
[ 01| Aamsouna_o1 a e a
[ 02| Aamsound_o2
03| Aarmsound_03 °
[ o5 |

1 Select Tag in the navigation area on the left of the window.
The Tag Setting Page appears.

2 Select a tag to use in data collection or recording (1 line = 1 tag = 1 channel).
Click the check boxes in the Monitor or Record column.
To select consecutive boxes, click the first cell, and then click the last cell while
holding down the SHIFT key.

3 Set the tags.
Clicking a cell in a column other than Collect or Record displays a list box or a win-
dow containing options. Select the desired setting. For the Tag No. and Tag Com-
ment cells, type text strings.
The type and value of alarms 1 to 4 are view only.

4 Register the alarm sound file to assign to the tag.
Alarm sounds are .mp3 files. Up to 20 files can be used.

IM 04L65B01-01EN
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Select the data type.

Select the device for the assigned channel.
Select the number

Select the Select the channel to assign. f decimal ol
or decima aces.
tags to use Type the tag number and P
comment string_ Select the alarm sound.
- Alarm 1
Record| Channel Tag No. Tag Comment | Type Dec. P0|l| Type Value. Soundm, |
T 001Device @ J7ag0001 TagCommento001 LONG ( @)a @ 15000 Standar
[0 ootDevice e 0002 agull agLommentulU LONG 4 ="H 1.5000 AlarmSoute
[0 001:Device @2 0003 Tag0003 TagComment0003 LONG ™4 & H 15000 AlarmSourGe)
[] 001:Device @ 0004, Tag0004 TagComment0004 LONG o4 & H 15000 AlarmSoursd
[ ootDevice @(__0005__) Tag0oos TagComment0005 LONG & 4 @ H 15000 None &
[E  001Davice & 0006 Tag0006 TagComment0006 LONG =4 ™ H 15000 None (=]
M 001:Device @& 0007 Tag000T TagComment0007 LONG o4 o) H 15000 None (2]
001:Device Tagooog TagComment0008 LONG 4 H 15000 None
= ] ] ® @
001:Device Tag0009 TagComment0009 LONG 4 H 15000 None
= ® [©] @ @
[H  001:Device Tag0010 TagComment0010 LONG 4 o H 15000 None
001:Device Tagoo11 TagComment0011 BOOL 0 0 None
[m] ] ® ® ®
001:Device Tago012 TagComment0012 BOOL 0 0 None
[m} @ @ @ ®
001:Device Tag0013 TagComment0013 BOOL 0 0 None
O & 5] ] =]
[] 001:Device @G Tag0014 TagComment0014 BOOL & 0 ] 0 None ]
001:Device Tago01s TagComment0015 BOOL 0 0 None
O =] @ @ @

Tag selection state. Click again to switch.

Tag settings are used to set display groups and other settings in a project. Therefore, even if
you change the device channel assigned to a tag, there is no need to change display group
settings or other settings that use tags.

i1t —— 111

Monitor| Record Channel ‘ Tag No. Tag Comment Tyne | Dec. Point | T A\‘;T; Sound

(Hooo+ 001:Device = Tag0oo1 TagDnmmenmum LDNG &4 & H 15000 Standard &
(Hoooz D 001:Device & Tagooo2 TagCommento002 LONG = 4 & H 15000 AarmSour&
(Mooo3| [0 001Device & Tag0003 TagComment0003 LONG 0 4 ®@H 15000 AlarmSours
Mooos| [ 001Device & Tag0004 TagComment0004 LONG & 4 @ H 15000 AarmSoured
[mooos| [ 001Device & Tag0005 TagComment0005 LONG &2 4 & H 1.5000 None (]
[mlooos | (W] 001Device = Tag0006 TagComment0006 LONG ™ 4 & H 1.5000 None [©]
[Mlooo7 | @ 001Device & Tag0007 TagComment0007 LONG & 4 ™ H 15000 None =
[Mlocos | [E o01:Device = Tag0008 TagComment0008 LONG &2 4 & H 1.5000 None (]
(Hoooe| [ 001Device & Tag0009 TagCommentd009 LONG 0 4 ®@H 15000 None &
[Wloo10| (W 001Device & Tag0010 TagComment0010 LONG G2 4 @ H 1.5000 None ()]
Cloo11| [0 001Device & Tag0011 TagComment0011 BOOL @20 ] 0 None [©]
[Joo1z] [0 001Device & Tag0012 TagComment0012 BOOL & 0 =] 0 None &

The tag settings are explained below.

(1) Monitor (tag index)
These are unique tag numbers assigned sequentially starting with 0001. You cannot
change the numbers. Click the boxes to specify whether to enable data monitoring.

(2) Record
Click the boxes to specify whether to enable data recording.

(3) Device
Specify the names of the devices to assign to the tags.

(4) Channel

Specify the channels to assign to the tags. Clicking a button displays a separate window.
Select a channel number to apply it to the sheet.

(5) Tag No. and Tag Comment
Enter aliases for the tags as tag numbers and tag comments. Specify up to 16 characters
for tag numbers and 32 characters for tag comments. You can select which name to
display (Tag Index, Tag No., or Tag Comment) to suit your purpose. To select which name
to display, on the View menu, click Tag Display Form.
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(6) Type
Specify the tag data types. Click the arrows, and select from the following data types.
Data Type Description
ANY Any data type
BOOL Boolean
SHORT 2-byte signed integer
USHORT 2-byte unsigned integer
LONG 4-byte signed integer
ULONG 4-byte unsigned integer
FLOAT 4-byte single-precision floating-point number
FLOAT(LOG) Data type for LOG input channels 1
LOG (Old) Data type for LOG input channels (DXAdvanced series)
LOG Data type for LOG input channels (FX1000 series)

Refer to the following table for the data types of the channels on data source devices.

Model Channel Type Data Type
DAQLOGGER All channels Undefined (LONG, FLOAT, or
DAQ32Plus LOG)
MXLOGGER
Measurement channels (excluding DI), LONG
GX/GP rET;Iath channels, communication channels
oM channels BOOL

Measurement channel whose input type is LOG "1 FLOAT(LOG)

Excluding the above Same as "Other"

Devices defined using Modbus  All channels Data types of registers defined
device definition files in the Modbus device definition
file are retained and used for
displaying and recording.
Data type mapping table :
“Data Types” on page 3-56
Other Measurement channels SHORT
Math channel LONG
Control channel SHORT
Extra channel SHORT
Math channel whose input is LOG LOG

1 For GX/GP firmware version R2.01 or later with the Log scale option (/LG).

(7) Dec. Point

Specify the number of decimal places for tags. Click the arrows to select the number of

digits (0 to 5).

Select the same setting as the decimal place setting specified on the device. Specify ANY
to retrieve the decimal place information from the device at the start of data collection.

(See below.)

Type, Dec. Point, and ANY

»  GA10 can continue data collection even if you change the connected device in
the middle of data collection as long as the Type and Dec. Point settings are the
same. For example, assume you set the tag Type to SHORT. If another device is
connected in the middle of data collection (for maintenance or other purpose), as
long as the measurement channels use the same Type and Dec. Points settings,
you can continue data collection.

* You can select ANY if you want to retrieve the channel information from the device
at the start of data collection and use those settings to perform data collection.
However, if the data collection time is set to PC time and the device is not
connected within 3 seconds after the start of data collection, the channel information
will not be retrieved at the start of data collection even if ANY is specified.

* In this situation, the channel information that was retrieved from the device at the
time of device registration is used. This is not a problem as long as the channel
information at the start of data collection is the same as the channel information that
was retrieved from the device at the time of device registration.

» Using ANY makes the data type and decimal place settings easier. However, you

cannot verify the actual data type.
Related topic: } “Q11” on page 12-11

IM 04L65B01-01EN

3-23

Buipiooay pue uoi3o3jjo) eyeq Buiiels pue Bulnbiyuon



Chapter 3 Configuring and Starting Data Collection and Recording

Nofte

« If the data collection channel is LOG input, set the data type to LOG. If set to LOG, the decimal
place setting is void.

» If the data type is set to BOOL, the decimal place setting is void.

(8) Type, value, and sound of alarms 1 to 4

You can assign an alarm sound to each tag.
The type and value of an alarm are those assigned to the device and cannot be changed.
The alarm sound settings and alarm sound files are saved in the project file.

Alarm sound

Description

None

Standard

This is when an alarm type is not assigned.
If an alarm type is assigned, this is the GA10’s standard alarm sound.

Alarm sound file

If an alarm type is assigned and alarm sound files are registered, file names are displayed
for you to select from.

Registering and deleting alarm sound files

Alarm sound files can be uploaded to the server, downloaded from the server, or deleted.

Alarm Sound

L

1

! Delete

No.

File Name

| no.

File Name

| wo.

File Name

| mo.

File Name

03
04
05

01 AlarmSound_01
02 AlarmSound_02
03

08
07
08
09
10

1
12
13
14
15

16 L
17 (L
L
L
L

18
19
20

* Upload

Click a number, click Upload, and specify an .mp3 file.

* Download

Click a number, click Download, and specify the client’'s save destination to save the file.

* Delete

You can select alarm sound files registered in the server. Click a number, and click Delete

to delete the file.
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WT3000/WT3000E Tag Setting Page

When the connection target is the WT3000/WT3000E, the
WT3000/WT3000E data group and data become the tags
collected by GA10. The following table shows the items on
the Tag Setting Page. For details, see the relevant tables
in “Detailed Information of the WT3000/WT3000E” on
page 3-12.

Editing Tags

Clearing, Deleting, and Inserting Rows

To clear, delete, or insert tag setting data (row), select the
target rows, and then click the appropriate button.

You can select rows by clicking the left edge of rows (the
numbers of Monitor tags).

Button Result
— Clear Click to delete the settings of the selected rows

Data Type Description C o and initialize the items.
Monitor - -
Record Same as other devices Delete Click to delelte the tag settings of the selected
Device (_Deiete ) rows and shift up.
Channel Assigned from 0001 up to 0251. (depending on the Inserting Rows Click to insert tag information (default values) for

WT3000/WT3000E element and option configurations) (__nsert ) the selected number of rows.
Tag No. Displayed in the following format: data group number:

Tag Comment data name
For example, data “U” of data group “Element 1” is
displayed as “1:U.”
For details, see the mapping on page 3-13.

Type FLOAT

Dec. Point 3

Collectively Editing Tags

To collectively edit setup data, you must select the target
setup data and then click a button on the action bar,
which is at the bottom of the window. The result varies
depending on the type of icon you click on the action bar
(see the following table).

Type Name Result
O Enable or Switches the check box state between
disable selected and unselected.

If all the data values in the selected range are
the same, clicking this icon will switch all of
them in the same way.

If the data values in the selected range are
not all the same, clicking this icon will switch
all of them to match the first data value in the
selected range.

Increment Assigns increasing channel numbers starting

with the first tag in the selected range.

Copy Copies the settings of the first tag in the
- selected range to the other tags in the
selected range.

Switches between selected and unselected
states for items to be pasted when copying
setup data. The items are normally selected
(pasted).

Clicking this button causes the corresponding
item to become unselected. The item will not
be pasted.

Copy flag

You can also copy and paste selected content using the Edit
menu.

To select the range of setup data, follow one of the
methods below.

» Select by dragging
Click the first line you want to select. Drag to the
last line you want to select and release the mouse
button.

» Select using the Shift key
After selecting the first line you want to select, hold
down the Shift key, and click the last line you want to
select.

» Select all lines
Click the title area of the Monitor column to select
all setup data.

IM 04L65B01-01EN
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Collective Editing

1 Select the rows that you want to edit collectively.
(1) Click the left edge of the first row.

Tag No. ‘

Dec. Point

Tag Comment ‘ Type

SHORT
SHORT
SHORT
SHORT
SHORT
SHORT
SHORT
SHORT
SHORT
SHORT
SHORT

m‘ Device ‘ Channel

[0 001Device @
[ 001:Device @
[ 001:Device @
[ 001Device &
[ 001Device &
L] 001:Device &2
[ 001Device &
[ 001Device &
L[] oo0t1:Device @
[1 001:Device @
01) | [E 002Device &
[H o002Device @ SHORT
[H 002Device @ SHORT
[H 002Device G2 SHORT
B 002Device (0005 ) SHORT

(2) Drag and release.

FREEEEERRERREEE
ANAWanRnAARSASASS
FREEEHRERUORREEE

2 Click an icon at the bottom for the column that you
want to edit.
The values in the selected range will be changed.

LONG
LONG
LONG
LONG
LONG
LONG
LONG
LonG
LG,
LonG,
LONG,

001:Device (2

001:|
001:0evice
001:Device

LOEPEUPEEEE
REPEURRERE

3 3Jala)aala)ayafala)

i

I
1

Sorting tags in order of the device No.

The specified tags can be sorted in order by device
number registered in the Devices List (first precedence)
and by channel number of each device (second
precedence). On the Project menu, click Sorting tags

in order of the device No. Or, click the & icon on the
toolbar.

Nofte

Sorting is not applied to math tags (/MT option).

When you perform Sorting tags in order of the device No.,
various settings are arranged as follows.

. Tag settings (Tag No., Tag Comment, Type, Dec.
Point) remain the same.

» Display Group: Remains the same.

» Record: Tag indexes (fixed sequence) are changed. If
a tag range is specified, the numbers are sorted while
maintaining the range position.

* Report/Print (/RP option): Tag Index numbers are
changed.

» Mail: Tag indexes are changed. If a tag range is
specified for Trigger, the numbers are sorted while
maintaining the range position. At this point, the Trigger
setting changes from Easy to Detail.

Exporting and Importing Tags

Tag information can be converted (exported) to a TSV file
You can edit the TSV file using an appropriate software
application and load (import) it back into GA10.

Nofte

Only tag numbers and tag comments are exported and
imported.

¢ Export Procedure

Display the Tag Setting Page of the project whose
tag information you want to save.

2 On the File menu, click Export tags.

Select the save destination, assign a name, and
save it.
The tag information file (.tsv extension) is saved to
the specified location.
Tag numbers and tag comments are exported in
pairs in separate lines as shown below.

TagQ001 TagCormment(001

TagQ002 TagComment(002

TagQ003 TagComment(003
TagQ004 TagComment(004

¢ Import Procedure

1 Display the Tag Setting Page of the project whose
tag information you want to update.

2 On the File menu, click Import tags.
An Open dialog box appears.

3 Select the file that you want to import, and click
Open.
The content of the imported tag information TSV file
is applied to the Tag Setting Page.
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Update Tag Information (Refresh)

The tag information on the Tag Setting Page is updated in
the following situations.

*  When a channel (device) is changed on the Tag Setting
Page
If you change the channel (or device) on the Tag
Setting Page, Tag No., Tag Comment, Type, and
Dec. Point are retrieved from the specified channel.
Channel change

i

W S
g
H
H

2

5

©
PREEEEEEEPRREE

viots o014 BOOL @0

Updated with the information of the new channel

* When monitoring is started
At the start of monitoring (when the device is
connected), the most recent channel information
is retrieved from the device, and the alarm value,
range, and unit are updated. These are entered
in the recording data file at the start of recording.
However, if PC time is specified and connection
cannot be established with the device even after
3 seconds passes after the start of monitoring,
tag information is not updated, and the channel
information of the device already registered is used.

*  When tag information is changed manually
If the tag information is changed on the connected
device side, you can update the tag information
by clicking Update Tag Information on the Project
menu. The information to be updated can be
selected from a submenu.

Sub Menu Description

Tag No., Tag Comment Update Tag No. and Tag Comment to
the latest information on the connected

device side.

Except Tag No., Tag Comment Update Type and Dec. Point to the latest
information on the connected device
side.

1 Open the project that you want to change the tag
information of.
* Open the project with manager or higher access
privileges (privileges that allow setting operation).
»  Only projects in which data monitoring is stopped can
be used.

2 Select Tag in the navigation area on the left of the

window.
Tag
W 001Device & (_0001__) VIo01 0001 LONG & 4 [}
W 001Device @ 0002 1002 0002 LONG & 4 [©)
@ 001Device (0 VI003 0003 BOOL &0 [©)
W o001:Device &a(_0004 ) VI004 0004 LONG @ 4 [©)
W 001Device & VI005 0005 LONG &4 [}
W 001Device & V1006 0006 LONG & 4 [}
W 001Device & Vioo7 0007 LONG & 4 [}
W 001Device @ 0008 Vi00s 0008 LONG & 4 [©)
@ 001Device (0009 VI009 0009 LONG @4 [}
W 001Device Ga(__0010 ) VI010 0010 LONG @4 =]
W 001Device ®(__0101__) VIo11 0011 BOOL &0 [}
W 001Device & vio12 0012 BOOL @0 [}
W o001Device ®(_0103__) VIo13 0013 BOOL 0 )
W 001Device G2 0104 Vio14 0014 BOOL & 0 &)

A Tag Setting Page opens.

3 Select the tags you want to update.

g
g

0001 LoNG

gguuu!uuugguudﬁ

g
EEEEEREEEEEEE

@
®
®

Selected range

4 On the Project menu, click Update Tag
Information. Then, click the information to update
on the submenu.

A confirmation message appears.

5 cickok.
Type and Dec. Point information of the selected tags
is updated.

Note

Even if you execute Update Tag Information, the tag

settings specified on the GA10 are not changed.

« In following situations, an error message will be
displayed.

« Some of the connected devices cannot communicate
with the server.

* The number of registered devices on the server is at
the maximum.

e If the A/D scan interval and the FIFO writing interval

of the device are not the same, the following devices

cannot be updated by a “user.” To update, log in as an

administrator.

DX1000, DX1000N, DX1000T, DX2000, DX2000T,

MV1000, MV2000, CX1000, CX2000, FX1000
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ing

3.3.4 Setting Display Groups

The GA10 Monitor Page can display multiple channels in groups.
The Display Group Setting Page is used to group channels and set the tag data display
method. The Display Group Setting Page consists of multiple tabbed pages. Each tabbed
page shows the settings of each waveform in rows and the setup items in columns.

1 2

@

File Edit View Pfoject Opefation User Help

Data Logging Software ~ [admin] [

Project B1]

oo nunh dox ®ee] oo

fGraupU‘\ roup 02 | Group 03 | Group 04 | Group 05 | Group 06 | Group 07 | Group 08 | Group 09 | Group 10 | Group 11 | Group 1

G pevie NeromEame:  [Group o ]
5 Tag || Waveform List g
Ho. Tag Index ‘ M 1o Ghiz L ‘Fom,‘ Meter ‘
@ Display ~ = woi Jag 0001 Yo1 & Detail Linear ] Foom O
e Cinear 15} T OO
. Display Group @ % [ w03 60 Detail Linear N F ool Ol
= 8] wo4. & Detail Linear 1) F ol O
W ot S [0 wo5. & Detail Linear N F ¢l Ol
06 & Detail Linear i) F d@l O
¥ Record O.1 & Detail Linear Tl F el Ol
08 & Detail Linear N F L@l Ol
(=] Email [E wog & Detail Linear H F $@l On
[0 w10 & Detail Linear N F @l Ol
[ v 11 & Detail Linear N F SOl Ol
@mm!'! [ w12 © Detail Linear 4 F ol Ol
[CITEEY & Detail Linear N F ¢Ol Ol
. 5 Féell Ol
Displays the waveform of the select number ;. F ol on
i rayuuin Jrw s Lz F
(w17 Tag 0017 J Y17 & Detail Linear 4 F el Ol
wig Tag 0016 Jy1s & Detail Linear N F ¢@l O
w19 13g 0019 Y19 & Detail Linear i) F d@l On
W20 13g 0020 Y20 & Detail Lingar I8 F ¢ol O
w21 Tag 0021 ¥21 & Detail Linear N F ¢Ol Ol
w22 J3g 0022 Y22 & Detail Linear I F ¢@l Ol
[Tw23 1390023 Y23 & Detail Linear N F ¢l Ol
W24 Tag 0024 Y24 & Detail Linear I8 F ool Ol
(w25 1390025 v25 © Detail Linear [0 F el Ol
W26 Tag 0026 Y26 & Detail Linear N F ool O
W27 139 0027 Y27 & Detail Linear i) F d@l On
W28 Tag 0028 Y28 & Detail Linear N F ¢l Ol
w29 Tag 0029 Y29 & Detail Linear N F SOl Ol
[1w30 1390030 ¥30 & Detail Linear 1) F ¢@l On
w31 Tag 0031 Jyai & Detail Linear N F &l Ol
w32 Tag 0032 J Y32 & Detail Linear 14 F ol Ol
2 L 20 v  —— v =TT
£l L EL = =] =] .
k3 |

Action bar: Use to collectively edit the settings
of the selected lines.

Basic Operation

— Scroll bars —

1 Select Display Group in the navigation area on the left of the window.
The Display Group Setting Page appears.

2 Click the tab of the group you want to configure.

wW

waveforms.

Edit the setup data. Click the No. cells (left-most column) to show or hide the

Details of settings: P The details are provided on the next page and subsequent pages. Use
the numbers in the figure to reference the corresponding descriptions.

Note

On the initial Display Group Setting Page, tags are assigned automatically for each device (when
there are tags specified as data collection channels on the Tag Setting Page).
If you want to perform Assign Tag Automatically again, do this first before setting the displays.
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Specify the group name.

i i Select fixed point
Group tab number (3 Specify the Y-axis. @ ) point
or floating point display.
Group 01 [ Graup 02 | Groug 03 | Group 04 | Group 05 | Group 06 | Group 07 | Group 08 | Group 08 ||Group 10 | Group 11 Group 12 | Group 13 | Group(+ [ »
@ Waveform - [ [EE2 s emeams ) Yore 8 Y eroue ot 0 e 17 e 72 i 1 rouelo L2
Group Name. [eroup 01 | |
No. Waveform List ps |
N Tag N ‘ Y- |F | Met ‘ o S
o L No. Mode  Type Title: orm: leter @) Mk
w01 0002 }vm & Detail & Linea® F el Om -2.0000
[ wo2 0003 Yo2 & Detall & Linea® M F &@u Ol -2.0000
[ wo3 0004 Y03 @ Detall & Linea® M F &oul Ol -2.0000
] o4 0005 Y04 & Detail & Linead 4 F oM (o] -2.0000
] wos 0006 Y05 & Detail & Linea® M F e (o] -2.0000
2 Specify the tag to assign to the waveform. (® Meter type (© Type the display
range.
(@ Specify the Y-axis grid line spacing.
(® Waveform display position (9 Trip line settings
(®Waveform color
Group 01 | Group 02 | froup 03 | Group 04 ) Group 05 | Grbup 06 |[Group 07 | Group 08 |[Group 09 |[dreup 10 | Group 11 ) Group 12 | Group 13 |[Group 14 | Greup 15 |(<[»
Group Name:  [Grofip 01 ]
Waveform List
‘ ‘ Scalemlerva\E‘ Zone _— Tript Trip2 Trip3 Trip4 o
Yo |max  |use vawe | mm_max | ©°°" Juse vae _Color |use Vawe _Color |Use Value _Color |Use Vaue _Color
[{wo1| 20000 ] 10000 0.0 1000 [m] 20000 O  -20000 [m] 1.0000 O  -10000
20000 [ 10000 0.0 1000 [m] 2.0000 O -20000 [m] 1.0000 0O -10000
20000 [] 10000 00 1000 O 20000 O  -20000 O 1.0000 0O  -10000
20000 [] 10000 0.0 100.0 ] 2.0000 0O -20000 ] 1.0000 O -10000
20000 O 10000 0.0 1000 O 20000 O  -20000 O 1.0000 O  -10000
(1) No.

These are waveform numbers assigned sequentially starting with W01. You cannot
change the numbers. Click the boxes to specify whether to display the waveform.

(2) Tag
Specify the tag to assign to the waveform. Clicking a button displays a separate window
(figure below). Select a tag number to apply it to the sheet. If you select the “Show
[Device No.: Device Name: Channel No.]” check box, the following information is
displayed after the tag number.

Displays tag information after the tag number.

.

Tag Index x
mw [Device No.: Device Name: ghannel NoJ

[Tag

I Tag0001[001: Device fooo1] ) Tag 0002 [001: Device _:0002] =)
Tag 00000 Dee_00031] ) (__Ton 0041001 Deres_00041 ) |
Tag 0008 [001: Device_ 0009] Tag 0010 [001: Device - 0010]
Tag 0017 [001: Device_: 2007] (____Tag0018[001: Device :2008] )

Tag 0019 [001: Device _: 2009] Tag 0020 [001: Device_: 2010]
Tan 0021 1001 Nevice 21041 ( Ten00271001 Dewice 210211

%

Device No.: Displays the number in the GA10 Devices List.

Device Name: Displays the first 9 characters of the device name assigned on the GA10
Tag Setting Page.

Channel No.: Displays the channel number of the connected device.

(3) Y-Axis
No.: Specify the Y-axis to use in the waveform display.
Mode: Select Detail or Compact mode.
Type: Specify the type of scale to add to the Y-scale of the waveform. Select Linear or
Logarithmic.
Title: Type the Y-axis title of the waveform. Enter up to 30 characters.

(4) Form.

Set the display format on the Monitor Page to fixed point or floating point.
F: Fixed point display
E: Floating point display
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(5)Meter
Specify the type of meter to display on the Meter Monitor. Select bar meter .:g’ or analog

meter 3%/,

(6)Scale MIN and MAX
Type the minimum and maximum values of the scale on the Monitor Page to define the
display range.

(7)Scale Interval
Set whether to specify the Y-axis scale interval of the waveform. Leave unselected to use
the default scale interval. To specify the scale interval, select the check box and enter a
value.

(8)Zone
MAX: Specify the maximum Y-axis position for displaying the waveform.
MIN: Specify the minimum Y-axis position for displaying the waveform.
This determines the waveform display position.

(9)Color

Specify the waveform display color. To change the color, click the appropriate cell to
display a separate window. Select a color to apply it to the sheet.

(10) Trip
Use: Click to use the waveform trip line.
Value: Type the value.
Color: Specify the trip line color. To change the color, click the appropriate cell to display a
separate window. Select a color to apply it to the sheet.
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Collectively Edit Setup Data

To collectively edit setup data, you must select the target
setup data and then click a button on the action bar,
which is at the bottom of the window. The result varies
depending on the type of icon you press on the action bar
(see the following table).
To select the range: The procedure is the same as
explained on p “Editing Tags”

Type Name Result

Show or hide Switches the check box state between

Enable or disable selected and unselected.

F-Type/E-Type Switches the item selection state.
If the data values in the selected range
are not all the same, clicking this icon will
switch all of them to match the first data
value in the selected range.

Increment Assigns increasing tag index numbers
starting with the first tag in the selected
range.

Default Resets the value to default.

Y-axis grouping

Groups Y-axes whose unit is the same
u (unit)

together.

Y-axis grouping Groups Y-axes whose unit and scale value

(unit & scale) are the same together.
Copy Copies the settings of the first tag in the
- selected range to the other tags in the
selected range.
Copy flag Switches between selected and

unselected states for items to be pasted
when copying setup data. The items are
normally selected (pasted).

Clicking this button causes the
corresponding column to become
unselected and will not be pasted to.

You can also copy and paste selected content using the Edit
menu.

Assigning Tags Automatically

Tags assigned on the Tag Setting Page can be assigned
automatically to display groups.
There are two methods for automatic assignment.

* Assign According to Tag Number

When you specify the number of tags to assign to
each display group, the specified number of tags are
assigned in order from the first number of display
group 1 on the Tag Setting Page.

For example, if the total number of tags is 50 and
you set the number of tags to 10, 10 tags will be
assigned to each group from Group 1 to 5.

If the Math function (/MT) is installed, math tags will
be assigned in order after tags are assigned.

* Assign According to Device

The tags of a single device are assigned to each
display group. For each device (device number)
that a tag has been assigned to, assign the tag to
a display group. Tags are assigned in ascending
order by device number starting with display group
1. Within a display group, tags are assigned in
ascending order by tag number.

If the number of tags of a device is greater than the
number of waveforms in a display group, multiple
display groups will be used for the device.

Nofte

*  When you assign tags automatically, the settings of
all display groups are reset to their default conditions.
After automatic assignment, you must configure the
settings again.

« Tags that are automatically assigned are those whose
Monitor item is selected on the Tag Setting Page and
whose channel is specified.

» Math tags are assigned automatically using Assign
According to Tag Number.

* Automatic Assignment Procedure

1 On the Project menu, click Assign Tag
Automatically.
An Assign Automatically dialog box appears.

2 Select the assignment method.

Assign Automatically x
O Assign According to Tag Number
Tag Mumber of Each Group: | 50
® Assign According to Device

T( Ok ] ( Cancel ]

To assign according to
device, do not change.

3 To assign according to tag numbers, select Assign
According to Tag Number and type the number of
tags to share in each group.

Assign Automatically X

® Assign According to Tag NUMBgL—
Tag Number of Each Grou
O Assign According to Device

(. OK ] ( Cancel ]

4 ciick oK.
All display group settings are initialized, and tags
are assigned to display groups on the Display Group
Setting Page.
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Basic Operation

3.3.5 Registering Data Collection Method and Monitor Page
After setting the display groups, register the data collection method and monitor page.
Data collection is performed for tags that are set to collect data on the Tag Setting Page.
On the Acquisition & Monitor Page, set the data collection conditions, namely the type of
timestamps to attach to data and data collection interval. In addition, specify the number of
windows to divide the Monitor Page into and their layout.

1 2 Area for setting data 8 Area for setting the Monitor

acquisition conditions
@ Data Logging Software —[admin] —[Project B1] —
File Edit View |Project Operation User | Help
HEa® wbhk OO @ les| @ | = 7 (e ek @ cood |
e =T
N | Acquisition
\Gp Device v
Data time: PC ime [ Pre-set mark 5
% Tag w || Monitor mterva 1Second S No. String A g
1 [ 2
© = 1
Display v - -
Display Group v
= Monitor ?
= Acquisiti — =
Monitor Data Set Number. 2 ] Resize the Monitor Set ©oN CoFF
3 Record Split Screen Direction Horizontal G2  Alarm Shape: ®0 oo |4
R Set Number in Spliting Direction: [1 | Alarm Color: orr[ll on [l @
g E-mai ‘Spiit Screen Data Set Monitor Set Layout EI
No. | Split Screen Data Set| |(=o100
Group01 =
- e 2o = : Olla
2| Diaital @) . - B |

1 Select Acquisition&Monitor in the navigation area on the left of the window.
The Acquisition&Monitor Page appears.

2 Set the data acquisition conditions, namely the type of timestamps to attach to data
and acquisition interval.

3 Configure the Monitor Page (monitor type, layout, etc.).

The Acquisition&Monitor Page is divided into two areas: an area for setting data acquisition
conditions and another for configuring the monitor. The details of each are provided in

the following pages. Use the letters (a to j) in the figure to reference the corresponding
descriptions.

Acquisition area

a: Data time c: Pre-set mark
Acquisition
Datatime PCtime o— 2 Pre-set mark
Monitor Interval 1 Seconde—_ &) Ho. String H
1 I
L2 ] I
3 0

b: Monitor interval
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Setting Data Collection Conditions
a Data time

Timestamps are attached to data that GA10 collects from devices. You can set the type
of timestamp to use to Device time or PC time. Device time is the time information that
the data collection device uses. PC time is the time information that the PC in which the
server is installed uses.

If Device time is selected

By selecting Device time, you can synchronize the data in GA10 with the data in the

corresponding device.

In addition, the backfill function becomes available.

However, if data is collected from multiple devices, time offset can occur between the

devices and the collection interval may be different. In other words, data cannot be

collected simultaneously with synchronized timestamps.

Moreover, if you are using the multi batch function, the backfill function will not work.
Operating conditions of the backfill function: p “Q4” on page 12-7

Important

The Math function (/MT option) does not work when “Device time” is in use. If you change to
“Device time” after setting math tags, a confirmation message will appear. To keep the math
settings enabled, click Cancel. If you click OK, the changes will be applied, and the math
settings will be disabled.

Nofte

Data collection using device time has the following limitations.

» You cannot specify the data collection and record interval on GA10. The acquisition interval of
each device is used.

» If different acquisition intervals are used during recording in different devices or even within the
same device, the collected data will be saved to separate files according to the intervals.

* The trend monitor on the Monitor Page displays data based on a single time axis. Therefore, if
there are multiple devices whose time or interval is different in a display group, the Monitor Set
will be divided and waveforms in the display group will be displayed in windows divided at the
interval level. Only up to four divided windows can be displayed. Anything in excess will not be
displayed.

* Asimilar behavior will also occur in alarm lists. The page will be divided, and the lists will be
displayed separately at the device level. If there are multiple acquisition intervals in the same
device, the page will not be divided at the interval level but at the device level.

If PC time is selected

If PC time is selected, data will be created using synchronized timestamps. You can
specify the data collection interval and record interval, and save data to a single data file
during recording. There are no display limitations on the Monitor Page.
Note
» Data collected using PC time will not necessarily be the same as those of the corresponding
devices:
P “Q9” on page 12-10
* The timestamps attached to data in PC time mode are determined so that data collection would
always occur at 0:00 am (00:00:00).

The difference between setting the Data time to PC time and setting the Data time to Device
time is also described in “Q12” on page 12-11.

b Monitor Interval

Click the arrow, and select from the following intervals. If Data time is set to Device time, you
cannot specify the Scan Interval.

Interval: 100 Millisecond, 200 Millisecond, 500 Millisecond, 1 Second, 2 Second, 5
Second, 10 Second, 20 Second, 30 Second, 1 Minute, 2 Minute, 5 Minute, 10
Minute

IM 04L65B01-01EN
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Nofte
Data update interval of the monitor screen depends on the data acquisition interval as follows:
Data acquisition interval Data update interval of the monitor screen
Less than 100 ms 100 ms
100 ms-10s As specified
20 s or more

Half the specified interval (i.e., 10 seconds if 20 seconds is specified)

c Pre-set mark

Specify text strings to assign to marks if you want to add marks on the Trend Monitor Page.
You can assign up to 16 characters to each mark. You can register up to five marks.

When you register text strings here, they appear in a list on the Monitor Page as shown
below, allowing you to easily add marks.

When you register text strings here,

Pre-set mark
No. String [2]
1| Mark_01 L]
2 | Mark_02 o _
3 I~
Mark_01 - = 7 (e [scionl

"Mark_01

they appear in the mark list on the Monitor Page.

If you click *, the mark appears on the monitoring page.
And if you click & , the marks appear on all monitoring pages.

Monitor area

e: Split Screen Direction i: Alarm Shape

d: Monitor Data Set Number h: Resize the Monitor Set j: Alarm Color
Monitor
L_q Monitor Data Set Number Resize the Monilor Set ¢ ® ON QOFF
) Split Screen Direction Alarm Shape @0 oge—
—e Set Number in Spliting Direction: Alarm Color orr [l on
Spiit Screen Data Set

Monitor Set Layout

No. | Split Screen Data Set
1 |Trend &
Digital (=]

o

f: Set Number in
Splitting Direction

® TAG 0003 ITAG 0004

g: Split Screen Data Set
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Configuring the Monitor Page

The GA10 Monitor Page can display four types of displays (referred to as Monitor Data
Sets): trend, digital, meter, and alarm. A total of up to 16 monitors can be arranged on the
Monitor Page.

To display multiple Monitor Data Sets simultaneously, specify how to divide the page and
where to arrange each Monitor Data Set.

When you specify items d to g below, a display layout appears in the Monitor Set Layout
area. By dragging the splitters that appear between rows and columns when you move the
pointer over the boundaries, you can adjust the size of Monitor Data Sets.

d Monitor Data Set Number
Select a number between 1 and 16.
e Split Screen Direction
Set the direction to arrange the Monitor Sets to Horizontal or Vertical.
f Set Number in Splitting Direction
Select a number between 1 and 16. Options that exceeds the Monitor Data Set Number
are not displayed.
g Split Screen Data Set
Assign Trend, Digital, Meter, or Alarm to each Monitor Data Set.

The Monitor Data Sets can be arranged vertically or horizontally on the page.

The following figure shows the layout when the Monitor Data Sets are arranged horizontally.
The number of vertical divisions is determined by the number of Monitor Data Sets in the
horizontal direction and the total number of Monitor Data Sets on the entire Monitor Page.
(When arranged vertically, the horizontal and vertical arrangement of the Monitor Data Sets
is swapped.)

Vertical splitter:

== — Honter st oyent p— The boundary of the
o O e 8 froum] ©) o Y divided areas can be
@ @ @ @ ‘ moved left and right.

©)
©)
®
hé

®

(Groupon) @ [couro] (_\’}.)ﬂ Olcor] T Horizontal splitter:
: A X X @ The boundary of the
divided areas can be
moved up and down.

©
®
&

Groupo1| & [Groupot] & [Groupot] |53)

®@ e e

_T— The last row is divided equally when the page is divided into 15 monitors.

h Resize the Monitor Set

When set to On, you can make fine adjustments to the arrangement also on the Monitor
Page.

i Alarm Shape

You can set the shape of the alarm display area to circle (O) or rectangular ().

j Alarm Color

You can change the color that appears when alarms are active (On) and when alarms are

inactive (Off). Clicking a color displays a Color Setting dialog box where you can select the
color.
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3.3.6 Setting the Data Recording Method

GA10 saves the data collected at the collection interval to data files at a specific record
interval. The instantaneous values of data are recorded. The collected data at each record
interval is saved to files without any data processing.

The figure shows an example of how data is recorded when the collection interval is 1
second, the record interval for instantaneous values is 5 seconds, and recording is started
at 0:00:00. In instantaneous-value recording, the collected data at 0:00:00, 0:00:05, and
0:00:10 are saved as record data. The first collected data is called “recording start point.”

[ ] ° ?

° i

Recording —r @ ¢ |
data o¢oo ¢OOOO?OOOchmwd

data
0© °o¢oo°o¢o°°°
69
i » Time

0:00:00 0:00:05 0:00:10 0:00:15 0:00:20 0:00:25

::’—_44— Collection interval (1 sec)
Record interval of instantaneous values (5 sec)

A
Recording start point

Click the Start Recording button to start data recording.

Note that the actual recording of data to data files starts when the recording start conditions
are met. Therefore, GA10 may enter the recording standby state when the Start Recording
button is clicked.

The following figure shows an example of how GA10 operates when an interval (everyday,
every week, every month) and start time are specified as recording start conditions.

Recording standby Recording standby Recording standby
Start Recording start Recording stop/Recording start Recording stop|  po 05404 from
Recording |condition met condition met |[condition met condition met this point
clicked —

Recording data

-
L e |

< e o © o o o |« e o o o
[o olo 0 0o 0o 0 0o 0 0o o o 0 0 o 0o 0 0 0 0O 0O O O O o|COIIected datf
Start Recording ‘ ‘ ‘ ‘
Start of recording End of recording Start of recording End of recording
to file 1 to file 1 to file 2 to file 2

The following settings are available on the Record Setting Page.
» Record Interval
* Record File Type
» Start/Stop Condition
= File Division
* Number of Files
» Folder
» File Name
+ Comment
The details of these settings are provided in the following pages.

Nofte

* The data recording settings vary depending on whether the data collection condition was set to
PC time or Device time. Also, the handling of alarm information and the number of record data
files vary.

» If the server stops for some reason during recording, the recording will resume when the server
recovers. However, if the server is stopped manually, or if the PC in which the server is installed
stops, the data file is cut at this point and saved. Recording will not resume even if the server is
restarted. When the server stops.
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Click here to display the Record Setting Page.

1 2)
(3 Data Logging Soffware — [admin] —[PJTOT] o X
File Edit View |Project Operation User Help
H1E2 wlhtb EICICE PR EE—— =] G ot ]
1 I RecordInterval rs
\:‘ sce e Record File Type: O Binary ® Excel O Binary&Exce| @— 3 '
2 Excel Files” Alarminfo: @ Exist O — 5
&“‘ﬂ Y Start Condition: Immediate o 4 3
Math Tag % | Stop Condition: Continuous o 5
File Division None = — 6
ﬂ - | Number ofFiles. [ Limit the Number of Files 4]unit @——— (7) (8) Ij'
& Record v Folder. C:Users\Public\Documents\SMARTDAC+ Data Logging Software\Data\PJT01 Re!err s
File Name: @— (g [Data ] [ Attach the Date [ Attach the Time:
[&2) Reportprint v Comment =
HNo. Title String @
b Eman v ‘
> a
@Wmm v j @
5 x
L) g
7
8
Computing [ Reset When Recording Starts | (1 O)
(1) Record Interval (5) Stop Condition
Select the interval from the drop-down list. You can specify the following for the stop condition.
Options: 100 Millisecond, 200 Millisecond, 500 Stop Condition Description
Millisecond. 1 Second. 2 Second. 5 Second. 10 Second Continuous Stops recording when the Stop Recording button is
’ ' . ’ : o i clicked.
29 Second, 30 Second, 1 Minute, 2 Minute, 5 Minute, 10 Specified Time Stops recording at the specified time. If the start
Minute condition is set to Alarm or Level, GA10 enters a
The intervals that are displayed in the list are integer recording standby state.
multiples of the collection period specified on the Monitor Specified Stops recording when the specified time elapses after
Duration recording starts. If the start condition is set to Alarm or

Page. If Data time is set to Device time, you cannot
specify the record interval.

(2) Record File Type

Specify the data output format.
You can save the recorded file in binary format (.dId
extension) or Excel format (.xIsx extension).

Note

If you want to record data on a device with the scan
interval set shorter than 10 ms using multiple projects, we
recommend that data be recorded in binary format.

(3) Excel Files' Alarm Info
Select whether to export alarm information to Excel.

Setting Description
Exist Alarm information is exported to an Excel file.
None Alarm information is not exported to an Excel file.

(4) Start Condition
You can specify the following for the start condition.

Start Condition Description
Immediate Starts recording when the Start Recording button is
clicked.
Specified Time Starts recording when the specified time arrives.
Specified Period Records at the specified period.
Alarm Starts recording using the alarm status as a trigger.
Level Starts recording using a collected data value as a

trigger.

Level, GA10 enters a recording standby state.

Data Number Stops recording at the specified number of data points.
If the start condition is set to Alarm or Level, GA10

enters a recording standby state.

Specified Period |Stops recording at the specified period and enters

recording standby state.

Alarm Stops recording using the alarm status as a trigger and
enters recording standby state.

Level Stops recording using a collected data value as a
trigger and enters recording standby state.

Nofte

» If you set the start condition to Specified Period, the
stop condition is fixed to Specified Period.

+ If the start condition is set to Specified Period and
the recording start time is set to the same time as the
record stop time, the recorded data file is not divided
at every interval.

+ If the start condition is set to Specified Period and the
period is set to the 31st of every month, for months
that do not have 31 days, the date is automatically set
to the last day of the month.

» If you set the start condition to Specified Time,
you cannot specify a nonexistent time due to DST
(daylight saving time) transition.

+ If the specified time overlaps due to the DST
transition, the first time is used to start recording.
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If the Start Condition is set to Alarm

1 Set Start Condition to Alarm.
The tag range, Level (1 to 4), and Alarm Change
are displayed.

Tag range —!
Alarm &|TagRange [ Jaqnnm J-C Tag 0100 D

[dievert [MLevel2 [ieveiz [dLevel4  Alarm Change: [OFF ta ON

Alarm levels

2 Click the first or last tag selection button.
The Tag Index dialog box appears.

Tag Index x

[ show Device No: Device Name: Channel No]

(Tao [wamTas)

( Tag 0001
i Tag0003
Tag 0005

_ Tag 0002 ]

Tag 0004

Tag 0006
Tag 0008
Tag 0010
Tag0012
Tag 0014
Tag 0016
Tag 0018
Tag 0020
Tan002

L
&
puuUUUuUuUuUuUUg
e e Tt
UUUUUUUUUL

)

\

3 Select the applicable tag range.
The dialog box closes, and the tag selection button
display changes to the selected tag.

4 Select Level (alarm level).

5 Set the Alarm Change to OFF to ON (alarm
activated state) or ON to OFF (alarm released
state).

Click the Start Recording button to enter the record-
ing standby state. When the monitored alarm reach-
es the specified alarm value, recording starts.

If the Stop Condition is set to Alarm

The setting procedure is the same as described
above. When the specified alarm value is reached
during recording, GA10 stops recording and enters
the recording standby state.

If the Start Condition is set to Level

1 Set Start Condition to Level.
Tag range, threshold value, and operation direction

appear.
Tag range
Level ©|TagRange (_ 0001 J-C Tag0100 )
| o [up

T
Type the threshold. Operation direction

2 Click the first or last tag selection button.
The Tag Index dialog box appears.

TagIndex X

[ show [Device No-: Device Name: Channel No |

T )
I T2 0001
i Tag 0003
Tag 0005
Tag 0007
Tag 0009
Tag 0011
Tag 013
Tag 0015
Tag 0017
Tag 0019
IC Tan0n21

- Tag 0002 » Lg
Tag 0004
Tag 0006
Tag 0008
Tag0010_

Tag 0012
Tag 0014
Tag 0016
Tag 0018
Tag 0020
Tan002>

al

UuUuUUUUUUUGU
NOONONANONO

PUUUUUUUUUL

3 Select the applicable tag range.
The dialog box closes, and the tag selection button
display changes to the selected tag.

Enter the threshold value.

G A

Set the operation direction to Up (data value is
greater than or equal to the threshold) or Down
(data value is less than or equal to the threshold).
Click the Start Recording button to enter the record-
ing standby state. When the monitored tag value
reaches the threshold in the specified direction,
recording starts.

If the Stop Condition is set to Level
The setting procedure is the same as described
above.
When the monitored tag value reaches the threshold
in the specified direction, GA10 stops recording.

(6) File Division
Set the conditions for dividing data files. The settings vary

depending on the selected condition. The figure below
shows an example when Specified Period is selected.

Set the conditions — Type the time.—
for dividing.
File Division: [Specified Period  \G)JEvery Hour Ggl[00: 00

Select Every Hour, Everyday,
Every Week, or Every Month.

Off
File is not divided.

Specified Duration
Based on the time of the first recorded data, the file
is divided at every specified hour and minute.
Example: If the division time is 1 hour, the time of
the first recorded data is 3:00:00, and the record
interval is 1 second, the first file will contain the data
from 3:00:00 to 3:59:59, and the second file will
contain the data from 4:00:00 to 4:59:59.

Specified Period
Select Every Hour, Everyday, Every Week, or Every
Month and the absolute time to divide the data file.
Data Number
The file is divided when the number of data values
in the data file reaches the specified number. Input
range: 100 to 2600000

Nofte

The file is divided in the following situations.

*  When the data file size exceeds 1 GB

*  When the data file output format is Excel and the
number of recorded tags is 180 or less, the files will
be divided every 65535 rows.

When the number of recorded tags is 181 or more, the
files will be divided in groups of the maximum number
of rows that meets the following condition: number of
tags No number of rows < 11796428.

*  When the data file output format is binary and the
number of recorded data points exceeds 10 million
This number is the number of timestamps that is
recorded and is not related to the number of tags.
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(7) Number of Files

If you use File Division, you can specify a upper limit to
the number of files to save for the data files that have
been divided during one iteration from recording start to
recording stop.

You can limit the number of data files that are saved from
the start of recording to the end of recording. When the
number of data files reaches the limit, the oldest file is
deleted to save the most recent file.

The handling of the number of files is different when the
data time of collected data is set to PC time or Device
time. The range of values that you can enter is 4 to 2000.

PC time
Because the data of every device is saved in a
single file, the number of data files of one iteration
from recording start to recording stop is applicable.

Recording start Recording stop

File division
v e
I I I |[__ocoo _osoo cocs

BODDD

nODDD

Number of saved files = Number of files

Device time
Because a file is saved for each device or each
interval, the number of data files of one iteration
from recording start to recording stop for each

device or interval is applicable.
Recording start Recording stop

File division

Device At—i—t—r—T —

Device BI—r—T—r—T1T D —

Device Cor—r——Tr—a—T1——= — 1T T T

Number of saved files = Number of files x unit (device or cycle)

(8) Folder
Specify the data file save destination.

Server PC Operation System |Default destination

Windows XP C:\Documents and Settings\All Users\
Documents\SMARTDAC+Data Logging
Software\Data
C:\Users\Public\Documents\SMARTDAC+
Data Logging Software\Data

Windows Vista, 7, 8

Nofte

We recommend you use the default setting for the data
save destination folder.

If you want to change the save destination, select a folder
that the server (Network service account) can write to.
Note that files cannot be saved to the desktop or
Document folders. If you select an area where writing is
not possible, an error message (E3055) will appear.

(9) File Name

Specify the name of the data file. When recording data
using Specified Period, it is convenient to add the date
or time to the file name. The date or time of the first data
point is added to the file name.

(10) Comment

You can attach comments to data files. You can view
these comments when you display the data in Universal
Viewer.

You can change the comments until you click Start
Recording but not afterwards.

(11) Math Action (Appears only when the /IMT
option is in use)

On GA10 with the Math function (/MT option), the Math
Action item appears on the Record Setting Page. To
reset math when recording starts, select the check

box. However, the math reset timing is delayed by one
recording interval from the record start timing. Also
depending on your PC environment, it could be delayed
by more than two record intervals.

Record Setting Page When the Math Function (/MT
option) Is in Use

G et Logging Software.{admin] prject o] lelol =
[Fue Edit View Project Operation User Help
Hicd whkk £ 0| @ [star e o [ [ lmen
N | Record ntenva 1Second 5]
\p Deviee | RecoraFie Tpe ©Bnay  Obeel  OBnansecel -
& | st concion [ rm— K
‘Stop Condition: Conbnuous 5] i
atnTag « | Fie owsion: [r—
Number o Files: ] Limittne Numoer ofFiles u o
€S ovtay ¥ | Fouger | (Referio) s
(2 mocors 0 FieName B ClatsenneDste [l Atacn ne Time @
Comment =
[ Emai No. Title [ string =
! a
3 Accesszothers 2 =
3 =]
i =
5 x
& E
¢ 3
8
w2t Action ] Reset ath When Recording Starts |
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Nofte

Differences in Data Recording When PC Time Is
Used and When Device Time Is Used
The table below summarizes the differences in the
recording files created when Data time is set to Device
time and when set to PC time.

files

Data Time Specified Data Time
Influence PC Time Device Time
Number of recording | One data file is created. A data file is created for

each device. Or if there
are multiple acquisition
intervals in the same
device, a data file is
created for each interval.

Alarm information

Alarm information is
recorded by taking the
logical OR of the alarm
information from the
collected data immediately
after the previous recording
data point to the current
recording data point.

The data files and alarm
information are aligned.

DST (daylight saving
time) when a recording
file is displayed on the
viewer

When a recording file is
displayed on the viewer,
the time information

is displayed correctly
according to the DST.

When the DST settings on
the PC and device are the
same, the time information
is displayed correctly. If
they are not the same,

the DST information of
the device is not reflected
correctly.

When device settings
are changed during
recording

The changes are not
reflected.

Recording stops.

Changes to devices during data collection and recording: } “Q11” on page

12-11

What is PC time, or Device time?: }“Q12” on page 12-11
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Basic Operation

3.3.7 Configuring Mail Settings

GA10 can send email when alarms occur or when the communication status changes.
Configure email settings on the Mail Setting Page.

You can specify up to 20 sets of mail settings of your choice.

The Email Setting Page consists of an area for SMTP server settings and an area for
detailed mail settings.

1 —2
13 Data Logging Software - [admin] - [project_a: [=[E] = ]
File Edit View Project Operation Usgqr Help
HeE2 i 00X B e [sar -z & (] el G Good |
% . : |SMTPServer. [ | PortNo Resend Times
Authentication Metho e
44 Tag v WYMWWWW) TE;
£ Display | | Name: [z 01 “+— 3 s
OnfOff. @® OFF @
L Record v 4 [E
q.

[ E-Mai

E Access&0thers

[x]

[N ]

x

1 Select E-Mail in the navigation area on the left of the window.
The Email Setting Page appears.

2 Specify the following SMTP server settings.

* SMTP Server: SMTP server name (up to 255 characters)

* Port No.: Port number that the SMTP server will use (0 to 65535)

* Resend Times: Select 0, 1, 2, 3, 4, or 5. If email transmission fails, GA10 retries
the specified number of times. GA10 will retry to transmit 5 min-
utes after the previous transmission failure.

» Authentication Methods: OFF (no authentication), SMTP Authentication, or POP

Before SMTP.

3 Select the mail tapped pages, and enter their names. (“Mail01” is used in this

example.)

4 set on/Off to On.

The Email Event Setting Page appears.

IM 04L65B01-01EN
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Email Event Setting Page

You can set the following items on the Email Event Setting Page. Set one set of conditions
on each tabbed page.

3 Data Logging Software — [admin] - [project_a] (=& = |
File Edit View Project Operation User Help
Bl Bk DO X E e P s R | E_Good |
SMTP Server [ ] PortNo Resend Times
e Devi V
Authentication Metho.. [OFF [] =
% Tag v Mail 01 | Mail 02 | Mail 03 | Mail 04 | Mail 05 | Mail 06 | Mail 07 [ Mail 08 § Mail 09 | Mail 10 § Mail 11 § Mail 12 § Mail 13 Ad E‘
@ § o | [ mame [Waio1 ] s
Onfoff: QOFF @oON
g Record v Condition: @ @® alarm Status O Comm. Status O Specified Period O Specified Duration O File is created N’
TRIG @ ®Easy TagRange [ Tag 0001 ) - C Tag 0001 )] -'r
[ E-Mail Levell [~ @] Levelz [— @] Leveld [ ©] Levela [— =
Opetail (_Settin
E Access&0thers
Sending Basic Setings:  Sentfrom [ |
@ Sentto [ ]
cc [ ]
Title [ |

Message Language: @ English &2
Attached Files @ [ miarm Information [ Instantaneous Value
®Range ( Tag 0001 ) - L Tag 0001 )
Olndividual (_Eefiing
Send Test Mail

CustomHeader X 1: [ |
Content

(1) Name

Enter the name of the mail event. This name becomes the tab name.
Default values: Mail01 to Mail20
Input range: Up to 30 characters

(2) On/Off

Enable or disable the mail event setting. The default value is OFF. Selecting ON displays

a setting page.

(3) Condition and (4) Trigger
Select the conditions for sending email.
Default value: Alarm Status

Send Conditions

Description

Alarm Status

Send an email when the alarm of the specified tag changes.

Comm. Status

Send an email when the communication status between the server and a data acquisition
device changes or when a data dropout occurs on the server.

Specified Period

Send an email at specified intervals (such as everyday, every week, and every month) or at
a specific time within the interval.

Specified Time

Send an email at specified intervals after data acquisition starts.

File is created

Send an email when the creation of a data file is completed.

Depending on the send condition you select, the trigger display changes as shown in the

following table.

Send Conditions  Trigger
Default Value Range
Alarm Status Easy Easy or Detail'
Comm. Status Communication Communication Disconnect, Communication Recover, Loss Data
Disconnect
Specified Period Everyday Everyday, Time
Time: 00:00:00 Every Week, Sunday to Saturday, Time
Every Month, 1st to 31st, Time
Specified Time 00:01:00 Enter the trigger time interval.

File is created

No trigger setting -

1 If you select Easy, set Tag Range and Level 1 to Level 4. If you select Detail, select the alarm
level for each tag in the Select alarm dialog box shown on the next page.
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If Send Condition Is Alarm Status and Trigger Is Set to Easy
Start tag button End tag button

Condition ® Alarm Status O Comm. Status O Spec+ed Period O Specified Duration |OF|Ie is created
TRIG: (®Easy |TagRange [ Tag0ool @ J - L Tag0001 @ ]
Levell [— & Level2 [— @_I Leveld [— @I Leveld [— [=]

Opetail sz Click to select the level.

1 Click the start tag button of Tag Range.
A Tag Index dialog box appears.

r \
TagIndex x
[ show [Device No: Device Name: Channel No |

Tag | WathTag

IC Tag 0001 )( Tag 0002 Ji

IC Tag 0003 J(C Tag 0004 ]

IC Tag 0005 J( Tag 0006 )
Tag 0007 )( Tag 0008, )
Tag 0009 )( Tag 0010 )
Tag 0011 JC Tag 0012 )
Tag 0013 JC Tag 0014 )
Tag 0015 J( Tag 0016 )

IC Tag 0017 )( Tag o018 )

IC Tag 0013 J(C Tag 0020 )

Y Tan 0021 Al Tan 0022 54 /)

2 Select the start tag.
The Tag Index dialog box closes, and the selection is reflected on the Email Event Setting Page.

3 Likewise, set the end tag.
The tag range is now set on the Email Event Setting Page.

4 Specify the changes in the alarm levels of Level 1 to Level 4.

If Send Condition Is Alarm Status and Trigger Is Set to Detail

Condition ® Alarm Status O Comm. Status O Specified Period O Specified Duration O File is created
TRIG (OEasy TagRange [ T5g 0001 J - L Tag 0001 )
Levell |— o Level2 [— o) Leveld |— &) Leveld |— &

® Detail

1 Click Setting.
A Select alarm dialog box appears.

'S ™
Select alarm X

Tag

[ Tag 0001 Levell Level2 Leveld Level4 {

[ Tag 0002 Levell Level2 Level3 Leveld
ON

[ Tag 0003 Levell opp Level2 Level3 Leveld

[ Tag 0004 Level1 \QUIOT Level2 Level3 Leveld

[OTag 0005 Levell [— & Level2 Level3 Leveld
[7ag 0006 Levell [— &) Level2 Level3 Leveld

[ Tag 0007 Levell Level2 Leveld Leveld
[ Tag 0008 Levell Level2 Leveld Leveld
[ Tag 0009 Levell Level2 Leveld Leveld
[ Tagoo10 Levell Level2 Leveld Leveld
[Tagoo1t Levell Level2 Leveld Level4

[Tagoo12 Levell [— @] Level2 Level3 Leveld
[T1agoo13 Levelt [— & Level2 Level3 Leveld
[ 1agoo14 Levelt [— @] Level2 Level3 Leveld
[Tagoo1s Levell [— &) Level2 Level3 Leveld
OTagoo16 Levell [— &) Level2 Level3 Leveld
- : r I =

:

2 Click the check boxes of the tags you want to select.
To clear a selected check box, click it again.

3 Click the arrows of alarm Level 1 to Level 4, and select the changes in the alarm
levels.
Options: ---, On, Off, On/Off. Default value: ---

4 To apply the selections, click OK. To cancel, click Cancel.
The dialog box closes, and the Email Event Setting Page returns.
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Trigger Display When Send Condition Is Set to Comm. Status

Condition: O Alarm Status ® Comm. Status O Specified Period O Specified Duration O File is created

TRIG: ® Communication Disconnect O Gommunication Recover O Loss Data

Trigger Display When Send Condition Is Set to Specified Period

Condition: O Alarm Status O Comm. Status @ Specified Period O Specified Duration O File is created
TRIG: Absolute Time 00 - 00 00

Trigger Display When Send Condition Is Set to Specified Duration

Condition: O Alarm Status O Comm. Status O Specified Period @ Specified Duration O File is created
TRIG 00 - 01: 00

When Send Condition Is Set to File is created (No trigger display)

Condition O Alarm Status O Comm. Status O Specified Period O Specified Duration @ File is created

(5) Sending Basic Settings

Enter the following sending basic settings. You can specify up to 10 email addresses
for Sent to and CC. To specify multiple email addresses, separate each address with a
semicolon.

Sent from: Sender email addresses (up to 100 characters.)

Sent to: Recipient email addresses (up to 500 characters, up to 255 for each address.)

CC: Carbon copy email addresses (up to 500 characters, up to 255 for each address.)

Title: Subject of the email (up to 250 characters.)

Custom Header: Enter up to 30 alphanumeric characters in first and second fields. (Colon
and space excluded. Characters outside the range are replaced with
hyphens.) If you enter “Mailer” in the first field and “GA10” in the second
field, the email’'s custom header will be “X-Mailer : GA10.”

First field Second field

Custom Header ¥ Mailer | - [Ga10 |

Content: Body of the email message. Enter up to 1000 characters per line and up to 500
lines (up to 1000 characters for the entire body of text).

(6) Message Language
The body of email messages consists of the message specified by the user and the
message automatically added according to the send conditions.
The following figure shows the message that is automatically added. It displays the event
information (send conditions) divided into the time of occurrence, type, and details.

Time: 2013/03/11 10:30:26 «———Time of occurrence

Type: Communication Status Type
Detail Information: The connection of 01:Device001 is Disconnected.

T— Details

You can change the language of these messages. You can select from English, Japanese,
Chinese, German, French, Korean, and Russian. The default value is the OS language.
For details on the body of messages, see the table on the next page.
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Details on the Body of Messages

Send Condition

Event Information

Message Strings

Alarm Status

Alarm Status

If a message occurs at alarm level 1:

Time: YYYY/MM/DD hh:mm:ss

Type: Alarm

Detail Information: ProjectName Tagindex TagNo TagComment
|[AlarmLevel1AlarmType] is occurred.lis released.

If a message occurs simultaneously at alarm level 1 and alarm level 2:
Time: YYYY/MM/DD hh:mm:ss

Type: Alarm

Detail Information: ProjectName Tagindex TagNo TagComment
[AlarmLevel1AlarmType] is occurred./is released.

ProjectName Taglndex TagNo TagComment [AlarmLevel2AlarmType] is
occurred./is released.

Comm. Status

Comm. Status

Communication Disconnect/Communication Recover

Time: YYYY/MM/DD hh:mm:ss

Type: Communication Status

Detail Information: The connection of Devicelndex : DeviceName in
ProjectName is disconnected/recovered.

Loss Data (PC time)

Time: YYYY/MM/DD hh:mm:ss

Type: Communication Status

Detail Information: Data Lack in ProjectName is detected.

Loss Data (Device time)

Time: YYYY/MM/DD hh:mm:ss

Type: Communication Status

Detail Information: Data Lack in Devicelndex : DeviceName in
ProjectName is detected. The duration of Data Lack is from YYYY/MM/
DD hh:mm:ms to YYYY/MM/DD hh.mm:ms.

Specified Period

Specified Period

Everyday

Time: YYYY/MM/DD hh:mm:ss

Type: Periodically Notification

Detail Information: The condition of sending mail in ProjectName is at
hh:mm:ss of every day.

Every Week

Time: YYYY/MM/DD hh:mm:ss

Type: Periodically Notification

Detail Information: The condition of sending mail in ProjectName is at
hh:mm:ss of each xxday.

Every Month

Time: YYYY/MM/DD hh:mm:ss

Type: Periodically Notification

Detail Information: The condition of sending mail in ProjectName is at
hh:mm:ss of each month.

Specified Duration

Specified Duration

Time: YYYY/MM/DD hh:mm:ss

Type: Regularly Notification

Detail Information: The condition of sending mail in ProjectName is
every hh:mm:ss.

File is created

File is created

Time: YYYY/MM/DD hh:mm:ss
Type: Data file
Detail Information: A data file(FileName) in ProjectName is created.

IM 04L65B01-01EN
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(7)  Attached Files

The alarm information and instantaneous value of tags can be attached as a file to outgoing
messages. The types and selectable range of Attached Files vary depending on the sending

condition.

Send Condition

File Attachment

File Type

Tag Specification

Alarm Status Yes Alarm information, Atag range can be specified, or tags can be
instantaneous value specified in detail (individually).

Comm. Status No Not available Not available

Specified period Yes Alarm information, Atag range can be specified, or tags can be
instantaneous value specified in detail (individually).

Specified duration ~ Yes Alarm information, Atag range can be specified, or tags can be
instantaneous value specified in detail (individually).

File is created Yes Data file Not available

When Range Is Used for Attached Files

Aftached Files:

[H Atarm Information

[ instantaneous Value

@®Range [ Tag 0001 J - ( Tag 0001
Olndividual | )
1 Click the start tag button of Tag Range.
A Tag Index dialog box appears.
rYag!mlex )(1
[ Show [Device No.: Device Name: Channel No.]
Tag [WaihTag
IC Tag 0001 J( Tag 0002 )&l
IC Tag 0003 J( Tag 0004 )
IC Tag 0005 )( Tag 0006 )
Tag 0007 )( Tag 0008 )
Tag )( Tag 0010 )
Tag 00 J( Tag 0012 )
Tag 00 J( Tag 0014 )
Tag 0015 )( Tag 0016 )
IC Tag 0017 )( Tag 0018 )
IC Tag 0019 )( Tag 0020 )
\ Tan 0021 1( Tan00% 10
2 Select the start tag.
The Tag Index dialog box closes, and the start tag is updated.
3 Likewise, set the end tag.
The tag range is now set.
When Individual Is Used for Attached Files
Aftached Files: [H] Alarm Information  [H Instantaneous Value
ORange [ Tag 0001 ) - i
@®Individual
1 Click Setting.
A Select Tags dialog box appears.
s \
Select Tags X
Tag
@ Tagooo1 O Tagooo2 O Tagooo3 O Tagooo4 [ Tagooos o
[ Tag 0006 [ Tag 0007 [ Tag 0008 [ Tag 0009 [ Tag 0010
[ Tagoo11 [ Tagoo12 [ Tagoo13 [ Tagoo14 [ Tag o015
[ Tago016 [ Tago017 [J Tagoo1g [J Tagoo1g [ Tago020
[ Tagoo21 [ Tagoo22 [ Tagoo23 [ Tagoo24 [ Tag 0025
[J Tago026 [ Tago027 [J Tago02s [J Tago029 [ Tag o030
[ Tag 0031 [ Tagoo32 [ Tag o033 [ Tagoo34 [ Tag o03s
[ Tag 0036 [ Tag 0037 [ Tagoo3s [ Tagoo3g [ Tagoo4o —
\ J

2 Click the check boxes of the tags you want to select.
To clear a selected check box, click it again.

3 To apply the selections, click OK. To cancel, click Cancel.
The dialog box closes, and the Email Event Setting Page returns.
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Nofte

On a GA10 with the Math function (/MT option), a Math
tag page is displayed in the Tag Index, Select alarm, and
Select Tags dialog boxes. The following figure shows an
example of a Math tag page in the Select alarm dialog

box.

(‘selectalam x|
[ Tag0001 Levelt Level2 Level3 Leveld. 5
[ Tago002 Levell Level2 Leveld Leveld
O Tagooos Levell Level2 Level2 Level4. a
[ Tag 0004 Levelt Level2 Level3 Leveld
[ Tag 0005 Levelt Level2 Level3 Leveld
[1Tagooos Lovelt Lovelz Levela Leveld
[ Tagooor Levell Level2 Level3 Leveld [

[ Tag 0008 Levelt Level2 Level3 Leveld
[ Tag 0009 Levelt Level2 Level3. Leveld
CITagooto Lovelt Lovelz Levela Leveld
[OTagoot11 Levell Level2 Level3 Leveld
O Tagoo12 Levelt Level2 Level3 Leveld
[JTag0013 Levell Level2 Leveld Leveld
CITagoots Lovelt Lovelz Levela Leveld
O tag0o15 Levelt Level2 Level3 Leveld [— []
[ Tagoo16 Levelt Level2 Level3 Leveld [— & |
= — — — — &
oK Cancel

Note that the method of specifying math tags is the same
as that for normal measurement tags.

(7) Send Test Mail
A test mail is sent according to the settings on the Mail
tabbed page.

Attachments are not sent during a test transmission.
Nofte

Test mail transmission to multiple clients is not possible to
prevent affecting server communication.

Behavior When Sending Email When Alarms Occur

If email send condition is set to Alarm Status, note the
following points.

» The timing for sending email is different when Data
time is set to PC time and when Data time is set to
Device time.

PC time
The specified tag range is assumed to be a single
group. If any of the alarms of the tags in the group
occurs, an email is sent.

Device time
The specified tag range is grouped by device or
interval. If any of the alarms of the tags in the group
occurs, an email is sent.

In each 1 second interval of each group, the data
timestamp of the earliest occurring alarm is used as
the alarm timestamp, and a single email message is
sent for this alarm.

The alarm information and instantaneous value

in the file attachment will only be for this earliest
occurring alarm.

Email is not sent for all other alarms that occur.

» The condition for sending email is based on the alarm
information of data collected at the data collection
interval. The condition for starting and stopping
recording is based on the alarm information of data
recorded at the record interval.

Behavior When Sending Email at Specified Intervals

If email send condition is set to Specified Period, note
the following points.

» Do not change the time during data collection and
recording. Doing so will affect the timestamps of data
attached to e-mails.

» The timing for sending email is different when Data
time is set to PC time and when Data time is set to
Device time.

PC time
The time on the PC in which the server is installed
is used. The data in the file attachment is all the tag
data within the specified range.

Device time
If Device time is specified, tags are grouped by
device or interval. Because the timestamps attached
to the data is used in each group, multiple emails
may be sent at the device level or interval level.
If there are no tags that belong to a group in the
specified range, file attachment is not created.

Nofte

¢ The maximum number of emails that the server can
hold is 40 per project. (This includes emails that fail
transmission and retransmissions.)

« Emails held in the server are deleted when the
specified retransmission count is reached or when the
server stops.

IM 04L65B01-01EN
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3.3.8 Setting Project Access Privileges

In GA10, you can set access privileges at the project level separately from the server access
privileges (administrator and user privileges).

These privileges define the operation scope of the project; they apply in the same way to the
administrator and users.

There are four types of project access privileges: Owner, Manager, Operator, and Monitor.
Only the owner can assign access privileges. The person creating the project is the initial
owner of the project. (To change owners: p» Sec. 9.4.3)

Administrator A

User B User C User D User E

(Owner) (Manager) (0perator> (Monitor)

All operations Edit Operation Monitor
Operation Monitor
Monitor
Project A

Privileges are assigned on the Access & Others Setting Page of the project.
From the users registered in the server, you can specify the users that can access the
current project and their operation scope.

Click here to display the Access&Others Setting Page.

Access user list
() Data Logging Softwhre — [admin] — [PJTOT] - o X
File Edit View Project Operation User Help
B2 aleh o0x 8 e@eg e oo e e ™
G Device v =
It Manager P Operator I Monitor =
&4 Tag v 3 Usert 2 Usera 2 Users ] Ed
Math Tag v
€ visolay v If
=
<k Record v
[ meportprint v @I
I I I =
B Eman v UserList =)
[E 7 & User2 ] Iy User3 ] Iy Users ] =
i UserT ] x Users ] & AllUsers ] |
- _ 3
Users registered in the server
Server user list

Others

[Keep Lock state: O on ® OFF 1|1
[DDE Server OON___ @OFF 1|1
[ hare Alarm ACK Qon @ OFF |
Modbus Server. O on @© OFF

,— Modbus Address:

I
Other settings (Keep Lock State, DDE Server, Share Alarm ACK)
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Access Privilege Types and Operation Scope

The table below shows the available project access
privilege types and their operation scope.

4 Drag the appropriate user to the appropriate
privilege area.

Access
Level Privilege Allowed Operation Details 2 Wanager & Openator K Montor
Type Operations .
1 Owner All operations  All operations (including deleting the Manager Operator Monitor
project) privileges privileges privileges
Set project access privileges.
2 Manager Setup Edit setup data.
Operation Start/stop data monitoring or recording.
Monitor View recorded data files.
Open data files. - — -
Delete data files. Usert ] &E Usez ] 2 wen
Monitor collected data. d‘{ Usert ] & users ] X Userr D]
3 Operator  Operation View setup data. E— s | = AlUsers ]
Monitor Start/stop data monitoring or recording. 1
View recorded data files. |
Open data files. User list
Delete data files.
Monitor collected data.
4 Monitor Monitor View recorded data files. 5 .
Open data files. Or, select the user, and click the Move button
Monitor collected data. pointing to the appropriate privilege area.
To assign access privileges, follow the procedure below. Move button
Skip steps 1 and 2 if you are already setting the details of
SN~ \A/ User List N~

Y Userz ] @ Uses ] B Users ] = User?

I3 Users ] AlUsers |

a project. ‘ o o )

The user who has owner privileges to the project

- The user moves to the specified privilege area.
logs in.

The user can now perform the granted operations in
the project.

2 In the Project List Page, double-click the appropriate Note

project to open the project.
The selected project appears on the Project Page.

You can select multiple users by clicking while holding
down the SHIFT or CTRL key on the keyboard.

3 Change the project setting window to the Access &
Others Setting Page. All Users
Alist of users registered in the server appears.

[T e ——— -

The user list displays a user named “All Users.” You

e T e gy 1y can use this to assign access privileges to all users in
i:_: e e = the server user list.
Be | — — E— : You can assign access privileges to both “All Users”
o v A and individual users. If you do, the higher privilege
:: j s takes effect for such users.
i : ‘ : Note
el v T g . .
@@ v = ] & wz ] X we ] ||g » If you assign access privileges to All Users on the

g | Setting Page and then add or delete individual users,

All Users will also be updated.
» Before deleting project access privileges of a user,

check the user status.

Oon___®or

Oon __@or

Oon___@orr

Con o
7

If you delete an owner user: p> Sec. 9.4.3

To open a project with lower access privileges: p> Sec.

Nofte 9.4.4
You can change how the users are displayed between
User Name and User Full Name by clicking User Display
Form on the View menu.
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3.3.9 Holding the Lock State

When Keep Lock State is enabled under Others on the
Access & Others Page, only the user that starts data
collection will be able to operate the relevant project.

The Keep Lock state is retained until the user that started

data collection logs in again and stops the data collection.

This feature is set to OFF by default. To use it, select ON.

Select ON tlo set the Keep Lock State feature.

3.3.10Using the DDE Server Feature

GA10 supports the DDE (Dynamic Data Exchange)
Server feature, which is used to send data to other

applications.

By using a DDE client, such as Excel, to access the DDE
server, you can retrieve the tag values that are being
collected in the project. You can begin retrieving the data
from a DDE client after the DDE server starts.

Nofte

The administrator can clear the Keep Lock state if there

is some reason in which data collection must be stopped.

To clear the Keep Lock state: > Sec. 9.4.5

e Retrievable Description
[kepioasme— ( @0) oo ] Information
[DDE Server Ton o J Date The date when the data was collected
[store A A — o | Time The time when the data was collected (excluding
Modbus Server. OoN ® OFF -
Modbus Address | E— the millisecond)
Millisecond The millisecond when the data was collected

Data number

The serial number of the data. The first data value

collected when data collection is started is number
zero.
Value The collected tag value

The application name, topic name, and item name that
are used to retrieve data are shown below.

Item Text String to Specify and Output Information

Application name DLGDDE (fixed)

Topic name Specify the name of the target project.

Item Date date Outputs the date as a text string.

name The date format is YYYY/MM/DD.
Time time Outputs the time as a text string.

The time format is hh:mm:ss.

Millisecond |msec Outputs the millisecond as a text
string.

The millisecond format is msec.
The millisecond is expressed
using a number between 000

and 999.

Data no Outputs the data number as a

number number. The data number starts
with zero.

Value tagxxxx Outputs the tag value as a

xxxx is the tag |number.

index number. |The value is displayed using the
number of decimal places for
tags that is specified on the Tag
Setting Page.

Even when multiple operation screens (clients) are
displayed on the same PC, there is only one DDE server.
The clients share the first DDE server that is started.
Clients connected to another GA10 server cannot share
the same DDE server.

When a DDE server is started, the host name or IP
address of the connected GA10 server is displayed after
Stop DDE on the File menu.
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Example in Which Excel Is Used as a DDE Client
Create a link to Excel for using DDE in advance.

1 In an Excel sheet, enter the indexes for the data you
want to retrieve.

Enter the index (item name).

A =]

Date:
Time:
msec:
No:
tag0004:
tag0015:
tag0016:
tag0017:
tag0018:

Loeipp e e ) R L = R e

L]

2 In the cells you want to display data (column B in
this example), enter the link expressions.

/  Set DDE Server to ON.

Others.

[eep Lock State: Son  ®orr ]
[DDE Server (en) oo ]
[Share Alam ACK: ON ® OFF ]
Modbus Server OON  ®OFF

Modbus Address: 1

Start the DDE server and data collection.

Click ”' to start data collection.
Start collection and recording: Psec. 3.2.4

Open the Excel file.
If a message appears asking you whether to update
the links, update them.

The collected data will be displayed in Excel cells.

A =]

1

2 Date: 2014/8/20
3 Time: 15:44:09
4 'msec: 0
5 No: 181
6 tag0004: -1.6294
7 |tag0015: 0
8 tag0016: 0

Important

A =]
1
2 | Date: =DLGDDE |test!Date
3 Time: |=DLGDDE|test!Time
4 msec: |=DLGDDE|test!msec
5 No: =DLGDDE|test!No
6 tag0004:=DLGDDE|testltag0004
7 tag0015:|=DLGDDE|test!tag0015
6 tag0016:=DLGDDE|test!tag0016
9 tag0017:|=DLGDDE|test!tag0017
10 |tag0018:|=DLGDDE |test!tagD018
11

Example: =DLGDDE|project!Date
(=application name|topic name!item name)

* The pipe symbol (]) and exclamation point (!) are
delimiters that are necessary in expressions.

* For details on the application name, topic name, and
item name, see the table on the previous page.

* In the above figure, column B is intentionally set to
display the expressions.

3 After you enter the expressions, save the Excel file,
and close it.

4 On the GA10’s File menu, click Start DDE.
The DDE server starts on the PC running the GA10
client.

5 In the Project List Page, double-click the project that
you want to use the DDE server with to open the
project.

6 Change the project setting window to the Access &
Others Setting Page.

10 To stop the DDE server, on the File menu, click

Stop DDE.

The host name or IP address of the GA10 server
connected to the DDE server is displayed after Stop
DDE.

e While DDE is running, do not change the project name
(topic name).

* To save files using Excel as a DDE client, set Files of
type to Excel 97-2003 book (*.xIs).

Nofte

If data collected by the DDE server is in error, it is

output using indications other than values.

For the different types of error data, see Sec. 6.9.2.

* The time information that is used for DDE queries is
the PC time in which the server is installed. The time
when the collected data is set to the DDE server is the
time that is output.

Therefore, if Data time is set to Device time, the time
and value of the data on the Monitor Page or data
recorded to the data file will not be synchronized to
the time and value output by the DDE server.

* The data number is output only when Data time is
set to PC time. It is not output when Data time set to
Device time.In the Project List Page, double-click

» If communication between the data collection device
and the server is disconnected and Data time is
set to PC time, OFF is output for the data value. If
set to Device time, data updating stops regardless
of whether FIFO is being used. This is the same
behavior as when the data collection from the device
is delayed.

» For information on how to use a DDE client, see the

manual for the DDE client.
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3.3.11Sharing Alarm ACK Operations

If Share Alarm ACK under Others of the Access&Others
Setting Page is set to ON, the ACK operation can be
shared among multiple clients connected to the same
server. If an alarm occurs in a project, you do not have to
perform ACK operation on each client.

1 Log in with a user who has privileges for editing the
settings of the project.

2 Open the project in which you want to share the
alarm ACK operation.

3 Click Access&Others.

() Data Logging Software—[admin] - [Project_A]
File Edit View Project Operation User Help
H:o? abbb hOx 8 & e @
001 GX10 002 GM10
Device Davice
BT B
e oorse | 10013734
008 006
D vispiay
< Record
[] Reporuprint [N R
[ E-man
0 @momm ) || g T

4 Click ON next to Share Alarm ACK.

Others

[Keep Lock state Son __ ®orF ]
[ODE Sever Oon  @or |
['share Alarm Ack: (®@0) O OFF ]

Modbus Server Oon ® oFF
Modbus Address: 1

The alarm ACK operation is shared among clients
that are connected to the same server.

Alarm ACK operations:’ Sec. 6.6.3

3.3.128Starting the Modbus Server and Setting
the Modbus Address

If Modbus Server under Others of the Access&Others

Setting Page is set to ON, responses are returned when

requests are received from a Modbus client.

1 Log in with a user who has privileges for editing the
settings of the project.

2 Open the project you want to access from the
Modbus client.

3 Click Access&Others.

[} Data Logging Software — [admin] - [Project_A]

File Edit View Project Operation User Help

Hio? bk OO0 B @ e P
2 Device j%

b 001 GX10 002 GM10

ce
$4 Tag e imz
& Matn Tag 10.0.137.36 10013734
005 006

5 oispiay

L/ Record

[B] Reporter oos o0

[ Emai

[( @mmEm ) || o13 014

4 Click ON next to Modbus Server.

Others.

[Keep Lock State: O oN ® OFF ]
[ODE Sewver Oon__ ®orF |
]

['share Alarm ACK: O oN ® OFF

Modbus Server ® oN} O oFF
Modbus Address: 1

5 Set the address in Modbus Address.
Assign an address (setting range: 1 to 247) to each
GA10 project.

For Modbus Server function:» “Chapter 11 Modbus
Server Function”
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3.4 Registering Modbus Devices

3.4.1 Registration of Modbus Devices

GA10 can connect to devices that use the Modbus
protocol.

To register such a device, you must create a Modbus
device definition file in advance and save it in a specific
server folder (step 3 below).

» If you are using GA10 R1.02 or later, UTAdvanced
series devices can be connected without creating
definition files. Select from the devices list.

*  When connecting an UTAdvanced device (UT32A,
UT35A, UT52A, UT55A, UT75A, UP35A, UP55A) to
a GA10 with the custom display function (/CG option),
select a model name with “_R3” from the list. (This
corresponds to the SP or other output channel.)

Basic Operation

1 Create a Modbus device definition file using the
Modbus Device Definition File Creating Tool.

You can download the Modbus Device Definition File
Creating Tool from the following URL.
www.smartdacplus.com/software/en/

Or, create the file in XML format by referring to the
provided example. We suggest that you use the
Windows standard Notepad or a text editor to edit
the file.

2 Save the file using UTF-8 encoding.

Place the Modbus device definition file in the C:\
Program Files\Yokogawa Electric Corporation\
SMARTDAC+ Data Logging Software\Modbus folder
of the PC in which the server is installed.

4 Start the GA10 client, and log in to the server.

The name of the registered Modbus device appears
next to Device Type in the Register Device Dialog
Box.*

* A dialog box for registering new devices.

5 Select the registered Modbus device from the

Device Type.
The input items for communication appear.
Register device x
Dewce Name
Detce Type: . )
Comm. Kind I

6 Input the information, then click OK.

Nofte

When using a Modbus definition file to perform
communication through the Ethernet interface, set the
scan interval to a value less than the communication
timeout value of the device.

3.4.2 What Is a Modbus Device Definition File?

The Modbus device definition file is a file that is referred
to when a new Modbus device is registered on the Device
Setting Page.
A Modbus device definition file is composed of the
following four sections.
Option list
This is where the Modbus device options are
defined.

Register list
This is where the Modbus device’s registers that
are read during data collection are defined. Modbus
Function codes, register addresses, data types, and
register names are specified in this section.

Channel list
This is where the Modbus device’s channels that are
read during data collection are defined. You can also
specify channel settings, collection data positions,
and related alarm information.

Value conversion table
This is where the table for converting the data read
from the Modbus device’s registers into values for
actual use is defined.

Modbus device definition files are in XML format.
Descriptions in files have a hierarchical structure.
For details on the format, see "Node Structure" and
subsequent pages.

Modbus device definition file example: > page App-10

IM 04L65B01-01EN
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Node Structure of Modbus Device Definition Files

Level 0 Level 1 Level 2 Level 3 Level 4 Level 5 Description Quantity
ModbusDevice Definition file root element 1
Options Option list node Oor1
Option Option information Oto5
Registers Register list node 1
Register Register information 1 to 3000
Channels Channel list node 1
Channel Channel information 1 to 500
Init Channel default setting Oor1
DecimalPos Default decimal place Oor1
Min Default minimum span Oor1
Max Default maximum span Oor1
Unit Default unit Oor1
Value Channel value 1
Write Write register Oor1
DataError Error data status Oor1
ADError A/D converter status Oor1
PlusOver +OVER status Oor1
MinusOver -OVER status Oor1
Burnout Burnout information Oor1
Type Burnout type Oor1
Value Burnout status Oor1
Alarms Alarm list node Oor1
Alarm Alarm information Oto4
Type Alarm type Oor1
Value Alarm value Oor1
Set Value Alarm set value Oor1
TransTables Value conversion table node Oor1
Table Value conversion table 0to 100
Value Conversion value 0to 100
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Node Attributes of Modbus Device Definition Files

If an attribute is not specified, the default value will be applied. However, if the Option, Mask, or Trans attribute is not
specified, GA10 assumes that the corresponding function is not used and does not apply the default value.

Node Name Attribute Type |Mandatory Range Default Value Description
ModbusDevice |Type string (A) Alphanumeric characters, 1 to 15 Modbus device type
characters Note: Match this with the file name of
Modbus device definition file.
PortNo int 1 to 65535 502 Ethernet port number of the Modbus
device
CommandDelay |int 0 to 10000 0 Command delay of the Modbus device.
Unit: msec
Option Name string (B) Alphanumeric characters, 1 to 15 Names of options supported by the
characters Modbus device
Register Name string (A) Alphanumeric characters, 1 to 15 Register names in the Modbus device
characters
FunctionCode int (A) Read: 1, 2, 3, or 4 Modbus communication function code
Write: 5, 6 or 16
Address int 2 (A) 1-465535 Modbus register
DataType enum (A) INT16 UNIT16 INT32_B Read data type
INT32_L UINT32_B UINT32_L
FLOAT B FLOAT L BIT
Channel Name string (A) 1 to 16 Unicode characters Channel name
DecimalPos int Oto5 0 Channel decimal place
Min double -1E16 to 1E16 0 Minimum channel span
Max double -1E16 to 1E16 100 Maximum channel span
ScaleRatio double -1E16 to 1E16 1 Channel scaling coefficient
ScaleOffset 4 double -1E16 to 1E16 0 Channel scaling offset
Unit string Up to 6 Unicode characters Channel unit
Option string Alphanumeric characters, up to 15 Option name
characters
Channel\Value [Register string (A) Alphanumeric characters, 1to 15 Register name
DecimalPos characters
Min Mask 1 int2 Hexadecimal number, 0 to 65535 Data bit mask
Max Trans string Alphanumeric characters, up to 15 Value conversion table name
Unit characters
DataError 5
ADError 5
PlusOver 5
MinusOver 5
Burnout\Type 5.6
Burnout\Value
Alarm\Type
Alarm\Value
Write Register string (A) Alphanumeric characters, 1 to 15 Register name
characters
Alarm\Type Kind enum “OFF”,“H”,“L”,“dH”,“dL",“RH",“RL","tH”, | “OFF” Default alarm type
“L”“PVH”,“PVL","DVH”,“"DVL","DVO”,*
DVI","SPH”,“SPL”,“OTH",“"OTL",“"ETC”
Alarm\SetValue |Register string Alphanumeric characters, 1 to 15 Register name
characters
Alarm\SetValue |Value double -1E16 to 1E16 0 Initial value of the alarm set value
Table Name string ©) Alphanumeric characters, 1 to 15 Value conversion table name
characters
ToDataType enum Int, String Int Target conversion data type
Value From int2 (C) -2147483648 to 2147483647 Conversion source value
To string (©) Up to 15 Unicode characters Conversion target value

To convert to a value, specify the value

using a character string.

(A): Mandatory item. However, for attribute name Register, node name Type is not mandatory.
(B): Mandatory item to use the option
(C): Mandatory item to convert data

1 If only a mask is available, bit mask is applied to the data value read from the register, and the result is handled as TRUE or FALSE.

a s~ 0N

Decimal and Hexadecimal integers are supported. For hexadecimals, the number must be preceded by a “Ox.”
For a description of Data Type, see the table below.
These are retrieved from registers or the definition file. The user can specify either one or both. In the latter case, register information takes precedence.
Scaling calculation: Y = ScaleRatio * X + ScaleOffset

X: Modbus register value (after decimal point calculation; after conversion is a value conversion table is available)
Y: Computed result
Channel data status is processed in the following order of precedence: ADError, DataError, Burnout, PlusOver, MinusOver.
7  If the burnout type is set to DownScale (type value is 2) and the burnout status is 1, the data status will be -BURNOUT. If the burnout type is set to UpScale (type value
is not 2) and the burnout status is 1, the data status will be +BURNOUT.
8 Node channels include optional attributes. When registering a device in the Register Device dialog box, if you do not select this option, this channel will not be available
in the registered device.
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Description of Data Type

Value How to Use
INT16 Use when a signed 16-bit integer is assigned to the device register.
UINT16 Use when an unsigned 16-bit integer is assigned to the device register.
INT32 B Use when a signed 32-bit integer is assigned to the device register and the smallest register number is assigned to the highest bit.
INT32 L Use when a signed 32-bit integer is assigned to the device register and the smallest register number is assigned to the lowest bit.
UNIT32 B Use when an unsigned 32-bit integer is assigned to the device register and the smallest register number is assigned to the highest bit.
UINT32 L Use when an unsigned 32-bit integer is assigned to the device register and the smallest register number is assigned to the lowest bit.
FLOAT B Use when a 32-bit floating-point number is assigned to the device register and the smallest register number is assigned to the highest bit.
FLOAT L Use when a 32-bit floating-point number is assigned to the device register and the smallest register number is assigned to the lowest bit.
BIT Use when a bit value (e.g., DI, DO) is assigned to the Modbus device register.

Data Type Defined in a MODBUS Device Definition File

GA10 (R2.02.xx and later) retains the data types of registers defined in the Modbus device definition file and uses them
for displaying and recording. The data types of each register correspond to the following channel data types.

Register Data Type Channel Data Type
INT16 SHORT
UINT16 USHORT
INT32 B LONG
INT32_L LONG
UNIT32 B ULONG
UINT32 L ULONG
FLOAT B FLOAT
FLOAT L FLOAT
BIT BOOL
Note

A read error will occur in the following situations.

* A mandatory item is missing.

* There is a syntax error. However, in the following situations, an error will not occur and the value
will be corrected when it is read.
« There is a limit to the string length for a node attribute, and this limit is exceeded.
« There is an allowable range for a node attribute, and the value is outside the range.
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3.5 Displaying Project Settings

Project settings can be displayed in tables on a browser. You can select whether to show or

hide the settings for each item.

w‘ £]] C:¥Users¥00113654¥AppData¥Roaming¥DAQClient¥{85B966D1-FOF1-4844-831E O ~ & H /& SMARTDAC+ GA10 Proj... ‘ ‘

PCtime |2016/10/31 17:26:20

Version [R3.01.01

Option /Math /Report /Gustom Display /2000
User List | admin

Project information

Setting Printout Config

¥ Display
Device / Display only registered devices
+/ Display only regisitered device's channels

- ¥ Display
/ Displaytags thatare assignedto device channels
¥ Display
Math Tag ¥/ Display math tags that are being monitared

+/ Display registered math constants

 Displa
Display Group gy

/ Displaythe waveforms that are selected under display group

~ Display
Record  Display
¥ Display
ReportPrint I No display ifthere are no reportiprinttask
/ Display report channels selected under Report Output Task
i Display
E-thail I No display if email setting s “off
 Displaythe selected tags that are listed under "TRIG*
AccessaOthers i Display
Tag Display Form. | Tag Index
Device
Communication
Device No. | Device Name | Device Type | Version No }m{
[ | Device [ Mx100 [R103 | Ethernet |
Device,
s
Devce NO. | oSt NamefP Address | Port No. | System No. | COM Porto. | Comm. Type | Baud Rate |
I [ 100136 159 [ T A NA [N

#®100% ~

3.5.1 Selecting the Settings to Be Shown
Follow the procedure below to select the project settings you want to show on the browser.

1 In the Project List Page, double-click the appropriate project to open the project.

2 On the Project menu, click Setting Printout Config.
The Setting Printout Config dialog box opens.

Sefting Printout Config
Printout Display information

Tag Display Form.

'Dwsb'\ay )

[H Device
[H] Display only registered devices
[H] Display only regisitered device's channels
W Tag
(9 Display tags that are assigned to device channels
8] Math Tag
[H Display math tags that are being monitored
[H Display registered math constants
[ Display Group
[ Display the waveforms that are selected under display group
8] Acquisition&Menitor
[H Record
8] ReportPrint
[H No display ifthere are no reportiprint task
[H Display report channels selected under Report Dutput Task
5] E-mail
[ Mo display if email setting i "ofF
[H] Display the selected tags that are listed under TRIG™
[ Access&Others
Tag Index &

oK (__Cancel

.
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3 Select the items you want to show.
By default, all items are selected. Click the items you want to hide to clear the check
boxes.
Check boxes when selected

[H] pevige

[H] Display only registered devices

N

For Tag Display Form, click ¥ to select Tag No., Tag Comment, or Tag Index.

5 ciick ok.

The selected items in the dialog box are saved.
Click Display to show the project settings on the browser according to the se-
lected items.

Click Cancel to cancel the items selected in step 3.

Nofte

The saved settings are applied to all projects at the client level. These settings are retained even
after you log out.

The following table shows the items and descriptions in Setting Printout Config. The
details of each item are displayed when the corresponding check box is selected.

Items Contents to be specified

Device Shows or hides device information.

Display only registered devices Shows or hides unregistered
devices.

Display only registered device's channels Shows or hides detailed channel
information of registered devices.

Tag Shows or hides tag information.
Display tags that are assigned to device channels Shows or hides tags that are not
assigned to channels.

Math Tag Shows or hides math tag
information.

Display math tags that are being monitored Shows or hides tags that are not
being monitored.

Display registered math constants Shows or hides unregistered math
constants.

Display Group Shows or hides display groups.
§Display the waveforms that are selected under display group Shows or hides waveforms that are
H not assigned to tags.

Acquisition& Monitor Shows or hides acquisition and
monitor information.
Record Shows or hides recording setting
information.
Report/Print Shows or hides report and print.
No display if there are no report/print task Shows or hides report settings

when Task is set to None,
iDisplay report channels selected under Report Output Task  Shows or hides report channels
that are not assigned to tags.

E-Mail Shows or hides email setting
information.

No display if email setting is "off" Shows or hides email setting
information when email is set to
Off.

Display the selected tags that are listed under TRIG Shows or hides tags that are not
specified as email triggers.

OPC-UA (/UA option) Shows or hides OPC-UA server
setting information.

Access&Others Shows or hides Access&Others
setting information.
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3.5.2 Showing Settings

Follow the procedure below to show project settings on the browser. You can also show the
settings by clicking Display in the Setting Printout Config dialog box.

1 In the Project List Page, double-click the appropriate project to open the project.
The selected project appears on the Project Page.

2 On the Project menu, click Config Display.
The Web browser starts, and the settings are displayed in tables.

To change or omit the displayed items, follow the procedure in section 3.5.1.

Structure of the Setting Display Screen
The following figure illustrates the structure of the setting display screen. Each information is

displayed in a table.

1) T Basic information
(2) + Project information
3) 1 Setting printout config

(4) —— Setting information

Device

Tag

Math Tag *

Display Group

Record

Report/Print*

E-mail

OPC-UA *

|
|
|
|
| Acquisition & Monitor
|
|
|
|
|

Access&Others

(1)Basic information

*: Options

Client time, server options, user list, etc.

Project name, owner name, etc.

Detailed display settings

\

Project configuration details

Items displayed as basic information are GA10 server and client information. They are
displayed at the top of the display screen.

Items Explanation/Display contents

PC time Time of output of the PC in which the GA10 client showing the information is installed.
Version GA10 server version

Option Options added to the GA10 server

User List List of users registered in the GA10 server
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(2)Project information

The items shown as basic project information are as follows.

Items Explanation/Display contents

Project's name Name of the project showing the information
Owner Project owner name

Comment Comment added to the basic project information

(3)Setting Printout Config

The display settings saved using Setting Printout Config. on the Project menu (section
3.5.1) are shown in table format.

(4)Setting information

The project setting details are displayed for each setting item.

¢ Device

Up to 20 devices are displayed in a table. If there are more than 20 devices, the tables
are divided. If the entire width of the table cannot be displayed depending on the print
paper size (A4 portrait), the table is divided into several tables.

Table Items Explanation/Display contents
Device Device No. Device number
Device Name Device name (e.g.,: Device01)
Device Type Device type (e.g.,: GX10)
Version No. Firmware version for the connected device.
Communication Comm. Kind Ethernet, Serial, or USB
Host Name/IP Address “N/A” is displayed when Comm. Kind is set to
Serial.
Port No. “N/A” is displayed when Device Type is not
DAQWORX.
System No. Same as above
COM Port No. COM1 to COM20.
“N/A” is displayed when Comm. Kind is set to
Ethernet.
Comm. Type RS-232C or RS-422/RS-485
“N/A” is displayed when Comm. Kind is not set to
Serial.
Baud Rate “N/A” is displayed when Comm. Kind is not set to
Parity Serial.
Stop Bit
Address “N/A” is displayed when Comm. Kind is not set to
RS-422/RS-485.
User Name User name and user ID when the security function
User ID of the connected device is set to communication
login.
Modbus Modbus Address “N/A” is displayed when Device Type is not a
Modbus device.
Monitor Interval
Timeout
Option
Channel Meas Ch. Displays the number of channels of each.
Math Ch.
Ctrl Ch.
Extra Ch.
Device's Channel Channel number
channels Use ON or OFF
(Device Tag No. Specified tag number
No.:x, Device Tag Comment Entered tag comment
Name:xxx) Type Tag (channel) data type
Dec. Point Number of decimal places
MIN Minimum scale
MAX Maximum scale
Unit -
Alarm 1to 4 Type Alarm type
Value Input value
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Tag

Up to 20 tags are displayed in a table. If there are more than 20 tags, the tables are

divided. If the entire width of the table cannot be displayed depending on the print paper

size (A4 portrait), the table is divided into several tables.

Items Explanation/Display contents
Tag Index Tag0001 to Tag2000
Monitor ON or OFF
Record ON of OFF
Not displayed when the project is an OPC-UA project (/UA option)

Device Device number : Device name
Channel Channel number
Tag No. Specified tag number
Tag Comment Input tag comment
Type Tag data type
Dec. Point Number of decimal places
Alarm 1to 4 Type Alarm type

Value Alarm threshold

Sound Assigned alarm sound fil

Math Tag (/MT option)

Math tag settings are displayed in math tag and math constant tables. Up to 20 tags or
constants are displayed in a table. If there are more than 20, the tables are divided. If
the entire width of the table cannot be displayed depending on the print paper size (A4
portrait), the table is divided into several tables.

Items Explanation/Display contents
Math Tag Tag Index A0001 to A2000
Acquisition & Computing ON or OFF
Record ON or OFF
Expression Expression
Span Dec. Point Number of decimal places
MIN Input value
MAX Input value
Unit Input value
Tag No. Tag number
Tag Comment Tag comment string
Alarm 1 to 4 Type Alarm type
Value Input value
Hysteresis Input value
Sound Assigned alarm sound fil
Constant Label Input value
Value Input value
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Chapter 3 Configuring and Starting Data Collection and Recording

Display Group

Each display group is displayed in a table. If there are more than 20 waveforms, the
tables are divided. If the entire width of the table cannot be displayed depending on the
print paper size (A4 portrait), the table is divided into several tables.

Items Explanation/Display contents
No. W01 to W50
ON/OFF ON or OFF
Tag Index/Tag No./Tag comment Displays the item name selected in the display settings
Y-Axis No. Y01 to Y50
Mode Detail or compact mode
Type Linear or logarithmic
Title mode Default, or customize (customize when you enter a
title)
Title Waveform’s Y-axis title
Form. F,or E
Meter Bar, or analog
Scale MIN Input value
MAX Input value
Scale interval Use ON or OFF
Value Input value
Zone MIN Input value
MAX Input value
Color RGB value
Use ON or OFF
Trip1 to Trip4 Value Input value
Color RGB value

Acquisition & Monitor

Acquisition and monitor information is shown in Acquisition, Pre-set mark, Monitor, and
Split Screen Data Set tables. The following items are displayed.

Items

Explanation/Display contents

Acquisition Data time

Device time or PC time

Monitor Interval

If Device time is selected, “~” is displayed.
If PC time is selected, Monitor interval selected from
options is displayed.

Pre-set mark No.

Pre-set mark

1to5

Displays the set mark

Monitor Monitor Data Set Number

1to0 16

Split Screen Direction

Horizontal or vertical

Set Number in Spliting Direction

1 to the Monitor Set Number

Resize the Monitor Set ON or OFF
Alarm Shape Round or rectangle
Alarm Color ON RGB value
OFF RGB value
Split Screen No. 1to 16

Data Set

Split Screen Data Set

Trend, Digital, Meter, Alarm
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¢ Record

Recording setting information is displayed in Record and Comment tables. The following

items are displayed.

Items

Explanation/Display contents

Record Record Interval

If Device time is selected, N/A is
displayed.

If PC time is selected, Record interval
selected from options is displayed.

Record File Type

Binary/Excel/Binary & Excel

Start Condition Displays specified conditions.
Stop Condition
File Division
Number of Files Limit the Number of Files ON or OFF
Number Number of files, or N/A
Folder Path to the save directory
File Name File name
File Name Attach the Date ON or OFF
Attach the Time ON or OFF
Computing Reset When Recording Starts ON or OFF

Displayed only on models with the
math function (/MT option)

Comment No. 1t08
Title Title string
String Comment string

Note

In report/print setting information and email setting information, the time of Condition and Range is

displayed using the following symbols.
* YYYY: year * MM: month * DD: day

* hh: hour * mm: minute » ss: second

* ms: millisecond

» w Weekday every week: Monday to Sunday + d Day every month: 1 to 31
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Chapter 3 Configuring and Starting Data Collection and Recording

Report/Print (/RP option)

For Report/Print setting information, report/print schedule list of the entire project is
displayed in a table first. Then, for each report in the list, the schedule, graph, and
template file tables are displayed. The items in the graph information display varies

depending on Print Type.

Report/Print-Schedule list

Items Explanation/Display contents

Schedule No. Report01 to Report20

Name Report name

Task None/Standard Print/Custom Print/Report Output

Report/Print-Schedule (Task: Standard Print)

Items Explanation/Display contents

Name Report name

Task Standard Print

Condition Displays specified conditions. (e.g., Every Hour mm:ss)

Range Start Time Displays specified start time. (e.g., Prev. Hour mm:ss)
End Time Displays specified end time. (e.g., Current Hour mm:ss)

Print Type Trend Graph/Circular/Sheet/Alarm List/Mark List

Group Start group to end group (e.g., 07~10)

Print Header Header items File name, type, serial number, time change, number of measurement
Comment channels, print comment, number of math channels, sample interval,

comment (one from 1 to 8 for the comment)

Printout Setup  Print Graph Format

Single page or multiple pages

Font size

6pt to 20pt

Line Thick

0.25pt/0.5pt/1.0pt/1.5pt/3.0pt

Tag Display Form.

Tag No./Tag Comment/Tag Index

Pring Graph Grid

Standard Grid, Dense Grid 1 to 4
1min, 2min, 5min, 10min, 20min, 30min, 1h, 2h, 3h, 4h, 6h, 8h, 12h,
1day, 7days, 1month when the waveform print format is multiple pages.

Sub Grid Same as above. (depends on the Print Graph Grid setting)
Y-axis grid Standard Grid, Dense Grid1, Dense Grid2, Dense Grid3, Dense Grid4
Y-axis zone Full Zone, Slide Zone, Auto Zone, Free Zone
Active Y-axis 11050
Y Axis Column Num 1 to 50
Legend Yes/No
Legend position Top, Bottom, Left, Right
Color Mode Black and white/color
Mark Color RGB value
Print Setup Printer Printer name
Paper Size Print paper size
Orientation Portrait or landscape

Output Language

Japanese/English/Chinese/German/French/Korean/Russian

Report/Print-Schedule (Task: Custom Print)

Items Explanation/Display contents

Name Report name

Task Custom Print

Condition Displays specified conditions. (e.g., Every Hour mm:ss)
Template File Template file name

Printer Specified printer name

Output Language

Japanese/English/Chinese/German/French/Korean/Russian

Report/Print-Schedule (Task: Report Output)

Items Explanation/Display contents
Name Report name
Task Report Output
Type Hourly + Daily, Daily + Weekly, Daily + Monthly, Batch, Daily custom
Condition Displays specified conditions.
Filename Naming Rule Rule Auto/Specify
File Name Specified file name, or N/A
Output Folder Folder type Data Folder, Subfolder in the data folder, Specified folder
Folder Path to the save directory
Template File Template file name
Print Setup Print Out Yes/No
Printer Specified printer name

Output Language

Japanese/English/Chinese/German/French/Korean/Russian
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Report/Print-[Report name] 's graph (Print Type: Trend Graph)

Items Explanation/Display contents
Print Type Trend Graph
Range Start Time Displays specified start time. (e.g., Prev. Hour mm:ss)
End Time Displays specified end time. (e.g., Current Hour mm:ss)
Group Group name
Printout Setup  Line Thick 0.25pt/0.5pt/1.0pt/1.5pt/3.0pt
Font size 6pt to 20pt

Tag Display Form

Tag No./Tag Comment/Tag Index

Print Graph Grid

Standard Grid, Dense Grid 1 to 4

Y-axis grid Standard Grid, Dense Grid1, Dense Grid2, Dense Grid3, Dense
Grid4

Y-axis zone Full Zone, Slide Zone, Auto Zone, Free Zone

Active Y-axis 1 to 50

Y Axis Column Num 1 to 50

Legend Yes/No

Legend position Top, Bottom, Left, Right

Color Mode Black and white/color

Mark Color RGB value

Print Quality Standard/High

Report/Print-[Report name]'s graph (Print Type: Alarm List)

Items Explanation/Display contents
Print Type Alarm List
Range Start Time Displays specified start time. (e.g., Prev. Month 1Day hh:mm:ss)
End Time Displays specified end time. (e.g., Current Month 1Day hh:mm:ss)
Printout Setup Tag Display Form Tag No./Tag Comment/Tag Index
Color Mode Black and white/color
Print Quality Standard/High

Report/Print-[Report name]'s graph (Print Type: Mark List)

Items Explanation/Display contents

Print Type Mark List

Range Start Time Displays specified start time. (e.g., Prev. Cycle hh:mm:ss)
End Time Displays specified end time. (e.g., Current Cycle hh:mm:ss)

Printout Setup Color Mode Black and white/color
Print Quality Standard/High

Report/Print-Template File

Items Explanation/Display contents

No. 01 to 20

File Name Displays registered template file name.(Displayed as "Unregistered" if

there are no registrations.
Type ---/Print/PDF/Excel (Displayed as “---" if there are no registrations)
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* E-mail
For email setting information, mail server, mail setting list, mail setting*(up to 20), and mail

trigger settings are displayed. The following items are displayed.
*: The displayed items of mail setting information varies depending on Condition.

E-Mail-Mail server

Items Explanation/Display contents

SMTP Server Server name specified by the user.

Port No. Port number specified by the user.

Resend Times Oto5

Authentication Methods OFF/SMTP Authentication/POP Before SMTP

POP Server Displays the server name when the authentication method is set to POP Before
SMTP.

Port No. Displays the port number when the authentication method is set to POP Before
SMTP

User Name User name

E-Mail-Mail setting list

Items Explanation/Display contents
Schedule No. Schedule number of the specified mail
Mail01 to Mail20
Name Mail name
On/Off OFF/ON
Condition Alarm Status/Comm. Status/Specified Period/Specified Duration/File is created

E-Mail-Mail setting (Condition: Alarm Status)
If Condition is set to Alarm Status, the mail and its trigger settings are displayed.

Items Explanation/Display contents

Name Mail name (e.g., Mail 01)

On/Off OFF/ON

Condition Alarm Status

TRIG Easy/Detail

Sending Basic Sent from Sender email addresses

Settings Sent to Recipient email addresses
CcC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian

Attached Files Alarm Information ON/OFF
Instantaneous Value ON/OFF
Tag select type Range/Detail
Specified tag Range: Start tag to end tag (e.g., Tag001 to Tag0100)
Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

E-Mail-[Mail name]'s trigger

Items Explanation/Display contents
Range If Tag select type is Easy, start tag to end tag are displayed (e.g., Tag001 to Tag0100).
Tag Index If Tag select type is Detail, a list of selected tags is displayed.
(e.g., Tag001, Tag002, Tag005...)
Use If Tag select type is Detail, ON/OFF is displayed for each tag.
Level 1to 4 ---, ON, OFF, On/Off

E-Mail-Mail setting (Condition: Comm. Status)

Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition Comm. Status
TRIG Communication Disconnect/Communication Recover/Loss Data
Sending Basic Settings Sent from Sender email addresses
Sent to Recipient email addresses
CcC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content
Message Language Japanese/English/Chinese/German/French/Korean/Russian

3-66

IM 04L65B01-01EN



Chapter 3 Configuring and Starting Data Collection and Recording

E-Mail-Mail setting (Condition: Specified Period)

Items Explanation/Display contents
Name Mail name

On/Off OFF/ON

Condition Specified Period

TRIG Every day hh:mm:ss

Every week w day hh:mm:ss
Every month d hh:mm:ss

Sending Basic Settings

Message Language

Attached Files

Sent from Sender email addresses

Sent to Recipient email addresses

CcC Carbon copy (CC) email addresses

Title Message title

Custom Header Header information entered by the user

Content Message content
Japanese/English/Chinese/German/French/Korean/Russian

Alarm Information ON/OFF

Instantaneous Value ON/OFF

_Tag select type Range/Detail

Specified tag Range: Start tag to end tag (e.g., Tag001 to Tag0100)

Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

E-Mail-Mail setting (Condition: Specified Duration)

Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition Specified Duration
TRIG hh:mm:ss
Sending Basic Settings Sent from Sender email addresses
Sent to Recipient email addresses
CcC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language

Japanese/English/Chinese/German/French/Korean/Russian

Attached Files

Alarm Information

ON/OFF

Instantaneous Value

ON/OFF

Tag select type

Range/Detail

Specified tag

Range: Start tag to end tag (e.g., Tag001 to Tag0100)

Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

E-Mail-Mail setting (Condition: File is created)

Items Explanation/Display contents
Name Mail name

On/Off OFF/ON

Condition File is created

Sending Basic Settings

Sent from Sender email addresses

Sent to Recipient email addresses

CcC Carbon copy (CC) email addresses
Title Message title

Custom Header Header information entered by the user
Content Message content

Message Language

Japanese/English/Chinese/German/French/Korean/Russian

Attached Files

None/Data file
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* OPC-UA (/UA option)

For OPC-UA server information, monitor, server setting, and server certificate are displayed.

The following items are displayed.

Server Operation-Acquisition

Items

Explanation/Display contents

Data time

PC time/Device time

Monitor Interval

If Device time is selected, “~” is displayed.
If PC time is selected, Monitor interval selected from options is displayed.

Server Operation-Server Setting

Items

Explanation/Display contents

Server Name

Server name specified by the user

Port No.

Port number specified by the user

Anonymous Login

Server Operation-Server Certificate

Items Explanation/Display contents
Version Version

Serial No. Serial number

Signature Algorithm Signature Algorithm

Signature Hash Algorithm Signature Hash Algorithm
Issuer Issuer

Valid from YYYY/MM/DD hh:mm:ss

Valid to YYYY/MM/DD hh:mm:ss

¢ Access & Others

For Access&Others setting information, access and other settings are displayed.

Access&Others-Access

Items Explanation/Display contents
Manager User name

Operator e.g., User01/User02/User03/...
Monitor

Access&Others-Others

Items Explanation/Display contents
Keep Lock State ON/OFF
DDE Server ON/OFF
Share Alarm ACK ON/OFF
Modbus Server ON/OFF
Modbus Address 1to 247
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3.5.3 Printing and Saving Displayed Information
You can print or save the setting display screen using the Web browser functions. The
following are examples using Internet Explorer 11 (IE).

Printing the Display Screen

1 On the IE’s File menu, click Print.
A Print dialog box appears.

2 Click Print.
The setting display screen on the browser are printed on the specified printer.
» To a print preview, on the IE’s File menu, click Print Preview.

Saving the Display Screen

1 On the IE’s File menu, click Save As.
A Save Webpage dialog box appears.

Move to the folder in which to save the page.

Enter a new name in File name.

AN WON

Click Save.
The setting display screen (HTML page) is saved in the specified location.

Note
* You can use Copy on the IE’s Edit menu to copy the displayed information to Excel or other
applications.
« For details on the IE functions and how to use them, see the Microsoft user’s guide, support
sites, and the like.
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Chapter 4 Using the Math Function (/MT option)

4.1 Setting Math Tags

The GA10’s Math function (/MT option) can be used to set expressions with constants,
operators, and functions to display and record (save) the calculated results. To use the Math
function, you need to set the math tags on the Math Tag Setting Page. You can set up to
2000 math tags. If the number of measurement tags increases due to a GA10 upgrade, the
number of math tags also increases accordingly. The following table shows the relationship
between the number of measurement tags and the number of math tags.

Measurement tags Math tags
100 200

200 200

500 500

1000 1000
2000 2000

Nofte

Before using the Math function, set the data time acquisition condition (on the Acquisition&Monitor
Page) to PC time.

Basic Operation

1 Select Math Tag in the navigation area on the left of the window.
Math Tag appears when the license for the Math function (/MT option) is already registered.

The Math Tag Setting Page appears.
2 3

@ Data Logging Software —[admin]—[PROJECT_02] A x
File Edit View Project Opergfion User Help
Hes o mhbh D)x 8 &= sE P ] '\@@LLJL'_AC'&J\.MJ ¥ ||
| E—
[ Math T / |lconstant
6 e ... Recordl Expression ‘ By S'm“ e @ Label ‘ Value Sl ';
[T TAG(0001) 2 ®  -100.00 1g0.0 0
g Tag i AD0D2| [0 TAG(DOOT) 2 ®  -100.00 1o 0 §
Ao003 | [ TAG(ooO1) 2 ®  -10000 100.0 0 a
1—= Math Tag v A0004| [0 TAG(oO01) 2 ®  -10000 100.0 ol
A0005| [ TAG(o001) 2 ®  -10000 100.0 0
3 o " A0008 | [ TAG(oO0OT) 2 ®  -10000 100.0 o | M
Display A0007 | [ TAG(O001) 2 ®  -10000 100.0 o | =
) Ao0og | [ Tacoo1) 2 ®  -10000 100.0 o |
<X Record « #0008 | [ TAG(0001) 2 ] -100.00 100.0 0 I@
[ Aoo10 % TAG(0001) 2 ®  -10000 100.0 0
. ADD11 TAG(0001) 2 ®  -100.00 100.0 0
[&2] revortprin 4 a0012] O TAGO001) 2 @ -10000 100.0 0 a
AD013| [0 TAG(DOOT) 2 @  -100.00 100.0 0
[~ E-Mail v Ao014| [ TAG(ooO1) 2 ®  -10000 100.0 0
A0015| [ TAG(o001) 2 ®  -10000 100.0 of | &
A0016 | [ TAG(oo001) 2 ®  -10000 100.0 ol [
E BT g A0017 | [0 TAG(0001) 2 ® -100.00 100.0 0 X
A0018| [0 TAG@o01) 2 ®  -10000 100.0 o B
A0019| [ TAG(@O01) 2 ®  -10000 100.0 0
A0020| [0 TAG(DOOT) 2 ®  -10000 100.0 0
AD021| [ TAG(DOO1) 2 ®  -100.00 100.0 0
AD022| [0 TAG(OOT) 2 ®  -100.00 100.0 0
AD023| [0 TAG(DOOT) 2 ®  -100.00 100.0 0
AD024 | [0 TAG(DOOT) 2 ®  -100.00 100.0 0
A0025| [ TAG(o001) 2 ®  -10000 100.0 0
A0026 | [ TAG(oo001) 2 ®  -10000 100.0 0
[1 ao027| [] TAG(0001) 2 ®  -10000 100.0 0
1 annno | [ Tarnnns 2 &= 100 an 1nnn 0
1] o] ~ I - [ > I -
1 1 1 1 I~ 0
< e 0
k3
Alarm Sound JL_ Downloa L
No. File Name No. File Name | No. File Name
01 || AlarmSound_01
02_|| AlarmSound_02
03
04
05

— Scroll to show the Unit, Tag No., Tag Comment, and Alarm items.

£

2 Select a tag to use (1 line = 1 tag = 1 math tag).
Click the check boxes in the Acquisition & Computing or Record column.

3 Set the expressions and the like of the math tags you want to use.
Setting details: P next page
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Chapter 4 Using the Math Function (/MT option)

You can set the following items for math tags.

O O O Math Tag O O Constant
Aeettnd masia Recom| Expression | Span .~ Label Value “
Dec. Point MIN MAX
B A0001| B  TAG(00O1) 2 ®  -100.00 10000 | || Constt 1
H Ac002| @ TacmOD1) 2 ®  -100.00 10000 | || Const2 2
0 ao003| O TaAG(001) 2 ®  -100.00 100.00 0
(1 aboos| [ TAG(OO1) 2 ®  -100.00 100.00 0
O a0005| O  TAG(0001) 2 ®  -100.00 100.00 0
0 ao00s| O TAGO01) 2 ®  -100.00 100.00 | 0
(1 aooo7| [ TAG(001) 2 ®  -100.00 100.00 o
O aocos| O Tac(oo01) 2 ®  -100.00 100.00 0

(1) Acquisition & Computing (Math Tag Index)
These are unique tag numbers assigned sequentially from A0001 to A2000. You cannot
change the numbers. Click to specify whether to acquire and compute. Blue is on
(record).

(2) Record

Click to specify whether to record (save the math data). If you set Record to On,
Acquisition & Computing will also be automatically set to On.

(3) Expression
Set the expression. If the expression that you enter is invalid, it will be displayed with red
characters.
» Default value: TAG(0001)
* Input range: Enter a text string using up to 127 characters. Constants and functions
are not case sensitive.
Available operators and functions: > page 4-5

(4) Dec. Point

Select the number of decimal places.
» Default value: 2

(5) Span
Enter the minimum and maximum values of the span.
» Default value: -100.00 (minimum value) 100.00 (maximum value)

* Input range: —3.4028235E+38 to 3.4028235E+38

Constants are detailed later.

Alarm 1
Math Tag . . .
" Alarm 1

e Unit | Tag Ho. | Tag Comment ‘ Type "Value Hysteresis Sound
[ Ao001 TagAooo1 TagCommenta0001 off =2} 0.00 0.00 Standard &2
@ ADDDZ TagAl002 TagComment40002 Off ] 0.00 0.00 AlarmSourka
L1 A0003 TagA0003 TagCommentA0003 Off (] 0.00 0.00 Mone &
L A0004 TagAooo4 TagCommenta0004 o & 0.00 0.00 Mone (<=3
L ADDOS TagADD05 TagCommentA0005 off (] 0.00 0.00 Mone (]
L| AOOOG TagAD00B TagCommentA0006 off =2} 0.00 0.00 Mone 3]
L ADOOT TagAD007 TagCommentA0007 off (€] 0.00 0.00 Mone (€]
Ll ADDDE TagAo008 TagCommentAal008 Off ] 0.00 0.00 Mone &

Alarms 2to 4 —>

(6) Unit

Enter the unit.
» Default value: Blank
* Input range: Enter up to 6 characters.
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(7) Tag No.
Enter the tag number.
» Default value: TagA0001 to TagA2000
» Input range: Enter up to 16 characters.

(8) Tag Comment

Enter the tag comment.
» Default value: TagCommentA0001 to TagCommentA2000
* Input range: Enter up to 32 characters.

(9) Alarm 1 to 4* Type
Select the alarm type from the list.
» Default value: Off
» Selectable range: Off, High (high limit alarm), Low (low limit alarm), rHigh (high
limit on rate-of-change alarm), rLow (low limit on rate-of-change
alarm)

* For alarms, you can set Alarm 1 to Alarm 4.

(10) Alarm 1 to 4 Value
Enter the alarm value.
» Default value: 0.00
* Input range: —3.4028235E+38 to 3.4028235E+38

(11) Alarm 1 to 4 Hysteresis
Enter the alarm hysteresis.
+ Default value: 0.00
* Input range: 0 to 3.4028235E+38

(12) Alarm1to4 Sound

Set the alarm sound.
You can assign an alarm sound to each math tag.
The alarm sound settings and alarm sound files are saved in the project file.

Alarm sound Description

None This is when an alarm type is not assigned.

Standard If an alarm type is assigned, this is the GA10’s standard alarm sound.

Alarm sound file If an alarm type is assigned and alarm sound files are registered, file names are displayed

for you to select from.

Registering and deleting alarm sound files
Alarm sound files can be uploaded to the server, downloaded from the server, or deleted.

Alarm Sound

No. File Name | Mo File Name | wo File Name | mo. File Name
01 | AlarmSound_01 T e

02 AlarmSound_02
03| AlarmSound_03

* Upload
Click a number, click Upload, and specify an .mp3 file.
» Download

Click a number, click Download, and specify the client’'s save destination to save the file.

* Delete

You can select alarm sound files registered in the server. Click a number, and click Delete

to delete the file.
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Setting Math Constants

You can use the following three types of constants. (They cannot be used in event functions
or time functions.)
» User-defined math constant: A constant that the user sets for specific text strings
(labels).
» Predefined math constant: A constant that is already defined in the GA10 Math
function.
» Numeric math constant: A constant that the user enters directly in expressions using
a number without setting a definition.

User-Defined Math Constant

User-defined math constants are set in the Constant area (the right side) of the Math Tag
Setting Page. You can set up to 200 pairs of labels and values.

a b
Constant
Label Value t‘
Const1 1
Const2 2
0
0

Basic Operation

1 Click a cell in the Label column under Constant, and enter a name for identifying the
constant.

2 Click a cell in the Value column, and enter the value.

a. Label

The name of the label. Set using a text string that is not already used in predefined
constants. If duplicate constant names exist, the first definition is used by expressions.
» Default value: Blank
» Input range: Enter up to 10 characters.
b. Value
Enter the constant value.
» Default value: 0
* Input range: —3.4028235E+38 to 3.4028235E+38
» Value’s displayed number of decimal places: The number of displayed decimal
places is undefined (the number of significant numeric digits is seven). When
necessary, it is displayed in exponential form to match the display of the actual
value (e.g., 1.234E12).

Predefined Math Constant
The following table shows the predefined math constants.

Constant Name Description

(Label)

NaN Undefined or error value

POver +Overrange

MOver —Overrange

Pi m(3.14..)

e Base of natural logarithm (2.718...)

Numeric Math Constant

To express a constant by entering a number directly in an expression, use the following
syntax.

[digits][.digits][{d | D | e | E}[digits]]

Example: “1.0d+1” represents “10.0.”
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Available Operators

The following operators can be used in expressions.

Operator Description

+ Unary plus operator

- Unary minus operator

! Logical negation operator, 1 if 0, otherwise 0

+ Addition
- Subtraction
Multiplication
/ Division
% Remainder
< Less than, 1 if true, 0 if false
> Greater than, 1 if true, 0 if false
<= Less than or equal to, 1 if true, O if false
>= Greater than or equal to, 1 if true, 0O if false

== Equal to, 1 if true, O if false

I= Not equal to, 1 if true, 0 if false

&& Logical AND, continue calculation even if false
Il Logical OR, continue calculation even if true
AR Exclusive OR

?: Conditional operator

, Comma operator

The operator precedence is shown below. The operator on the left of the arrow has higher
precedence than that on the right.
“+ — I"(unary operator) «“+ — * / %”(arithmetic operator) «“< > <= >= == |="(relational

operator) —“&& || *’(logical operator) «“?”(conditional operator) «*,”(comma operator)

Available Functions

The following functions can be used in expressions. (Math constants cannot be used in

event functions.)

Event Functions

Functions that perform specific actions. (Math constants cannot be used in event

functions.)

Function Action Example

ResetMath() Resets math. TAG(00010)>=1.0 ?
ResetMath() : 0

Mark("mark") Creates a mark. Characters of your choice inside the double Mark("alarmMark")

quotations.

Reference Functions

Functions for retrieving measured values and alarm values.

Function

Action Example

Tag(<Taglndex>)

Returns the current value of the specified tag. Either Tag(0001)
tag index or tag number can be specified.

PreTag(<TagIndex>)

Returns the previous value of the specified tag. PreTag(0001)
Either tag index or tag number can be specified.

Alarm(<TagIndex>,<alarmLevel>)

Returns the alarm value of the specified tag. Alarm(0001,4)
ON=1, OFF=0
Either tag index or tag number can be specified.

Alarm(<Taglndex>)

Returns the alarm value of the specified tag. Alarm(0001)
ON=1, OFF=0
Either tag index or tag number can be specified.

Alarm()

Returns the alarm value of any tag. Alarm()==
ON=1, OFF=0
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Chapter 4 Using the Math Function (/MT option)

Arithmetic Functions

Function Action Example
sin(<Value>) Returns the sine of <Value>. sin(TAG(0001))
cos(<Value>) Returns the cosine of <Value>. cos(TAG(0001))
tan(<Value>) Returns the tangent of <Value>. tan(TAG(0001))
asin(<Value>) Arc sine. asin(TAG(0001))
acos(<Value>) Arc cosine. acos(TAG(0001))
sinh(<Value>) Hyperbolic sine. sinh(TAG(0001))
cosh(<Value>) Hyperbolic cosine. cosh(TAG(0001))
tanh(<Value>) Hyperbolic tangent. tanh(TAG(0001))
pow(<Value1>,<Value2>) <Value1> to the power of <Value2> pow(TAG(0001),TAG(0002))
abs(<Value>) Absolute value abs(TAG(0001))
sqrt(<Value>) Square root sqrt(TAG(0001))
logE(<Value>) Natural logarithm logE(TAG(0001))
log10(<Value>) Common logarithm log10(TAG(0001))
expE(<Value>) E to the power of <Value> expE(TAG(0001))
exp10(<Value>) 10 to the power of <Value> exp10(TAG(0001))

max(<Value>,..., <Value>)

Maximum value among multiple max(TAG(0001),TAG(0002),T

specified values.

AG(0003))

min(<Value>,..., <Value>)

Minimum value among multiple specified min(TAG(0001),TAG(0002),T

values.

AG(0003))

pp(<Value>,..., <Value>)

(Maximum value — minimum value) pp(TAG(0001),TAG(0002), TAG(0003))

among multiple specified values.

sum(<Value>,..., <Value>)

Sum of multiple specified values.

sum(TAG(0001),TAG(0002), T
AG(0003))

ave(<Value>,..., <Value>)

Average of multiple specified values.

ave(TAG(0001),TAG(0002),T
AG(0003))

poly(<x>,<a0>,<a1>,..., <an>)

Polynomial, variable parameters
Calculates aOxn+a1xn-1+...+anx0.

poly(TAG(0001), TAG(0002),T
AG(0003))

ceil(<Value>)

Returns the minimum integer greater ceil(TAG(0001))

than or equal to <Value>.

floor(<Value>)

Returns the maximum integer less than floor(TAG(0001))

or equal to <Value>.

limit(<x>, <a>, <b>)

Rounds the value to [a] or [b] if x is limit(TAG(0001),10,20)

outside the range [a,b].

rnd()

Returns a random number between 0 TAG(0001)*rnd()

and 1.

IsNaN(<Value>)

Returns 1 if <Value>is NaN, 0 otherwise. IsNaN(TAG(0001))

Time Functions

The following table shows the available time functions. (Math constants cannot be used in

time functions.)

Function

Action

time(<year>,<month>,<day>,<hour>,<minute>)

Edge action on the date and time

bfTime(<year>,<month>,<day>,<hour>,<minu
te>)

Previous edge action on the date and time

time(<year A>,<month A>,<day A>,<hour
A>,<minute A>,<year B>,<month B>,<day
B>,<hour B>,<minute B>)

Level action between time A and B

monthly(<day>,<hour>,<minute>)

Edge action on <day> every month at <hour>, <minute>.

bfMonthly(<day>,<hour>,<minute>)

Previous edge action on <day> every month at <hour>,
<minute>.

monthly(<day A>,<hour A>,<minute A>,<day
B>,<hour B>,<minute B>)

Level action between <day A>, <hour A>, <minute A> and <day
B>, <hour B>, <minute B> every month.

weekly(<day of week>,<hour>,<minute>)

Edge action on <day of week> every week at <hour>, <minute>.

bfWeekly(<day of week>,<hour>,<minute>)

Previous edge action on <day of week> every week at <hour>,
<minute>.

weekly (<day of week A>,<hour A>,<minute
A> <day of week B>,<hour B>,<minute B>)

Level action between <day of week A>, <hour A>, <minute A>
and <day of week B>, <hour B>, <minute B> every week.

daily(<hour>,<minute>)

Edge action at <hour>, <minute> every day.

bfDaily(<hour>,<minute>)

Previous edge action at <hour>, <minute> every day.

daily(<hour A>,<minute A>,<hour B>,<minute
B>)

Level action between time A and B every day

hourly(<minute>)

Edge action at <minute> every hour.

bfHourly(<minute>)

Previous edge action at <minute> every hour.

hourly(<minute A>,<minute B>)

Level action between minute A and B every hour.
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« Edge: Returns 1.0 at the time of computation immediately after the specified
duration or time.
» Previous edge: Returns 1.0 at the time of computation immediately before the
specified duration or time.
» Level: Returns 1.0 during the specified duration or time.
» Parameter setting range
<year>: 1970 to 2036
<month>: 1 to 12
<day>: 1 to 31
<day of week>: 0 to 6 (0: Sunday, 1: Monday, ..., 6: Saturday)
<hour>: 0 to 23
<minute>: 0 to 59

Bit Operation

This is an operation function that retrieves the value of the specified bit position of an
integer that is 32 bits maximum.

Function Action Example
Bit(<Value1>,<Value2>))  Returns the value of the <Value2>th bit of <Value1>. Bit(5,1)
Value2: 0 to 31 (values below zero are assumed to be Bit(Tag(0001),1)

zero, and values above 31 area assumed to be 31)

4.2 Performing Computations

Computation starts when data collection starts. Click the ”’ icon displayed on the tab on

the right side of the screen to start data collection. Click the ™% icon to start data collection
and recording.
The execution interval of computation is the same as the monitor interval (for PC time).

IM 04L65B01-01EN
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Chapter 4 Using the Math Function (/MT option)

4.3 Resetting Computation

You can reset computation from the menu, separately from the acquisition and recording
operation.

On the Project menu, click Reset Computing.

Project | Operation User Help

550N

Append Mark »

Reset Computing

Start Device's Computing

Stop Device's Computing

Reset Device's Computing(L)
Reset & Start Device's Computing

This command appears only if the user who opened the project has operator or higher
privileges and data collection (computation) is in progress.

You can also configure the software to reset computing automatically when recording is

started. On the Record Setting Page of the project, select the Reset Math When Recording
Starts check box next to Math Action.

(G Data Logging Software - [admin] — [project_a] [S[E[ =7

Flle Edit View Project Operation User Help

H3o® w00 X/ @ e @ st o o [ -
“I Record Interak 1Second &)

RS Y| Recourietor  @Bnay  Ofxel  OBnansecel =
9 | st condon: [rerr— 3

topConton: Err— 2
& wanag | Fie Ouision: one S

Number of Files: [ Limitthe Number of Files. Unit /\?-
R ¥ Foer ) G s
= 4 FieName: B ] Oascnneose  ClatscnmeTime

Comment

[ Emai v

o, Title [ String

o e

o6 B

B

Math Acton Q@ese! Wath en Recoraing Stas

— Select this check box.

In this situation, the math reset timing is delayed by up to two recording intervals from the
record start timing.

Setting the data recording method: P> Sec. 3.3.6

4-8
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Chapter 5 Using the Report/Print Function (/RP option)

5.1 Configuring Auto Print

5.1.1 Print Types and Basic Operation
The GA10’s Report/Print function (/RP option) can be divided into the following three

functions.

You can set which function to use and with what kind of schedule to print from the Report/

Print Setting Page.

Standard Print

You can select the display group and display format (trend graph, circular, sheet, alarm
list, mark list) and print from a data file at the specified time on the specified printer.

Custom Print

You can select the display group and display format (trend graph, alarm list, mark list) and

print from a data file according to the specified template file at the specified time on the

specified printer.
Report Output

You can create a report file (PDF, Excel) from a data file according to the specified
template file and specified report settings. You can create report data (PDF, Excel) of the
average, maximum, minimum, sum, and instantaneous values over a specified duration.

In addition, custom print and report output can be performed manually from the Data files

» Sec.5.3

The following table shows the print types and their characteristics.

Standard

Custom

Report Output

Auto printing at the
specified time

Auto printing at the
specified time using the

Auto printing at the
specified time using the

Use specified layout specified layout and
report type
Hourly, Daily, Weekly, Hourly, Daily, Weekly, Hourly + Daily,
Condition Monthly, Periodically, Monthly, Periodically, Daily + Weekly,
End of record End of record Daily + Monthly, Batch,
Daily custom

Print Layout

Cannot be specified

Can be specified

Can be specified

None

Report templates for
PDF report files (*.tpl)

Report templates for
Excel report files (*.xIsx,
* xlsm),

Report templates for
PDF report files (*.tpl)

Print type Trend Graph, Trend Graph,
Circular, Sheet, Alarm List, Trend G_raph,
: - Alarm List,
Alarm List, Mark List X
- Mark List
Graph Mark List
Number of graphs 1 graph/setting Up to 4 graphs/setting Up to 4 graphs/setting
ltems Specified with Print Specified with keyword Specified with keyword
Header
Output channel Cannot be specified Cannot be specified Max. 100ch
. s Local printer Local printer Local printer
Print Destination PDF file Excel file

Number of Graph Print Pages

Multiple pages

Number of pages
defined in the template

Number of pages
defined in the template
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Chapter 5 Using the Report/Print Function (/RP option)

When using the Report/Print function (/RP option), note the following points

Report schedule is executed only when a project is "Recording".

Report output and auto printing may be delayed up to 10 minutes depending on the
specified conditions. This is because the execution time is shifted after a temporary file is
created internally.

If the recording duration is long and the number of data points in the target range is large,
standard print, custom print, and report output may take time.

To perform custom print or report output, you must specify a template file (Sec. 5.1.2).

If Data time is set to Device time and data of multiple devices is being recorded, data is
saved to separate files for each device and for each data acquisition interval. Therefore,
report files are also created for each device and for each data acquisition interval. If Data
time is set to PC time, a single report file is created even when multiple devices are being
recorded.

The printers that can be used with the Report/Print function are the local printers
registered on the server PC. Network printers are not displayed in print settings. Virtual
printers of local printers are displayed, but interactive virtual printers (e.g., WindowsXPS
DocumentWriter) that require users to enter the file name cannot be used.

Report Output When Communication Is Disconnected

If a communication interference occurs between the GA10 server and the connected
devices, dropouts may occur in the report or print data. Only when Data time is set to
Device time, the data in the dropout section is consolidated as “Off data,” and the dropout
section is output with compensation. (See the figure below.)

Data dropout occurrence

1 f2ﬁ O 3 4

‘ Consolidated as OFF data

s

f1, f2, f2’, £3, and f4 are included in reports and printing.

.......

ft 2 | i

» This function is not supported on versions earlier than GA10 R2.03.xx. (The file is
divided at the data dropout section and output.) We recommend that you use the
latest version of GA10.

5-2
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Chapter 5 Using the Report/Print Function (/RP option)

Basic Operation

The following procedure i

1 Select Report/Print

s for setting a schedule and printing automatically.

in the navigation area on the left of the window.

Report/Print appears when the license for the Report/Print function (/RP option) is already

registered.

The Report Setting Pa

@ower
2 Record v

&) roportprnt
[ E-Mai

ge appears. (See the figure on the next page.)

» The Report Setting Page consists of a tabbed page area for setting schedules in the
top half and an area for registering template files in the lower half. You can register
up to 20 schedule settings (tabbed pages) and up to 20 template files (PDF, Excel).

* The template reg

istration area can be shown or hidden by clicking the up/down

slide bar. By default, the template registration area is shown, but once you change
its state, it is stored for each Windows user.

1 — Area for setting report schedules
(4 Data Logging Softwgre — [admin] - [project_a [ol@] = |
File Edit View Pfoject Operation Usgr Help
Hic2 b DD x| Bfes| @ st = & [ e [ Good |
n Schedule Name
\cp Dorice v | Repor 05 | Repor 06 | Reporto7 | =
Report 01 [Rsp nuz]Rspmm]Repmm Report 05 | Report 06 || Report 07 || Report na]Rapnnug]Repmm]Rspmﬂ ]Ri« > [
& Tag w | Name [Repart01 ] cl
2
Task ® None O standard Print © Custom Print O Report Cutput s
@oomr |
<¥ Record v 2 2
@ &
Report/Print v 7]
[ Email
B o =
ers
&)
X
3
Template File L Upload JI__ Download ) Delete
File Name Type . File Hame | Type

Area for registering template files

Click this bar to show or hide the template registration area.
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Chapter 5 Using the Report/Print Function (/RP option)

2 Select the task (default value: None).
Settings appear in the schedule setting area depending on the selected task.

3 Set the print schedule in line with the task.
» For details on the settings for each task, see Standard Print, Custom Print,
and Report Output.
» For Custom Print and Report Output, you use a template file. For instructions on
how to register templates, see the next page.

4 start recording ..

The report is output or printed according to the schedule.

Nofte

* You can view the schedule and history of report schedules that have been set on the Status
Page.
Viewing report schedules: P sec. 5.2

« The results of auto report printing is displayed in the project log of the Log dialog box. A log
entry is sent when printing completes successfully or unsuccessfully.
Opening the Log dialog box: P sec. 6.10

» All unexecuted report schedules of the relevant project registered in the server are executed
after the last recording file is created upon the completion of a recording.

» Auto print schedules that have not been completed due to a PC shutdown are executed again
when the server recovers. However, output results of auto print executed in this way may have
up to 10 minutes of data missing before the shutdown.
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5.1.2 Registering Template Files

Before performing a custom print or report print, register template files. The area for
registering template files is in a two-column tabular form. You can register up to 20 report
template files in the following format.

Template Files That You Can Use

Template File Save Format Extension Remarks

Excel format * xlsx A template created by entering keywords* and text of
your choice in Excel cells.

Excel macro-enabled format  *.xIsm Same as above

PDF format *tpl Created using the SMARTDAC+ Report Template

Builder (a tool for creating and viewing report
templates in PDF format). You can download Report
Template Builder from the following URL.
www.smartdacplus.com/software/en/

*

Keywords specify the type of data that will be entered into a cell. Entering keywords makes it
possible to print the information. » “Keyword Definitions” on page App-3

On the template file registration area, you can use the control buttons in the upper right to
register (to a PC), save, and delete template files.

=
Template File [ upload J[ Downioad [ Detete ||
No. File Hame Type File Name: | Type
01 | RepTempSample_B_DataTime.tpl Print/PDF -

02 | RepTempSample_B_ElapsedTime tpl PrintPDF

03 Unregistere

04

05

06

o7

03

09

10

Nofte

Click the No. cell for the File Name that you want to perform the action on.
To register, select a row showing “Unregistered.”

The selected row turns blue. You cannot select multiple rows.

Click a control button.

Clicking Upload displays a standard Open dialog box.
Clicking Download displays a standard Save As dialog box.
Clicking Delete deletes the file registered in the GA10 server.

If you click Upload, select the file you want to register, and click OK.
If you click Download, select the save destination, and click OK.

The file will be registered or saved.

» If you place the SMARTDAC+ Report Template Builder installer in the same folder as the GA
installer, Report Template Builder will be installed automatically when you install GA10.

* For information on how to use SMARTDAC+ Report Template Builder, see the Help menu of
Report Template Builder.

» For instructions on how to create report templates for Excel report files and examples of how
write keywords, see “Appendix 1 Creating Report Templates”.

10

to
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5.1.3 Standard Print

If you set Task to Standard Print, the schedule page shows the Standard Print settings.
In standard print, the specified content is printed automatically from a data file at the
specified time.

Schedule Name
Report m]Repon 02)Report 03|Report 04|Report 05|Report 06 |Report 07|Report 08|Report 08)Report 10|Report 11)Report 12@

@ —® Mame ‘Repurtm |
@ —® Task O Mone @ Standard Print O Custom Print O Report Output
@ ___b Condition: [Everyday &)| [00]:[00]: 00
@ —p Rane Start Time

End Time: [o07:[oo]

Range
[ I I S  — I I |

0:00 §00 1200 1800  0:00 §00 1200 1800  0:00
(5) — Print Type
(6) —s Group -
@ —p Print Header
g Printout Setup: Print Graph Format: ® 1 page O Multiple Pages

Line Thick: 1.0pt 7]

Font Size:

Tag Display Form.

Graph Print Grid:

¥ s Grid:

¥ Ais Zone:

Active Y Axis No

¥ Axis Column Mum

Legend: O Yes ® Mo

Legend Position

Color Mode: O BlackiWhite @ Color

Mark Color: |:|
@ — Print Setup: Printer: [prtoo1-om5075 Gal|

Paper Size: [A4 (210297 mm) [}

Orientation: ® Portrait O Landscape
— Output Language: Japanese &

In a Standard Print schedule, set the following items.
(1) Name
Enter the name of the schedule.
» Default value: Report01 to Report 20
* Input range: Enter a text string using up to 30 characters.

(2) Task
Select Standard Print.
» Options: None, Standard Print, Custom Print, Report Print

(3) Condition
From the list, select the time to execute printing.
» Default value: 00:00:00 every day
» Options: Every Hour, Everyday, Every Week, Every Month, Interval, Recording is
finished
The range (4) will vary depending on this condition.

(4) Range

Set the target data range. For details, see Schedule Conditions and Range described
later.

(5) Print Type
Select the print type from the list.
» Default value: Trend Graph
» Options: Trend Graph, Circular, Sheet, Alarm List, Mark List
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(6) Group

Specify the range of display groups to print using group numbers.

* Default value: 01-01
* Input range: Enter the display group numbers in the range of Group 01 to 50. Enter
them so that the start group number is less than the end group number.

(7) Print Header

Click the Detail button, and click the items you want to print in the Print Header Detail
dialog box shown below. For File Name, the character strings of Schedule Name and
Date will be output.

'y ™)
Print Header x
[ File Name [ math ch. ] comment4
[ Deivce Type O Sampling Int. [ comment5
[ serial Mo [J comment 1 [J comment &
[ Time Correct [J comment 2 [J comment 7
[] meas ch [] comment 3 [] comment8
[ comment

[ selectan ) [_SelectNone

( OK ) (_cance )

(8) Printout Setup
Set the graph details. The items vary depending on the print type set in (5).

Item Default Show or hide Range
Value
Print Graph Format 1 page Displayed for Standard Print and Trend Graph 1 page, Multiple Pages
Line Thick 1.0pt Displayed for Trend Graph and Circular 0.25pt, 0.5pt, 1.0pt, 1.5pt,
3.0pt
Font size 6pt Displayed for Trend Graph 6pt, 7pt, 7.5pt, 8pt, 9pt, 10pt,
11pt, 12pt, 14pt, 16pt, 20pt
Print Graph Grid 1h(/div) Displayed for Trend Graph and Multiple Page 1min, 2min, 5min, 10min,
20min, 30min, 1h, 2h, 3h,
4h, 6h, 8h, 12h, 1day, 7days,
1month
Print Graph Grid Standard Displayed for Standard Print or Trend Graph Standard Grid, Dense Grid1,
Grid when 1 Page is selected Dense Grid2, Dense Grid3,
Displayed for Custom Print or Report Output. Dense Grid4
Sub Grid None Displayed for Trend Graph and Multiple Page Varies depending on the
Print Graph Grid setting.
(See the separate table.)
Split Circular 1h(/rev.) Displayed for Circular 1h, 2h, 6h, 8h, 12h, 16h,
Interval 1day, 2days, 1week, 2weeks,
4weeks
Sub Split None Displayed for Circular Varies depending on Split
Circular Interval. (See the
separate table.)
Y-axis grid Standard Displayed for Trend Graph Standard Grid, Dense Grid1,
Grid Dense Grid2, Dense Grid3,
Dense Grid4
Y-axis zone Full zone Displayed for Trend Graph Full Zone, Slide Zone, Auto
Zone, Free Zone
Active Y-axis 1 Displayed for Trend Graph 1to 50
Tag Display Tag No. Displayed for Trend Graph, Circular, Sheet, Tag No., Tag Comment, Tag

and Alarm List.

Index

Y Axis Column Num 1

Displayed for Trend Graph and Circular

Enter a number between 1
to 50.

Legend No Displayed for Trend Graph and Circular Yes or No

Legend position Right Displayed for Legend [Yes] Top, Bottom, Left, Right

Color Mode Color Displayed always. Black/White or color

Mark Color Orange Displayed for Trend Graph, Circular, and Sheet Click the color to select the
color from a Color Setting
dialog box.

Print Quality Standard Displayed for Custom Print, Report Output Standard, High

as well as when Graph Type is set to None
for manual Custom Print and manual Report
Output.

Standard: 300 dpi
High: 600 dpi
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Sub Grid Range (Trend)
Print Waveform Grid Range

1min None, 30sec, 10sec, 5sec, 2sec, 1sec
2min None, 1min, 30sec, 10sec, 5sec, 2sec
5min None, 2min, 1min, 30sec, 10sec, 5sec
10min None, 5min, 2min, 1min, 30sec, 10sec
20min None, 10min, 5min, 2min, 1min, 30sec
30min None, 10min, 5min, 2min, 1min, 30sec
1h None, 30min, 10min, 5min, 2min, 1min
2h None, 1h, 30min, 10min, 5min, 2min
3h None, 1h, 30min, 10min, 5min, 2min
4h None, 2h, 1h, 30min, 10min, 5min

6h None, 3h, 1h, 30min, 10min, 5min

8h None, 4h, 2h, 1h, 30min, 10min

12h None, 6h, 3h, 1h, 30min, 10min

1day None, 12h, 6h, 3h, 1h, 30min

7days None, 1day, 12h, 6h, 3h, 1h

1month None, 15days, 10days, 5days, 1day, 12h

Sub Split Range (Circular)
Split Circular Interval Range

1h None, 2min, 1min, 30sec, 10sec, 5sec
2h None, 5min, 2min, 1min, 30sec, 10sec
6h Nonec, 10min, 5min, 2min, 1min, 30se
8h None, 30min, 10min, 5min, 2min, 1min
12h None, 30min, 10min, 5min, 2min, 1min
16h None, 1h, 30min, 10min, 5min, 2min
1day None, 1h, 30min, 10min, 5min, 2min
2days None, 2h, 1h, 30min, 10min, 5min
1week None, 12h, 6h, 3h, 1h, 30min

2weeks None, 12h, 6h, 3h, 1h, 30min

4weeks None, 12h, 6h, 3h, 1h, 30min

(9) Printer Setup

» Printer: Displays a list of registered printers. Select the printer on the server side to
perform printing. Network printers are not displayed. Select a local printer
registered on the server PC.

»  Paper size: Displays a list of paper sizes retrieved from the specified printer. Use

paper whose size is between A4 and A3.

»  Orientation: Set to Portrait or Landscape.

(10) Output Language
Specify the language for the printed materials. The date format and decimal point format
vary depending on the language.
» Default value: Language of each user (the registered language if a schedule
registered on the server has already been displayed)
» Options: Japanese, English, Chinese, German, French, Korean, Russian

Language vs. Date Format and Decimal Point Format

Output Language Date Format Decimal Point Format
Japanese YY/MM/DD Point (.)

English MM/DD/YY Point (.)

German DD.MM.YY Comma (,)

French DD/MM/YY Comma (,)

Russian DD.MM.YY Comma (,)

Chinese YY/MM/DD Point (.)

Korean YY/MM/DD Point (.)
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5.1.4 Custom Print

If you set Task to Custom Print, the schedule page shows the Custom Print settings. In
custom print, the specified content is printed automatically from a data file according to a
template at the specified time.

Auto print is performed only when a template is specified. Be sure to register a template in

advance.

:"‘Registering Template Files” on page 5-5

Schedule Name
Report m]Repnn nz]Repnn na]Report ﬂti]Repnn ns]Repnn ns]Repnn n?]Report ns]Repnn na]Repnn m]Reporm]Repnn 12@
@— Name: |Repurl 01 \
@ ——8 Task O Mone O standard Print ® Custom Print O Report Qutput
@ — Condition: [Everyday & [00]: oo
@ ——» Template File [None |
(5) —s Printer: [prig01-0ms078 )
@ ———¢ Output Language Japanese [=]
Graph Graph 1 ] Graph 2 ] Graph 2 I Graph 4 ]
Piint Type =
Range Start Time [oo:
End Time [oo]:
Remge
[ I I I ] I I I ]
0:00 6:00 12:00 18:00 0:00 6:00 12:00 18:00 0:00
@ (| croum:
Printout Setup:  Line Thick: 1.0pt &
Font Size: 6pt &
Tag Display Form.: L4
Graph Print Grid:
¥ Ais Grid
¥ Axis Zone
Active Y Axis No

(uondo gy/) uooung juud/iodey ey buisn

In a Custom Print schedule, set the following items.

(1) Name
Enter the name of the schedule. (The default value and input range are the same as
those for Standard Print.)

(2) Task
Select Custom Print.

(3) Condition
From the list, select the time to execute printing.
The range (7) will vary depending on this condition. : P>Schedule Conditions and Range

(4) Template file
From the list, select the template file (*.tpl) to apply to printing. If no template files (*.tpl)
are registered, only None is displayed.
Nofe
* You can create template files (*.tpl) using SMARTDAC+ Report Template Builder. You can
download it from the YOKOGAWA website for free.

» If the template file is set to None, custom print is not possible.
» Excel templates cannot be used for custom print.

(5) Printer
Displays a list of printers registered in the server.
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(6) Output Language
Specify the language for the printed materials. The date format and decimal point format
vary depending on the language (See Language vs. Date Format and Decimal Point
Format provided earlier).

(7) Graph 1 to 4
Print Type

Select the type of graph defined in the template file.
* Options: None, Trend Graph, Alarm List, Mark List

Range
Set the print target data range. #*Schedule Conditions and Range

Group

Specify the number of the group to print. Only the valid group numbers (groups that are
assigned tags) among Group 01 to 50 are displayed as options.

Printout Setup
Same as “Printout Setup” on page 5-7. See the items in the table.

Nofte

The graph output varies depending on the defined size as follows.

« For a trend graph, all trends in the setting range are output according to the size.

« For an alarm list and mark list, the number of output lines is calculated from the vertical length
and font size, and data is printed over the calculated output lines in order from the latest time.

» Set the width of the alarm list to at least 102 mm and that of the mark list to at least 196 mm.
Otherwise, character strings that do not fit width wise will be cut and not be output.
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5.1.5 Report Output

If you set Task to Report Output, the schedule page shows the Report Output settings. In
Report Output, report files (PDF, Excel) are created according to the specified template.

Report files are output only when a template is specified. Be sure to register a template in advance.

:"‘Registering Template Files” on page 5-5

(uondo gy/) uooung juud/iodey ey buisn

Schedule Name
Report m]Repon 02Report 03|Report 04[Report 05 [Report 06|[Report 07 |Report 08|Report 09)Report 10)Report 11Report 12[@
1) — e name [Report 01
®—-Task: O None (O Standard Print O Custom Print @® Report Output
@ ——e Type: [Hourly + Daily [=]
(@) —s condition: Everyday =) [o0]: 00
@ ——» Filename Naming Rule: ® Auto O Specify
(6) —p Dutput Folder. Data Folder )| Clusers\Public\Documents\SMARTDAC+ Data Logging Software\Data\PJ.
@ ____§ Template File: [None [}
_,F'rmtOut @ No O Yes
(9) — OutputLanguage Japanese &)
Report channel: No. Tag Index ] Sum scale @
R0O01 300001 J® Off Qlsec O Imin O Mhour O Iday
R0O02 a0 J® Off Oisec Ofm!n O hour O Iday
R0O03 ag J® of Qisec O Imin O Mhour QO rday
R004 200004 J® off Oisec O Jmin O Mhour O Iday
- I 1 I 1 I 1 1 1 152
Graph Graph 1 1 Gapnz | Gapn3 | Graphd |
Print Type: &l
Range Start Time
End Time :
FEnge
@ [ I I I Il I I I |
0:00 6:00 12:00 18:00 0:00 6:00 12:00 18:00 0:00
Group
Printout Setup:  Line Thick:
Font Size Gipt &
Tag Display Form.: T
Graph Print Grid:
¥ Axis Grid:
¥ Auis Zone
Artive ¥ Avie o T | o
(1) Name

Enter the name of the schedule. (The default value and input range are the same as
those for Standard Print.)

(2) Task
Select Report Output.

(3) Type
Select the report type. Condition (explained next) varies depending on the selected report
type. See the table below.
» Default value: Hourly + Daily

Relationship between Report Type and Condition

Report Type Condition
Hourly + Daily Fixed to Everyday. hh:mm can be set.
Daily + Weekly Fixed to Every Week. The day of week and hh:mm can be set.

Daily + Monthly Fixed to Every Month. The day and hh:mm can be set.

Batch Condition is not displayed.

Daily custom Fixed to Interval. The hour and base time (hh:mm) can be set.

IM 04L65B01-01EN 5-11



Chapter 5 Using the Report/Print Function (/RP option)

(4) Condition
From the list, select the time to execute printing.
» Default value: Everyday
The range (11) will vary depending on this condition. :®»Schedule Conditions and

Range
Save Interval (Hidden on the initial page because the report type is Hourly +
Daily)
This appears only when the report type is Batch or Daily custom. Set the data recording
interval.

* Default value: 10min
* Options: 1min, 2min, 3min, 4min, 5min, 10min, 15min, 30min, 1Thour

(5) Filename Naming Rule
* Default value: Auto
» Options: Auto, Specify
When Auto is selected
PDF file name example: YYYYMMDDhhmmss_serial number.pdf
Excel file name example: YYYYMMDDhhmmss_serial number.xlsx
When Specify is selected

You can specify the front text string of the report file name. Enter up to 32 characters.
The default value is “Report.”

PDF file name example: Report_YYYYMMDDhhmmss_serial number.pdf

Excel file name example: Report_ YYYYMMDDhhmmss__serial number.xlsx

YYYY (year), MM (month), DD (day), hh (hour), mm (minute), and ss (seconds) are the date and
time of the condition date.

(6) Output Folder
Select the folder to save the generated reports in.
« Default value: Data Folder
» Options: Data Folder, Subfolder in the data folder, Specified Folder

Save Location Description
Data Folder Displays the GA10 data folder.

Example: C:\Users\Public\Documents\SMARTDAC+ Data Logging Software\Data
Subfolder in the data folder Enter the name of a subfolder in the data folder. Enter up to 255 characters.
Specified Folder Enter the path to the specified folder or use the Browse button to specify it. When

entering the path, use up to 255 characters.

Note

If Output Folder is set to Desktop, My Documents, or any other Windows user folder, report file
output will fail. Select a folder other than a Windows user folder.

(7) Template File

From the list, select the template file (*.tpl) to apply to printing or an Excel template file
(*.xIsx, *.xIsm). If no template files are registered, only None is displayed.

Nofte

* You can create template files (*.tpl) using SMARTDAC+ Report Template Builder. You can
download it from the YOKOGAWA website for free.
« If the template file is set to None, report output is not possible.

(8) Print Out

Displays a list of printers registered in the server. This item is valid for a template file
(*.tpl). It does not appear for an Excel template file. (When using an Excel template file,
you cannot print directly from GA10).
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(9) Output Language
Specify the language for the printed materials. The date format and decimal point format
vary depending on the language (See Language vs. Date Format and Decimal Point
Format provided earlier).

(10) Report channel
Set the channel to output in reports.

Nofte

The device’s LOG input channel is not output. If a tag corresponding to the device’s LOG input
channel is specified, the report channel value will be blank, and the status will be error.

a b c

|

No. Tag Index | Sum scale O
ROD1 | 120.0001 J® off Oisec Olimin O ihour O iday
RO0Z_ [ 1300002 J@® of Oisec Oimin O hour O iday
ROD3 | 3 J@ of Ciisec O imin O ihour O iday
RO04 K Tag.0004 J® Off Olsec O /min QJhour O dav

- 1 1 ! 3 I 3 I 1 I 3 I~
L4 L
Report Channel Settings

Symbol Item Name Default Range Description
Value

a No. R001 to 001 to 100 (fixed) Report channel number. Click a No.
R100 cell to select the row.

b Tag Index1 Valid Tag range (including math tags) Select the tag. Click the tag to display
tags are of the project. the Tag Index dialog box. Then, click
assigned in the tag you want to specify.
ascending
order.

[ Sum scale Off Off, /sec, /min, /hour, /day Displays the sum scale of the report

channel.

d Auto increment button None R001 to R100 Assigns tag indexes in ascending
order from the first tag in the selected
range.

e All On button None R001 to R100 Clicking the button collectively turns
on the sum scales in the selected
range.

*

To select a tag, click a tag button under Tag Index, and select the tag from the displayed dialog
box shown below. If the Math function (/MT option) is installed, you can also select math tags.

r ~
Tag Index x
[ show [Device No.: Device Name: Channel No]
C Tag 0001 ) Tag 0002 )=
C Tag0003 ) ( Tag o0os )]
IC Tag 0005 J( Tag 0006 ")
IC Tag 0007 ) Tag 0008 )
IC Tag 0009 )( Tag 0010 ]
IC Tag 0011 ) Tag 0012 )
IC Tag 0013 J( Tag 0014 ]
IC Tag 0015 J( Tag 0016 )
IC Tag 0017 )( Tag 0018 )
IC Tag 0019 ) Tag 0020 )
Tan0n21 10 Tan0n2) 5]

(11) Graph1to4
Print Type
Select the type of graph defined in the template file.
» Options: None, Trend Graph, Alarm List, Mark List
Range
Set the target data range. : P>Schedule Conditions and Range

Group

Specify the number of the group to print. Only the valid group numbers (groups that are
assigned tags) among Group 01 to 50 are displayed as options.

Printout Setup
Same as in Standard Print (“Printout Setup” on page 5-7). See the items in the table.

IM 04L65B01-01EN
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5.1.6 Schedule Conditions and Range

Display examples of Condition (report output and time to execute printing) and Range on the
report schedule setting page are provided below. The schedule range display allows you to

view the specified range on a time table. The condition time is displayed with E the start time

of the specified range with E and the end time with ] The range display for each condition
applies both to auto print and manual print. You can view the schedule and history of report

schedules that have been set on the Status Page.

Nofte

« If the Beginning Time of Recording and the time of the report schedule condition are the same,

a report is output for the data at that time.

*  When recording is finished, all scheduled events will be executed.

When Condition Is Set to Every Hour

Below is the display example for Condition and Range when Condition is set to Every

Hour.
» Time span: 2 hours

» Scale (minute): 0, 15, 30, 45, 0, 15, 30, 45, 0

&) [01]:[30]:[00]

Condition: [Everyday & [01]:[30]: 00
Range: Start Time: [Prev. Day
End Time: [Current Day

&) [01]:[30]:[00]

Ramge

§— Condition time

L [ |

[ — | —

0:00 6:00 12:00 18:00

0:00 6:00 12:00 18:00 0:00

Start Time End time
Item Default Value Selectable Range
Condition: 0:00 (mm:ss) Every Hour

Every Hour  every hour Minute: 00 to 59

Range Prev. Hour 0:00 to Prev. Hour and
Current Hour 0:00 Current Hour
Minute: 00 to 59
Second: 00 to 59

Start Time: 0 minutes or later of the Prev. Hour

End Time: Up to the specified minute of the condition
The maximum time between start and end is 1 hour.
Start Time < End Time (Standard Print, Custom Print,
Report Output)
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When Condition Is Set to Everyday or When Report Type Is Set to Hourly +
Daily
Below is the display example for Condition and Range when Condition is set to Everyday.
» Time span: 2 days
 Scale (every 6 hours): 0:00, 6:00, 12:00, 18:00, 0:00, 6:00, 12:00, 18:00, 0:00

Condition: [Every Hour &]:[ 30 |: 00
Range: Start Time: [Prev. Hour o] [30 ]:[00]
End Time: [Current Hour &) [30]:[00]
Ramge & Condition time
| | [ | | | — |
0 15 30 45 0 15 30 45 0
Start Time End time
Item Default  Selectable Range
Value
Condition: Everyday Everyday
Every Hour 00:00:00 Hour: 00 to 23
Minute: 00 to 59
Range Standard Prev. Day Hour: 00 to 23  Start Time: 0:00:00 or later of Prev. Day
Print 0:00:00 to Minute: 00 to 59 » End Time: Up to the specified time of the condition
Custom Print Current ~ Second: 00 to 59 The maximum time between start and end is 24
Day * hour.
0:00:00 Start Time < End Time (Standard Print, Custom
Print, Report Output)
Hourly + Prev. Day Same as above « Start Time: Time of Prev. Day Condition or later
Daily Report 0:00:00 to » End Time: Up to the time of Current Day condition
Current * The maximum time between start and end is 24
Day * hour.
00:00:00 Start Time < End Time (Standard Print, Custom

* Print, Report Output)
Not split even the time spans over two days.

Example: Hourly + Daily output data time
Note

To create a report using the data from 1:30:00 (not including 1:30:00) of the previous day to 1:30:00
(including 1:30:00) of the current day, set the conditions and range as follows.

If you want to create a report every day with these conditions, set Stop Condition to Continuous
and File Division to Everyday 1:30:00.

Condition: Everyday 01:30:00
Range: Prev. Day 01:30:00 to Current Day 01:30:00

Data times will take on the following values.
Hourly data

yyyymmdd 02:30:00

yyyymmdd 03:30:00

yyyymmdd 04:30:00

-y-)-/yymmdd 23:30:00
yyyymmdd 00:30:00
yyyymmdd 01:30:00

Daily data
yyyymmdd 01:30:00
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When Condition Is Set to Every Week or When Report Type Is Set to Daily +

Weekly

Below is the display example for Condition and Range when Condition is set to Every

Week.

* Time span: 2 weeks
» Scale (day-of-week steps): SUN, MON, TUE, WED, THU, FRI, SAT, SUN, MON,
TUE, WED, THU, FRI, SAT, SUN, ...

Condition: [Every Week )| [Friday &)| [01]:[30]: 00
Range: Start Time: [Prev. Week & [Thursday @] [00 ][00 |:
End Time: [Current Week | [Tuesday =] [59
RERgE Condition time
G
I 0 I
SUN MON TUE WED THU FRI SAT SUN MOM TUE WED THU FRI SAT SUN
Start Time End time
Item Default Selectable Range
Value
Condition: Every Every Week
Every Week Week Sunday to
Sunday Saturday
00:00:00  Hour: 00 to 23
Minute: 00 to 59
Range Standard Prev. Week Prev. Week and Start Time: 0:00:00 or later on Sunday of Prev.
Print Sunday Current Week Week
Custom Print 0:00:00 to Day of week: End Time: Up to the specified time on the specified
Current Sunday to day of the condition
Week Saturday The maximum time between start and end is 7
Sunday Hour: 00 to 23 days.
0:00:00 Minute: 00 to 59 Start Time < End Time (Standard Print, Custom

Second: 00 to 59

Print, Report Output)

Daily +
Weekly
Report

Prev. Week Same as above

Sunday
0:00:00 to
Current
Week
Sunday
0:00:00

Start Time: Time on the day of the week of
Condition in Prev. Week or later

End Time: Up to the time on the day of the week of
Condition in Current Week

The maximum time between start and end is 7
days.

Start Time < End Time (Standard Print, Custom
Print, Report Output)

Not split even the time spans over two weeks.
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Condition:

Range:

When Condition Is Set to Every Month or When Report Type Is Set to Daily +
Monthly

Below is the display example for Condition and Range when Condition is set to Every

Month.

* Time span: 2 months

» Scale (10-day steps): 1 day, 11 days, 21 days, 1 days, 11 days, 21 days, 1 day, ...

» Displayed using the previous month’s color and current month’s color (light green
and green) from the start time to the end time.

[Every Manth &3] [25Day & [01]:[30]: 00
Start Time: [Prev. Month @] [15Day &) [23]:[59]:
End Time: [current Month Ga] [15Day & [23]:[59 ]
Condition time
| L0 | | | L |
1Day 11Day 21Day 1Day 11Day 21Day 1Day
Start time End time
Item Default Selectable Range
Value
Condition: Every Every Month
Every Month Month Day: 1 to 31
1 day Hour: 00 to 23
00:00:00  Minute: 00 to 59
Range Standard Prev. Prev. Monthand  + Start Time: 0:00:00 on the 1st of Prev. Month
Print Month Current Month « End Time: Up to the specified time on the specified

Custom Print 1 day Day: 1st to 31st day of the condition
0:00:00 to  Hour: 00 to 23 * The maximum time between start and end is 31
Current Minute: 00 to 59 days.
Month Second: 00 to 59  « Start Time < End Time (Standard Print, Custom
1 day Print, Report Output)
0:00:00 If a day that does not exist in the relevant month
(e.g., 31st, 30th, or 29th) is specified, it is corrected
to the last day of the month.
Daily + Prev. Same as above + Start Time: Time on the day of the week of
Monthly Month » Condition in Prev. Week or later
Report 1 day » End Time: Up to the time on the day of the week of
0:00:00 to » Condition in Current Week
Current The maximum time between start and end is 7
Month « days.
1 day Start Time < End Time (Standard Print, Custom
0:00:00 » Print, Report Output)

If a day that does not exist in the relevant month
(e.g., 31st, 30th, or 29th) is specified, it is corrected
to the last day of the month.

Not split even the time spans over two months.

Example: Daily + Monthly output data time

Condition: 25th of every month 01:30:00
Range: 25th of Prev. Month 01:30:00 to 25th of Current Month 01:30:00

Data times will take on the following values.

Daily data
yyyymm26 01:30:00
yyyymmz27 01:30:00

yyyymmO1 01:30:00

yyyymm24 01:30:00
yyyymm25 01:30:00

Monthly data
yyyymmdd 01:30:00
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When Condition Is Set to Interval or When Report Type Is Set to Daily custom

Below is the display example for Condition and Range when Condition is set to Interval.

« Time span: 2 cycles

« Scale: When Interval = 4 hours: 0:00, 1:00, 2:00, 3:00, 0:00, 1:00, 2:00, 3:00, 0:00
When Interval = 6 hours: 0:00, 2:00, 4:00, 0:00, 2:00, 4:00, 0:00
When Interval = 8 hours: 0:00, 2:00, 4:00, 6:00, 0:00, 2:00, 4:00, 6:00
When Interval = 12 hours: 0:00, 4:00, 8:00, 0:00, 4:00, 8:00, 0:00
When Interval = 24 hours: 0:00, 8:00, 16:00, 0:00, 8:00, 16:00, 0:00

» Displayed using the previous cycle’s color and current cycle’s color (light green and

green) from the start time to the end time.

Condition: [Interval | [Bhours &) Base Time: [ 05 |:[ 00 |: 00
Range: Start Time: [Prev. Cycle ®| [05 ][00 ]:
End Time: [Current Cycle &a] [05 ][00 ]:
Condition time
| | | [ | [ ]
0:00 2:00 4:00 T 0:00 2:00 4:00 T 0:00
Start time End time
Item Default Value Selectable Range
Condition:  Interval Interval « Interval and specifiable base time range
Interval 6h Hour: 4h, 6h, When Interval = 4h, 00:00:00 to 03:59:00
Base time 8h, 12h, 24h When Interval = 6h, 00:00:00 to 05:59:00
00:00:00 Base time When Interval = 8h, 00:00:00 to 07:59:00
(For Daily custom, Hour: 00 When Interval = 12h, 00:00:00 to 11:59:00
the interval is to 23 When Interval = 24h, 00:00:00 to 23:59:00
the file division Minute: 00
interval.) to 59
Range Prev. Cycle Prev. Cycle « Start Time: Base time of the previous Condition or later
0:00:00 to and Current + End Time: Up to the time the Condition is met
Current Cycle Cycle * The maximum time between start and end is 1 cycle.
0:00:00 « Start Time < End Time (Standard Print, Custom Print, Report
Start Time Output)
Hour: 0 to 3,
5,7,11,23
(interval — 1
hour)
Minute: 00
to 59
Second: 00
to 59
End Time
Hour: 0 to 4,
6, 8,12, 24
Minute: 00
to 59
Second: 00
to 59

When Report Type Is Set to Batch

If Report Output is set to Batch, you do not need to set Condition. The graph range is the
entire duration (the following figure), and a time table is not displayed.

Range: Start Time: Start of Recording
End Time: End of Recording

If Condition Is Set to Recording is finished

If Condition is set to Recording is finished, the range is fixed to the entire duration. A time
table is not displayed.

| Recording is finished 62|

Start Time: Start of Recording
End Time: End of Recording
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Nofte

Graphs are created on the basis of the End Time of Range. As such, if the device time is changed,
the start time of the graph may differ from the start time of the range.

Nofte
The following limitations apply to DST (Daylight Saving Time).

If the time for Condition or Range is set to a time that does not exist in DST (Daylight Saving

Time), it is executed at the time DST takes effect.

Example: If the setting is at 02:30:00 and the time for switching to DST is between 02:00:00

and 03:00:00, the condition will be executed at 03:00:00.

If Condition is set to Interval, Base time to a time on the hour (e.g., 0:00:00), and Range to a

duration equal to Interval, the range of the graph will be longer than the specified interval when

the time changes from DST to standard time.

Example: If the time change from DST to standard time is 1:00 to 0:00, Interval is 4hours, Base
time is a time on the hour, and the range is from 0:00:00 to 4:00:00, the actual graph
will be 5 hours between 0:00:00 and 4:00:00.

If the Start Time (or the End Time) of the specified range in manual Custom Print or manual

Report Output is in the DST transition time period, the range will assumed to be from before the

DST transition (or up to the end of the DST transition).

Example: If the transition from DST to standard time is 1:00 — 0:00 and the specified start and
end times are 0:50 and 2:00, the range will be 2 hours 10 minutes.

IM 04L65B01-01EN
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5.2 Viewing Report Schedules
On GA10 with the Report/Print function (/RP option), you can view the execution schedule
and history of reports and printing that have been set.

Click the Status Page icon IE on the Project tab to display the Status Page. The Report/
Print History and Report/Print Schedule tabs appear behind the device status tab described

earlier.

[ Device Running State T Report/Print History I Report/Print Schedule ]

5.2.1 Report/Print Schedule

The Report/Print Schedule tab shows the print execution schedule in a list. To view the
details of a selected schedule, you can click Display the details.

Displays the details of the selected schedule
Updates the display

Doves Running Ss | ReporPintHsian | RepourntSeneae |

[ T Ls“, e detais

Output
Type Print ReportFile.
B None

Plan
Plan

2014112125 1430:00000 Report 01 Everyday 14:30:00 StandaraPrint  —
2014112128 08:00:00.000 Report 02

Every Week Sunday 08:00: Standard Print  —

Exist None on

The following items are displayed in the list. If all the items do not fit on the screen, you can
use the scroll bar to see the hidden items.

Item

Description

Execute

Plan

Absolute Time

The time when the schedule will be
executed

Schedule
Name

The name of the report schedule

For projects whose Data time is set to
Device time, the name will be schedule
name + (device number + recording
interval).

Condition

The condition for executing the
schedule.

Task Task

Standard Print, Custom Print, Report
Print

Type

Report type
“---" is displayed for Standard Print
and Custom Print.

Output Print

None, Exist

Report File

PDF, Excel, None

Output Folder  Printer

The selected printer.

Folder

The specified output folder.

Details-of-schedule Screen

Details of schedule:Report 01

Absolute Time: 2018102115 14:19:20.000

print Bt
ReportFile None
Condilon Everyday 00:00:00
Task Standard Print
Group: o1-01
Range Prev. Day 00:00:00 - Curent Day 00:0000
PrintType: Trend Graph
Printout Setup: Print Graph Format: 1page
Line Thick “opt
Font Size ot
Tag Display Form TagNo
Graph Print Gid: Standard Grid
¥ i Grid Standard Grid

¥ s Zone: FullZone
Acive Y Ais Not 3

¥ Ads Column Num: 1
Legena No
Legend Positon Right
Golor Wode: Golor

L

On the Details-of-schedule screen, the details of the specified print schedule are displayed.
Setting the Report/Print function (/RP option): Psec. 5.1

5-20
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5.2.2 Report/Print History

The Report/Print History tab shows the print execution history in a list. The result of each
schedule is displayed as “Completed” or “Error” in the Execute column.

In addition, the following control buttons can be used to display the result of a selected
schedule, re-execute the schedule, and delete logs. However, with the exception of Delete,
you cannot operate more than one schedule at once.

(1) (2|) (©) 4) (®)

T

Sate X N | |
Refresh Display the details ) Open the reportfile Re-execute Delete

Execute Absolute Time Schedule Name | st g2

Completed 2015DEC/11 16:21:48.001 Report 01
Error 207FEBI15 15:48:54.00C Report 02
Completed 20 S/FEB/15 17:01:00.00¢ Report 02

(1) Refresh
Click this button to refresh the list.
(2) Display the details
Select a schedule from the list and click this button to display the details of the schedule.
(3) Open the report file
Select a schedule from the list and click this button to display the report file that has been
generated.
(4) Re-execute

Click this button to re-execute the selected schedule.
(5) Delete

Deletes the print execution log. From the list, select the schedule that you want to delete,
and click to display a confirmation message. Click OK to delete it. If you select schedules
while holding down the SHIFT key, you can delete several logs at once.

Nofte

* Anhistory of up to the most recent 100 schedules is displayed.

» Clicking an item name in the list sorts the list using the item. The first click specifies ascending
order; the second descending order. The sort condition is displayed with an icon next to the item
name.

» Entries whose schedule result is error are displayed using red characters.

IM 04L65B01-01EN
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Chapter 5 Using the Report/Print Function (/RP option)

5.3 Printing Recorded Data Manually
On GA10 with the Report/Print function (/RP option), the Custom Print and Custom Report

Basic Operation

buttons are displayed at the top of the Data File List screen @ (Page 8-1). You can use
these buttons to print manually.

5.3.1 Manual Custom Print

You can use the Custom Print button at the top of the Data File List screen to manually
perform printing that is equivalent to the Custom Print of scheduled (auto) printing.

Manual custom print —J.

1— Manual report output

Data File List [ Shaw Files in Link View Custam Print Custom Report Open Delate

Folder. CAUsers\Public\Documents\SMARTDAC+ Data Logging Software\Data\project_a =
Data List el lalellalle E

File Name ~| DataHumber | Record Interval Start Time ‘ End Time | File Size ‘ Comment1 EL

Data.dld 18econd 2014/11/07 16:09:22.000  2014/11/07 16:11:56.000 136734 s
Data-0001.did 39 1 Second 20141107 16:12:18.000  2014/11/07 16:12:56.000 79894

Data-0002 did 2 1 Second 2014/171/07 16:24:16.000 2014/11/07 16:24:17.000 61764 M
Data-0003.did 171 1 Second 2014/11/07 16:30:44.000 2014/11/07 16:33:34.000 144574 1
Data-0004.did 4 18econd 20141107 16:47.09.000  2014/11/07 16:47.12.000 62744 q
Data-0005.dld 4830 1 Second 20141107 17:01:19.000  2014/11/07 18:23:28.000 2476484

Data-0006.dld 55 1 Second 2014/12/24 09:41:51.000 2014/12/24 09:42:45.000 41430 @
Data-0007 did 590 1 Second 2014/12/24 09:46:49.000 2014/12/24 09:56:38.000 150100

Data-0008.did 663 18econd 2014/12/24 11:20:10.000  20714/12/24 11:4112.000 163974
Data-0009.dld 170 1 Second 2014/12/24 16:07:49.000  2014/12/24 16:10:38.000 54388

Data-0010.dld 68 1 Second 2014/12/24 16:11:12.000 2014/12/24 16:12:19.000 43784 @
Data-0011.did 237 1 Second 2014/12/24 16:14:54 000 2014/12/24 16:18:50.000 77922

Data-0012.did 200 18econd 2014/12/24 16:23:42.000  2014/12/24 16:27.01.000 70448

Data-0013.dld 208 1 Second 2014/12/24 16:44:04.000  2014/12/24 16:47:31.000 72064

X

7 Click the Data files Page icon @
The Data File List screen appears.

print.
The selected line turns blue.

Click Custom Print.

A Custom Print dialog box appears.

Click this to switch the display.

Click the file (a single file or several files that have been linked into one) you want to

' '
Custom Print x
Data File: Data-0001.did
Template File ® Server [= | C_Referto )
O Local = | (_Referto__)
Printer: [prtoo1-0m5075 &
Output Language [English Gal
Graph: Graph 1 [ Graph 2 || Graph 3 || Graph 4 ]
Print Type -
Range: [20187 02/ 15 &dl[09 - 11: 23]-[20187 02/ 15 &d|[08 - 11 31]
Group
Printout Setup:  Ling Thick
Font Size:
Tag Display Form :
Graph Print Grid:
¥ Asis Grid:
Y Axis Zone:
Active Y Axis Mo: =
( 0K ) (_cancel_)
. »
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Chapter 5 Using the Report/Print Function (/RP option)

4 Select the template file to apply to printing.
To use a template registered in GA10, click Server.
To use a template from a PC, click Local.

5 Click Browse. (This example assumes that Server has been selected.)
A Template File dialog box appears.
If you selected Local in step 4, a standard Open dialog box will appear.

f Y
Template File x
[ 1RepTempSample_B_DataTimetpl | 11
( 2RepTempSample_C_1page.tpl )] 12:

( 3:RepTempSample_HD tpl )] 13:
4 14
5 15
6 16:
7 17:
8 18:
g 19
10 20:
W »

6 From the list, select the template file you want to use.
The dialog box closes, and the template appears in the Custom Print dialog box.

7 Set the Print Type, Range, Group, and Printout Setup items on the Graph 1 to 4
tabs.

8 Click OK.

Printing will be executed.

Data File
Displays the data file name of the print target (line) selected in the list. If the entire file
name cannot be displayed, the end is abbreviated with ellipses.
Template File
Displays the name of template file selected from the server or the local PC. If the entire
file name cannot be displayed, the end is abbreviated with ellipses.
Server
Select this to use a template file registered in GA10. Registered templates will be
displayed in a list (Template File dialog box).
Local
Click this to use a template file from a PC. An standard Open dialog box will appear.

Printer

Displays a list of registered printers. Select a printer on the server side that will be used.
Network printers are not displayed. Select a local printer registered on the server PC.

Output Language

Specify the language for the printed materials. The date format and decimal point format
vary depending on the language.
Display format of each language: "‘Language vs. Date Format and Decimal Point Format” on
page 5-8
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Chapter 5 Using the Report/Print Function (/RP option)

Graph 1to 4

Print Type

Select the type of graph defined in the template file.
» Options: None, Trend Graph, Alarm List, Mark List

Range

From the start time of the first file to the end time of the last file in the selected data file
list.

Group
Select the number of the group to print from the Group 01 to 50 options.

Printout Setup
Same as “Printout Setup” on page 5-7.
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Basic Operation

5.3.2 Manual Report Output

You can use the Custom Report button at the top of the Data File List screen to manually
perform printing that is equivalent to the Report Output of scheduled (auto) printing.

7 Click the Data files Page icon @
The Data File List screen appears.

2 Click the file (a single file or several files that have been linked into one) you want to

print.
The selected line turns blue.

3 Click Custom Report.
A Custom Report dialog box appears.

Custom Report x
Data File: Datadid
Type Hourly + Dail [5])
Condition: Everyda [] 00
Template File @ sener = ] C_Referto )
O Local = (Referio )

File Name ]
Output Folder Data Folder & CiUsers\P DAC~ Data Logging Software\Datalpr..
Ouput Printer. @ HNo OYes
Output Language Japanese [
Report channel No. Tag Index Sum scale @

RO Off Qlsec Q'min Onour Qiday

RO oft Olsec Olmin Ohour Olday

RO off Qlsec Qimin Qhour Qiday

RO oft Olsec Olmin O hour Ciday

ROD5 L of Qlsec QImin QO ihour Qiday

RO oft Olsec Qmin O hour Qiday

RO off Qrsec Qmin QO hour Qiday

R008 off Olsec Q'min O hour Qiday

RO09 off Qisec Qmin QO hour Qiday

RO10 200010 off Ises Imin ihour ida

o I i3 I £ I £ I 1 I 1 16
Graph: Graph 1 [ Graph 2 ] Graph 3 ] Graph 4 ]
Print Type None

4 Select the report type from the list.

Type:
Condition:

Template File:

5 Set the condition.

Daily + Weekly
Daily + Monthly
Batch

Daily custom

(uondo gy/) uooung juudpiodey syy buisn

6 If you set the report type to Batch or Daily custom, select the save interval.

Type Daily custom &)
Condition: Interval 2| | Bhours ‘Ei

Base Time . . 00

Save interval 10min Ga| |4hours
Bhaurs
Template File: ® Server 8hours (__Referto
QO Local 12hours C_Reerie._)

24hours
File Name

IM 04L65B01-01EN
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7 Set the report output range.
Date: Click the drop-down button and select from the calendar that appears.
Time: Enter the hour, minute, and second.
A value cannot exceed the data start time or end time.

Range 2016/ 02/ 01 ()2 - 29- 19] - [2016/ 02/ 01 |12 - 45 58]
=

Template File: ® Server | C_Refertto_)
O Local = ]
File Name:
Output Folder. [DataFolder &) C\Users\PubliciDecuments\SMARTDAC Data Logging Software\DatalPr.
Print Out ®No OvYes
Output Language English [
Report channel N

o. Tag Index Sum scale £
RO01 J___TagQ001___J® Off Oisec OJmin O hour O rday

8 Select the template file to apply to printing.
To use a template registered in GA10, click Server.
To use a template from a PC, click Local.

9 Click Browse, and select the template.
The procedure for selecting the template is the same as step 5 in “Custom Print”
on page 5-9.
10 Set the File Name, Output Folder, Output Printer, and Output Language items.
11 Set the report channel.

12 Set the Print Type, Range, Group, and Printout Setup items on the Graph 1 to 4

tabs.
Graph 1 [ Graph 2 [ Graph 3 ] Graph 4 ]
Print Type: Trend Graph [5] L:'
Range Start Time: [oo]:[on]
End Time: Current Da [] '
Remge
[ [ I I [l [ I I ]
o.o0 6:00 12:.00 18:00 000 600 12:00 18.00 0:00—
Group: Group01 [3]
Printout Setup: Line Thick:
Font size
Tag Display Form Tag No. [5]
Graph Print Grict [Standard Gad — Gall &)
13 ciick ok.

Printing will be executed.

Data File

Displays the data file name of the print target (line) selected in the list. If the entire file
name cannot be displayed, the end is abbreviated with ellipses.

Type
Select the report type from Hourly + Daily, Daily + Weekly, Daily + Monthly, Batch, and
Daily custom.

Condition

The condition varies depending on the report type.
For details, see “Schedule Conditions and Range” on page 5-14.
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Save Interval (Hidden on the initial page because the report type is Hourly + Daily)
This appears only when the report type is Batch or Daily custom. Set the data recording
interval.

» Default value: 10min
e Options: 1min, 2min, 3min, 4min, 5min, 10min, 15min, 30min, 1Thour

Range
Set report output data range.
« Default value: From the start time to the end time of the selected data file.
* Input range: Same as above (from the start time of the first data file to the end time
of the last data file)

Template File

Displays the name of template file selected from the server or the local PC. If the entire
file name cannot be displayed, the end is abbreviated with ellipses.

Server
Select this to use a template file registered in GA10. Registered templates will be
displayed in a list (Template File dialog box).

Local
Click this to use a template file from a PC. An standard Open dialog box will appear.

File Name

Enter the name of the report file to create manually (using up to 60 characters).
The file name is created according to the following rules.

Input file name_creation time_serial number

Creation time: YYYYMMDDhhmmss (no spaces)

Serial number: 6 digits, 0 filled

Output Folder
Select the folder to save the generated reports in.
« Default value: Data Folder
» Options: Data Folder, Subfolder in the data folder, Specified Folder

Save Location Description
Data Folder Displays the GA10 data folder.

Example: C:\Users\Public\Documents\SMARTDAC+ Data Logging Software\Data
Subfolder in the data folder Enter the name of a subfolder in the data folder. Enter up to 255 characters.
Specified Folder Enter the path to the specified folder or use the Browse button to specify it. When

entering the path, use up to 255 characters.

Output Printer

Select whether to print. Selecting Yes displays a list of registered printers. However,
Output Printer does not appear for an Excel template file. (When using an Excel template,
you cannot print directly from GA10).

Output Language

Specify the language for the printed materials. The date format and decimal point format
vary depending on the language.

Display format of each language: "‘Language vs. Date Format and Decimal Point Format” on
page 5-8
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Report channel
Set the channel to output in reports.

Nofte

The device’s LOG input channel is not output. If a tag corresponding to the device’s LOG input
channel is specified, the report channel value will be blank, and the status will be error.

a b c
|
No. Tag Index | Sum scale ® @
RO01 |Ce__Tag 0001 J@® off Olsec Q /min Q Ihour Q Iday
RO0Z | Tag 0002 g@ofr Oisec O imin O ihour O iday
RO03 )(____Tag0003 ® off Olsec QO Jmin O Ihour O Iday
RO04 | b ® OfF Olisec O imin O ihour O iday
RO05 | ® Off QOlisec QO imin O ihour O iday
RO0G | ® Off Olisec O imin O hour O iday
RO07 ® Off Olsec O Imin O hour O Iday
RO08 | ® OfF Olisec O imin O ihour O iday
i | 1 I 1 I i3 ! 3 I 1 | L
[—d L e
Report Channel Settings
Symbol Item Name Default Range Description
Value
a No. R001to 001 to 100 (fixed) Report channel number. Click a No.
R100 cell to select the row.
b Tag Index! Tag0001 Tag range (including math tags) Select the tag. Click the tag to display
to of the project. the Tag Index dialog box. Then, click
Tag0100 the tag you want to specify.
c Sum scale Off Off, /sec, /min, /hour, /day Displays the sum scale of the report
channel.
d Auto increment None R001 to R100 Assigns tag indexes in ascending
button order from the first tag in the selected
range.
e All On button None R001 to R100 Clicking the button collectively turns
on the sum scales in the selected
range.

*

To select a tag, click a tag button under Tag Index, and select the tag from the displayed dialog
box shown below. If the Math function (/MT option) is installed, you can also select math tags.

(tag index x|
[[] show [Device No.: Device Name: Channel No
(& Tag 0001 ) ( Tag 0002 )l
C Tag0003 ) ( Tag 0004 V]
( Tag 0005 J( Tag 0006 J
( Tag 0007 J( Tag 0008 )
( Tag 0009 ) ( Tag 0010 )
C Tag 0011 J( Tag 0012 )
( Tag 0013 ) Tag 0014 "]
( Tag 0015 I Tag 0016 )
( Tag 0017 ) ( Tag 0018 )
( Tag 0019 J( Tag 0020 )
s Tan0n21 A Tan oz 1)
Graph 1to 4
Print Type

Select the type of graph defined in the template file.
» Options: None, Trend Graph, Alarm List, Mark List
Range

Set the data range of the graph to be output in reports.

» Display format: If the report type is Batch, an absolute time (clock time) is displayed.
Otherwise, a relative time (interval from the current time) is
displayed.

» Default value: The start time and the end time of the selected data file if the report
type is Batch. Otherwise, it is the same as the graph range setting
when auto printing report schedule is set.

* Input range: From the start time to the end time (maximum-minimum value) in the
report output range if the report type is Batch. Otherwise, it is the same
as the graph range setting when auto printing report schedule is set.

For details, see “Schedule Conditions and Range” on page 5-14.
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Group
Specify the number of the group to print. Select the number of the group to print from
the Group 01 to 50 options.

Printout Setup
Same as “Printout Setup” on page 5-7.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

6.1 Monitoring on the Monitor Page

This section explains the Monitor Page for Detail Settings e Close

mode. In Simple Settings mode, the Monitor Page Click to close the project.
consists of the Trend Monitor Set and Digital Monitor Set. . . . . .
The operation is the same. * Viewing the Project Status in the Project List Page

6.1.1 Displaying the Data Collection Status Click the EE icon to show the Project List Page. You

You can monitor data collection in the following page. cgn view the prOJect..Status.
! '\ Data not being monitored

—m— Client and server EI Projectt £
__— communication status
Project tab Owner: admin
3 Start and stop data monitoring
2 MNot monitoring ~ Dat itoring i
IIIIIIIIIIIIIIII e MsMonitoring | B Project 9 ata monitoring in progress
s¢—— Start and stop data recording
Tag 0004 quOt recording Owner:  admin
0,1482 &, Recording A ——  The boundary color changes.
"""" v Manual Save _ _
= . f | W | ‘| Data recording standby
@ Setting Page Project1 ¥
locHRaENs Monitor Page '
Status Page Owner: admin
I ' E Data files Page
<z Close ) )
i —3 ‘| Data recording in progress
B Projectt ¥
Owner: admin
A 4
* Client and Server Communication Status You can check the alarm status and alarm ACK status
The client and server communication status is indicated for the opened project.
as Good, Ordinary, or Bad. [J :r.__ When an alarm is not occurring
. Projectt i
* Project Tab ' ol
The tab shows the project name, and operation icons. Owner:  admin _“
The project alarm status is indicated in red.” |4 admin  locing Y

*  Blinking red: Alarm occurring
Solid red: Alarm acknowledged

: When an alarm is occurring
» Start and Stop Data Monitoring :

: , "o | (indicated in red
Click to start or stop data collection. 8| (indicated in red)

) m
Owner:  admin

 Start and Stop Data Recording | 4 sdmin  :Loding

Click to start or stop data recording. Related topic: P> Sec. 6.6.3

» Setting Page, Monitor Page, Status Page, and Data If communication with a data acquisition device is
files Page disconnected, you can check which projects are
Click to display the corresponding page. affected.
Setting Page P> Sec. 3.2, Sec. 3.3 - S oY ; ;
Monitor Page p Sec. 6.1.2 | B Projecta B3 ; Normal device connection
Status Page p» Sec. 6.7 = = | (displayed with a green icon)
Data files Page p Sec. 8.1 | ELEE milEL <
4 admin :anﬂ'lg : 3

* Manual Save Button

When clicked, the recording data is split at that = ': -\ Disconnected device connection
I

| : ..
position. This button is valid only during recording. | [ Project a : o
You can show or hide the button by selecting Manual ol

Save Button from the View menu. i C 0 e
k A admin :anki_n__g__

(displayed with a red icon)

Related topic: P> Sec. 6.6.4
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Chapter 6 Monitoring Data Collection

6.1.2 Displaying the Monitor Page

Open a project, and click the Monitor Page icon on the
Project tab to open the Monitor Page.

In Simple Settings mode, the Monitor Page consists of
the Trend Monitor Set and Digital Monitor Set as shown

Tag 0002 Tag0003 |

|
-0,3816‘\

Tag 0007 iTag 0008

1,79

Monitor set boundary  Monitor sets Maximize icon

In Detail Settings mode, the Monitor Page that you
configured opens.

wostona B (1€

Tag 0004

3)
o BEN M=

Inlbo00 Be

Monitor set boundary  Monitor sets Maximize icon

¢ Resizing the Monitor Set
To resize the Monitor Set, Resize the Monitor Set on
the Acquisition & Monitor Setting page must be set to
On.
Move the pointer near the boundary of the Monitor Set
to change the pointer to @ or . In this condition,
drag the pointer to move the boundary to the desired
position.

* Maximizing the Monitor Set

Click the Maximize icon |1} in the upper right of the
Monitor Set to expand the Monitor Set to fill the entire

window. Click |[5] to return to its original size.

* Full Screen
If you click Full Screen on the View menu, the selected
Monitor Set is displayed in a full screen. When there
are multiple Monitor Sets, the selected Monitor Set is
indicated with a light blue frame. Press ESC to change
the full screen display back to the normal condition.

Maximize Full Screen

» Switching the Display Group at Once

On the View menu, click Group Link. Or, click the &=
icon on the toolbar.

When you change the display group of one Monitor
Set, the display group of other Monitor Sets also
changes.

To cancel linking, on the View menu, click Group
Link to unselect it. Or, click the icon on the toolbar to
unselect it.

6-2
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6.1.3 Setting General Display Options

* Tag Display Form
From the list of options that appears when you click
Tag Display Form on the View menu, select the items
to display as tags. This applies to all pages.

* User Display Form
From the list of options that appears when you click
User Display Form on the View menu, select the
items to display as user names. This applies to all
pages.

e Screen Background Color
On the View menu, click Style, and click Light or
Dark to select the background color. This applies to all
pages.

* Date Format
From the list of options that appears when you click
Date Format on the View menu, select the date
format. This applies to all pages.

* Month Display Form
From the list of options that appears when you click
Month Display Form on the View menu, select the
month display format. This applies to all pages.

Item Description

Digit Example: “10” for October

Character |Example: “OCT” for October

¢ Decimal Point
On the View menu, click Decimal Point to select the
symbol to use for the decimal point. This applies to all

pages.

Item Description
Period

\ Comma

6.2 Monitoring on the Trend Display
6.2.1 Displayed Content

Scan interval

Group tab
Trip line value
Waveform Trip line
Grid Y-axis
- O 5 [ [ e
[EE)
Badlinuy Bocfsssns|T
e
n S
B
/ \ \‘\\ / @
/ A\ [/
/7 MRS ry il &
\\ /01,22l 42
/ \ i § 4

Active

waveform mark
Vertical splitter

Time axis scroll bar

Legend Alarm display Time axis

Scan Interval
The data collection interval.

Group Tab
Switches the displayed group. Alarms occurring in tags
of each group are indicated in red.

Waveform

Displays each waveform according to its corresponding
data tag color.

P See "Waveform Display" on next page.

Grid

The grid shown in the waveform display area.

Trip Line

Trip line assigned to a tag. Only the trip line of the
active waveform is displayed.

Moving the trip line
Drag the value of the trip line to the desired position.

Y-axis
Displays the Y-axis scale, title, and unit. Each y-axis is
displayed according to its corresponding tag color.

Legend
Displays tags, tag colors, waveform display on/off
check boxes, and Y-axis display on/off check boxes.

Alarm Display
Displays alarms using bars from occurrence to release.

Time Axis
The right end shows the most recent data time.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

¢ Vertical Splitter
Use the vertical splitter to adjust the width of the Y-axis
display area.
When you move the pointer over the vertical splitter,
the pointer changes to <. In this condition, drag the
pointer to expand or reduce the width of the Y-axis
display area.

Waveform Display

¢ Active Waveform
The front-most displayed waveform is called the active
waveform.

¢ Changing the Active Waveform
Click a tag in the Legend or a Y-axis to make the
corresponding waveform the active waveform. When
a Y-axis is shared among multiple waveforms, the
waveform with the smallest waveform number will
become the active waveform. The active waveform
mark (a) moves below the Y-axis of the active
waveform.

¢ Automatically Updating the Displayed Data (monitor
mode)
When the time-axis scroll bar is at the right end
or when it is not displayed, the data display is
automatically updated. This mode is called monitor
mode. The right end of the waveform is the most recent
data.

¢ Viewing Past Data (playback mode)
Move the time-axis scroll bar from the right end to
view past data. This mode is called playback mode.
Automatic updating of the data display stops.
Returning the scroll bar to the right end switches GA10
back to monitor mode. If you do not operate the scroll
bar for 30 minutes, GA10 will return to monitor mode.

When Collecting Data Using Device Time
The window is divided by a combination of device
and scan interval. Trends of up to four devices can be
displayed at each scan interval.

6.2.2 Changing the Display
You can change the display using the icons in the upper
right.
Show or hide the legend
Zoom in on or out of the time axis
Y-axis display zone
Waveform line thickness
Grid density

Waveform
display limit

=Y BT EE=EFET T B

e Show or Hide the Legend
You can show or hide the legend.

e Zoom in on or out of the Time Axis
You can zoom in on or out of the time axis.
* Y-axis Display Zone
You can switch the Y-axis display zone.
p Sec.6.2.3

* Waveform Line Thickness
You can change the waveform line thickness. This
applies to all waveforms.

* Grid Density
You can change the grid density.

¢ Waveform Display Limit

e

o o0 eon Tedon w T Tedom
AosovieTie s = s i3

With limit Without limit
When you click the icon to select it, waveform display
limit is enabled. When you apply the waveform display
limit, the Y-axis display range is limited to the minimum
and maximum values that you specified using Scale
in Display Group. Measured values that are less than
the minimum scale value are set to the minimum
value, and values that are greater than the maximum
scale value are set to the maximum value. When you
click the icon to unselect it, waveform display limit is
disabled. In this condition, measured values outside the
scale are displayed as they are.

Nofte

If multiple operation screens are displayed on the same
PC, the display conditions stored in the PC are shared.
Be careful when you change the display conditions on the
screen.

Display conditions when multiple screens are shown:

P sec. 6.9.6

IM 04L65B01-01EN



Chapter 6 Monitoring Data Collection

6.2.3 Controlling the Y-axis

¢ Y-axis Display Zone
You can select the Y-axis display zone.
Y-axis display zone specifies the scale position and
length. It is the waveform position and range.
Full zone
Slide zone
Auto zone
Free zone

Eeallmmy Boo[@@Ean £

» Full Zone: Displays all waveforms in the maximum
range

» Slide Zone: Displays each waveform cascaded from
the top to the bottom of the waveform display area

* Auto Zone: Divides the waveform display area
into equally spaced zones in accordance with the
number of waveforms and displays the waveforms

» Free Zone: Displays waveforms in user-specified
zones

¢ Operations in Free Zone
In Free Zone mode, you can change the Y-axis display
zone as you like.
Zoom in/out on the Y-axis
When you move the pointer near the lower or upper

edge of the Y-axis scale, the pointer changes to II In
this condition, drag the pointer to move the desired
position to zoom in or out on the Y-axis.

Moving the Y-axis

When you move the pointer on an Y-axis scale, the
pointer changes to é In this condition, drag the pointer
to move the desired position to move the Y-axis to the
desired position.

¢ Compact Mode and Detail Mode
A Y-axis can be displayed in compact or detail mode. In
compact mode, scale values are hidden, narrowing the
width of the Y-axis.
In detail mode, if you move the pointer on the Y-axis
and click the :ﬂ% icon at the top of the Y-axis, the
mode changes to compact. In compact mode, if you

click the g icon, the mode changes to detail.

* Scrolling a Y-axis Scale
When you move the pointer on an Y-axis scale, the

PN
pointer changes to <Q or !
Spinning the mouse wheel in this condition causes
the Y-axis scale to scroll, maintaining the difference
between the upper and lower limits of the scale.
Click the scale initialization icon W to return the scale
to its original position.

e Zooming in or out on an Y-axis Scale
When you move the pointer on an Y-axis scale, the
pointer changes to <Q or é Clicking when the pointer
is 1Q shows a scale zoom in/zoom out icon .
Click an arrow of the icon or spin the mouse wheel to
zoom in or out on the scale value in reference to the
icon position.
Click the scale initialization icon W to return the scale
to its original position.

e Changing the Active Waveform
P “Waveform Display”

6.2.4 Showing and Hiding Waveforms (Using the
Legend)

The legend can be displayed in tag display mode or axis

display mode. Each time you click the display mode icon,

the mode toggles between tag display and axis display.
Tag display mode Axis display mode

Display mode icon

=] [7ag 0001 2 -1 Tag00011v]

(2 W Tag 0002 t@ [~ Jaq 0001 ]

2 W g 0003 W Tag 0002
{2 M Tag 0004 Tag 0003[V]
Tag 00041]

L2 M ag 000e

Tag name Click + to display tags.
Tag color Axis check icon

Waveform check icon

» Tag Display Mode
The tags assigned to the display group are displayed.
Waveforms whose waveform check icons are selected
are shown. If you click an icon to clear the check box,
the waveform will be hidden.

* Axis Display Mode
A list of Y-axes used by tags is displayed. Expand a
Y-axis to display a list of tags that are using the Y-axis.
If you click an Y-axis check icon to clear the check box,
the axis and waveform data sharing the axis will be
hidden.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

6.2.5 Viewing the Alarm Occurrence Status

When you click Alarm on the View menu to add a check
mark, alarm bars are displayed in the alarm display area.
Remove the check mark to hide the alarm bars.

Alarm bar

.................... ———————
T T T T
14:30:00 14:35:00 14:40:00 14:45:00 14:50
Absolute Time [h:m:s] Smini

The bars show the data range in which alarms are
occurring for the tags displayed in the group. The alarms
are from the top alarm level 1, alarm level 2, alarm level 3,
and alarm level 4.

» Alarm bars are displayed with tag display colors.

» The alarm bars of the active waveform area always
shown in front. If the alarm bars of multiple tags are
overlapped and you want to view the alarm bars in
the back, make the appropriate waveform the active
waveform.

6.2.6 Reading Values with Cursors

You can use cursors to read values from waveforms. You
can display two cursors: cursor A and cursor B.

¢ Showing and Hiding Cursors

1 Click a point in the waveform graph.
Cursor A (vertical line) appears, and the value at the

intersection of the cursor and waveform is displayed.

2 Drag the cursor, and release the mouse button.
Cursor B (vertical line) appears, and the value at the

intersection of the cursor and waveform is displayed.

3 To clear the cursors, on the View menu, click Erase

cursor.
If the cursor value displays of multiple tags are
overlapped and you want to view the cursor values in
the back, make the appropriate waveform the active
waveform. Or, use the cursor value dialog box.
When a cursor is displayed, the waveform display
enters playback mode, and automatic updating of data
display stops.

Cursor Cursor
I s et
Fie Eot View Prie Operstion User fidp
josl @ [t 5 o | - Fimem
rfup o5 | Group s | [F=]
o alnhy BooMEuums )|
> : H
AN
78\ "
7 NN &
\

+ oty A b B
\\ E
/ AW =
/ 9 0002 VAN R C=]
/ et VA o =
iy \ / g Cl
t 0001 - h Tag 0001 - o 8 x|
2= VL 8 i

144000 164500 145000 125500
‘Absoute Tie Ims]

= -

e Cursor Value Transparency
On the View menu, click Cursor value transparency
to choose Transparent or Opaque.

¢ Reading the Difference between Two Cursors
On the View menu, click Cursor value. The Cursor
Value dialog box appears. From this dialog box, you
can read the difference between cursors A and B.
Click the cursor move icon () to move the cursor by 1
data point.

Alarm indicator
(I:ursor movement icon

Cursor Value x
1 Second Cursora Cursor®
Data to. [EEE B ol

Zovaie

e | resz00

00:0000.000

Value A

ValueB___| ValueBValueA

s [ o 00000
osers [ oot 00000
s [l v 00000
rsn [l e 00000

» Data No.
A sequence number of collected data points taking
the first collected data point to be zero.

* Alarm indicator
The status of alarm level 1, alarm level 2, alarm
level 3, and alarm level 4, are displayed from the

left.
Displayed Content Description
Red Alarm occurrence
Green Alarm release
Gray Alarm not set

When Alarm in the View menu is not checked,
alarm indicators are not shown.
To close the cursor value dialog box, click the x icon
in the upper right.

6.2.7 Displaying Statistical Results

The minimum, maximum, P-P, mean, and rms values for
each waveform in the range specified by cursors A and B
are calculated and displayed.

1 On the View menu, click Statistics.

Number of the first data point in the computed region (cursor A)

Number of the last data point in the computed region (cursor B)
‘ Recor‘npute

-
Statistics[Group 01:1 Second]

Time i
Section 445 - CERIT/12/00 11:64:12.000 - 2017/12/01 1186224000

Tag Index MIN | owmax | P-P |
-1.6877 -1.2313 0.4364
20 00021V] -1.4252 -0.7614 0.5438
20 0003(V] -0.8323 -0.2783 0.8140
20 00041V -0.3987 0.2437 08424
ag 00050V] 0.1220 0.7432 0.8272
ag 00061V 0.8348 1.2036 0.5830
20 0007]]
10 0008V .
o 000N Column show button |
I
Column show button
(This appears when the
column is hidden.)

» Calculated results are not synchronized to the cursor
positions or waveform group. If you change the cursor
A or B position or the display group, click Re-calc. to
update the calculated results.

* The formula for calculating the rms value is as follows:

RMS = [ L5 (x,)
N k=0

n : Number of data
Xk : value
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Chapter 6 Monitoring Data Collection

¢ Copying Data to the Clipboard

Clicking the Copy button copies the contents of the
Cursor Value dialog box to the clipboard. You can paste
the contents to a tab separated text file or to an Excel
spreadsheet.

* Showing or Hiding Columns

When you move the cursor over a column title, a hide
button appears. Clicking the hide button hides the target
column. To show a column, click the show button.

6.2.8 Adding Marks

You can add marks to data. To add a mark, specify the
mark string and the data to add the mark to.

1 Type the string in the mark edit box.
You can edit the displayed string as well as select
from a list of strings that you used in the past from
the drop-down menu. The drop-down menu displays
the most recent five strings.
Mark edit box
Current group
All groups

Hst o2 makh & [[es]| @ [Mara

[ v o [ e

2 Click the data position you want to add a mark to

display a cursor.
To add a mark to the most recent data, perform step
3 in monitor mode. Step 2 is not necessary.

3 On the Project menu, click Append Mark and then
Current Group or All Groups. Or, click the Current

Group or All Groups icon.
A mark is added to the specified position.

Mark

@ Data Logging Software-Tacjnin-{Profe
I7OUR REE RV JOSIHNP BEAR 2-HU) ALTH

H31c? whbh @ |[es] @ [Maria P o e @]
BHagllmny BoofEHE&EE$

= [T

ey

| OES & F B

e

e ?,

o
e ——
ey Tesghi00 Tezdb:on Teedbion Tezsbzon
ErAT) 135 encs] /A

* Adding a Mark to the Current Group
If you select Current Group, a mark is added only to the
group shown on the trend monitor.

¢ Adding a Mark to All Groups

If you select All Groups when data is being collected

using PC time, a mark is added to all groups.

If data is being collected using device time,

* In playback mode, a mark is added at the same
position as cursor A to all display groups that contain
tags of the same device and of the same collection
interval as the monitor set subwindow that you
added a mark to.

* In monitor mode, a mark is added to all groups.

¢ When Marks Are Overlapped
Sometimes marks overlap and the string of the lower
mark cannot be read. Clicking a mark with Shift held
down moves the mark to the back.

Nofte

* Marks that have been added cannot be deleted or
edited.

* Mark information is saved in data files. (Only binary
data files.) Mark information added to data positions
in files that have already been closed is saved in the
data file that is currently being recorded. You can view
these marks by displaying connected data files.

¢ The maximum number of marks that can be added
from the start to the end of monitoring is 10,000.

¢ The maximum number of marks that the expression’s
mark function (/MT option) can add to a data point at
the same time position is 200.

* The data range that can be referenced in playback
mode is up to 3600 points from the most recent
acquired data. However, if recording is in progress
and the recording interval is the same as the data
acquisition interval (Monitor Interval), data can
be referenced up to the start point of recording
(exceeding the 3600 point limitation). Displaying may
take some time if the amount of data to be played
back is large.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

6.3 Monitoring on the Digital Display
6.3.1 Displayed Content

Tag display area —s

Tag 0004

0,4668

Alarm indicator
Tag color

l Tag name Measured value

1,4265

IIIIIIIIIIIIIIIIIIIIIIIIIIAIIIIIIIIIIIIIIIIII

Measurement bar display

¢ Tag Display Area
Tag alarm status is indicated in the alarm color.

* The alarm colors specified on the Acquisition &
Monitor page.

¢ Alarm Indicator
The status of alarm level 1, alarm level 2, alarm level
3, and alarm level 4, are displayed from the top. Tag
alarm status is indicated in the alarm color. Alarm
indicators show a character that indicates the alarm
type.”

It is not shown if the display area is limited.
Characters that indicate alarm types p> Sec. 6.5.3

6.3.2 Showing and Hiding Alarm Indicators
When you click Alarm on the View menu to add a check
mark, alarm indicators are shown. To not show alarm
indicators, click Alarm on the View menu to unselect the
command.

6.4 Monitoring on the Meter Display
6.4.1 Displayed Content

There are bar meters and analog meters.

Tag color
l Tag name

Measured value

Bar meter

Bar meter

e Unit

Alarm zone and
alarm value mark

Alarm indicator

Tag color
J Tag name

Analog meter

Analog meter

Measured value
and unit

Alarm indicator

» Tag Display Area
Tag alarm status is indicated in the alarm color.

¢ Alarm Zone

The zone where alarms occur is indicated in the alarm
color.

e Alarm Value Mark (bar meters only)
Indicates the alarm value of data collection devices.
This appears when the alarm type is set to high limit,
low limit, difference high limit, difference low limit, delay
high limit, or delay low limit.

Displayed Content |Description

. Indicates that the alarm type is high
limit or difference high limit.

. Indicates that the alarm type is low
limit or difference low limit.

E Indicates that the alarm type is delay
high limit.

H Indicates that the alarm type is delay
low limit.

¢ Alarm Indicator
The status of alarm level 1, alarm level 2, alarm level
3, and alarm level 4, are displayed from the left. Tag
alarm status is indicated in the alarm color. A character
that indicates the alarm type is displayed.”

* ltis not shown if the display area is limited.

Characters that indicate alarm types P> Sec. 6.5.3
You can show and hide alarm indicators.
p Sec. 6.3.2
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Chapter 6 Monitoring Data Collection

6.5 Monitoring Alarms

An alarm Monitor Set displays alarm information of
monitored tags in three formats.

6.5.1 Group Overview

Click the Group tab. Alarm information is displayed at the
group level. Groups that do not have alarms set on any
tags are not displayed.

Group name

(| 5 [ Ack] [

ntong 7 [ €

E e [ (=3

¢ Alarm Occurrence Display
Alarm occurrence is displayed in the alarm color in the
group display area.ACK operation can be performed on
groups in which alarms activated.

6.5.2 Tag Overview
Click the Tag tab. Alarm information is displayed for tags
in the display group. Tags that do not have alarms set are
not displayed.
Alarm indicator
Tag name

Tag 0002
L
Tag 0003 Tag 0004
H L
Tag 0005 Tag 0006
H

Tag 0008

T

e
=
2
&
d
&l
E3

Tag 0007
L

Tag 0009 Tag 0010

H

¢ Alarm Occurrence Display
Alarm occurrence is displayed in the alarm color in the
tag display area.ACK operation can be performed on
groups in which alarms activated.

¢ Alarm Indicator
The status of alarm level 1, alarm level 2, alarm level
3, and alarm level 4, are displayed from the left. Tag
alarm status is indicated in the alarm color.

6.5.3 Alarm Overview

Click the Log tab. The history of all monitored tags’ alarm
occurrences and releases is displayed. The top line is the
most recent entry. The display is automatically updated as
alarms occur and are released.

If data is being collected in device time, the history is
displayed by dividing the window for each device.

Most recent alarm

Alarm list Scroll bar

tion User Help

@ ]
yootoig 1 [[|E

x| 0, 6)E] (vl F.

Alarm level
Alarm type
Status

Date Time Tag name

l
| @ 4 Z013/10/25 13:20:27.000 Taz 0002 (1 H On

{ Alarm type icon
Alarm status icon

* Most Recent Alarm
The top line always displays the most recent entry.

e Alarm List
The history of alarms are displayed in the order of
occurrence. Move the scroll bar down to view past
alarms. This condition is called playback mode. In
playback mode, the history is not automatically updated
(the line showing the most recent alarm is automatically
updated). Move the scroll bar to its top position to exit
playback mode.

¢ Alarm Status Icon
Indication

Description

Alarm-on color” Alarm occurrence

Alarm-off color* Alarm release

* The alarm colors specified on the Acquisition & Monitor page.
If ACK has not been executed, the icon background blinks.

e Clearing the alarm log
On the Project menu, click Clear Alarm Log to clear the
alarm log of all devices.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

* Alarm Type Icons

Displayed Content

Description

High limit alarm, measurement high limit
alarm, deviation high limit alarm, setting
high limit alarm, output high limit alarm

Low limit alarm, measurement low limit
alarm, deviation low limit alarm, setting
low limit alarm, output low limit alarm

Difference high limit alarm

Difference low limit alarm

High limit on rate-of-change alarm

Low limit on rate-of-change alarm

Delay high limit alarm

Delay low limit alarm

Deviation out limit alarm

Deviation in limit alarm

O)(O|e=> 4h OO

Other alarm

¢ Date and Time

The date and time of alarm occurrence and release.

e Alarm Level

Displayed Content |Description
L1 Alarm level 1
L2 Alarm level 2
L3 Alarm level 3
L4 Alarm level 4
¢ Alarm Type

Displayed Content

Description

H

high limit alarm

L Low limit alarm

dH Difference high limit alarm

dL Difference low limit alarm

RH High limit on rate-of-change alarm
RL Low limit on rate-of-change alarm
tH Delay high limit alarm

tL Delay low limit alarm

PVH Measurement high limit alarm
PVL Measurement low limit alarm
DVH Deviation high limit alarm

DVL Deviation low limit alarm

DVO Deviation out limit alarm

DVI Deviation in limit alarm

SPH Setting high limit alarm

SPL Setting low limit alarm

OTH Output high limit alarm

OTL Output low limit alarm

ETC Other alarm

o Status

Displayed Content |Description

ON

Indicates that an alarm has occurred.

OFF

Indicates that an alarm has been
released.

¢ Changing Alarm Types during Data Collection and

Recording

If alarm types (including use and not use) are changed
on the connected device side during data collection,
recording, or record standby, the changes are reflected
on the alarm monitor. Changes in alarm types are

not reflected in the alarm list of the recording file.
Further, this applies only when the connected device
is a SMARTDACH+ series (GX/GP, GM) device and the
GA10 version is R2.02.xx or later.

The changes are reflected in the following areas.

» Digital, alarm, and meter monitor sets

« Alarm display of the value display area in the cursor
value dialog box

« Alarm list display

» Alarm zone and alarm value mark of the meter
display

IM 04L65B01-01EN
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6.6 Checking Alarms

6.6.1 Displaying the Alarm Overview Dialog Box

While displaying the Monitor Page, click Alarm List on the
View menu to display the alarm overview dialog box.

The displayed content and operation in this dialog box are
the same as those of the alarm list of the alarm Monitor
Set.

Click % in the upper right of the dialog box to close it.

* Page Switching and Dialog Box Display
The dialog box stays open until you close it. If you
move to another page with the dialog box open, the
dialog box disappears. But, if you return to the Monitor
Page, the dialog box will appear again.
If you change the project while the dialog box is open,
the alarm information of the opened project will be
displayed in the dialog box.

6.6.2 Notification of Alarms and Communication
Errors with Sound

On the Operation menu, click Warning Beep to add a

check mark. When an alarm or communication error with

connected devices occurs, the PC will beep.

To stop the sound, on the Operation menu, click Stop the

Warning Beep. Or, click the icon.

To disable the alarm sound, on the Operation menu, click

Warning Beep to remove the check mark.

Nofte

» To generate sounds, the PC must be equipped with a
sound generating function and sound must be turned
on.

* You cannot change the sound.

¢ Sharing of the Temporary Suspension of Warning
Beeps
If multiple clients are connected to the same server, the
Stop The Warning Beep operation can be shared.
On the Operation menu, click Share the Warning Beep
across clients. Add a check mark to use shared mode;
clear it to use non-shared mode. You can configure
this function on each client. If warning beeps are
temporarily stopped on a client that is set to shared
mode, warning beeps are also stopped on other clients
(see Note). If set to non-shared mode, other clients are
not affected even if you perform the same operation.

Nofte

» The suspension of warning beeps is shared among
clients that are connected to the same server and that
are set to shared mode.

» This mode setting is stored internally, so it will be valid
when the clients are restarted the next time.

6.6.3 Perform Alarm ACK Operations

If an alarm occurs in a monitored tag after data monitoring
is started, the corresponding area blinks in the alarm color
to indicate the alarm occurrence. An alarm ACK operation
refers to the act of stopping this blinking.

The following three ACK operation methods are available.
The blinking alarm indication stops when you perform an
ACK operation.

» Alarm ACK on all tags
On the Project menu, click Alarm ACK. Or, click the

icon.

» Alarm ACK on each group
Open the Group tabbed page of the alarm monitor
screen, click the applicable group to perform ACK
operation.

» Alarm ACK on each tag
Open the Tag tabbed page of the alarm monitor screen,
click the applicable tag to perform ACK operation.
To display the alarm monitor screen, see section 3.3.5,
“Registering Data Collection Method and Monitor Page.”

* Alarm ACK Operation and Alarm Indication
Transition
The following figure shows how the alarm indication
transitions as an alarm occurs, is released, and is
acknowledged with alarm ACK. The figure shows an
example of a Digital Monitor Set tag.

H Tag 0001

H  Tag 0001

- 1,5151 ease

Alarm ACK

Blinks in alarm-on color

—
[Alarm releasel Alarm ACK ]

# Tag 0001 Tag 0001

1,7143

\'
Turns on in alarm-on color

Blinks in alarm-off color

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

« If an alarm occurs and is released before the alarm
ACK operation, the color changes to that when
alarm is not occurring, but blinking continues until
the alarm ACK operation is executed.

« If an alarm occurs again after an alarm ACK
operation is executed, blinking will start again.

* Alarm ACK operations do not affect data collection
devices.

¢ Sharing Alarm ACK Operations
The alarm ACK status of a project can be shared
among multiple clients that are connected to the same
server. Alarm ACK can be shared by setting Share
Alarm ACK under Others on the Access&Others
Setting Page. This feature is set to OFF by default. If
set to ON, the setting is applied starting from the next
acquisition.

Access & Others

@ Data Logging Softwarl — admin] - [PITOT] - o x
Fle Edt View Plject Operaion User Help
H3oe mne B0 eBoB 2 © & [ Ees) [ B o ]
S vewoe D=
[ Manager o Operator ] Wonitor =
B4 T vl @ Usert ] e Userd ] 3 Users IR
Mt Tag v
€S vipioy v g
5
2 Recort v
[ revorprmt | v
I I
£ eman vl o
(0@ oo 0| a ] 1 weo ] [T r—
X User? ] & Users ] AlUsers ]

Others

Lock State Oon__ @OFF
DDE Server Oon __ @OFF
Share Alarm ACK: Oon @O
Modbus Server: Oon  @OoFF
Modbus Address: 1

If a single client performs an ACK operation for an
alarm that occurs in a project whose this setting is set
to ON, the blinking stops on all clients connected to
the same server. If set to OFF, other clients are not
affected even if you perform an ACK operation on a
single client.

Related topic:? Sec. 3.3.11

6.6.4 Performing an Acknowledge of Device
Communication Interference

If communication with connected devices is disconnected
during data collection and recording, the icon on the
toolbar blinks in the alarm color to indicate the error.
Acknowledge of Device Communication Interference is an
operation for checking the communication error and the
affected projects.

» Stopping the Warning Beep
To stop the warning beep, click the icon or

click Stop the Warning Beep from the Operation
menu.
You cannot stop the sound just by performing an ACK
operation. Note that even when the beep is stopped,
if a communication disconnection occurs again, it will
beep again.
Related topic: Sec. 6.6.2

* Checking the Device Communication Disconnection
On the Operation menu, click Acknowledge of Device
Communication Interference. Or, click the =i
icon. The icon blinking stops, and the Project List Page
appears. On the Project List Page, you can determine
which projects are affected by the communication
disconnection by checking the changes in the
communication status icon of each project. The status
icons are valid only when the project is open.

Blinks in warning-on color

—/
lBIinking stops]

ACK

Move to the Project List Page

Communication status icons

Disconnected Normal

& === 1= 5 b T G )
[EE Project_a o= | BB Project a
—— o '
i . i
| Owner:  admin ﬁ | Owner:  admin |
| & admn  -Locking | & admn  lockng |
At least one device All devices

is disconnected. are connected.

* When communication is restored, data collection and
recording resume.

* If communication recovers before an Acknowledge of

Device Communication Interference is performed, the
communication status icon will return to normal.
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6.6.5 Showing the Alarm Indication Window in
Front

The client window can be shown in front when an alarm
occurs.

* You can set it by clicking Move The Window To The
Top When Alarm Occurred on the View menu.

« If there are multiple client windows, you can select
whether to show the window in front for each of the
windows.

 If an alarm occurs in an opened project, the
corresponding window moves to the front of all other
windows (except the window you are using).

» Even when an alarm is activated, if the alarm type
changes, it is considered a new alarm.

« |f the window is minimized, it is restored.

» Even if you close the window, the setting is applied each
time the window is opened.

6.7 Checking the Project Operation
Status

Click the Status Page icon on the Project tab to display

the Status Page. A Status Page is used to monitor:

» The project data collection and recording status

» The communication status between the data collection
device in the project and the server

The displayed data is automatically updated periodically.

6.7.1 Displayed Content

Project operation status
Device communication status

@ Data Logaif Sof - o x

O [— [Eack] Good
2018005008 150049 |Remaining Disk Capacity_ 3590 Gote |3
0000:10 N | =

* Project Status

Stopped, Monitoring, Record Standby, or Recording

* Loss Data

Recording data dropout status

¢ Write Error

Whether data writing to the data file is being performed
normally

¢ Modbus Server Status

Stopped, Executing, or Error (an error occurs when the
Modbus address overlaps with that of another project.)

¢ Time Correction

----, Valid, Correcting, Invalid

Corrects the difference between the PC time and the
data time of each project. This requires a connection to
a time server.

If a difference of 1 second to 15 seconds occurs
between the PC time and the data time of each
project, the data time is gradually corrected to match
the PC time. If a difference of more than 15 seconds
occurs between the GA10 server time and data

time, subsequent times (at the project level) are not
corrected. Time correction is performed for each project
separately. The time correction state is reset when the
data monitoring of a project is stopped.

If monitoring has not been started on a “Device time”
project or “PC time” project, “----" is displayed.

IM 04L65B01-01EN
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Beginning Time of Recording
The time of the first data value in the first data file that
is created after recording to data files is started

Total Time of Recording

The elapsed time since the start of recording.

The timer continues until all recordings stop or when
Recording Standby is reached.

Number of Generated Files
The number of data files that have been created after
recording was started

Remaining Disk Capacity

The free space on the disk that contains the data file

save destination directory.

In the following conditions, “----- " is displayed, and the

bar does not display the amount of space used.

* Not recording.

» The data file save destination folder is set to a
network folder.

Device Communication Status
The status of communication with the devices in the
Device List is displayed. Nothing is displayed when
data collection is stopped.

Model icon

Device name

Model name
Communication address
Communication status

001  DX2000 &—
DX2000 R4.14 &—

10.1.32.85 0——

Normal @——

6.8 Controlling Device Computation

from GA10

On the Project menu, click Start Device's Computing, Stop

Device's Computing, Reset Device's Computing, or Reset

& Start Device's Computing.

Computation is collectively controlled on the devices that

meet the following conditions.

» Devices that are in the Device List of the project

» Devices that have computation functionality

» Devices that support Start Device's Computing, Stop
Device's Computing, Reset Device's Computing, or
Reset & Start Device's Computing

Connected
Device,
Software

Start
Comp.

Stop
Comp.

Clear
Comp.

Clear&Start
Computing

LR10000,
UR20000

Yes

Yes

No

Yes

DX1000,
DX1000N,
DX1000T

Yes

Yes

Yes

Yes

DX2000,
DX2000T

Yes

Yes

Yes

Yes

MV1000,
MV2000

Yes

Yes

Yes

Yes

CX1000,
CX2000

Yes

Yes

Yes

Yes

FX1000

Yes

Yes

Yes

Yes

MX100, MW 100

No

No

No

No

DA100, DR130,
DR230,
DR240

Yes

Yes

Yes

Yes

GX10,
GX20,
GP10,
GP20

Yes

Yes

Yes

Yes

DAQLOGGER,
DAQ32Plus,
MXLOGGER

No

No

No

Item Description

Model icon Device icon

Device name Device name and device number

Model name Model name and release number or software
name and release number

Communication |IP address

address

Communication |Communication status between the server

status and device

Normal, Error, Retrying

Devices
supporting
the Modbus
protocol

No

No

No

No

Yes: Supported No: Not supported
* When connected over an Ethernet network, the user registered
in the device must have privileges to use computation for this

feature to work.
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Chapter 6 Monitoring Data Collection

6.9 Things to Consider

6.9.1 Time Zone and Daylight Saving Time

Be sure to set the same time zone and daylight saving

time settings on the PC running the GA10 server, the PC
running the GA10 client, and the data collection devices.
If they are not the same, data time may not be displayed

correctly.

6.9.2 Error Data

If collected or recorded data is in error, it is displayed
or recorded using indications other than values. For the
different types of error data, see “Data that indicates

errors.”

» Data Display in a Digital Monitor Set or Meter
Monitor Set

Display Data Condition*

+OVER +OVER

—-OVER -OVER

INVALID INVALID

BURNOUT BURNOUT

ILLEGAL ILLEGAL

LACK LACK

OFF OFF

* See “Data that indicates errors.”

* Display in the Trend Monitor Set

Waveform Cursor Value |Data Condition”

Drawn exceeding the |[+OVER +OVER

scale upper limit

Drawn exceeding the |-OVER -OVER

scale lower limit

Nothing INVALID INVALID
BURNOUT BURNOUT
ILLEGAL ILLEGAL
LACK LACK
(blank) OFF

* See “Data that indicates errors.”

* Data in Recording Data Files

Data in Binary Data |Data in Excel Data [Data Condition®
Files Files

+OVER +OVER +OVER

—OVER —OVER -OVER

INVALID INVALID INVALID
BURNOUT BURNOUT BURNOUT
ILLEGAL ILLEGAL ILLEGAL

LACK LACK LACK

OFF OFF OFF

* See “Data that indicates errors.”

¢ Data That Indicates Errors

The following table shows the different types of data
that indicates errors.

Data Description

+OVER +Qver-range data

—-OVER -Over-range data

SKIP Channels that have been set to skipped

INVALID Invalid data
The data type and decimal place specified on
the Tag Setting Page do not match those of the
collected data.

BURNOUT |Burnout data

ILLEGAL lllegal data

LACK Indicates that the device failed to acquire the data

OFF Indicates one of the following conditions.

« Data collection has not been performed since
the project was opened.

+ Channels are not assigned to tags.

*  When the data time is set to PC time, the
collected data is SKIP data.

+  Communication error condition

+ Initialized condition as a result of changing the
Device Setting Page or Tag Setting Page while
data collection is stopped

* An attempt was made to collect data from a
device using the backfill function, but there is
no data recorded in the device.

6.9.3 Reflecting Changes Made on the Monitor
Page to the Setting Page
If the access privilege is Owner or Manager, changes
made to the following settings on the Monitor Page are
reflected on the corresponding Setting Page (Display
Group or Acquisition & Monitor). If the access privilege is
Operator or Monitor, the changes are not reflected.
* Monitor Set size adjustment
»  Waveform display on/off state, Y-axis display on/
off state, Detail/Compact, Zoom in/Zoom out, and
movement in the Trend Monitor Set
» Trip line position

6.9.4 Changing the Time on the Device after
Starting Data Collection and Recording

Do not change the time on the device after starting data

collection and recording, because doing so will cause

adverse effects on the monitor screen and recorded data.
Related topic “Changes to devices during data
collection and recording”: » Q11 on page 12-11

6.9.5 Changing the PC Time after Starting Data
Collection and Recording

If the PC time is changed after starting data collection with

the [PC time] setting, adjustments exceeding 5 seconds

will not be reflected in the data time.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

6.9.6 Conditions When Multiple Screens Are
Shown

When multiple screens (clients) are shown on the same
PC, the screens use the same display conditions in the
PC. If a setting included in these conditions is changed on
a given screen, the change is not immediately applied to
the other screens. However, such changes are applied the
next time the clients are started.

The display conditions held in the PC are listed below.

* Window size and position

» Alarm show/hide stateGroup link state
» Cursor value transparency

» Display items of tag display

» User display form

» Screen background color (style)

» Date and moth display form

» Decimal point

» Toolbar show/hide state

» Mark bar show/hide state

» Warning action bar show/hide state
* Language

» Width of each column on the setting page (Tag, Math
Tag, Display Group, Data File List, Report/Print History,
Report/Print Schedule) sheets

» Show/hide state of each column on the Display Group
and Data File List sheets

» Sort method on the Data File List page, Report/Print
History, and Report/Print Schedule sheets

* Login information in the startup login dialog box
» Show/hide state of tooltips on the Simple Settings page

The CPU and memory usage when multiple clients are
running varies depending on the collection and recording
environment (PC performance, number of tags, interval,
number of projects, etc.) and the number of monitor sets
on the Monitor Page. As such, limitation may be placed on
the number of screens that can be started. See the table
below for the CPU and memory usage rates.

* When running a single project with four monitor sets

Clients |Tags |Acquisition [CPU usage |[Memory usage
interval

2 2000 |500 msec  |Approx. 19%|Approx. 470 MB

4 2000 |500 msec  |Approx. 36%|Approx. 940 MB

2 500 100 msec  |Approx. 18%|Approx. 400 MB

4 500 |100 msec |Approx. 38% Approx. 800 MB

This example was verified in the following environment.
CPU: Intel Core i5 (2.67GHz), Memory: 4.0 GB,
OS: Windows 7 Ultimate SP1

6.10 Viewing the Log

You can view the log that the server sends in the Log
dialog box. You can open the Log dialog box at any time
when you are logged in to the server. The dialog box stays
open until you close it. If you log in for the first time after
installation, a log dialog box appears. At this point, if you
switch between show and hide, the state is stored and
reflected the next time the software is started.

6.10.1Displayed Content in the Log Dialog Box

Up to 1000 log events that occur from when the user logs
in to the server until the user logs out are displayed.
There are two types of logs: system log (displayed in
yellow), which deals with the server, and project log
(displayed in blue), which deals with projects.

System log includes events such as server login and
logout. Project log includes data collection start and stop.
System logs are sent to all users. Project logs are sent to
users that have the projects opened.

6.10.20pening the Log Dialog Box
On the View menu, click Log. The log dialog box opens.

Log X

Fitter: [ 20 [ Project

114B1557:43 (&) Project!: admin sxcutes stopping collscting Projectt 1)
K002]

1118155813 [®)Project!: acmin excutes collecting Project! [WiO01] ~

1118155920 (8] Project!: admin excutes stopping callecting Praject (39— Log list
K002]

11A816:00:02 () Profectt: acinin sxcutes recording Project! [AKOD3] )

11HB 160005 (&) Projecti: Project's recording stated MKOOS] ~ v

T1HB1E0005  (B) Project!: Project!’s recording star=s pvikans ~ e—— NIOSt recent Iog entry

Filter

* Filter
The events that correspond to the filter box that you
clicked and turned blue appear. For details, see
“Transmission scope.”

* Log List
The log events are displayed in the order of
occurrence. If there are events that do not fit in the
dialog box, a scroll bar appears.
Transmission date and time
Transmission scope
Source
Sent information

1IME 155813 [®] Project!: admin excutes collecting Project! [WHO01] ~

!
I Jump icon
Log number

* Most Recent Log Entry
This line always displays the most recent log entry.

e Transmission Date and Time
The date and time when the log was transmitted.
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Chapter 6 Monitoring Data Collection

¢ Transmission Scope
Indicates the log transmission scope

Icon Description

Sent to all users (system log).
Set the Filter to Log to display the corresponding log.

EI Sent to users that that have the relevant projects
opened (project log).
Set the Filter to project to display the corresponding log.

e Source
SYS or the project name.

¢ Sent Information
The log information.

¢ Log Number
Displays the number that corresponds to the log event.

e Jump Icon
Displayed when there is a page associated with the log
event. Clicking the icon shows the relevant page. For
example, if you click the icon for a “recording started”
event, the corresponding project’s Monitor Page will be
displayed.

To close the log dialog box, click the % icon in the upper
right.

6.10.3Changing the Size of the Log Dialog Box

Point to a corner of the dialog box so that the pointer
changes to an arrow. Then, drag to change the size.

6.10.4Log Shown in the Log Dialog Box
System Log

Number |Message Description
WKO009 |Data loss happened in When a data dropout occurs
[ProjectName]. during data recording.
If data dropouts occur
consecutively, a log entry is
made on the first dropout.
If the data time is set to PC
time, a log entry is made when
a communication timeout
occurs and the data dropout is
confirmed.
If the data time is set to Device
time, a log entry is made when
the data dropout is confirmed
from the FIFO data acquired
after the communication
recovers.
WKO010 |[UserName] has opened --
[ProjectName].
WKO011 |[UserName] has closed This includes the case when
[ProjectName]. a project is forcibly closed
as a result of losing access
privileges to the project.
WKO012 |[UserName] has locked When a user with operator
[ProjectName]. or higher privileges opens a
project.
WKO013 |[UserName] has unlocked  |When a user with operator
[ProjectName]. or higher privileges closes a
project. When an administrator
unlocks a project forcibly or
when an unlock occurs due to
a communication error.
WKO014 |Project([ProjectName])'s -
owner changed from
[FormerUserName] to
[NextUserNamel].
WKO015 |In [ProjectName], disconnect|When the communication

from [Device name]

between the server and device
is disconnected.

Number |Message Description

SY002 |[Server is trial version. When an attempt is made to
log in to a running server using
a trial version.

SY003 |[UserName] has logged on. |--

SY004 |[UserName] has logged off. |This does not appear when

a logout occurs due to a
communication error.

Project Log

WKO016 |In [ProjectName], have When the communication
connected from [Device between the server and device
name] again. is restored

WKO017 |Disk remaining capacity of | Transmitted periodically (once
[ProjectName] is less than  |a minute) while the free space
50M. on the data save destination

drive is less than 50 MB.

WKO018 |Failed to send mail to -

[ProjectName](MailName).
(Cause)

WKO019 |Fail to write data file in When data cannot be written

[ProjectName]. due to some problem at the
data save destination.
Some problems include the full
data file path exceeding 260
characters, starting to record
to a read-only destination, or
not having write privileges.

WKO020 |The event of [ProjectName] |--

(ScheduleName) executed
successfully.

WKO021 |Failed to execute the -
event of [ProjectName]
(ScheduleName) .

WKO022 |Sending mail of -

[ProjectName](MailName)
completed successfully.

Number |[Message Description
WKO001 |[Username] executes -
monitoring [Projectname].
WKO002 |[UserName] executes --
stopping monitoring
[ProjectName].
WKO003 |[UserName] executes -
recording [ProjectName].
WKO004 |[UserName] executes -
stopping recording
[ProjectName].
WKO005 |[ProjectName]'s recording |-
started.
WKO006 |[ProjectName]'s recording |-
stopped.
WKO007 |In [ProjectName] data -
file([FileName]) has been
generated.
WKO008 |[ProjectName]'s data file has |When the number of data files
been deleted automatically. |has reached the limit and a
data file is deleted to create a
new data file

UserName: User that executed the operation.
Tag: Tag that the alarm occurred on
FileName: Name of the data file.
DeviceName: Name of the connected device.
ProjectName: Name of the project.
FormerUserName: User name of the project’s owner before the change
NextUserName: User name of the project’s owner after the change
ScheduleName: Schedule name for auto report printing.

MailName: Name of the mail event.
Cause: Cause of the mail transmission failure.

IM 04L65B01-01EN
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Chapter 6 Monitoring Data Collection

The following causes are displayed.

Fail to connect POP server.

Fail to connect SMTP server.

Authentication failed.

Sender address does not exist.

All of sending address do not exist.

Some of sending address do not exist.

Communication with SMTP server failed while sending mail. (This message
is displayed also when the attached file size is larger than the supported
size.)

System error occurred.

6-18
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Chapter 7 Using the Custom Display Function (/CG option)

7.1 What Is the Custom Display Function?
By using the custom display function (/CG option), you can add original monitor pages to the
GA10’s standard monitor pages (trend, meter, digital, and alarm). These additional monitor
pages are called custom display monitors. Custom display monitors are created using
DAQStudio (DXA170), a software application for creating screens. Screen data that you
create can be saved to custom display files (.gacd extension).

Nofte

* The GA10’s custom display function includes a license for DAQStudio (DXA170) Custom
Display Builder. This license is different from the GA10’s option license (a number that starts
with 400-).

* Download DAQStudio from YOKOGAWA's website, and install it in your PC. For instructions on
how to use it, see the DXA170 DAQStudio User’s Manual (IM04L41B01-62EN).

7.2 Registering a Custom Display
Register the custom display files (.gacd extension) created with DAQStudio in the GA10’s
Acquisition&Monitor page and Monitor Set Type.

Data Logging Software—[admin]—[Pfoject D] =
aging o5 = x
File Edit View Project Operation User Help
Hio? ahb® 8|5 e P | -|@ & (s (e [IEwEe o
G Device v =
Data time PClime ® T B
8 o0 || monttor intervar 1Second @) o. String B 2
1 [ i
1] .
-~ - o
Math Tag v o -
@Disuay ¥ | | Monitor ,f
" Display Group « | | Monitor Data SetNumber: [E & Resizethe Monigr Set @on O oFF -'
|8 AcquistbonaMontior v | SPitScreen Direcon Horzontal @)
| | SetNumberin Spiiting Direction:
< Record + | | Custom DisplayFile: —
b ‘Spit Screen Data Set
[z) Reporternt - & Split Screen Data Set
1011GA10. Monitor0iad)
Ed eman Diaital <

Weter
Alarm
Trend
Weter
Digital
Treng

[£2 Accessgothers

FREEEEREE
QREREOE

Basic Operation

1 Open the Collect & Monitor Page setting page of the project.

2 Click Regist for the custom display file.
An Open dialog box appears.
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Chapter 7 Using the Custom Display Function (/CG option)

3 Move to the location where the custom display file created with DAQStudio is saved.

143 Open =
G g oustoroe e emr
T Name
-~ || DAGStudio_E.gacd
Recent Places vy oritoro1_Trend.gacd
w | Monitor02_Trend_Digital.gacd
pekrop L TenKLevelgacd
Libraries
N
Computer ¢ (T G
. File nome E |
‘,I_d_ Files of type: [ustom Display Fles gs0dh =] [ Benee ]

4 Select the file that you want to register, and click Open.
The file name appears to the left of the Register button, and the custom display monitor becomes

available in the Monitor Set Type list.

Note
» The Register button appears only on GA10s that have the /CG option installed.

One custom display file can be registered in a single GA10 project. If you register a second file,

it overwrites the registration.

Up to 50 screens can be defined in a single custom display file.

Monitor

Monitor Data Set Number.
Split Screen Direction:

4 [=1]
Harizontal [5]

SetNumberin Spliting Direction: 2 &g
ICusmm Display File: DAQStudio_E gacd I

Spiit Screen Data Set

Resize the Monitor Set:
Alarm Shape:
Alarm Color.

___Register

®ON O oFF
®0 (ou|
oFr [l [ |

Monitor Set Layout

Ho. | Split Screen Data
1_[Trend =
Trend

Digital

Weter

Alarm

5 (oo |

[01]GA10_WMonitor02_1)

o

If the file fails to be loaded, an error message appears.

# [ITAG 0002

i TAG 0003

Setting the Monitor Set Type
When you register a custom display file, the custom display monitors defined in that file
appear in the Monitor Set Type list. The displayed name is the name that is defined when
the file is created. The method to set the Monitor Set Type, layout, and so on are the same

as that of a standard Monitor Page.
Related topic: Section 3.3.5
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7.3 Displaying a Custom Display Monitor

Click the Monitor Page icon !!! on the Project tab to open the custom display monitor page.
In addition to the normal Monitor Set Maximize button, the size of the custom display
monitor can be adjusted by clicking the following buttons. The custom display is expanded or
reduced according to the Monitor Page size.

Select the Frame Size Display check box on the View menu to display the screen size in the
upper right of the window. Remove the check to hide it.

[@ (Light style)
(Dark style)

Fit to Monitor Page

The custom display is expanded or reduced according to
the Monitor Page size.

@J (Light style)

== ratio constant
(Dark style)

The custom display is expanded or reduced to the page’s

Fit to Monitor Page keeping the aspect width or height, whichever is shorter, keeping the aspect

ratio constant.
For the long side, the display is aligned to the center.

Related topic: Displaying the Monitor Page 4 page 6-2

Fit to Monitor Page

GA10_Monitor02_T

Temperature

olute Time [h:m

Display
Display
Display

Place None
Place None
Place None
Place None i
Boeffnny E--FEEEEE Tag 0001
0.4644

o
Tag 0001

1

= Tag 0001

- a |k 0.4644

5

L
P il
= r 0.4644
[

Tag 0001
0.4644

Fit to Monitor Page keeping the aspect ratio constant

(GAT0_Honitor02 T

Temperature

Place

None Display

Place None Display
Place None Display

Place None |
Eecefllnvmy B--AEEEEE Tag 0001

-1.2368

i

i

i I : Tag 0001
I ; A1.2368
i

\i

Tag 0001

-1.2368

\
Tag 0001

-1.2368

\J

Nofte

If there is only one Monitor Set, the Maximize Monitor Set button does not appear.
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Chapter 7 Using the Custom Display Function (/CG option)

7.4 Custom Display Components
GA10 custom display screens are created using DAQStudio (DXA170), a software
application. This section provides an overview of the components used to create screens.
For details on components and settings, see the DXA170 DAQStudio User’s Manual
(IM04L41B01-62EN).

GA10 Custom Display Monitor Components

Component Type Component Name
Diagram components Line, Triangle, Rectangle, Arc, Ellipse,

Components for channel assignment Simple digital, Digital, Simple bar meter, Simple analog meter, Analog meter,
Alarm, Representative alarm

Status display component Disk memory bar

Label components Label, System label

Components with action functions Button operation, Digital output, Value list output, controller component
Components for summary display Alarm summery

(GA10: Components for Alarm list)

Components for trend display Trend

Components for static image display Image

You can control GA10 and devices on the custom display monitor by using the following
components. Depending on the action assigned to the components, a confirmation dialog
box appears when the component is used.

e Button operation

” o«

“Page switching,” “data collection and recording operation,” "Display image" and other
actions assigned to the button is executed when the push button is used.

Assignable Action Dialog Timing of Execution
Page switching
Start Monitoring
Stop Monitoring
Start Recording
Acknowledge alarm sound
Alarm ACK
- M1023 Do you want to run the operation?? .
Acknowledge device error Executed when you click OK.
Append Mark
Bit Write
Constant Write
Reset Computing
Manual save
Stop Recording M1006 Do you want to stop the recording?
Display message No confirmation dialog box is displayed. Executed immediately when the button
is clicked.
Display image A Display image dialog box appears, and the Image shown when the button is
image registered when the window was created |clicked.
is shown.
- Digital output =1
The input value is output to the assigned tag (see Note).
Assignable Action Dialog Timing of Execution
Value output A dialog box for entering a value appears. |Enter a value in the edit box of the dialog
box and click OK to output the value
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* Value list output

The input value is output to the assigned tag (see Note).
Assignable Action Dialog Timing of Execution

Output the selected value from a list |A list box for selecting a value appears. |Select a value from the list and click
OK to output the value.

Nofte

The tag that the value is output to must have a writable channel of a Modbus device assigned to it.

7.5 Controlling GX/GP/GMs or Controllers with the Custom Display Function
Using the GA10 (R3.02 or later) custom display function, you can monitor and control the
custom display function status of GX/GP/GMs with PID control modules and UTAdvanced
series controllers. This section describes the controller component that you use and their
operation dialog boxes.

Controller Component

The component that you use for the control operation on the custom display is called a
controller component. There are two display types to the controller component: faceplate
and controller.

Controller Faceplate
LOOP Loop name display
— — bl I T T i—— AUTO/MANUAL/CASCADE
RUN 1
_AUTO oo AUTO 55 L runisTop
[PV l Py ' L~ REMOTE/LOCAL
50.0
sp | 500 PV

ouT | 50.0% |SP ——SP
out 50.0%| —— ouT

100.0
Bar Graph
0.0
The following table details each component item.
Item Initial value Description
Loop name Name specified on DAQSTUDIO -
Alarm Gray Control alarms L1 to L8 are shown.
AUTO/MANUAL AUTO The assigned tag value is shown during monitoring. “***”

is shown for values other than AUTO/MANUAL, and you
cannot click it.

RUN/STOP RUN The assigned tag value is shown during monitoring.
“***” js shown for values other than RUN/STOP, and you
cannot click it.

REMOTE/LOCAL LOCAL The assigned tag value is shown during monitoring. “***”
is shown for values other than REMOTE/LOCAL, and
you cannot click it.

PV Off The assigned tag value is shown during monitoring. The
value is shown in red while an alarm is occurring.

SP Off The assigned tag value is shown during monitoring.
When you set the value, it is written to an assigned,
writable tag.

ouT Off The assigned tag value is shown during monitoring.

When you set the value, it is written to an assigned,
writable tag. The decimal place is fixed to 1.

PV Bar graph -2.000 to 2.0000 The upper and lower limits of the assigned tag value are
shown during monitoring. The bar is shown in red while
an alarm is occurring.

OUT Bar graph -- --
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Chapter 7 Using the Custom Display Function (/CG option)

Basic Operation

Like other component screens, screens using these components are created using the
DAQStudio, a software application for creating screens. For instructions on how to create
screens and descriptions of component attributes, see DXA170 DAQStudio User’s Manual
(IM04L41B01-62EN).

The control operation procedure on the GA10 is shown below.

1 Register a GX/GP/GM (firmware version R4.01 or later, with a PID control module) or a
UTAdvanced series controller in the GA10 devices list.

r ™\
Register device X
Device Type. DX1000 X
x DR230 B
Comm. Kind: DR240
HostNameflP Address GX10
—GX20
User Name: Gl
GP20
User D GM10
WT3000
Password: WT2000E B
GateWT for GA10
- _DAQLOGGER
Of ) |_Ofline f DAQ32PIUs
MXLOGGER LJ

GXGPGM_PIDSIot0
GXGPGM_PIDSlot1
GXGPGM_PIDSIot2
GXGPGM_PIDSIotz  |=
GXGPGM_PIDSlot4
GXGPGM_PIDSIots
GXGPGM_PIDSlot6
GXGPGM_PIDSlot?
GXGPGM_PIDSIot8
UM33A

UP35A

UP35A_R3

UPS5A

UP55A_R3

UT324 |
UT32A4_R3 |

Select the device to register in the GA10 Register device dialog box from the following.

* When the connected device is a GX/GP/GM: GX/GP/GM_PIDSIot0 to GX/GP/GM_
PIDSIot9 For “Slot,” select the number of the slot that the PID module is installed in.

* When the connected device is a UTAdvanced controller: A UT model that ends with
« R3”

Nofte

When connecting to a GX/GP/GM, check the following on the main unit.

» The PID control module is installed (detected).

* In the main unit settings, Communication (Ethernet) settings > Server settings > Server list >
MODBUS is set to ON.

2 Using DAQStudio, edit the controller component, assign the device tag (e.g., PV, SP)
registered in step 1 to the component, and save the custom display file (*.gacd).

3 Register the custom display file saved in step 2 in the GA10 Acquisition&Monitor page.
Registration procedure:> page 7-1

7-6
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On the loaded custom display monitor, click the operation mode (AUTO/MANUAL,
RUN/STOP, LOCAL/REMOTE), target setpoint (SP), or control output value (OUT) are
of the controller component to display an operation dialog box.

@ Data Logging Software [admin] — [PID Project] - =
File Edt View Project Operation User Help
H3c2 mbeb DX B @les | |m & [ [ewcl (el o
GA10_Honitor01] =)
=
:
[ I I I ] [ I I I ] M
| AUTO o AUTO o s
LOCAL LOCAL &
PV PV
£n Nl I =]
(s x| 500 &
SP ED ] 50.0
ouT Output range: 0.0100.0 50.0%
oK Cancal o 8
\ J

-

=
=}

5 Enter values in the dialog box, and click OK.

If you click Cancel, the dialog box will close, and the settings will not be sent.

Description of the Operation Dialog Box

The following table shows the operating range and operating procedure on the controller

component’s operation dialog box.

Operation

Operating Range

Dialog

AUTO/MANUAL switching

Selectable range: AUTO/MANUAL

Qutput x

[auTO =)

RUN/STOP switching

Selectable range: RUN/STOP

G oK ) (__cancsl__)

REMOTE/LOCAL switching

Selectable range: REMOTE/LOCAL

Select the operation mode from the list, and
click OK to send the setting and close the
dialog box. If you click Cancel, the dialog box
will close, and the settings will not be sent.

Target setpoint (SP)

When the operation mode is LOCAL,
clicking this displays a setting dialog box.

Data type [Range

INT16 -32768 to 32767
UINT16 0 to 65535

INT32 -9999999 to 99999999
UINT32 -9999999 to 99999999
FLOAT -9999999 to 99999999
BIT 0to1

sP x

50.0

Oulputrange: 0.0H00.0

Control output value (OUT)

When the operation mode is MANUAL
and RUN, clicking this displays a setting
dialog box.

Input range: -50% to 105.0%

The title is either SP or OUT.

Enter the value in the edit box. If the value

is out of range, it is corrected to the upper or
lower limit. For SP, the range shows the upper
and lower limits. For OUT, the range is fixed to
-5.0% to 105.0%.

Click OK to send the setting and close the
dialog box. If you click Cancel, the dialog box
will close, and the settings will not be sent.

IM 04L65B01-01EN
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Chapter 7 Using the Custom Display Function (/CG option)

Note

The following displays and operations are not available on the controller component.
* PV error string display * Updating values when the setting dialog box is open
* RSP error string display « Displaying device errors (e.g., access rejection)
« Alarm blinking « Displaying the loop information dialog box
« Deviation display * Alarm ACK
« Alarm type string display *  AUTO/MAN/CASCADE switching
» Tag string display + PROGRAM/LOCAL switching

« Alarm setpoint mark display on the PV value bar graph «  Writing SP and OUT values in REMOTE mode
» PV switching

7-8 IM 04L65B01-01EN



Chapter 8 Managing Recording Data

8.1 Displaying a List of Data Files

Click the Data files Page icon on the Project tab to
display the Data File List Page.

11er0ag

BEN Nz

x|(m)

Project tab

|E| Data files Page icon

The data files in the data file save destination directory are
listed. Only data files saved in binary format are displayed.
Data files saved in Excel format are excluded.

@

Fle Edt View Project Operation
L ENSE TR Y )

Dt Logging Software-[scmin]-Project
User Help

8 [es]| @ [Mara

s ]

Deta Pl List
ader

] Show Fies in ik View

Data List

Data 2013118162736 06
Deta-20131118161736 8¢
300

s
2011113 15:19:40.000 sttse
2013112 130708000 14752

20131 250
20111713 1459:48.000
201311012 1307:02000

Item Displayed Content

File Name Name of the data file

Data Number Number of data values in the data file
The total number of data values if files are
linked and displayed”

Record Interval |Recording interval used to create the data file

Start Time The time of the first data value in the data file
The time of the first data of the entire data if
files are linked and displayed”

End Time The time of the last data value in the data file
The time of the last data of the entire data if
files are linked and displayed”

File Size Data file size

(Unit: byte) The total data size if files are linked and
displayed”

Comment 1 Title and content of Comment 1 to 8 that were

Comment 2 specified when the file was created

Comment 3

Comment 4

Comment 5

Comment 6

Comment 7

Comment 8

* Does not include the values of deleted files and other files that

do not exist

Showing Files in Link View

You can link and display files that have been divided by
the recording stop condition or other factors.

Click the Show Files in Link View to turn the box
blue. Files are linked from the start of recording to the
end of recording and displayed in one line. Clicking

the box again to turn it to white returns the page to the
individual file display.

5t Loggng Sorvare (aamn] 7

Fle Edit View Project
B3 mbwb

x| B2 |

Data Fie List

Foder  C

Deleting Files

1 Click the file you want to delete.

Selecting multiple consecutive files

Example: Selecting consecutive files: File005, File006,

and File007

» Click File005. Drag to File007, and release the
mouse button.

» Click File005 to select it. While holding the Shift key
down, click File007.

Click Delete.
A confirmation dialog box appears.

Click OK.
The files are deleted.

Showing and Hiding Columns

If you move the pointer over a column title, a hide icon
appears. Click it to hide the column. When you hide a
column, a show icon will appear in the upper right of
the page. Click this icon to show the hidden columns.

1k View Open Delete

e Time Hide icon

[RECT Y

‘ File Size

201311138 16:07:57 000 40980

N1 AR 1607227 ANN 197788

1k View Ope: Delete

/-]
/\,033— — Show icon

=

End Time | Comment1

2013711118 16:27:35.000

The results of showing and hiding columns apply to
every project in the same client.

IM 04L65B01-01EN
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Chapter 8 Managing Recording Data

* Adjusting Column Widths 8.2 Displaying Recording Data
When you move the pointer near a boundary of Recording data can be displayed in a viewer (Universal
a column title, the pointer changes to <. In this Viewer).
condition, drag the pointer to move the boundary to the
desired position. The results of adjusting column widths T select the file you want to view.
apply to every project in the same client. You can select multiple link files.
« Sorting the File List 2 Click Open.
Click a column title to sort the file list on the basis of the The viewer (Universal Viewer) starts, and the data in
clicked column. Click it again to sort in reverse order. A the file is displayed.

sort mark (£ ,~\) appears in the column title area.

You can also double-click the file to display the

¢ Refreshing the Display data

On the View menu, click Refresh.
The most recent file information is retrieved from the

server, and the page is refreshed. » Editing and Saving Recording Data

The following file 1 saved on the viewer for the file
displayed using the above procedure is discarded
when the GA10 client software is closed.

* Link settings file (.Idx)
* Display template file (.tdx)

To edit and save data, start the viewer according to the
following procedure, and directly open the files 2 stored
in the server. The tag that the value is output to must
have a writable channel of a Modbus device assigned
to it.

Windows Start--> All Programs --> SMARTDAC+
Data Logging Software --> Viewer

1 For details on the viewer’s display condition file, see
chapter 4 in the viewer user’s manual (IM 04L61B01-
01EN).

2 Files saved in the directory specified by Folder on the
GA10 Record Setting Page.

To convert data on the viewer, set the file save
destination to a folder other than the default. The
default folder is discarded when the Universal Viewer
software is closed.

Nofte

» Forinstructions on how to use Universal Viewer, see
the Universal Viewer User’s Manual (IM 04L61B01-
01EN).

* GA10 recording data (.dld extension) can be displayed
on Universal Viewer version R1.03 and later.

* The language set in GA10 do not apply to the
language of the viewer. To change the language for
displaying files on the viewer, set it in the viewer.
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Chapter 9 Managing Users

9.1 Administrator and Users
In GA10, you can set server access privileges.
There are two types of server access privileges: administrator and user. The administrator
manages all users. The administrator can perform the following operations in addition to all
the operations available to users.

* Register users

» Delete users

* Initialize user passwords

» View the login status of users

The following sections explain how to use the User Management Page.

Registration A

Server ' New user

Administrator

o
. View - View .
- E User management %& -

User A User D
Logged in Logged in

View - _Delete iew
Initialize password

Y -
User B User C
Not logged in

Note that at the GA10 project level, users can be assigned one of four project access
privileges: Owner, Manager, Operator, and Monitor. These privileges are assigned for each
project using Details Settings mode.

For details, see “3.3.8  Setting Project Access Privileges”.

IM 04L65B01-01EN 9-1
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Chapter 9 Managing Users

9.2 Managing User Status

9.2.1 Using the User Management Page

The administrator can view the status of other users on
the User Management Page.

1 Start the client, and log in to the server with GA10
administrator privileges.

‘‘‘‘‘‘‘‘‘‘‘‘

2 On the View menu, click User Management Page.

Or, click the % icon.
The User Management Page appears.

(Cormearase

3 Check the user status by looking at the icons (see

below).
Not logged in

: Usert

User Full Na AAAAL

Logged in

Number of users logged in

.

3
‘I.Iseﬂ

User Full Na AAAAA

Appears in blue when logged in

9.3 Changing User Information

This section explains how to change the user full name

and password. This procedure can also be performed by a

user who is logged in.

9.3.1 How the Administrator Changes Other
User Information

The administrator performs the following procedure to
change the full name and initialize the password of a user.

1 Follow steps 1 and 2 in section 9.2 to display the
User Management Page.

2 Select the user you want to change.
The user is selected.

The frame turns blue when selected.

l
:US&I"I

User Full Na AAAAA

3 Double-click the selected user.
The Change User’s Information dialog box opens.

4 To change the full name, type the new name.
To initialize the password, click Initialize.

Type in this box to change the full name.

7 n
Change User's Information x

User Name: User1

User Full Name ARAAA

Password

Confirm New Password: l:l

OK Cancel

A S

Click here to initialize the password.

5 Check the information, and click OK.
The full name or password will be changed.

Nofte

You cannot change the information if the applicable user
is logged in or if the user has been deleted from another
client.

9-2
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Chapter 9 Managing Users

9.3.2 How Users Change Their Information

The following example shows how the administrator or a
user changes his or her full name and password.

1

Nofte

Start the client, and log in to the server.
The Project List Page appears.

On the User menu, click Change Information.
The Change User’s Information dialog box opens.

Change the full name or password, view the

changes, and click OK.
To change the password, type the current and
new passwords.

£ Y
Change User's Information x
User Name: Userd
User Full Name: AAAAA
Password
New Password
Confirm New Password
Co ) Come
- y,

You can change the full name and password
simultaneously.

» Enter the password using 4 to 30 alphanumeric
characters..

The default values of the settings in the Change User's
Information dialog box are shown below.

Item Initial value

Full Name User full name before change
Password Nothing is displayed.

New Password Nothing is displayed.

Confirm New Password

Nothing is displayed.

9.4 Registering and Deleting Users

Only the administrator can register and delete other users.
9.4.1 Registering a New Users

1 Start the client, and log in with the administrator

account that you created earlier.

2 On the View menu, click User Management Page.
Or, click the £ icon.
The User Management Page appears.

3 On the User menu, click Register New User.

= o [ —

(Jepojecpogs )

The Change User’s Information dialog box appears.

4 Type the user name and user full name that you

want to register.
Enter a name that is easy for the administrator
to identify.

Registe User x

User Name: |User1 |

User Full Name |ElElElEl_fuIIname |

( OK ) (_canca)

5 Check the entered information, and click OK.
The user is registered, and an icon is added in the

window.
3 Usert

User Full Na BBBB_fu

6 In the case of an administrator, on the File menu,
click Logout to log out.

Aregistered user can log in without a password.
Follow the instructions in Sec. 9.3.2 to set a pass-
word.

IM 04L65B01-01EN
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Chapter 9 Managing Users

9.4.2 Deleting a User

You cannot delete a user that is logged in.
We recommend that you check the user access privileges
before deleting the user.

1 Follow steps 1 and 2 in section 9.2 to display the
User Management Page.

2 Select the user you want to delete.
The user is selected.

3 On the Edit menu, click Delete.

Or, click the 3¢ |icon.
A warning message appears.

Warning X

& Do you want to delete this user(User1)?(W2001)

( oK ) (__cancel ]

4 To proceed, click OK.
The user will be deleted.

9.4.3 Changing a Project Owner
If you delete an owner user
If the administrator deletes a user, the access
privileges granted to the user is lost. If the deleted user
had been a project owner, the project will no longer
have any owner. This condition is displayed as follows.

Project 4

Owner: Q
I

Displays a dash when there is no owner.

To change a project owner (specify a new owner),
follow the procedure below.

Nofte

Only the owner of the relevant project or the administrator
can change the owner.

1 Display the Project List Page.
On the View menu, click Project List Page. Or,
click the HE icon.

2 Select the project you want to change.

3 On the Project menu, click Modify Owner.
A Change Project’s Owner dialog box appears.

Change Project’ s Owner dialog box

4 From the New Owner list, select a user.
Any user registered in the server can become a
project owner.

Change Project's Owner x
Owner:
Mew Owner: ‘admin (@|

[ OK ] [ Cancel ]

Select a new owner.

5 After selecting the new owner, click OK.
The owner will be changed.

IM 04L65B01-01EN



Chapter 9 Managing Users

9.4.4 Opening a Project at a Specific Privilege
Level

A user assigned to a project can open the project at a
privilege level that is lower than the assigned privilege
level.

1 Display the Project List Page.
2 Select a project.

3 On the Project menu, click Open with Specified

Permission.
An Open with Specified Permission dialog box ap-
pears.

4 Select the privilege level that you want to use to
open the project.

You can select any level up to your assigned level.

The following figure is an example of a user who

is assigned the Manager level. The user cannot
select the Owner level, because it is higher than the
Manager level.

rOpen with Specified Permission b9
Please Choose Access Permission
|© Owner O Wanager O Operator © Monitor
[ OK ] [ Cancel ]
\,
5 ciick oK.

The dialog box closes, the Project Page appears.

Nofte

Only the operations allowed at the specified privilege
level can be used in the project. However, if the project
is locked, users other than the user who applied the lock
can only access the project at the Monitor level.

9.4.5 Unlocking a Project by Force
The administrator can only unlock locked projects.

1 On the Project List Page, select the locked project.

Locked project

s a 3
Project 1 ¥
Owner:  admin

Useri :Locking _J

Displays the user
who locked the project

2 On the Project menu, click Unlock Project

Forcibly.
A confirmation message for unlocking appears.

3 To proceed, click OK.
The dialog box closes, and the name of the user
who locked the project disappears from the project.

=

.

Project 1 *

Owner. admin

IM 04L65B01-01EN
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Chapter 10 OPC-UA Server Function (/UA option)

10.1

Overview

10.1.1 Basic Functions of the OPC-UA Server

The GA10’s OPC-UA server function enables OPC-UA clients of a host system to access
GA10’s data. This function can be used to deliver tag information and measured values to

OPC-UA clients.

Basic functions of the OPC-UA server are listed below.

Specification

Description

Compatible profile

UA 1.02 Micro Embedded Server
DataAccess Server Facet

Used port

4840: OPC UA TCP Protocol (can be changed)

Maximum number of client connections

16 (Max 16 sessions)

Maximum number of subscriptions

100/session

Maximum number of monitor items

2000/session

Sampling interval

100ms, 200ms, 500ms, 1s, 2s, 5s, 10s, 20s, 30s, 1min,
2min, 5min, 10min

Supported services

FindServers
GetEndpoints

CreateSession
ActivateSession
CloseSession

Browse

BrowseNext
TranslateBrowsePathsToNodelds
RegisterNodes

UnregisterNodes

Read

CreateMonitoredltems
ModifyMonitoredltems
DeleteMonitoredltems
SetMonitoringMode

CreateSubscription
ModifySubscription
DeleteSubscriptions
Publish

Republish
SetPublishingMode

OPC-UA clients’ access privileges are controlled by the GA10’s user management function.
The user privilege relationship between GA10 and OPC-UA client users is shown below.

GA10 User Privileges

OPC-UA Client User Privileges

Owner Read/Write

Manager Read/Write

Operator Read/Write

Monitor Read Only
Note

OPC-UA clients can access GA10 only while data collection is in progress.

IM 04L65B01-01EN
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Chapter 10 OPC-UA Server Function (/UA option)

10.1.2 GA10 Data Structure
Root

_ Objects

l — &) Server

|— ] Yokogawa Logger

| [ —] Status
| [ —¢_] Model Name

| ! —<] Serial Number

—&) Math_GA10

I

I

I

I

I

I

I

I

I
l— Channel Data — — —l
I

I
-

— = ) Channel Data
!_&) ChannelName_001

l_ Data

: — /—7 EURange

| I_U EngineeringUnits

| 1— /7 InstrumentRange

|— All Alarm Status

—<¢1 Alarm 1 Status

|—<:| Alarm 2 Status
| —<_] Alarm 3 Status

I— ] Alarm 4 Status

GA. — Channel Data — —

Node 1 Description Class Data Type Note

Server Server information Object - -

Yokogawa Logger Data Object -- -

DeviceXXX Data of each device Object -- -

Device Status Device status information Object -- -

Status Registered device status Variable Int32 1: normal, 2: error,
3: error (In
communication retry)

Model Name Registered device name Variable String ex.) DX1000, GX20

Serial Number Registered device serial number Variable String ex.) X5G905023

Math_GA10 Math tag data Object -- -

Channel Data Channel data Object -- -

ChannelName_XXX 2 Data of each channel Object String -

Data Measured value Variable Float ex.) 123.4

EURange Upper and lower range limits Variable Range ex.)-10~10

(ExtensionObiject)
EngineeringUnits Unit Variable EUInformation ex.)
(ExtensionObiject)
InstrumentRange Upper and lower range limits Variable Range ex.) 11~11
(display boundaries) (ExtensionObject)

All Alarm Status Status of all alarms Variable Boolean true: alarm ON,
false: alarm OFF

Alarm Status 1to4  Status of each alarm Variable Boolean true: alarm ON,

false: alarm OFF

1 All nodes are read only.

2 Tag name and tag comment are displayed in the description of ChannelName_XXX.

10-2
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Chapter 10 OPC-UA Server Function (/UA option)

10.1.3 Server Certificate Operations

This function can be used to perform the following server certificate operations. For the
actual procedure, see Sec. 10.2.4.

Installation

Installs the certificate file that the user has prepared in GA10 to make it an OPC-UA server
certificate. The certificate must be generated from an internal private key.

Creating a Self-Signed Certificate

A server certificate is typically issued by a certification authority (CA) signing a certificate
signing request (CSR). This function can generate a self-signed certificate that can be used
when a certification authority (CA) signature is not necessary. A self-signed certificate can be
generated from the internal private key and installed.

Creating a Certificate Signing Request (CSR)

A certificate signing request (CSR) to be signed by a certification authority (CA) can be
created. It is created from the internal private key available at the time of execution.

IM 04L65B01-01EN
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Chapter 10 OPC-UA Server Function (/UA option)

10.2

OPC-UA Server Project

This section describes the various setting pages of the OPC-UA server function and how the
operations differ from those of normal projects.

10.2.1 Project List Page

When GA10 with the OPC-UA server function starts, the Project Page shows a single “OPC-
UA” server project. You cannot delete this project. Nor can you change its basic information.
The following figure shows the initial screen that appears when you log in to GA10 with the
OPC-UA server function.

To Project Page

Note that because an OPC-UA server project does not have a recording function, record
control buttons are disabled and adding marks is also not allowed.
Monitoring and recording are disabled.

[ 2 Data Logging Software—[z min]

Selected

10-4
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Chapter 10 OPC-UA Server Function (/UA option)

10.2.2Project Tab

An OPC-UA server project consists of a setting page and
status page. Depending on the privileges of the user who
opened the project and the lock status, if the setting page
is enabled, the setting page appears. Otherwise the status

page appears.

The following figure shows the OPC-UA server project
tab. Unlike normal projects, the record button and buttons
for displaying the Monitor Page and Data files Page are

not available.

Project icon and project name

Start
monitoring —e

Status indication
(monitoring)

«— Setting Page

«— Status Page

10.2.3Setting Pages

An OPC-UA server project consists of Device, Tag, Math
Tag, Server Operation, and Access&Others Setting
Pages. Device, Tag, Math Tag, and Access&Others are
the same functions as those of typical projects. There is
no Simple Settings mode. Math Tag appears when the
Math function (/MT option) is installed.

Item Name Description Condition
Status Indicates the project status. The None
indication behavior is the same as that for typical
projects.
Icon OPC-UA server icon None
Project name  OPC-UA None
Start Monitoring A button for starting or stopping Disabled in a
button monitoring. The behavior is the same  locked state.
as that for typical projects. Disabled for

If monitoring starts, the Status Page

will appear.

monitor users.

Clicking the Start Monitoring button
starts the OPC-UA server. If the server
fails to start, error message E3069 will

appear.

Then, a consistency check is
performed between the server
certificate and private key. If the check
fails, error message E3070 will appear.

(3 Data Logging Software — [admin] — [OPC-UA 1 e[ =]
File Edit View Project Operation User Help
150 mehi 00X @le e o ) - [
ﬁ‘— Register Device ) Update Sefing ust
Device v
@ o oz o3 [ mKng @ Ememet  @sens @ use L
N awuz s S
2 Tag omio (. cP | o) 3
auuz 3 e o0 3
Matn Tag 1001357 ﬁ
005 005 oo 008 100163 | 1001742 | 100764
3, Server Setting
[£3 Accesszothers n
08 o0 o1 o1z
" -
Searcn
o1 o1t ots [ Comm Kind: (8 Ememet [ Serial Ouse
MV2000 MV1000 DX2000 oxioon (2]
i o oe oz 10015729 | 10013627 | 10073644 | 10013750
DXZO00 (£ FXAD00 (£ DKAD00 (- amaooo |
(=]
= = = 2 10073657 | 1001677 | 10013668 | 10013751
GRIDO00 (k20000 cm e
Device Name:  GM_M22.3 Meas ch 2 Sefin
7| TR E0 Mancn,
(=LY Version No. R20296 ctrich.
Comm. Address: 100.136.37 Edrach

444

W

Depending on the access privileges of the user when

the project is opened and the project status, each of the
displayed setting pages may be enabled or disabled. (See
the table below.)

Setting Page

A button for calling up the project
button setting window. The behavior is the
same as that for typical projects.

Disabled in a
locked state.
Disabled for
monitor users.

Status Page

A button for calling up the Status Page. None

button The behavior is the same as that for

typical projects.

Running Setting Page Access Privileges When the Project Is
State Opened
Owner Manager Operator
Not Device Enabled Enabled Enabled?
monitoring | Tag Enabled Enabled Disabled
Math Tag Enabled Enabled Disabled
Server Enabled Enabled Disabled
Operation
Access&Others | Enabled Enabled’ Disabled
Monitoring |Device Enabled? Enabled? Enabled?
Tag Disabled Disabled Disabled
Math Tag Disabled Disabled Disabled
Server Disabled Disabled Disabled
Operation
Access&0Others | Enabled3 Disabled Disabled

1 Only Keep Lock State and DDE Server in the page are enabled. All others
are disabled.

2 Devices List in the page is disabled. All others are enabled.

3 Keep Lock State and DDE Server are enabled. All others are enabled.

IM 04L65B01-01EN
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Chapter 10 OPC-UA Server Function (/UA option)

Device Setting Page

Selecting Device displays the Device Setting Page. The
function is the same as that for normal projects.

For the procedure, see “3.3.2 Registering Devices to
Connect”.

Tag Setting Page

Selecting Tag displays the Tag Setting Page. The basic
tag functions are the same as those for normal projects.
However, because there is no recording function, the
corresponding column does not exist.

For the procedure, see “3.3.3 Setting Tags”.

Math Tag Setting Page

Selecting Math Tag displays the Math Tag Setting Page.
The basic math tag functions are the same as those for

normal projects. However, because there is no recording
function, the corresponding column does not exist.

For the procedure, see “4.1  Setting Math Tags”.

Nofte

Before using the Math function, set the data time
acquisition condition to PC time. This is set using Data
time on the Server Setting Page described later.

If set to Device time, the Acquisition & Computing check
box for the math tag will be cleared, and you will not be
able to set math tags.

Server Setting Page

Selecting Server Operation displays the Server Setting
Page. The details are described on the next page.

Access&Others Setting Page

Selecting Access&Others displays the Access&Others
Setting Page. The function is the same as that for normal
projects.

For the procedure, see “3.3.8 Setting Project Access
Privileges”.

10-6
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Chapter 10 OPC-UA Server Function (/UA option)

10.2.4 Server Setting Page

On the OPC-UA server project setting page, selecting Server Operation displays the Server
Setting Page (see the following figure).

(2 Data Logging Software— [admin] - [OPC-UA 1 =[E] = ]

File Edit View Project Operation User Help
Heoo bbb o0 8| oo B cosd ]
g
I Monitor
6 Device w
Data time: PCtime [ @
& Tag + | | Monitor Interval: 1 8econd [ 3
=
>
Math Tag - Server Setting
Server Name: [GA10 UA Sewver J e
[k ServerSetting  #/< | PortNo: [4840 ]
| 5| I
Anonymous Login ® Allow O Prohibit D
ia
Server Cerlificate 7
Version: v3 Issuer: GA10-UAServer@CPC001-136564-06
Serial No. 5d-22-47-5-d0 Valid from: 20141117 15:44:32
Signature Algorithm 'sha1WithRSAEncryption Valid to: 2037/12/02 06:00:00
Signature Hash Algorithm: ~ SHA1
Install a certificate Generate a selfsigned cerificate Issue a cerificate signing request{CSR} =

The page is divided into three areas: Monitor, Server Setting, and Server Certificate.
Each area is described below.

* Monitor
Maonitor
@ —®Data time: PCtime &
@ —eitonitor Interval 1 Second []

(1) Data time

Select the time to assign to data.
» Default value: PC time
* Input range: PC time, Device time
You cannot set this when monitoring is in progress.

(2) Monitor Interval

Select the data monitor interval.
* Default value: 1s
* Input range: 100ms, 200ms, 500ms, 1s, 2s, 5s, 10s, 20s, 30s, 1min, 2min, 5min,
10min
You cannot select this when Data time is set to Device time. In addition, note that if set to
Device time, math tag settings will be disabled.
Related topic: > “Setting Data Collection Conditions”

IM 04L65B01-01EN

10-7



Chapter 10 OPC-UA Server Function (/UA option)

e Server Setting

Server Setting

[E410 UA Server |
[2840 |
® Allow O Prohibit

@ —®Senver Name:
(2) —pPortNo-:
@ —efAnonymous Login:

(1) Server Name

Enter the OPC-UA server name using a character string.
» Default value: GA10 UA Server
* Input range: Up to 20 characters

You cannot set this when monitoring is in progress.

(2) Port No.

Enter the OPC-UA port number.

» Default value: 4840

* Input range: 1025 to 65535
If the input is outside the range, the value will be reset to 4840 (default value).
You cannot set this when monitoring is in progress.

(3) Anonymous Login

Select Allow to allow anonymous connection from an OPC-UA client. The privilege for
such connection is ReadOnly.

» Default value: Allow

» Options: Allow, Prohibit
You cannot set this when monitoring is in progress.

¢ Server Certificate
Certificate information

Server Certificate

Version: V3 Issuer: GA10-UASener@CPC001-13654-06

Serial No - 54-22-47-f5-d0 Valid from 2014M1M7 15:44:32

Signature Algorithm sha1WithRSAENcryption Valid to: 203712402 06:00:00 b

Signature Hash Algorithm:  SHA1

( Install a certificate @ ) ( Generate a self-signed cem&ale ) (Issue a certificate signing requeleSRg ]
| | |
@® @ ®

The Server Certificate area shows the certificate information (see the following table).
Item Name Description
Version Certificate version
Serial No. Certificate serial number
Signature Algorithm Certificate signature algorithm

Signature Hash Algorithm

Certificate signature hash algorithm

Issuer Certificate issuer (common name)
Valid from Start of the certificate’s valid period
Valid to End of the certificate’s valid period

* The area will be blank if there is no certificate.

Clicking the Install a certificate, Generate a self-signed certificate, or Issue a certificate
signing request(CSR) button displays a dialog box for executing or creating the relevant
item. (For the procedure, see the next page.)

IM 04L65B01-01EN



Chapter 10 OPC-UA Server Function (/UA option)

Basic Operation

(1) Installation of certificate

1 Click Installation of certificate.
An Open dialog box appears.

(42 Open [ =]

~ @ > E-

Laok in: Dert
K

Name Date modified  Type

=
’*.»' [Slopc-ua.der 2014/11/17 ...  Security Cer
Recent Places

Desktop
uEJ
Libraries
A
Computer

il nsme: pr—— -

Files of type: [certifieate Filests der) - [ Gencer |

4 i | 3

2 Select the certificate file (*.der) that you want to install, and click Open.
The certificate is installed, and the server certificate information is updated.
If registration fails, an error (E3057) will appear.

Basic Operation

(2) Generate a self-signed certificate

1 Click Generate a self-signed certificate.
A Generate a self-signed certificate dialog box appears.

-
Seli-signed Certificate{*:Required fields) x
Country(*).

| |
State(*) | |
City(") | |
Organization(*): | |
| |
| |
| |

Organization unit:

Common name(*):

E-mail address:

L OK J | Cancel )

2 Enter the items. The input ranges are as follows.
» Country: 2 alphabet characters
 State, City: Alphanumeric characters, spaces, and symbols. Up to 128 characters.
Prohibited characters: !"# $%&";?|
» Organization, Organization Unit, Common Name, E-Mail address: Alphanumeric
characters, spaces, and symbols. Up to 64 characters.
Prohibited characters: !"# $%&";?4|

3 Click OK.
A self-signed certificate is created.
If creation fails, an error (E3072) will appear.

Nofte

» If a character string that you enter exceeds the limit, it is truncated within the limit.
» Issuer information and subject information will be the same.
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Chapter 10 OPC-UA Server Function (/UA option)

The following table shows the items and descriptions of the self-signed certificate that is

created.
Item Name Description
Version “V3”
Serial No. Auto generation?
Signature Algorithm Sha1lRSA
Signature Hash Algorithm Sha1

Issuer: Country

Setting entered in the dialog box

Issuer: State

Same as above

Issuer: City

Same as above

Issuer: Organization

Same as above

Issuer: Organization unit

Same as above

Issuer: Common name

Same as above

Issuer: E-Mail address

Same as above

Valid from

PC time when the certificate was created

Valid to

2037/12/1 21:00:00

Subject: Country

Setting entered in the dialog box

Subject: State

Same as above

Subject: City

Same as above

Subject: Organization

Same as above

Subject: Organization unit

Same as above

Subject: Common name

Same as above

Subject: E-Mail address

Same as above

1 Generated automatically from the server software license number.

If a certificate does not exist when the GA10 OPC-UA server is started, a self-signed

certificate is automatically created with the following information. Issuer information and

subject information will be the same.

Details of the Items in the Self-Signed Certificate Created Automatically

Item Name Description
Version “V3”

Serial No. Auto generation?
Signature Algorithm Sha1RSA
Signature Hash Algorithm Sha1

Issuer: Country “JP”

Issuer: State “Tokyo”

Issuer: City “Musashino”

Issuer: Organization

“Yokogawa Electric Corp.”

Issuer: Organization unit

“Product Business Center”

Issuer: Common name?

“GA10-UAServer@"“+[ComputerName]

Issuer: Domain component?

[ComputerName]

Valid from PC time when the certificate was created
Valid to 2037/12/1 21:00:00

Subject: Country “JP”

Subject: State “Tokyo”

Subiject: City “Musashino”

Subject: Organization

“Yokogawa Electric Corp.”

Subject: Organization unit

“Product Business Center”

Subject: Common name?

“GA10-UAServer@"“+[ComputerName]

Subject: E-Mail address?

Blank

1 Generated automatically from the server software license number.

2 The PC name is entered in ComputerName.

10-10
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Chapter 10 OPC-UA Server Function (/UA option)

Basic Operation

(3) Creating a Certificate Signing Request (CSR)

1 Click Issue a certificate signing request (CSR).
A Issue a certificate signing request (CSR) dialog box appears.

.

Issue a C SR(*:Required fields) x

Country(*): |
State(*):

City(*):

Crganization(*):

Common name(*):

E-mail address:

File Mame{*).

|
| |
| |
| |
Organization unit: | |
| |
| |
| |
|

Folder(*). | [ Refer to ]

L Ok ) | Cancel |

2 Enter the items up to File Name. The character input range is as follows.

« Country: 2 alphabet characters
» File Name: Up to 60 characters excluding V:,;*?"<>|
« State, City: Alphanumeric characters, spaces, and symbols. Up to 128 characters.
Prohibited characters: "# $%&';?%|
» Organization, Organization Unit, Common Name, E-Mail address: Alphanumeric
characters, spaces, and symbols. Up to 64 characters.
Prohibited characters: "# $%&';?%|

3 Click Browse to specify the save destination folder.
The Browse for Folder dialog box appears.

i Browse for Folder ‘ = |

Bl Desktop -
> €l Netwark
> [ Libraries
& Recyde Bin
> [B Control Panel
4 (M Computer
b & Local Disk (C:)
> eiy DVDRW Drive (D:)
> 1 Capture
| chedk_temp .

|

The character input range is as follows.

* Up to 255 characters.
Prohibited characters: /?"<>|

4 ciick OK.
A certificate signing request (CSR) is created in the specified folder. The file name extension is
.CST.
If creation fails, an error (E3067) will appear.
The following table shows the items and descriptions of the certificate signing request (CSR) that

is created.

Item Name Description

Country Setting entered in the dialog box
State Same as above

City Same as above

Organization

Same as above

Organization unit

Same as above

Common name

Same as above

E-Mail address

Same as above

IM 04L65B01-01EN
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Chapter 10 OPC-UA Server Function (/UA option)

10.2.5 Status Page

OPC-UA server projects do not have a recording function, so unlike normal projects, items
related to recording are not displayed on the Status Page.

Project Status. Monitoring
Loss Data: —

Device Running State ]

r 001: GM_M22_3 ) D ‘@ 003: GX20
BIS] cwio  roozss|| 25 cPio Roo20d cX20  R20201

10.0.136.37 10.0137.42 10.0.137 64
Normal Normal Normal

* Project Status
Not monitoring or monitoring
* Loss Data
Recording data dropout status
¢ Device Running State
The status of communication with the devices in the Device List is displayed. Nothing is
displayed when data collection is stopped.
Model icon

001: GM_M22_3 «—1— Device name
GM10 R2 02 9f5¢4— Model name

10013637 e | Communication address

Mormal — Comm. Status
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Chapter 11 Modbus Server Function

1.1

Basic Functions of the Modbus Server

The Modbus server function receives requests from Modbus/TCP client devices and returns
information about the currently running GA10 project specified by the Modbus address as
responses.
A Modbus client device can carry out the following operations on the GA10.
» Read the data of tags and math tags
Value, status, scale upper and lower
» Read project information data
Data collection and recording status, alarm status, alarm ACK status, data dropout
presence/absence, write error presence/absence, beginning time of recording, total time
of recording, number of generated files

Data Logging Software GA10
Modbus Server

L GA10 internal register Client
T ~ Ethernet 9 Command
~
R I + Input register -Read Read
—— > Rea
BXXXXX
GX/IGP
Hold register
=) L) ——» Read
= 4AXXXXX
Modbus client device
Basic functions of the Modbus server are listed below.
Specification Description
Protocol Modus TCP
Port number 502 (default value)
Function code 3 (read hold register), 4 (read input register)
Maximum number of connectable clients 30
Data update interval Same as the scan interval of the corresponding GA10 project
Address range 1 to 247 (assigned to the GA10 project)

IM 04L65B01-01EN
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Chapter 11 _Modbus Server Function

11.2 Modbus Server and Register Assignments

11.2.1 Modbus Server
Function code
The GA10 supports the following functions.

Function Code  Function Operation

3 Read the hold register The client (master) device reads the GA10 tag and math tag data.
(4XXXX, 4XXXXX)

4 Read the input register The client (master) device reads the GA10 tag and math tag data.

(BXXXX, 3XXXXX)

11.2.2 Register Assignments

The Modbus register addresses for tabs and math tags are assigned fixed address in order
by the GA10 project's tag indexes (1 to 2000) and math indexes (1 to 2000) as shown in the

following table.

Tag and Math Input Registers

Type Input Register Data Type
Value Tag 300001 to 304000 32-bit floating point (little endian)
Math tag 310001 to 314000 32-bit floating point (little endian)
Status Tag 320001 to 322000 16-bit unsigned integer
Math tag 324001 to 326000 16-bit unsigned integer
Scale lower and upper|Tag 330001 to 338000 32-bit floating point (little endian)
Math tag 346001 to 362000 32-bit floating point (little endian)
Tag and Math Hold Registers
Type Hold Register Data Type
Value Tag 400001 to 404000 32-bit floating point (little endian)
Math tag 410001 to 414000 32-bit floating point (little endian)
Status Tag 420001 to 422000 16-bit unsigned integer
Math tag 424001 to 426000 16-bit unsigned integer

Scale lower and upper

Tag

430001 to 438000

32-bit floating point (little endian)

Math tag

446001 to 462000

32-bit floating point (little endian)

Project Information Input Registers

capacity

Type Register Value Data type
Project Status 365001 0: Stopped, 1: Monitoring, 2: 16-bit unsigned integer
Recording
Data dropout 365002 0: No, 1: Yes 16-bit unsigned integer
Write error 365003 0: No, 1: Yes 16-bit unsigned integer
Time correction 365004 0: Disabled, 1: Enabled 16-bit unsigned integer
(correcting), 2: Enabled, 3: Not
used
Recording |Year 365005 — 16-bit unsigned integer
start time |Month 365006 1-12 16-bit unsigned integer
Day 365007 1-31 16-bit unsigned integer
Hour 365008 0-23 16-bit unsigned integer
Minute 365009 0-59 16-bit unsigned integer
Second 365010 0-59 16-bit unsigned integer
Millisecond |365011 0-999 16-bit unsigned integer
Total time of recording | 365012 — 32-bit unsigned integer (little
(s) endian)
Number of Generated |365014 — 32-bit unsigned integer (little
Files endian)
Total disk capacity 365016 The unit is MB. 32-bit floating point (little endian)
Remaining disk 365018 The unit is MB. 32-bit floating point (little endian)

11-2
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11.2.3 Input Registers
Client devices can read the input registers.

Tag, Math Data

Type Tag data Input Register |[Data Type
Value Tag Lower bytes of the tag 0001 data 300001 32-bit floating point (little
Higher bytes of the tag 0001 data 300002 endian)
| |
Lower bytes of the tag 2000 data 303999
Higher bytes of the tag 2000 data 304000
Math tag Lower bytes of the math tag 0001 data 310001
Higher bytes of the math tag 0001 data  |310002
| |
Lower bytes of the math tag 2000 data  |313999
Higher bytes of the math tag 2000 data | 314000
Status Tag Tag 0001 status information 320001 16-bit signed integer
| |
Tag 2000 status information 322000
Math tag Math tag 0001 status information 324001
| |
Math tag 2000 status information 326000
Scale minimum, |Tag Lower bytes of the tag 0001 data 330001 32-bit floating point (little
maximum Higher bytes of the tag 0001 data 330002 endian)
| |
Lower bytes of the tag 2000 data 337999
Higher bytes of the tag 2000 data 338000
Math tag Lower bytes of the math tag 0001 data 346001
Higher bytes of the math tag 0001 data | 346002
| |
Lower bytes of the math tag 2000 data 361999
Higher bytes of the math tag 2000 data  |362000
Status
Bit15 Bit0
Lit il tebitstasi [ |} ]
Bit Description
0 Alarm level 1 (On: 1, Off: 0)
1 Alarm level 2 (On: 1, Off: 0)
2 Alarm level 3 (On: 1, Off: 0)
3 Alarm level 4 (On: 1, Off: 0)
4t07 Reserved
8to 15 Error code (5-bit binary into decimal)
0: No error
1: +OVER
2:-OVER
3: Skip
4: Data dropout (recorder)

5: Undefined data

6: No data

7: Invalid

8: +OVER burnout

: -OVER burnout

10: Not a number

11: Error

12: Off

13, 14: Not used

15: Data dropout (GA10)

©

Data dropout at the relevant measurement point on the recorder.

Data not acquired or data dropout at the relevant acquisition point on the GA10.

IM 04L65B01-01EN
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11.2.4 Hold Registers

Client devices can read the hold registers.

Tag, Math Data

Type Tag data Hold Register|Data Type
Value Tag Lower bytes of the tag 0001 data 400001 32-bit floating point (little
Higher bytes of the tag 0001 data 400002 endian)
| |
Lower bytes of the tag 2000 data 403999
Higher bytes of the tag 2000 data 404000
Math tag Lower bytes of the math tag 0001 data 410001
Higher bytes of the math tag 0001 data |410002
| |
Lower bytes of the math tag 2000 data  |413999
Higher bytes of the math tag 2000 data  |414000
Status Tag Tag 0001 status information 420001 16-bit unsigned integer
| |
Tag 2000 status information 422000
Math tag Math tag 0001 status information 424001
| |
Math tag 2000 status information 426000
Scale minimum, |Tag Lower bytes of the tag 0001 data 430001 32-bit floating point (little
maximum Higher bytes of the tag 0001 data 430002 endian)
| |
Lower bytes of the tag 2000 data 437999
Higher bytes of the tag 2000 data 438000
Math tag Lower bytes of the math tag 0001 data 446001
Higher bytes of the math tag 0001 data  |446002
| |
Lower bytes of the math tag 2000 data  |461999
Higher bytes of the math tag 2000 data  |462000
Status

See the status in section 11.2.3, “Input Registers.”

11.2.5 Responses to Requests and Timeout Processing
Responses to requests are described below, including normal cases.
 If the specified function code is not 3 (read hold register) or 4 (read input register),
exception code 1 is returned.
 |If there is no specified project or if monitoring is not in progress, exception code 2 is

returned.

 If the register of the specified tag exceeds the range, exception code 2 is returned.
 If the register of the specified tag is within range but the tag does not exist, “no data”

status is returned.

» For all other cases, a normal response is returned.

Timeout Procedure

If there is no communication with a Modbus client for 2 minutes (the value specified on the

GA10 client screen), the connection to the Modbus client will be disconnected.

11-4
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Chapter 12 Troubleshooting

12.1 Messages That GA10 May Display

Messages may appear on the screen during operation. This section describes the messages and how to respond to

them.

Messages

Code Message

Description and Solution

M1001 OK to switch to detail setting mode? Unavailable to
back to simple setting mode.

M1002 Do you want to start the monitoring all at once?

M1003 Do you want to stop the collecting all at once?

M1004 Do you want to start the recording all at once?

M1005 Do you want to stop the recording all at once?

M1006 Do you want to stop the recording?

M1007 Do you want to log out?

M1008 Do you want to enforce to be unlock?

This is a message that asks the administrator to confirm the unlocking
of the locked project.

M1009 Do you want the user(%s)'s password to be initialized?

This is a message that asks the administrator to confirm the
initialization of a user password. %s indicates the name of the user
whose password will be initialized.

M1010 Trial version is time up, operation is prohibited.

This message appears when a client accesses the server after the
server trial period has expired.

M1011 Successed in Activation.

This message indicates that the client license has been registered
successfully.

M1012 Server is activated. Please restart server.

After the server license registration is complete, the server needs to be
restarted.

M1013 Option is added to server. Please restart server to
enable option.

After an option is added to the server, the server needs to be restarted.

M1014 Is it OK to exit?

This message asks whether you want to close the client.

M1015 OK to add new channels of new devices or changed
devices in the tag settings? (The current tags
information is not changed)

This message appears when a device is added to the Devices List or
when a device channel is added. If you click OK, the changed device
and channel information are reflected in the Tag Setting Page and
Display Group Setting Page.

M1016 OK to update the selected device's channel
information? (Updated tag information will appear in
the tag settings screen.)

This message asks whether you want to update the device channel
information. If you click OK, GA10 will access the selected device,
retrieve its channel information, and reflect the information on the Tag
Setting Page.

M1017 Update the selected tag information?

Click OK to update information other than tags and tag comments.

M1018 Schedule re-executed successfully.

The re-execution of the specified schedule is complete.

M1019 Print completed successfully.

M1020 Generating a report completed successfully.

M1021 OK to execute sorting of tags in order of the device
number? (Resetting is needed in Math tags)

If you click OK, tags are sorted by device number. If you select
[Cancel], tags are not sorted.

M1022 Reflect Tag No, Tag Comments by Device setting?

If you click OK, the character strings of the tags and tag comments set
in the device are retrieved. If you select Cancel, they are not retrieved.

M1023 Do you want to run the operation?

A confirmation message. If you click OK, the operation is executed.

M1024 Mail sending is successful.

M1025 Some mail sending is successful.

M1026 Mail test is in process in other projects. Please try
again after a while.

M1027 Do you want to save manually?

M1028 “The port number is already in use. Specify another
port number.”

IM 04L65B01-01EN
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Chapter 12 Troubleshooting

Warning Messages

Code

Message

Description and Solution

W2001

Do you want to delete this user(%s)?

This message asks whether you want to delete the registered user. %s
indicates the name of the user that will be deleted.

W2002

Do you want to delete this device(%s)?

This message asks whether you want to delete the device from the
Devices List on the Device Setting Page or the Registered Devices
List. %s indicates the name of the device that will be deleted.

W2003

Do you want to delete this data file(%s)?

This message asks whether you want to delete the data file from the
Data files Page. %s indicates the name of the data file that will be
deleted.

W2004

Do you want to delete the Project(%s)?

This message asks whether you want to delete the project. %s
indicates the name of the project that will be deleted.

W2005

The release number(%s)of handled meters is out of
support.

The release number of the device is not supported. Thus, proper data
collection cannot be guaranteed. Consider updating the firmware or
using a supported device.

For the supported models and versions, See the General
Specifications (GS 04L65B01-01EN).

W2006

Total number of channels of registered devices
exceeded the supported range.

This message notifies that when you are registering a device to the
device list or updating the device information, the total number of
channels of registered devices exceeds the number of tags that can be
supported. Click OK to proceed with the operation.

W2007

If changed to Device time, math tags will be unavailable.

This message appears when you try to change Data time to Device time.
The Math function works when PC time is selected. Clicking OK will
change the setting to Device time. Clicking Cancel will discard the
change.

W2008

Option configuration of project does not have
compatibility with the server. It will be converted to
match the options configuration of the server during
importing. Continue importing?

This message appears when you try to import a project that was
created on a GA10 with different number of channels or options. (The
importing GA10 has less channels or does not have the functions.)

If you click OK, import is executed to the greatest extent possible.

If you click Cancel, importing does not take place. For details, see
“Importing a project created on a GA10 with a different system
configuration (GA10 version R2.02.xx or later)” on page 3-8.

W2009

Failed to add some of new channels.

This message appears when new devices or channels on the Devices
List fail to be assigned completely to the Tag Setting Page. If you click
OK, you can resume operation.

W2010

Do you want to delete report/print history (%s) ?

Confirms whether print logs will be deleted on the Report/Print History
tab of the report/print function (/RP option). %s indicates the name of
the schedule that will be deleted.

W2011

Do you want to delete all unused devices?

Select whether to delete unused devices.

12-2
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Error Messages

Code Message

Description and Solution

E3001 Unable to connect to the specified server.

Check whether the DLGServer server program is running as a service.
How to check: ’page 2-10 2.7.1 Checking Whether the Server Is
Running

Check for problems in the communication path to the server and IP
address and port number settings.

If you cannot connect to the server, stop the server firewall, or register
DFMServer.exe and DLGServer.exe as exceptions in the server firewall
configuration.

Login failed. Please confirm the user name or the

E3002
password.

GA10 is connected to the server, but the user information for logging
in is not correct. Check the user name and password that you have
entered.

Connected clients has reached maximum, you can not

E3003 .
log in.

Wait for the other client to log out.

E3004 Unable to connect to the server.

Check for problems in the communication path to the server.

The user name already exists, the user can not be

E3005 registed.

A user with the same name is already registered. Check the user
name, and register with a different name.

E3006 The password is incorrect.

The password that you entered for changing the password is incorrect.
Check the current password, and re-enter it.

E3007 Please enter at least four characters for the password.

Enter 4 to 30 characters for the password.

The new password and the comfirmed password does

E3008 not match.

Enter the new password and confirmation password so that they
match.

E3009 You can not delete the logged user.

Delete the user after the relevant user logs out.

Users to change is logged into the server. The basic

E3010 information can not be changed.

Modify the basic information after the relevant user logs out.

User to be initialized is logged in to the server, user

E3011 PR Initialize the user after the relevant user logs out.
can not be initialized.

E3012 The maximum ngmber of logins has been reached, the Delete registered users first, and then register additional users.
user can not log in.

E3013 Since the Project name you entered already exists, the A project with the same name is already registered. Check the project
project can not be created. name, and register with a different name.

E3014 Since the Project name you entered already exists, A project with the same name is already being used. Check the project

you can not change it.

name, and change to a different name.

E3015 The Project which is opening, can not be deleted.

Delete the project after closing the relevant project.

E3016 The Project which is running, can not be deleted.

Delete the project after stopping the relevant project.

The maximum number of registered devices has been

E3017 reached ,the device cannot be registered.

Delete any of the devices registered in the server first, and then
register the new device.

E3018 The equipment in use can not to be removed.

The device that you want to delete is being used in a project. Check
that the device is not being used in another project. Delete the device
from the Devices List on the Device Setting Page of other projects, and
then delete the device.

Original owner is opening projects, you cannot change

E3019 the owner.

When the administrator tried to change the owner of a project, the
current owner had the project opened. Change the owner after the
current owner closes the project.

E3020 Server can not receive device information.

» Check the information for accessing the device and the
communication path between the server and device.

» Device with the channel set to zero cannot be registered.
Reconfigure the connected devices to detect the 1/O modules,
turn on the communication channel, or perform other appropriate
measures. (To register temporarily, use offline registration.)

» To register GateWT for GA10 as a connection target in the GA10
Device List and then start it, right-click and choose Run as
administrator.

E3021 Fail to create record folder.

The specified drive does not exist. Change the data file save
destination folder.

E3022 Failed to start Universal Viewer.

Check whether Universal Viewer is installed in the PC.

IM 04L65B01-01EN
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Chapter 12 Troubleshooting

Code Message Description and Solution
E3023 An error occurred while reading the file. Failed to load thg file vyhen mpqrtmg a project or tag information.
Check that the file for importing is correct.
E3024 An error occurred while writing the file. Checlf that the export _destlnatlon folder is not set to read-only and that
there is enough free disk space.
E3025 User manual does not excit in the specified location.  Place the PDF manuals in the client installation folder.
E3026 Failed to start Adobe Reader. Check whether Adobe Reader is installed and the version.
Simultaneous running projects has reached the The number of running projects in the server has reached the
E3027 - ” o . o }
maximum number, failed to start monitoring. maximum number. Stop data collection in other projects.
. Data collection cannot be started because the maximum device
Because the maximum concurrent number of . . L -
E3028 . . . connections will be exceeded. Stop data collection in other projects or
connected devices is reached, collecting cannot start. . .
change the data collection device.
Because the maximum device number that can be Delete any of the registered projects first, and then register the new
E3029 ; . . )
registered is reached, the Project can not be created. project.
Because the maximum number of open projects is The number of projects that the client has opened has reached the
E3030 . . -
reached, the project cannot be opened. maximum number. Close any of the opened projects.
E3031 Failed to delete data file. Another client may be using the data file that you want to delete.
E3032 Failed to open data files. Update the |nf(_)rmat_|on on the Data files Page, and check that the
relevant data file exists.
E3033 Fail to launch web browser. A Web browser may not be installed.
E3034 g&?:}tt'on failed because there is no right to access Ask the project owner to grant project access privileges.
Operation failed because the target user does not The user may already have been deleted. Update the information on
E3035 " )
exist. the User Management Page, and check whether the user exists.
E3036 Fail to '”.”'"°” project because registered devices reach Delete unneeded devices from the Registered Devices List.
the maximum number.
E3037 Project is cloged, because Project lock status is To use the project, open it again.
released forcibly.
E3038 Operation failed because the project is locked by Use the project after the project is unlocked.
another user.
E3039 Specified new owner does not exist, you can not The user may already have been deleted. Set the new owner to an
change the owner. existing user.
. . — The project may already have been deleted. Update the information on
E3040 Operation failed because Project is deleted. the Project List Page, and check that the project exists.
E3041 Serial no is invalid. Activation failed. Check the license number, and enter it correctly.
E3042 Server has_not been activated. Adding option to Register the server license first, and then add options.
software failed.
Adding the option would cause the number of tags to exceed the
Tag upgrade option's serial no is invalid. Fail to add maximum recording tags in the project. In the server information dialog
E3043 . ) .
option's serial no. box, check the current number of tags, and check whether the option
that you tried to add is appropriate.
E3044 Part of the data files can not be deleted. Some of the d_ata files that you tried to delete could not be deleted.
They may be in use.
Some of the data files that you tried to open could not be opened.
E3045 Part of the data files can not be opened. Update the information on the Data files Page, and check that the data
files exist.
Failed in registration. The administrator authority is Log on again as a Windows administrator. Or, choose Run as
E3046 required. Please restart as an administrator or run as  administrator when starting Data Logging Software. (In Windows 7,
administrator and restart. right-click the software icon, and click Run as administrator.)
Try the following:
. . . » Stop other running programs.
E3047 Ifgi:gflment memory available to the OS. Operation » Reduce the number of simultaneously running projects.
' * Increase the PC RAM.
« If you are using a 32 bit edition, try a 64 bit edition.
Since the number of tags in the imported project The number of tags in the project that you are trying to import exceeds
E3048 configuration information exceeded the number of tags the number of tags handled by the current server. Consider increasing

supported by the current server,failed to import.

the number of tags handled by the server.
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Code Message Description and Solution
If Start Monitoring Simultaneously cannot be executed, it could be any
of the following reasons.

» The number of simultaneously running projects or simultaneously
connected devices exceeds the limit.
. . . * There is not enough available memory on Windows.

E3049  Failed to operate some projects or all project at once. If Start Recording Simultaneously cannot be executed, it could be any

of the following reasons in addition to the reasons listed above.
» The data save destination folder failed to be created.
Close projects that do not require data collection. To start recording,
change the data file save destination folder.
Try the following:

- . . . * Stop other running programs.

E3050 Icr|1§lsJ£f|C|ent memory available to the OS. Project will » Reduce the number of simultaneously running projects.

’ * Increase the PC RAM.

« If you are using a 32 bit edition, try a 64 bit edition.
Fail to start monitoring because the necessary setting There is an error in the information that is used during data collection.
E3051 . . ) o
is not correct. Check for errors in Modbus device definition files.
E3052 Operation failed because device has been deleted. Update the device information on the Registered Devices List.
Searching is not allowed because auto-search in Another client is searching devices with different search conditions.

E3053 . : ; )

progress. Wait for the search operation to complete, and try searching again.

E3054 Failed to update the information of some specified tags Check the communication status of the device used by the tag to be

or all tags. updated.
Below are possible reasons. Check the condition of the save
destination.
* There is not enough free space on the data save destination drive.
« If the data save destination is an external storage device, the device

E3055 Cannot write to specified recording folder. is not inserted properly or is removed.

» The data save destination is set to read-only.

» The data save destination drive is broken.

* Alocation (folder) that is restricted by the operating system of the
server is specified.

Make sure that the version of the added client is the same as the

E3056 Connecting this version's server is not available. server version. Download the latest version of the software from the
following URL: www.smartdacplus.com/software/en/

E3057 Failed to install the certificate. The certificate cannot be stored in the server. Check the certificate
format, file size, free space in the save destination folder, and write
privileges.

E3059 Failed to register the template file. The template file cannot be stored in the server.

Check the free space in the save destination folder and write privileges.

E3060 Failed to download the template file. The template file cannot be downloaded to the specified folder.

Check the free space in the specified folder and write privileges.

E3061 Failed to delete the template file. The template file cannot be deleted. Check write privileges of the
save destination folder. Check that the file is not opened with another
application.

E3062 Failed to delete the schedule. A schedule that is in the middle of monitoring or recording cannot be
deleted.

E3063 Excel is not installed. Install Excel.

E3064 Can not open the report file. Check that the report file is in the report folder.

E3065 Failed to generate a report file. Check the disk space of the server’s report file save destination and
folder’s write privileges. Check the presence of the data file.

E3066 Failed to print. Check the presence of the data file.

E3067 Failed to issue a certificate signing request. Check the presence of the data file. Check that the file name, destination
folder, and other settings are correct.

E3068 The option is already enabled. The option corresponding to the license number you entered is already
enabled. You can check enabled options by clicking Server Information
or Input Server License (license input screen) on the server’s Help menu.

E3069 Failed to start the OPC-UA server. The port number is There may be a port number collision. Check that the OPC-UA server

already in use. port number is not being used by another process.

E3070 The server certificate is invalid. The private key and certificate are inconsistent.

IM 04L65B01-01EN
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Code Message Description and Solution
E3071 Can not import the project. It contains unavailable There is not enough number of channels (tags) or an option is not
function. available for importing the relevant project. The number of channels

(tags) or optionson the server do not meet the configuration
requirements of the project that you are trying to import.

E3072 Failed to generate a self-signed certificate. The private key does not exist, or you do not have write privileges to
the folder.

E3073 Failed to paste project. The project cannot be pasted because there is not enough disk space
on the server.

E3074 Failed to register the custom display file. Custom display setting file cannot be registered. Check the disk space
of the server and folder’s write privileges.

E3075 Failed to register the alarm sound file. Check the disk space of the server’s alarm sound file save destination
and folder’s write privileges.

E3076 Failed to download alarm sound file. Check the disk space and write privileges of the client’s specified
folder.

E3077 Failed to delete alarm sound file. Check the write privileges of the alarm sound file storage folder of the
server, and check that the file is not opened by another application.

E3078 Failed to send mail. Check that the SMTP server, authentication method, and sender

settings are correct.
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12.2 Frequently Asked Questions (FAQ)

Q1

Q2

Q3

Q4

Can GA10 and GA10CL be installed and run in the same PC?
A1
GA10 and GA10CL cannot be installed on the same PC.

Is there a way to back up the recording data files automatically?
A2
You can use the mail transmission feature to send generated data files as email

attachments. You can store the data files as back up in the device receiving the email
messages.

The communication between the server and the data acquisition
device was disconnected. How does the server behave when
communication is restored?

A3

Resuming data collection and recording

The server will retry to connect approximately every 30 seconds. When reconnection is
successful, the server resumes data collection and recording.

Recording data
The way that the server handles recording data when communication is restored varies
depending on whether data is being collected in PC time or device time.
* If data is being collected using PC time
The data during which communication was not possible will not be recorded.
* If data is being collected using device time

After communication is restored, the server prioritizes the collection of data that can be
gathered in real time through communication. Then, the server collects data that could
not be collected from devices and fills the missing data in the recorded data files. This

function is called backfill. Backfill only works when the necessary conditions are met. If
the conditions are not met, the data during which communication was not possible will

not be recorded. See Q4.

How does backfill work?
A4

When a communication error occurs between a server and device, data dropout occurs in
the data file that the server is recording. Backfill is a function that fills the dropped data in the
recording file by retrieving the missing data from the device after the system recovers. Data
is retrieved automatically from the device when the operating conditions are met.

When the communication interference is eliminated, the backfill function operates
automatically. The restored data is saved as a new file, and you can view it on the Data files
Page. Marks that indicate that backfill has been performed are added to the beginning and
end of the restored section of the data.

In the case of a short communication interference,* data loss may be restored even when
the above settings are not specified. In such a case, GA10 does not create a new file but
writes directly to the recording file.
* The length of interruption time that makes this operation possible varies depending on the
connected device.
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Backfill Operation Conditions
On the GA10 side

Applicable data: Binary data (Excel data is not included)
Data time is set to Device time.

On the connected device side

Applicable devices: GX10, GX20, GP10, GP20, GM10, DX1000, DX2000,
DX1000N, DX1000T, DX2000T, FX1000, MV1000, MV2000

Device’s internal memory contains the event data file corresponding to the data
loss location.

The scan interval of the device is the same as the recording interval of the event
data.

FTP transferring of files is enabled.(FTP server function: ON, Port number: 21)
The multi batch function is not in use. If the multi batch function is enabled,
backfilling is not performed.

The time zone and daylight saving (DST) settings on the main unit are the same
as those on the PC.

On the GX/GP/GM with Advanced Security function (/AS option) side

If the advanced security function is disabled, backfill operates.

If enabled, backfill operates when Communication in Security basic settings is set
to Off.

If Communication in Security basic settings is set to Login, backfill operates only
when a Monitor user is connected.

On the DXAdvanced series with Advanced Security function (/AS option)

Backfill operates regardless of whether the advanced security function is enabled
or disabled.

Handling of files collected by backfilling

Files collected by backfilling are the same as normal data files except for the point
given below.

The file division conditions specified on the recording setting page do not apply.
Therefore, the files may become larger than normal data files.

Other information

Backfill is not performed if a communication error or other error had occurred at
the start of recording.

If a data backfill operation cannot start due to a device access failure, because an
event data file is being created, or due to some other reason, GA10 will access the
device every hour.

If the server stops during a backfill operation, the operation will stop. Even if the
server is restarted, the previous backfill operation will not be performed.

If any of the following settings on the device is changed after starting data
collection, backfill will not be performed.

Acquisition interval, time, channel on/off, decimal place, unit, span (scale), alarm
on/off, alarm type, and alarm value

If the advanced security function (/AS) option is enabled on the GX/GP/GM,
backfill operation is not performed for user levels other than monitor.

12-8
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Q5

Q6

The server stopped or the server PC shut down. How does the server
operate after it restarts?

A5

Server recovery

The server retains the most recent status information just in case the host PC shuts down.
When the PC restarts, the server recovers the operation based on the status information.

Resuming data collection and recording

The server resumes data collection and recording after it restarts unless the user had
manually stopped the server or shut down the host PC.

Depending on the power-off condition, monitoring and recording after restarting will behave
as shown in the following table.

Power-off

Condition
Sudden power-off |Unpredictable shutdown
such as a power failure or PC
power cord disconnection
Shutdown by a user, restart  [Resume (version R2.02.xx|Divide
due to Windows updating, and [and later)
the like Resuming is not possible
on older versions of
GA10.

Description Monitoring/Recording File Division Backfill
after Restart Display Division Operation

Resume Divide No operation

Normal restart No operation

Monitoring and recording are not affected by logging off of the PC.

When the report/print function (/RP option) is in use

Auto print schedules that have not been completed due to a PC shutdown are executed
again when the server recovers. However, output results of auto print executed in this way
may have up to 10 minutes of data missing before the shutdown.

A communication error occurred between the client and server. Will
data collection continue?
A6

Because data collection is performed between the server and data collection devices, the

operation continues even when a communication error occurs between the client PC and

server PC.

When a communication error occurs between the client PC and server PC, the client logs

out from the server. The project that was open is closed. In this situation, if data collection

was in progress and the project’s Keep Lock State was set to ON, the project will remain

locked.

To control the project before the communication recovers, perform either of the procedures

below from a client on another PC using the same project.

» Open the project using the same user.

* Log in as an administrator. On the Project menu, click Unlock Project Forcibly to unlock
the project.
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Q7 Unable to control the project. Why?
A7

Below are possible reasons.

» The user is not assigned privileges to control the project. — Open the project using a user
who has privileges to control the project, such as Owner, Manager, or Operator.

» The project is locked. — If an owner, manager, or operator user is logged in, the project
is locked. Other users can only monitor the project. Wait until the other user using the
project closes it.

» The project is locked. — If data collection is in progress and the project’s Keep Lock
State is set to ON, the project remains locked even when an owner, manager, or operator
closes the project. To control the project, perform either of the following procedures.

» Ask the user who locked the project to unlock the project.
» Clear the Keep Lock state.

Q8 | forgot the user password. What do | do?
A8
If the administrator password is lost, there is no recovery method. Contact your nearest
YOKOGAWA dealer.
If a user password is lost, the administrator can initialize the password. Then, the user can
log in with the initialized password (blank) and set a new password.

Q9 The device data and the data collected and recorded by GA10 are not
synchronized. Why?
A9
Data collected using Device time is recorded as-is by the software. In this situation, the
device data and the collected and recorded data are synchronized.
However, data collected using PC time are timestamped with the PC time and the values are
adjusted accordingly. In this situation, the device data and the collected and recorded data
based on PC time may not be synchronized.

Q10 Can the recorded data be printed?
A10
Data files can be printed using Universal Viewer. Universal Viewer is supplied with this
software and installed along with this software.

You can also print a specified range of data at the specified time by adding the /RP option. :
» 5.1 Configuring Auto Print
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Q11
to data collection?
A11

Changes to devices before data collection is started
This software retrieves device information when the device is registered to the Device List. If
this information is different from the actual device information at the start of data collection,

the software will collect data but will handle it as invalid data.
Check the following settings and match them.

Channel data type, unit, span, decimal place, alarm type, and alarm value
You can use Update Setting on the Device List to update the settings.

Changes to devices during data collection and recording
If you change the device settings during data collection and recording, the changes will not
be reflected to the software. Stop the data collection, apply the setting changes using either
of the methods below, and restart the data collection.

» Execute Update Setting of the devices in the devices List.
» Register the device again.

Device settings were changed. At what point are the changes applied

However, if data is being collected using Device time and you change the device’s
acquisition interval, the software will reset the entire monitor data, restart monitoring, and

stop recording.

Do not change the time on the device after starting data collection and recording, because
doing so will cause adverse effects on the monitor screen and recorded data.

When the connected device is a SMARTDAC+ series (GX/GP or GM) device and the GA10
version is R2.02.xx or later, alarm information changed on devices during data collection is
reflected on the monitor. Changes in the alarm on/off states and types are reflected on the

monitor. Note that changes in alarm types are not reflected in the alarm list of the recording

file.

Q12

setting the Data time to Device time?

A12

What is the difference between setting the Data time to PC time and

For information on the different data collection conditions, see also Setting Data Collection
Conditions on page 3-33.
The following table summarizes the major differences. For a detailed explanation, see the

following pages.

Differences . Display
L " Collection and .
Mode Description | Backfill Record Interval| Trend Monitor | Alarm Overview Saved Data Files
Time on the |No Select from No display limitations because all |Data can be
PC time server PC available the data can be displayed on the [saved to a single
options same time axis. file.
Time on the |Yes The interval on |[If there are The page is Files are divided
device (fills each device is  [multiple devices [subdivided and |by a combination
dropped used, soitis with different a list is displayed |of device and
data using [not possible to [times or scan for each device. [scan interval.
data on the [specify a single [intervals,
Device time device) interval. Monitor Sets
are subdivided
to display each
combination of
device and scan
interval..

IM 04L65B01-01EN

12-11

Bunooysajgnoul



Chapter 12 Troubleshooting

What is PC time?
PC time is the time information that the server PC uses. In PC time mode, the server
attaches PC timestamps on the data collected from devices. This data is displayed on the
Monitor Page and saved in recording files.
» Data collected using PC time will not necessarily be synchronized to the data of the
corresponding devices.
» Q9

» The timestamps attached to data in PC time mode are determined so that data collection
would always occur at midnight (00:00:00).

» The data collection interval and record interval are specified on GA10.

» The data of all tags is saved to the same file.

What is Device time?

Device time is the time information that the data collection device uses. In Device time
mode, the server collects and records data at the data acquisition intervals of devices. If
there are multiple acquisition intervals in a single device, data is collected and recorded at
each acquisition interval. Device data and collected data are synchronized (the values and
timestamps match).

» Data collection and recording
» Data is collected separately for each device and for each data collection interval.
» Data is collected and recorded at the devices’ data acquisition intervals. You cannot
specify the data collection interval or record interval on GA10.
» Data is saved to separate files for each device and for each data acquisition interval.

PC time Tags for device A and device B
Data
file U
Device time | Tag for device A, Tag for device A, Tag for device B,

collection interval A1  collection interval A2 collection interval B1

Data Data Data
file file file
\

Device A Device B

Collection Collection
intervals interval
A1 and A2 B1

The device number, device name, and device acquisition interval are included in the
names of data files. Below is the file name format when date and time are included.
FileName-DeviceNo-DeviceName-Interval-YYYYMMDDhhmmss.ext

FileName: The file name string specified by the user

DeviceNo: Device number on the Device Setting Page

DeviceName: Device name on the Device Setting Page

Interval: The acquisition interval of each device
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Monitor

The trend monitor displays data based on a single time axis. If there are multiple devices,
the Monitor Set will be divided and waveforms in the display group will be displayed in
windows divided at the interval level. Only up to four divided windows can be displayed.
Anything in excess will not be displayed.

A similar behavior will also occur in alarm lists. The page will be divided, and the lists will
be displayed separately at the device level.

Filling data dropouts

If data collection is set to Device time mode, the backfill function can be used.
What is the backfill function? Q4

Mail transmission function

In the email transmission based on alarm occurrence and release, the software monitors
relevant tags for each device and for each data collection interval to transmit email.

In the email transmission based on the specified period, the software sends email for
each device and for each data collection interval.

In the email transmission based on the specified duration, the software calculates the
duration and sends email for each device and for each data collection interval.

IM 04L65B01-01EN
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Appendix

Appendix1 Creating Report Templates

Creating Report Templates for Report Files in Excel Format

To create a report template, enter keywords and text in the cells of an Excel file. Keywords

specify the type of data that will be entered into a cell. Text are output as they are in reports.

Save the report templates that you create in Excel format (.xlsx extension) or Excel macro

format (.xIsm extension).

P Function: See page App-1 in section 1.12, “Using the Report Template Function (/MT
option)”.

P Setup: See page App-1 in section 1.11, “Configuring the Report Function (/MT option)”.

> Loading and saving report templates: See page App-1 in section 1.12.5, “Loading and
Saving Report Template Files”.

Template Example

Channel number $Ch(R001)$ $Ch(R002)$

Name Tank 1 temperature Tank 1 pressure

Unit $Unit(R001)$ $Unit(R002)$
$ReportDataTime(Hour)$ $ReportDatalnst(Hour, R001)$ |$ReportDatalnst(Hour, R002)$
$Repeat$ $Repeat$ $Repeat$

$Repeat$ $Repeat$ $Repeat$

Report Output Example

Channel number TIC-001 PIC-002

Name Tank 1 temperature Tank 1 pressure
Unit °C kPa

2012/12/01 00:00:00 76.5 45.6

2012/12/01 01:00:00 78.9 56.7

2012/12/01 02:00:00 77.7 50.8

Keyword Format

Keywords are written by themselves or with parameters.
$ Keyword(parameter)$ Example: $ReportDataSum(Hour,R001,00,23)$

Basic Rules

» The dollar sign on the left indicates the start of a keyword, and the dollar sign on the right
indicates the end of a keyword.

* You can only write keywords using letters of the alphabet, dollar signs, parentheses,
commas, and spaces. You can put a space after an opening parenthesis, before and after
a comma, and before a closing parenthesis. Keywords are not case sensitive. You cannot
use a dollar sign inside of a keyword.

» The maximum length of a keyword, including spaces, is 100 characters.

Parameter Rules

» Parameters are enclosed in parentheses.

» Multiple parameters (up to 4) are separated by commas.

+ Examples of how parameters can be omitted are shown below.
$ReportDataSum(Hour, R001, ,23)$ The third parameter has been omitted.
$ReportDataSum(Hour, R001, 01, )$ or The fourth parameter has been omitted.
$ReportDataSum(Hour, R001, 01)$
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Excel Format Rules

» Set the data format by setting the cell format.

» Set the proper format for each keyword’s cell in the cell’'s Number properties.

» The keyword in a cell is only valid when the keyword name and parameters are all in the
same format. When a keyword’s font size or some other property is not consistent, it is

invalid.

$ReportDataSum(Hour, R001, 00, 23)$

keyword is invalid.

The font size of “Hour” is different, so the

+ If a single cell contains text and a keyword, only the format of the keyword has to be
consistent. The format of the text can be different.

Date and time: $DateTime$

The format of the keyword is consistent, so it

is valid.

Limitations on Report Types and Template Types

If you violate the rules illustrated below, data will not be output.

Keyword Template Type

Parameter

Report Kind Hour Day Week Month Hour + Day Day + Day + Batch Day

Week Month Custom

Hour v v

Day v v v v

Week v v

Month v v

Batch v

Custom v

Free v
Limitation on Report Types and Parameter Omissions
If you violate the rules illustrated below, it will be considered a keyword format error.
The keyword will not be converted and will remain as is.
Report Kind Start date and time End date and time Start number End number
Hour Start time (hour) End time (hour) — —
Day Start day End day — —
Week — — — —
Month — — — —
Batch Relative start time (minute) |Relative end time (minute) | Start number End number
Custom Start time (hour:minute) End time (hour:minute) — —
Free — — — —
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Keyword Definitions
For examples and details, see “Report Template Examples”.

System Keywords

Keyword Meaning Display Format
Time Current time Time*
Date Current date Date*
DateTime Current date and time
DateTimeString Current date and time Character string
Serial Serial number
Ch Channel number’
Tag Tag string’
Chlid Tag number’
Unit Unit'
FileName File name
Model Model
MeasCh Number of measurement channels Number
MathCh Number of math channels Number
Samplelnterval Sample interval Character string
CommentTitle File comment title?
Range: 1t0 8
CommentDetail File comment details?
Range: 1t0 8
PrintGroup Group number
PrintGroup(p1) Group number of the specified graph™®
PrintGroupName Group name
PrintGroupName(p1) Group name of the specified graph™
PrintRange Print range®

Range: G1 to G4

1 The parameter is the report channel number (it cannot be omitted).
2 The parameter is the comment number (it cannot be omitted).
3 The parameter is the graph number (it cannot be omitted). Excel templates can show down to

seconds.

4 The item becomes a character string in PDF and printer output.

5

The parameter is the graph number (it cannot be omitted).

* Report Data Keywords")

*.

. These keywords cannot be used for the Custom Print.

Keyword Meaning Display Format
ReportDateTime Report creation/print date and time™® Date and time
ReportDataDate Report creation date’ Date®
ReportDataTime Report creation time' Time®
ReportDataDateTime Report creation date and time' Date®

ReportDataDateTimeString

Report creation date and time'

ReportDataElapsedTimeString*

Report data time out date and time

Character string

ReportDataStatus Report data status?®

ReportDataSum Report data sum? Number or character
ReportDatalnst Instantaneous report data value? string3
ReportDataAve Average report data value?

ReportDataMax Maximum report data value®

ReportDataMin

Minimum report data value?®

1

[e>é)]

Write the parameters in this order: report type (cannot be omitted), report start date and time
(can be omitted), report end date, time (can be omitted), start number (can be omitted), and end
number (can be omitted).

Write the parameters in this order: report type (cannot be omitted), report channel number
(cannot be omitted), report start date and time (can be omitted), report end date and time (can
be omitted), start number (can be omitted), and end number (can be omitted).

The decimal point type (dot or comma) depends on whether the converted data is a value or
character string. Whether the converted data is a value or character string depends on the
format of the cell that the keyword is written in. When the cell format is numerical, the decimal
point type is determined by the cell format. When the cell format is text, the decimal point type
matches the format of the report data.

Valid only when the report type is Batch.

The item becomes a character string in PDF and printer output.

Write the parameters in this order: data reference (cannot be omitted), date type (cannot be
omitted).

IM 04L51B01-01EN
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Report Graph Keywords

Keyword Meaning Display Format Example

ExtGraph Report graph’ Image $ExtGraph(G1)$
Range: G1 to G4

1 The parameter is the graph number (it cannot be omitted).

Inserting a Graph
To insert a graph in a report template for Excel report files, follow the procedure below.

1. Insert a graph (image file) at the appropriate location in the created Excel template.
2. Right-click the graph, and select Format Picture.

3. From the menu on the left, select Alt Text.

4. In the Title box under Alt Text, type the above key word (“SExtGraph(G1)$”).

Format Picture |u|
. Alt Text
Line Color Title:
Line Style | $ExtGraph(G1)s |
C e IE_Jescr\phon:
| = = S . Reflection
H Glow and Soft Edges
1 3-D Format
. 3-D Rotation
: Picture Corrections '-I'I.ﬁes arid desc;ipﬁ:ons pro;fiae aii‘:e‘ma‘ti‘ve, ﬁexi‘:hase;:l
= representations of the information contained in tables, diagrams,
H Picture Color images, and other objects. This information is useful for people
i . with vision or cognitive impairments who may not be able to see or
£ Artigtic Effects understand the object.
g Crop A title can be read to a person with a disability and is used to
£ . determine whether they wish to hear the description of the
i g content,
E Properties
é Text Box
I_E- Alt Text
E | Close
: L0
Right-click on the picture
Special Keywords
Keyword Meaning Display Format
Repeat Specifies the output location of the data that corresponds The same as the
the report data keyword and the Index keyword (a corresponding keyword.
special keyword).
Copy Outputs all data that corresponds the report data The same as the
keyword and the Index keyword (a special keyword). corresponding keyword.
This keyword is valid for PDF and printer output.
Index Outputs serial numbers from the value specified by Number

“start” to the value specified by “end.”
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Parameters
Parameter Name Format Range Description Remarks
Report channel number Rxxx" R01-R100  The software’s report
channel
Report Kind Hour — Hourly report
Day — Daily report
Week — Weekly report
Month — Monthly report
Batch — Batch report
Custom — Daily custom
Free — For daily custom reports,
Computed results, such as
sum values, of data in the
file are appended to the file.
This piece of data is called
“Free.”
Start date and time hh? 00 to 23 Specifies the start hour Used in hourly
reports
dd® 01 to 31 Specifies the start day Used in daily
reports
mm* 0to 12000  Specify the start minute Used in batch
reports
hh:mm?® hh: 00 to 23  Specifies the start hour:time Used in Daily
mm: 00 to 59 custom reports
End date and time hh? 00 to 23 Specifies the end hour Used in hourly
reports
dd? 01 to 31 Specifies the end day Used in daily
reports
mm? 0 to 12000 Specify the end minute Used in batch
reports
hh:mm?® hh: 00 to 23  Specifies the end Used in Daily
mm: 00 to 59 hour:minute custom reports
Start number xxx' 001t0200 Specifies the start number Used in batch
End number xxx' 00110200 Specifies the end number ~ reports
Data Reference Start — Report start reference
End — Report end reference
Date Type Year — Year
Month — Month
Day - Day
Hour — Hour
Minute — Minute
Second — Second
WeekOfMonthSun — Week No. of the month.
Regard Sunday as the first
day of a week.
WeekOfMonthMon — Week No. of the month.
Regard Monday as the first
day of a week.
WeekOfYearSun — Week No. of the year.
Regard Sunday as the first
day of a week.
WeekOfYearMon — Week No. of the year.
Regard Monday as the first
day of a week.
1 xxx is a number without a limitation on the number of digits
2 hhis a number without a limitation on the number of digits
3 ddis a number without a limitation on the number of digits
4 mm is a number without a limitation on the number of digits
5 Spaces are allowed before and after colons.
6 Start time and end time are relative to the record start time.
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Starting and Ending Dates and Times

Use the start date and time and end date and time to specify the parts of the report file’s
report data that you will output to the file that you create with the template.

You can specify the starting and ending dates (for daily reports) or times (for hourly reports).

Report Kind Start Date and Time End Date and Time
Hour Start time (hour) End time (hour)

Day Start time (day) End time (day)

Batch Start time (minute) End time (minute)

Day custom Start time (hour:minute) End time (hour:minute)

Example when the report type is hourly and the report is created at 18:00.

| $ReportDataSum(Hour,R001,20,22)$ | | $ReportDataSum(Hour,R001,16,19)$ |
Report |
h 18:00] [19:00] [20:00] [21:00] [22:00] |----- | [16:00] [17:00] [18:00] [19:00]
creation [ [ [ [ [ [ | | |
time ,
I \ \ \ \ )Y \ \ | \

Report Report
file 1 file 2

Keyword: $ReportDataSum(Hour,R001,20,22)$

From the hourly data from 19:00:01 to 22:00:00, the report data (sums) of report channel
R001 for 20:00, 21:00, and 22:00 is output.

Keyword: $ReportDataSum(Hour,R001,16,19)$

From the hourly data from 15:00:01 to 19:00:00, the report data (sums) of report channel
R001 for 16:00, 17:00, and 18:00 is output. Because the report data for 19:00 is in another
report file, it is not output.

Keyword: $ReportDataSum(Hour,R001)$

One file’s worth (18:00:01 to 18:00:00) of data from report channel R001 is output, starting
from 19:00.

When you omit the start and end times for an hourly report, the data for the hour after the
report creation time until the 24th hour is output. For daily reports, the data for the day after
the report creation time until the end of the month is output.

Keyword: $ReportDataSum(Hour,R001,08)$

From the hourly data from 07:00:01 to 18:00:00, the report data (sums) of report channel
R001 for 08:00 to 18:00 is output.

App-6
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Report Template Examples

System Keyword Examples
Intermixed Keyword and Text

File header: $FileHeader$

Date and time: $DateTime$

i)

File header: GX20

Date and time: 2012/12/01 12:00:00

Intermixed Multiple Keyword and Text

Device number: $Serial$ File Header: $FileHeader$

1
Device number: ABCDEFG File Header: GX20

Report Data Keyword Examples

The following examples are for when the hourly report data for report channel R001 is 101,
102, 103, 104, and 105 and the hourly report data for report channel R002 is 201, 202, 203,

204, 205, and 206.

The $Repeat$ command applies to the closest keyword above the command in the same

column.
$ReportDatalnst(Hour,R001)$ 101
$Repeat$ 102
$Repeatd 103
$Repeat$ 104
$ReportDatalnst(Hour,R002)$ 201
$Repeat$ 202
$Repeat$ 203
$Repeatd 204
$Repeat$ 205

The $Repeat$ command applies to the keyword above it in the same column, even when
that keyword is not directly above the command.

$ReportDatalnst(Hour,R001)$ 101

$Unit(R001)$ °C

$Repeat$ 102

$Unit(RO01)$ °C

$Repeat$ $Unit(RO01)$ 103 °C

keyword does not exist, nothing is output.

You can mix system keywords, report data keywords, and text. If the data specified by

Q

$ReportDatalnst(Hour,R001)$($Unit 101 (°C)
(RO01)$)

$Repeat$ 102
$Repeat$ 103
$Repeat$($Unit(RO01)$) 104 (°C)
$Repeat$(°C) 105 (°C)
$Repeat$

IM 04L51B01-01EN
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Appendix 1 Creating Report Templates

Keywords in merged cells are affected by the leftmost cells above them.

$ReportDatalnst(Hour,R001)$ $ReportDatalnst(Hour,R002)$
$Repeat$ $Repeat$ \
$Repeat$ $Repeat$
[$Repeat$ $Repeat$ |
101 201
102 202
203
1103 204 \

When a keyword is written incorrectly or its formatting is wrong, the keyword will be output to

the file as it is written.

$ReportDatalnst(Hour,R)$

$ReportDataInst(Hour‘,R)$

$ReportDatalnst(Hour,R002)$

.
$ReportDatalnst(Hour,R002)$ 201
$Repeat$ $Repeat$
$Repeat$ 202
$Repeat$ 203
$Repeat$ 204
$ReportDatalnst(Hour,R001)$ " 101

$ReportDataInst(Hour‘,R002)$

1 When there are multiple system keywords in the same cell, only the first keyword is valid.

Creating Report Templates for PDF Report Files and Printer Output

Report templates for PDF report files (*.tpl) are created using SMARTDAC+ Report
Template Builder. Report Template Builder can be downloaded from the following URL for

free.

www.smartdacplus.com/software/en/
In Report Template Builder, keywords, text, and images (JPG, PNG, BMP) are arranged in
tables, graphs, and text components to create report templates.
Keywords specify the type of data that will be entered into a cell. Text are output as they are

in reports.

J SMAETIAL » Regut Tempiote ader -

fhe [t gew desrgevent  Lorfee levpiay "_‘lb.
Da#dnn Rxr v aq

G~ AMB %

[y

[Fie name
[Date

Marme
Uit

SMART i+ R2 Report

[sFieressers |

[DateTimes

Is;uu number |

[Channel Number[SCHROO1)S  [SCHRC02)S
I [Tark 1 temperat Tark 1 lemperati No3 Voltage | Nod rpmn I
[SUnt(ROOTIS  |SUnHRO02S  [SUMROIS  |SURARO4)S  |Sunt
'smmomm:ﬁnwoaulm:$R¢waau1m<:$Rmelm:smealaIMl:Sﬂ

[scHRO3)S  [SCHROYS  [SCH(

.SRep-ul!» SRepeats SRepeatd SRepeats SRepeats £Rgy
[SRepeats  [SRepeats  [SRepeatSs  |SRepeats  |SRepeati SR
[SRepaats  |SRepeats  |SRepeats [$Rapeats  |SRepeats R
[sRepaats  |SRepeats  |SRepeats |sRapeats  [SRepeats |88
[sRepeats  [sRepears  [sRepears |sRapeats  [SRepeas  [sR
SRepeats SRepeat$ SRepeat SRepeats SRepeats SR
"

SRepeats SRepeatl

e ]
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Appendix 1 Creating Report Templates

To insert a graph in a template, click the Graph for GA10 icon @ and enter the
keyword $ExtGraph(G1)$.

[+ SMARTDAC+ Repert Template Builder - RepTempSample_C_1page.tpl* [=[=] = ]

‘ I7AIUF) BEE) FTR(V) BEA) FTrIL—bESEC) ~LT(H) ‘
DB BaT s BBEXE Y[aa
=mE A = 5@

]

$ExtGraph(G1)$

e DR E

A

For the keywords that you can use, see Creating Report Templates for Report Files in

Excel Format.

IM 04L51B01-01EN
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Appendix2 Modbus Device Definition File Example

A sample Modbus device definition file is provided in the following pages. The sample shows
how the XML file should be structured.

When you create a Modbus device definition file, refer to the description of registers
in the user’s manual of the Modbus device that you want to connect. You can also use
the Modbus Device Definition File Creating Tool by downloading it from the YOKOGAWA
website.

www.smartdacplus.com/software/en/

<?xml version="1.0" encoding="utf-8"?>
<ModbusDevice Type="A" PortNo="502" CommandDelay="0"> Match Type (Modbus device name) with the file name.

<Options>
<Option Name="remote" />

</Options>

<Registers> Specify all the data to load from the device.
<Register Name="PVERROR1" FunctionCode="3" Address="42002" DataType="INT16"></Register>
<Register Name="PV1" FunctionCode="3" Address="42003" DataType="INT16"></Register>
<Register Name="CSP1" FunctionCode="3" Address="42004" DataType="INT 16"></Register>
<Register Name="OUT1" FunctionCode="3" Address="42005" DataType="INT16"></Register>
<Register Name="HOUT1" FunctionCode="3" Address="42006" DataType="INT16"></Register>
<Register Name="COUT1" FunctionCode="3" Address="42007" DataType="INT 16"></Register>
<Register Name="MOD1" FunctionCode="3" Address="42008" DataType="INT16"></Register>
<Register Name="PID1" FunctionCode="3" Address="42009" DataType="INT16"></Register>
<Register Name="CSPNO" FunctionCode="3" Address="42010" DataType="INT16"></Register>
<Register Name="ALM1" FunctionCode="3" Address="42011" DataType="INT16"></Register>
<Register Name="ALM2" FunctionCode="3" Address="42013" DataType="INT 16"></Register>
<Register Name="PVERROR2" FunctionCode="3" Address="42018" DataType="INT16"></Register>
<Register Name="PV2" FunctionCode="3" Address="42019" DataType="INT16"></Register>
<Register Name="CSP2" FunctionCode="3" Address="42020" DataType="INT 16"></Register>
<Register Name="OUT2" FunctionCode="3" Address="42021" DataType="INT16"></Register>
<Register Name="HOUT2" FunctionCode="3" Address="42022" DataType="INT16"></Register>
<Register Name="COUT2" FunctionCode="3" Address="42023" DataType="INT 16"></Register>
<Register Name="MOD2" FunctionCode="3" Address="42024" DataType="INT16"></Register>
<Register Name="PID2" FunctionCode="3" Address="42025" DataType="INT16"></Register>
<Register Name="A11" FunctionCode="3" Address="42104" DataType="INT16"></Register>
<Register Name="A21" FunctionCode="3" Address="42105" DataType="INT16"></Register>
<Register Name="A31" FunctionCode="3" Address="42106" DataType="INT16"></Register>
<Register Name="A41" FunctionCode="3" Address="42107" DataType="INT16"></Register>
<Register Name="A12" FunctionCode="3" Address="42154" DataType="INT16"></Register>
<Register Name="A22" FunctionCode="3" Address="42155" DataType="INT16"></Register>
<Register Name="A32" FunctionCode="3" Address="42156" DataType="INT16"></Register>
<Register Name="A42" FunctionCode="3" Address="42157" DataType="INT16"></Register>
<Register Name="AL11" FunctionCode="3" Address="42801" DataType="INT16"></Register>
<Register Name="AL21" FunctionCode="3" Address="42805" DataType="INT16"></Register>
<Register Name="AL31" FunctionCode="3" Address="42809" DataType="INT16"></Register>
<Register Name="AL41" FunctionCode="3" Address="42813" DataType="INT16"></Register>
<Register Name="AL12" FunctionCode="3" Address="43901" DataType="INT16"></Register>
<Register Name="AL22" FunctionCode="3" Address="43905" DataType="INT16"></Register>
<Register Name="AL32" FunctionCode="3" Address="43909" DataType="INT16"></Register>
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<Register Name="AL42" FunctionCode="3" Address="43913" DataType="INT16"></Register>
<Register Name="BSL" FunctionCode="3" Address="45109" DataType="INT16"></Register>
<Register Name="PUNI1" FunctionCode="3" Address="45201" DataType="INT16"></Register>
<Register Name="PDP1" FunctionCode="3" Address="45202" DataType="INT16"></Register>
<Register Name="PRH1" FunctionCode="3" Address="45203" DataType="INT16"></Register>
<Register Name="PRL1" FunctionCode="3" Address="45204" DataType="INT16"></Register>
<Register Name="PUNI2" FunctionCode="3" Address="45221" DataType="INT16"></Register>
<Register Name="PDP2" FunctionCode="3" Address="45222" DataType="INT 16"></Register>
<Register Name="PRH2" FunctionCode="3" Address="45223" DataType="INT16"></Register>
<Register Name="PRL2" FunctionCode="3" Address="45224" DataType="INT16"></Register>

<Register Name="CTRLMODE" FunctionCode="3" Address="45001" DataType="INT16"></Register>
<Register Name="CTRLTYPEL1" FunctionCode="3" Address="45003" DataType="INT16"></Register>
<Register Name="CTRLTYPEL2" FunctionCode="3" Address="45004" DataType="INT16"></Register>
<Register Name="AMR" FunctionCode="3" Address="42301" DataType="INT16"></Register>
<Register Name="AMW" FunctionCode="6" Address="42301" DataType="INT16"></Register>
<Register Name="CAMR" FunctionCode="3" Address="42303" DataType="INT16"></Register>
<Register Name="CAMW" FunctionCode="6" Address="42303" DataType="INT16"></Register>
<Register Name="RSR" FunctionCode="3" Address="42304" DataType="INT16"></Register>
<Register Name="RSW" FunctionCode="6" Address="42304" DataType="INT16"></Register>
<Register Name="LRL1R" FunctionCode="3" Address="42306" DataType="INT16"></Register>
<Register Name="LRL1W" FunctionCode="6" Address="42306" DataType="INT16"></Register>
<Register Name="LRL2R" FunctionCode="3" Address="42307" DataType="INT16"></Register>
<Register Name="LRL2W" FunctionCode="6" Address="42307" DataType="INT16"></Register>
<Register Name="ATL1R" FunctionCode="3" Address="42308" DataType="INT16"></Register>
<Register Name="ATL1W" FunctionCode="6" Address="42308" DataType="INT16"></Register>
<Register Name="ATL2R" FunctionCode="3" Address="42309" DataType="INT16"></Register>
<Register Name="ATL2W" FunctionCode="6" Address="42309" DataType="INT16"></Register>
<Register Name="SPNOR" FunctionCode="3" Address="42312" DataType="INT16"></Register>
<Register Name="SPNOW" FunctionCode="6" Address="42312" DataType="INT16"></Register>
<Register Name="MOUTL1R" FunctionCode="3" Address="42333" DataType="INT16"></Register>
<Register Name="MOUTL1W" FunctionCode="6" Address="42333" DataType="INT16"></Register>
<Register Name="MOUTCL1R" FunctionCode="3" Address="42334" DataType="INT16"></Register>
<Register Name="MOUTCL1W" FunctionCode="6" Address="42334" DataType="INT16"></Register>
<Register Name="MOUTL2R" FunctionCode="3" Address="42335" DataType="INT16"></Register>
<Register Name="MOUTL2W" FunctionCode="6" Address="42335" DataType="INT16"></Register>
<Register Name="MOUTCL2R" FunctionCode="3" Address="42336" DataType="INT16"></Register>
<Register Name="MOUTCL2W" FunctionCode="6" Address="42336" DataType="INT16"></Register>

</Registers>

<Channels>
<Channel Name="PV1"> PV1 channel settings -

<Init>
<DecimalPos Register="PDP1"></DecimalPos> Decimal place
<Min Register="PRL1"></Min>
<Max Register="PRH1"></Max> :l Maximum and minimum values
<Unit Register="PUNI1" Trans="temperature"></Unit> Unit

</Init>

PV1 basic information
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<Value Register="PV1">

<PlusOver Register="PVERROR1" Mask="0x0010"></PlusOver> :I .
over, -over

<MinusOver Register="PVERROR1" Mask="0x0020"></MinusOver>
<DataError Register="PVERROR1" Mask="0x4000"></DataError> Error"
<Burnout>
<Type Register="BSL"></Type> :I Burmout
<Value Register="PVERROR1" Mask="0x0001"></Value>
</Burnout>
</Value>
<Alarms>
<Alarm> First alarm (up to four)
<Type Register="AL11" Trans="alarmTypesPV"></Type> Alarm type

<Value Register="ALM1" Mask="0x0001"></Value> Alarm setting
<SetValue Register="A11"></SetValue> Alarm value
</Alarm>
<Alarm> Second alarm

<Type Register="AL21" Trans="alarmTypesPV"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>

</Alarm>

<Alarm> Third alarm
<Type Register="AL31" Trans="alarmTypesPV"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>

</Alarm>

<Alarm> Fourth alarm
<Type Register="AL41" Trans="alarmTypesPV"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>

</Alarm>
</Alarms>
</Channel>
<Channel Name="SP1"> SP1 channel settings
<Init>
<DecimalPos Register="PDP1"></DecimalPos>
<Min Register="PRL1"></Min>
<Max Register="PRH1"></Max>
<Unit Register="PUNI1" Trans="temperature"></Unit>
</Init>
<Value Register="CSP1"> </Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesSP"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesSP"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>

PV1 values

1. Masked because the parameter
contains multiple pieces of
1 information.

PV1 alarm information
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<SetValue Register="A21"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL31" Trans="alarmTypesSP"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesSP"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="0OUT1" DecimalPos="1" Min="0" Max="100" Unit="%"> OUT1 channel settings
<Value Register="OUT1"></Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL31" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="HOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="HOUT1"></Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesOUT"></Type>
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<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL31" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="COUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="COUT1"></Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL31" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="PIDNO1" DecimalPos="0" Min="0" Max="8">
<Value Register="PID1"></Value>
</Channel>
<Channel Name="PV2">
<Init>
<DecimalPos Register="PDP2"></DecimalPos>
<Min Register="PRL2"></Min>
<Max Register="PRH2"></Max>
<Unit Register="PUNI2" Trans="temperature"></Unit>
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</Init>
<Value Register="PV2">
<PlusOver Register="PVERROR2" Mask="0x0010"></PlusOver>
<MinusOver Register="PVERROR2" Mask="0x0020"></MinusOver>
<DataError Register="PVERROR2" Mask="0x4000"></DataError>
<Burnout>
<Type Register="BSL"></Type>
<Value Register="PVERROR2" Mask="0x0001"></Value>
</Burnout>
</Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesPV"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesPV"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesPV"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesPV"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="SP2">
<Init>
<DecimalPos Register="PDP2"></DecimalPos>
<Min Register="PRL2"></Min>
<Max Register="PRH2"></Max>
<Unit Register="PUNI2" Trans="temperature"></Unit>
</Init>
<Value Register="CSP2"> </Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesSP"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesSP"></Type>
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<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesSP"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesSP"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="OUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="0OUT2"></Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>

<Channel Name="HOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">

<Value Register="HOUT2"></Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
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<Alarm>
<Type Register="AL22" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="COUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="COUT2"></Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="PIDNO2" DecimalPos="0" Min="0" Max="8">
<Value Register="PID2"></Value>
</Channel>
<Channel Name="SPNQO" DecimalPos="0" Min="1" Max="8">
<Value Register="CSPNO"></Value>
</Channel>
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<Channel Name="AUTO/MAN" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD1" Mask="0x0001"></Value>
</Channel>
<Channel Name="AUTO/MAN/CAS" DecimalPos="0" Min="0" Max="2">
<Value Register="MOD1" Mask="0x0070" Trans="AMCValue"></Value>
</Channel>
<Channel Name="LOCAL/REMOTE1" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD1" Mask="0x0002"></Value>
</Channel>
<Channel Name="LOCAL/REMOTEZ2" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD2" Mask="0x0002"></Value>
</Channel>
<Channel Name="RUN/STOP" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD1" Mask="0x0004"></Value>
</Channel>
<Channel Name="AutoTuning1" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD1" Mask="0x4000"></Value>
</Channel>
<Channel Name="AutoTuning2" DecimalPos="0" Min="0" Max="1">
<Value Register="MOD2" Mask="0x4000"></Value>
</Channel>
<Channel Name="CTRLMODE" DecimalPos="0" Min="0" Max="100">
<Value Register="CTRLMODE">
</Value>
</Channel>
<Channel Name="CTRLTYPE1" DecimalPos="0" Min="0" Max="100">
<Value Register="CTRLTYPEL1">
</Value>
</Channel>
<Channel Name="CTRLTYPEZ2" DecimalPos="0" Min="0" Max="100">
<Value Register="CTRLTYPEL2">
</Value>
</Channel>
<Channel Name="C_AUTO/MAN" DecimalPos="0" Min="0" Max="1">
<Value Register="AMR">
<Write Register="AMW">
</Write>
</Value>
</Channel>
<Channel Name="C_AUTO/MAN/CAS" DecimalPos="0" Min="0" Max="2">
<Value Register="CAMR">
<Write Register="CAMW">
</Write>
</Value>
</Channel>
<Channel Name="C_RUN/STOP" DecimalPos="0" Min="0" Max="1">
<Value Register="RSR">
<Write Register="RSW">
</Write>
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</Value>
</Channel>
<Channel Name="C_LOCAL/REMOTE1" DecimalPos="0" Min="0" Max="1">
<Value Register="LRL1R">
<Write Register="LRL1W">
</Write>
</Value>
</Channel>
<Channel Name="C_LOCAL/REMOTE2" DecimalPos="0" Min="0" Max="1">
<Value Register="LRL2R">
<Write Register="LRL2W">
</Write>
</Value>
</Channel>
<Channel Name="C_AUTOTUNING1" DecimalPos="0" Min="0" Max="9">
<Value Register="ATL1R">
<Write Register="ATL1W">
</Write>
</Value>
</Channel>
<Channel Name="C_AUTOTUNING2" DecimalPos="0" Min="0" Max="9">
<Value Register="ATL2R">
<Write Register="ATL2W">
</Write>
</Value>
</Channel>
<Channel Name="C_SPNO" DecimalPos="0" Min="1" Max="8">
<Value Register="SPNOR">
<Write Register="SPNOW">
</Write>
</Value>
</Channel>
<Channel Name="C_MOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="MOUTL1R">
<Write Register="MOUTL1W">
</Write>
</Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>
</Alarm>
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<Alarm>
<Type Register="AL31" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesOUT"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="C_MCOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="MOUTCL1R">
<Write Register="MOUTCL1W">
</Write>
</Value>
<Alarms>
<Alarm>
<Type Register="AL11" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0001"></Value>
<SetValue Register="A11"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL21" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0002"></Value>
<SetValue Register="A21"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL31" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0004"></Value>
<SetValue Register="A31"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL41" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM1" Mask="0x0010"></Value>
<SetValue Register="A41"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="C_MOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="MOUTL2R">
<Write Register="MOUTL2W">
</Write>
</Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>

App-20 IM 04L51B01-01EN



Appendix 2 Modbus Device Definition File Example

<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesOUT"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
<Channel Name="C_MCOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
<Value Register="MOUTCL2R">
<Write Register="MOUTCL2W">
</Write>
</Value>
<Alarms>
<Alarm>
<Type Register="AL12" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0001"></Value>
<SetValue Register="A12"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL22" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0002"></Value>
<SetValue Register="A22"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL32" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0004"></Value>
<SetValue Register="A32"></SetValue>
</Alarm>
<Alarm>
<Type Register="AL42" Trans="alarmTypesCOUT"></Type>
<Value Register="ALM2" Mask="0x0010"></Value>
<SetValue Register="A42"></SetValue>
</Alarm>
</Alarms>
</Channel>
</Channels>
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<TransTables>

<Table Name="AMCValue" ToDataType="Int">
<Value From="0x0020" To="0"></Value>
<Value From="0x0040" To="1"></Value>
<Value From="0x0010" To="2"></Value>

</Table>

<Table Name="temperature" ToDataType="String">
<Value From="0" To=""></Value>
<Value From="1" To="°C"></Value>
<Value From="2" To=" "></Value>
<Value From="3" To=""></Value>
<Value From="4" To=""></Value>
<Value From="5" To="°F"></Value>

</Table>

<Table Name="alarmTypesPV" ToDataType="String">
<Value From="0" To="OFF"></Value>
<Value From="1" To="H"></Value>
<Value From="2" To="L"></Value>
<Value From="3" To="ETC"></Value>
<Value From="4" To="ETC"></Value>
<Value From="5" To="ETC"></Value>
<Value From="6" To="ETC"></Value>
<Value From="7" To="ETC"></Value>
<Value From="8" To="ETC"></Value>
<Value From="9" To="ETC"></Value>
<Value From="10" To="ETC"></Value>
<Value From="11" To="ETC"></Value>
<Value From="12" To="ETC"></Value>
<Value From="13" To="ETC"></Value>
<Value From="14" To="ETC"></Value>
<Value From="15" To="ETC"></Value>
<Value From="16" To="ETC"></Value>
<Value From="17" To="ETC"></Value>
<Value From="18" To="ETC"></Value>
<Value From="19" To="ETC"></Value>
<Value From="20" To="ETC"></Value>
<Value From="21" To="ETC"></Value>
<Value From="22" To="ETC"></Value>
<Value From="23" To="ETC"></Value>
<Value From="24" To="ETC"></Value>
<Value From="25" To="ETC"></Value>
<Value From="26" To="ETC"></Value>
<Value From="27" To="ETC"></Value>
<Value From="28" To="ETC"></Value>
<Value From="29" To="ETC"></Value>
<Value From="30" To="ETC"></Value>
<Value From="31" To="ETC"></Value>

</Table>
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<Table Name="alarmTypesSP" ToDataType="String">
<Value From="3" To="H"></Value>
<Value From="4" To="L"></Value>
<Value From="9" To="H"></Value>
<Value From="10" To="L"></Value>
<Value From="11" To="ETC"></Value>
<Value From="12" To="ETC"></Value>
<Value From="13" To="ETC"></Value>
<Value From="14" To="ETC"></Value>

</Table>

<Table Name="alarmTypesOUT" ToDataType="String">
<Value From="15" To="H"></Value>
<Value From="16" To="L"></Value>

</Table>

<Table Name="alarmTypesCOUT" ToDataType="String">
<Value From="17" To="H"></Value>
<Value From="18" To="L"></Value>

</Table>

</TransTables>
</ModbusDevice>[EOF]
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Appendix3 GA10 Storage Data Size

The following table shows a guideline of the GA10’s record file sizes.
Note that using the report/print function (/RP option) to perform printing will consume a free
hard disk space twice the total file size shown in the following table.

Calculation of Each Block Size in Files

Block Size (Byte)
Common 2568
Group information 24 + (208 + 216 x the number of channels assigned to each display group) x

the number of groups

Channel information 24 + 408 x the number of channels

Message information 72 + 200 x the number of messages

Recorded data 424 + 16 x the number of channels + (16 + data size x the number of
channels) x the number of data points.

+ Substitute the following for the “data size” and “number of data points” of recorded data.
Data size: Up to 6 bytes
Number of data points: Recording time/recording interval.

» Use the calculated file size as a rough guide.

Calculation Example

The file size will be calculated for 500 channels, 1 s recording interval, 10 display groups, 50
channels which are assigned to each display group, 10 messages, and 1 hour recording.

Block Size (Byte)

Common 2568

Group information 24 + (208 + 216 x 50) x 10 = 110104

Channel information 24 + 408 x 500 = 204024

Message information 72 + 200 x 10 (the number of messages) = 2072

Recorded data 424 + 16 x 500 + (16 + 6 x 500) x 3600 = 10866024

File sizes = Common + Group information + Channel information + Message information +
Recorded data = 11184792 bytes
11184792 (byte) /1024/1024 =10.66665 (MB) = Approximately 11 MB.

Size of the file created will be about 11 MB. Using the report/print function will
consume about 21 MB of hard disk space.
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